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Chapter 1: Overview

This document provides information about the administration, configuration and use of version 6.3 of
ArcSight Data Platform (ADP) Logger and standalone ArcSightLogger. It includes information on
storage, receiver, and forwarder configuration; working with events; user management; and setup and
maintenance considerations.

Note: Where there are no specific differences, all types of Logger are called Logger in this
document. Where there are differences, the specific type of Logger is indicated.

O INTrOdUCH ON 22
O | 0gger FeatUreS L 23
o Deployment SCONAIIOS .. o 28
e Centralized Management il 31
e Running Logger on Encrypted Appliances .. .l 31

Introduction

Logger is a log management solution that is optimized for extremely high event throughput, efficient
long-term storage, and rapid data analysis. Logger receives and stores events; supports search, retrieval,
and reporting; and can optionally forward selected events. Logger compresses raw data, but can always
retrieve unmodified data on demand for forensics-quality litigation data.

You can have a single, standalone Logger or as many as you need. As part of the ArcSight Data
Platform (ADP), Logger is managed by ArcSight Management Center (ArcMC). Multiple Loggers can
work together o scale up to support extremely high event volume with search queries distributed
across all Loggers.

Logger is available in the form factors: an appliance and software. The appliance-based solution is a
hardened, dedicated, enterprise-class system that is optimized for extremely high event throughput,
efficient long-term storage, and rapid data analysis. The software-based solution is similar in feature
and functionality to the appliance-based solution, however, the software solution enables you to install
ArcSightLogger on a supported platform of your choice. The software version is also available as a
VMware VM.

An event consists of a receipt time, an event time, a source (host name or IP address), and an un-parsed
message portion. Logger displays events in a tabular form, with fields that describe how Logger
received the event.
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Similar to ArcSight Manager, Logger receives structured data in the form of normalized Common Event
Format (CEF) events and unstructured data, such as syslog events. The file-type receivers configured
on Logger only parse event fime from an event. Although Logger is message-agnostic, it can do more
with messages that adhere to the Common Event Format (CEF), an industry standard for the
interoperability of event- or log-generating devices.

For more information about CEF, refer to the document "ArcSight CEF.": For a downloadable a copy of
this guide, search for “ArcSight Common Event Format (CEF) Guide” in the ArcSight Product
Documentation Community on Protect 724.

Logger is available in the form factors: an appliance and software. The appliance-based solution is a
hardened, dedicated, enterprise-class system that is optimized for extremely high event throughput,
efficient long-term storage, and rapid data analysis. The software-based solution is similar in feature
and functionality to the appliance-based solution, however, the software solution enables you to install
ArcSight Logger on a supported platform of your choice. The sofware version is also available as a
VMware VM.

Logger Features

The following sections provide an overview of key Logger features with links to relevant sections of this
guide.

e Storage ConfiguIratioN o L 24
o Receiver ConfigUIatioN . 24

o ANalyzing EVeNtS il 25
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® GroUPING EVENTS 26
® EXPOrting EVeNTS L 26
o Forwarder Configuration ... L 27
o User Management . 27
e Other Setup and MainteNaNCe ... .. o L 28

Storage Configuration

Logger events can be stored locally on any Logger and remotely on Logger Appliance models that
support Storage Area Network (SAN). SAN can be used for storing events on both types of Loggers;
however, only one LUN can be used for storing events. Using a Network File System (NFS) as primary
storage for events is not recommended.

The Logger Appliance includes onboard storage for events. Some Logger models include RAID 1or
RAID 5 storage systems. (See Logger specifications at http://www8.hp.com/us/en/software-

solutions/enterprise-security.html.)
Events are stored compressed. You cannot configure the compression level.

An NFS or a CIFS system can be used for archiving Logger data such as event archives, Saved Searches,
exported filters and alerts, and configuration backup information. You can also configure the Logger to
read event data or log files from a CIFS host.

The storage volume, either external or local, can be divided into multiple storage groups, each with a
separate retention policy. Two storage groups are created when Logger is first configured. New storage
groups can be added later. A storage group’s size can be increased or decreased and the retention
policy defined for it can be changed.

For more information on storage strategy, refer to the Logger Installation Guide. For more information
on event storage, see "Storage" on page 347.

Receiver Configuration

Logger receives events as syslog messages, encrypted SmartMessages, Common Event Format (CEF)
messages, or by reading log files. Traditionally, syslog messages are sent using User Datagram Protocol
(UDP), but Logger can receive syslog and CEF messages using the more reliable Transmission Control
Protocol (TCP) as well.

Logger can also read events from text log files on remote hosts. Log files can contain one event per line
or event messages that span multiple lines separated by characters such as newline (\n) or a carriage
return (\r). Each event must include a fimestamp. Logger can be configured to poll remote folders for
new files matching a filename pattern. Once the events in the new file have been read, Logger can delete
the file, rename it, or simply remember that it has been read. Logger can read remote files on network
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drives using SCP, SFTP, or FTP protocol, or using a previously-established NFS or CIFS mount or, on
some Logger Appliance models, a SAN.

/Ret.eiver
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Logger may also receive events from an ArcSight Manager as CEF-formatted syslog messages. These
events are forwarded to Logger through a special software component called an ArcSight Forwarding
SmartConnector that converts the events into CEF-formatted syslog messages before sending them to
Logger.

o For more information on setting up receivers, see "Receivers" on page 294

o For more information on setting up SmartConnectors, refer to the Logger Installation Guide.

o For more information on collecting events from ArcSight ESM, refer to the Logger Installation Guide.

Analyzing Events

Events can be searched, yielding a table of events that match a particular query. Queries can be entered
manually or automatically created by clicking on terms in the event table. Queries can be based on plain
English keywords (full-text search), predefined fields, or specified as regular expressions. Logger
supports a flow-based search language that allows you to specify multiple search commands in a
pipeline format.

By default, a Logger queries only its primary data store even if peer Loggers are configured. However,
you can configure it to distribute a query across peer Loggers of your choice.
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Queries can be saved as a filter or as a saved search. Saved filters can be used to select events for
forwarding or to filter for the same things later. A Saved Search is used to export selected events or to
save results to a file, typically as a scheduled task.

The following topics provide more information about analyzing events:

e "Searching for Events" on page 102

e "Saving Queries (Creating Saved Searches and Saved Filters)" on page 129
o "Filters" on page 260

e "Saved Searches" on page 264

o "Parsers" on page 315

Grouping Events

The combination of a source IP address and a Logger receiver is called a device. As events are received,
devices are automatically created for each IP/receiver pair. Devices can also be created manually.

Devices can be categorized by membership in one or more device groups. While an incoming event
belongs to one and only one device, it can be associated with more than one device group.

Storage rules associate a device group with a storage group. Storage rules are ordered by priority, and
the first matching rule determines to which storage group an incoming event will be sent.

Device groups, devices, storage groups, and peer Loggers can each be used to filter events using Search
Constraints, which can be specified interactively on the Analyze page as well as when creating filters or
Saved Searches.

The following topics provide more information about grouping events:

e "Event Archives" on page 351
¢ "Storage Rules" on page 349
e "Searching Peers (Distributed Search)" on page 107

Exporting Events

A Logger Appliance can export events to various sources. Events that match the current query can be
exported locally, to an NFS mount, a CIFS mount, as a file or to a SAN, when the appliance supports
SANSs.

Events from a Software Logger can be exported locally to the Logger (to the
<install dir>/data/logger directory) or to the browser from which you connect to the Logger.
The<install _dir>/data/logger directory can be mounted to an NFS or CIFS.

Events can be exported in Comma-Separated Values (CSV) format for easy processing by external
applications or as a PDF file for generating a quick report. A PDF report includes a table of search
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results and any charts generated for the results. Both raw (unstructured data) and CEF events
(structured data) can be included in the PDF exported report.

Events in Common Event Format (CEF) have more columns defined, making the data more useful, but
non-CEF events can be exported as well, if desired. The user can control which fields are exported.

Exports can be scheduled to run regularly by creating a Saved Search Job. First, a Saved Search is
created, either manually or by saving a query on the Analyze page. A Saved Search can be based on an
existing filter. A Saved Search Job combines one or more Saved Searches and a schedule with export
options.

The following topics provide more information about exporting events:

e "Exporting Search Results" on page 126
e "Time/NTP"on page 410
e "Scheduled Searches/Alerts" on page 265

Forwarder Configuration

Logger can send events (as they are received or past events) to other hosts using UDP or TCP, to a
Logger Streaming SmartConnector, or to an ArcSight Manager. The events sent to a particular host can
be filtered by a query that events must match. Outgoing syslog messages can be configured to either
pass the original source IP and timestamp or to use Logger's “send time” and IP address.

Syslog messages can be sent to an ArcSight Manager using a syslog SmartConnector, but Logger can
also send CEF events directly to an ArcSight Manager using its built-in SmartConnector. Logger can act
as a funnel, receiving events at very high volumes and sending fewer, filtered events on to an ArcSight
Manager, as depicted under "Logger can act as a funnel, forwarding selected events tfo ArcSight
Manager" on page 29.

The following topics provide more information about forwarding events:

e "Forwarders" on page 321

o "ESM Destinations" on page 339

User Management

User accounts can be created by the Logger administrator to distinguish between different users of the
system. User accounts inherit privileges from the User Group to which they belong. User Groups can
have an enforced event filter applied to them, limiting the events that a specific user can see.

The following topics provide more information about user management:

e "Users/Groups" on page 442
e "Change My Password" on page 459
e "Search Group Filters" on page 263

HPE Logger 6.3 Page 27 of 623



Administrator's Guide
Chapter 1: Overview

Other Setup and Maintenance

Logger configuration settings, such as receivers, filters, Saved Search jobs, and so on—everything
except events—can be backed up as a configuration backup file to any disk and later restored.

Logs detailing Logger activity can be downloaded through the browser on demand, for debugging or
other reasons. Other system information is available for viewing. Various system settings can be
modified. Some require a system reboot or restart for the changes to take effect.

The Logger Appliance can be rebooted using controls in the user interface. For Software Logger, the
Logger service and related processes can be restarted. Follow instructions in "Software Logger
Command Line Options" on page 468 to start, stop, or restart Software Logger.

The following topics provide more information about setup and maintenance:

¢ "Configuration Backup and Restore" on page 383
o "Retrieve Logs" on page 364

e "Storage"on page 421

e "System"on page 404

o "License & Update" on page 413

o "Network" on page 406

Deployment Scenarios

Typically, Logger is deployed inside the perimeter firewall with a high degree of physical security to
prevent tampering with the collected event information. Logger does not require other ArcSight
products. It receives and forwards syslog and log file events created by a wide variety of hardware and
software network products.

Logger also inter-operates with ArcSight Manager as shown in the following figures. A typical use of
Logger is to collect firewall or other data and forward a subset of the data to ArcSight Manager for real-
time monitoring and correlation, as shown below. Logger can store the raw firewall data for compliance
or service-level agreement purposes.
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Logger can act as a funnel, forwarding selected events to ArcSight Manager
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Logger can store and forward filtered events in a hierarchical ArcSight Manager deployment

{Logger has a built-in
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Setting up Search Heads for Faster Peer Searches

If you have several peered Loggers and many users that need to search at the same time, you can set up
your Loggers so that some of them are used for receiving, storing, and forwarding events, and others
are used only for searching their peers.

A nodeis any peered Logger used for receiving, storing, and forwarding events. A search head is a
peered Logger that is only used for searching. Search heads do not forward, receive, or store events. To
take advantage of search heads, you must set up your architecture so that no data is sent to the
Loggers that will be used as the search heads.

Receive, forward, and store events Send Events to Logger nodes with

Run peer searches from on 1-100 peered Logger nodes any number of SmartConnectors

1-10 Logger search heads i
1l illn i i

1k
' < X < '
1ln 1ln
< X i
Tip: For best search speed, both nodes and search heads require a minimum of 16 GB Ram, with 32
GB recommended.
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Once this configuration is in place, fen users can log in to the search head and run searches across ten
specified nodes at the same time. You can scale this out to enable 100 users to run concurrent searches
by setting up ten search heads.

Centralized Management

HPEADP ArcSight Management Center (ArcMC) provides centralized management for Loggers and
connectors with a single panel view of all managed ArcSight ADP products.

Using ArcMC, you can create or import configurations for managed products, and then rapidly push
them to products of the same type across your network, ensuring consistent configuration for managed
products with one action. You can perform a variety of remote management tasks, singly and in bulk, on
Loggers, and connectors. Logger tasks you can perform using ArcMC include initial configuration, peer
configuration, and user management.

For more information, consult your sales representative or refer to the ArcSight Management Center
Administrator's Guide.

Running Logger on Encrypted Appliances

Logger can run on encrypted hardware to help you to meet compliance regulations and privacy
challenges by securing your sensitive data at rest.

You can encrypt your L7600 Logger Appliance by using HPE Secure Encryption, available from the
Server Management Software > HP Secure Encryption web page. For instructions, refer to the HPE
Secure Encryption Installation and User Guide, available in PDF and CHM formats through the
Technical Support / Manuals link on that page.

L7600 Logger Appliances are encryption-capable. They come preinstalled with everything necessary
for you to encrypt them using HP Secure Encryption. The length of time encryption takes depends on
the amount of data on the server being encrypted. In our festing, a Gen 9 appliance with 7.5 TB of
stored data took about 72 hours to encrypt. You can continue using Logger while the encryption runs.
You may notice some performance degradation after encrypting your existing Logger appliance.

Caution: After encryption, you cannot restore your Logger to its previously unencrypted state.
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Chapter 2: User Interface and Dashboards

The following topics provide an overview of how to connect to Logger, and explores Logger's
dashboards. Logger includes standard dashboards that display the real-time and historical status of
receivers and forwarders as well as storage, CPU, and disk usage statistics. You can create your own
dashboards for an all-in-one view of Logger information that is of interest to you.

e ConNNECHiNG T0 LOGQOT .. 32
e Navigating the User Interface ... .. L 34
O SUMMIAIY e 38
o Dashboards .o 41
e Setting a Default Dashboard ... . .l 63

Connecting to Logger

You can connect to Logger and log in with most browsers, including Chrome, Firefox and Internet
Explorer. Refer to the Release Notes for a list of browsers supported in this release.

To connect and log into Logger:

1. Use the URL configured during Logger installation to connect to Logger through a supported
browser.
e Forthe Logger appliance, use https://<hostname or IP address>
The End User License Agreement is displayed. Review and accept the EULA.

o For Software Logger, use https://<hostname or IP address>:<configured_port>,
where the hostname or IP address is the system on which the Logger software is installed, and
configured_port is the port set up during the Logger installation, if applicable.

The Login screen displays.
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ArcSight Logger

Username | admin

Password |sesssses

Login

—

Hewlett Packard
Enterprise

Copyright ® 2001-2016 Hewlett-Packard Enterprise Development Company, L.P.
Confidential commercial computer software. Valid license required.

2. Enter your user name and password, and click Login. Use the following default credentials if you
are connecting for the first time or have not yet changed the default credentials:

Username: admin
Password: password
o If login succeeds, the Summary page (Logger’s default home page) is displayed. For information
on the Summary page see "Summary" on page 38.

o If login fails, the message Authentication Failed is displayed at the top of the login screen. Enter
the correct username and password combination to try again.

Note: The first time you log in with the default user name and password, you will be required
to change the password.

Depending on your system administration settings, the following options maybe also be available.

o Forgot Password?: A “Forgot Password?” link is displayed if your Logger is configured to show it.
Click this link to change your password. For more information on the Forgot Password link, see

"Forgot Password" on page 446.

o Use Local Authentication: The “Use Local Authentication” checkbox is always displayed, but only
becomes active when a login attempt fails. By default, this option is available only for the default

admin. For more information on the Use Local Authentication option, see "Local Password" on
page 443.
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Navigating the User Interface

A navigation and information bar (navbar) runs across the top of every page in the user interface.

e | s e
ArcSight Logger ~ Summary  Analyze Dashboards  Reports Configuration System Admin ake me fo.. (Alt+) eesm: {03 eesour: O cru: b —

e Menus, Take Me To, and Bar GaUges . . . ... 34

e Server Clock, Current User, and Options Dropdown ... . 35

o Logger OptiONS . 36

Menus, Take Me To, and Bar Gauges

The Summary, Analyze, Dashboards, and Reports menu tabs provide access to various Logger
functions and data stored on it.

Summary  Analyze Dashboards Reporis Configuration System Admin

You can configure system settings and administrative functions in the Configuration and System Admin
menus. For more information on each, refer to the sections below.

e The options available in the Summary menu are discussed in "Summary" on page 38.

e The options available in the Dashboards menu are discussed in "Dashboards" on page 41.

e The options available in the Analyze menu are discussed in "Searching and Analyzing Events" on
page 65.

e The options available in the Reports menu are discussed in "Reporting" on page 147
o The options available in the Configuration menu are discussed in "Configuration" on page 259.

e The options available in the System Admin menu are discussed in "System Admin" on page 404.
Take Me To Navigation Box

To the right of the menu tabs, the Take me to... navigation box provides a quick and easy way to

navigate o any location in the Ul. The Take me to... feature enables you to navigate to any Logger
feature simply by starting to type the feature’s name.
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Receivers

Realtime Alerts

Currently Running Tasks
Mainfenance Results
Retrieve Logs

Reboot

Remote File Systems

You can access the Take me to... navigation box by clicking in it or by using the Alt+o, Alt+p, or
Ctrl+Shift +o hot keys. As you type, a list of features that match drops down. Click an item in the list or
press entfer to go to the specified feature.

You can open the help for the current page by typing help in the Take me to... search box.
Bar Gauges

Bar gauges at the top right of the screen provide an indication of the throughput and CPU usage,
which is available in more detail on the Monitor Dashboard discussed in "Dashboards" on page 41.

EPSIn: i EPSOut: 9 (3 CPU: O%

The range of the bar gauges can be changed on the Options page, as discussed in "Logger Options" on
the next page.

Server Clock, Current User, and Options Dropdown

The server clock is shown to the right of the bar gauges, along with the currently logged-in user’'s name
and the Options dropdown arrow.

The server clock displays the Logger server’s system time. This may be different from the user’s local
time.
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(fgMD)
TSmith TSmith W
Options
Help
About
Logout

Below the clock is the login name of the current user. To the right of the user's login name is the
dropdown arrow that you can use to open the "Logger Options" below and the "Help, About, and
Logout" on page 41 options.

Logger Options

When you click the Options drop-down arrow, you can access the Options page and the "Help, About,
and Logout"on page 41options as well.

The Options page enables you to set the default start page (home page) for all users and specific start
pages for individual users and to upload a custom logo to display instead of the default logo.
To access the Options page from any user interface page:

Click the down-arrow by your user name (M) and then select Options.

Options

System

EPS input rate bar gauge max I 100K

EPS output rate bar gauge max I 100K

] &= =]

Default start page for all users I Summary

LIRS 2, Browse... | No file selected.

Show default logo

Personal

Default start page for admin I Use default for all users IZ|
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Customizing the Maximum EPS

You can set the maximum rate on the EPS In and EPS Out bar gauges from by using the EPS Input
rate bar gauge max and EPS output rate bar gauge max dropdowns in the Options menu. If the
event rate exceeds the specified maximum, the range is automatically increased.

Customizing the Logo

The Upload a logo (PNG file) option in the Options menu enables you to replace the HPE ArcSight
Logger logo with your custom logo. The logo must be in .png format. The recommended logo size is 150

X 30 pixels and the maximum file size is IMB.

150 by 30 pixel logo:
ArcSight Logger

To display a custom logo:

1. From the Options menu, click Browse, navigate to the logo you want to use, and click Open. The
name of your logo is displayed by the browse button.

2. Then uncheck Show default logo. The custom logo will be displayed on the login page and on the
menu bar.

To display the default HPE ArcSight logo:

Check the Show default logo checkbox.

Customizing the Start Page

To set your own personal start page:

From the Personal section of the Options menu, select one of the start page options.

Personal
Default start page for admin | Use default for all users ILI
Use default for all users
Summary
Analyze
Dashboards

Reports Dashboard
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The Default start page for all users option indicates which user interface page is displayed after a
user logs in. You can set the default start page (home page) for all users and specific start pages
individual users. Refer to the following table for information on how to configure a specific start page.

If you want to set... Configure the...

The same start page for  Default start page for all users option to the desired page.

Il
all users This is a global setting for your Logger. To override this setting, configure a different start

page for specific users by using the Default start page for <username> option.

When you set Default start page for all users option to Dashboards, the Monitor Dashboard
is the default dashboard displayed for all users, except users who have configured other
dashboards as their defaults, as described in "Setting a Default Dashboard" on page 63.

A different start page for Default start page for <username> option to the desired page.

specific users . ) . :
P This setting overrides the global Default start page for all users setting.

When this option is set to “Use default for all users,” the global default page (Default start
page for all users) value is used for all users.

A specific dashboard for ~ Default start page for <username> option to Dashboards.

a specific user . . . .
peciicu The Monitor Dashboard is the default dashboard displayed for all users. However, if you

OR want to display a different dashboard for one or more users, set the desired dashboard as
i . ils, "Seftti Default Dash !
A specific dashboard for the default when logged in as those users. For deftails, see "Setting a Default Dashboard" on
page 63.
all users

Logger’s default home page is the Summary page. (For information on how fo use a different page as
your home page, see "Logger Options" on page 36.) The Summary page is a dashboard that provides
summarized event information about your Logger in one screen. It enables you to gauge incoming
events activity and the status of indexing. The events that are in Logger’s primary storage (not aged
out due to retention or archived data) are used to generate the summary information.

Logger's home page, the Summary page, displays data in four panels. Each panel is displayed in a donut
chart by default. You can change the display setting for each panel by clicking the appropriate icon.

e Select £ for a list.
e Select @ for a column chart.

e Select 2 for a donut chart.

Note: Donut charts display an event total in the middle of the donuft. This is the total number of
events displayed in that chart. If the number of events is more than 1000, the event total is

displayed using the appropriate standard metric prefix (k, M, G, T).
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The panels on the Summary page can display up to 30 items. If there are more than 30, the panels
display the top 30, by count.

Logger’s Home Page: The Summary Page

epsin: 288 epsour: B cPu:Mx

ArcSight Logger ~ Summary Analyze Dashboards Reports Configuration System Admin

Global Summary
There are 570,994,828 events indexed from 2016/07/13 19:31:41:703 PDT fo 2016/07/22 11:54:05:585 PDT RCEEIEEY

Event Summary by Receiver 222/ ©  Event summary by Device =mo

\:

TCP 10514 B 1521413045
TCP 10515 15.214.129.244
TCP Receiver = 15.214.135.201
Logger Internal Event Device 127.0.01

TCP 10517 m 1521413060
TCP 10518

a7 i ’ o i v

Event Summary by Agent Severity # O  Event Summary by Agent Type HEWO

syslogng
checkpaintfirewall_ad_opsec
windowsfg

bluecoat file

H Low

‘ Medium
.1
| High

Very-High

superagent
ract_file
nt_local
syslog file

Unknown
2

570M .3

sdkmultifolderreader
syslogng dve
syslog

syslogng dvch
syslogng dv
sysl

‘ i v « i I v

Hover your pointer over a column, donut slice, or over the itemin the legend to display information
about it. For even more details, you can drill down to view the events by a specific resource—receiver,
device, agent severity, or agent type. To do so, click the column, donut slice, or list resource to search for
those events. The Search page opens and the search box is automatically populated with the search
that generated the information you clicked on the Summary page. The Start and End fields are
populated with the time of oldest events stored on your system (that have not aged out due to
retention) and the current time, respectively.

For example, if you click Logger Internal Event Device under Event Summary by Receiver, the Analyze
> Search page opens with the following query populated, and the search is run. If desired, you can
further refine the search query to filter the search results to suit your needs. Click Go! to run the search
again.

ArcSighT Logger Summary Analyze Dashboards Reports Configuration System Admin Take me to.. (Alt+0)
"B X & LV AlFieds E| Custom time range E start B8 7/12/2016 | 23:53:50 [ Dynamic End |$Now [¥] Dynamic
_deviceGroup in ["Logger Internal Event Device"] - Go! Advanced

You cannot change or add other panels to the Summary page. If you need to display other information,
you can create a custom Dashboard as described in "Dashboards" on page 41.
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The information displayed on the Summary page is for your local Logger only, and does not include
information about peer Loggers even if peers are configured.

Summary Dashboard Panels

¢ Global Summary: The number of events indexed on your Logger during the time period displayed
on the screen. This time period is dependent on the retention policy set on your Logger. The start is
the time of the oldest event stored in the Logger since the Logger was restarted, that has not aged
out due to retention; the end time is current time. The Add Data (EEESED button at the top opens
the Receivers page where you can add and manage the receivers that put log data into your Logger.
For more information on managing receivers, see "Receivers" on page 294.

o Event Summary By Receiver: The list of receivers configured on your Logger, the number of
events received on each receiver (that are in Logger’s primary storage, not aged out due to retention
or archived data), and the timestamp of the last event received on each receiver. If a receiver is
deleted, the summary information for it will continue to display until the events received on it age out
from Logger’s primary storage. However, the receiver name is changed to the receiver ID (a numerical
string) associated with the deleted receiver.

o Event Summary By Device: A device is a named event source, comprising of an IP address (or
hostname) and a receiver name. The Devices panel lists devices configured on your Logger, the

number of events received on each device (that are in Logger’s primary storage, not aged out due to
retention or archived data), and the timestamp of the last event received on each device. If a device is
deleted, the summary information for it will continue to display until the events received on it age out
from Logger’s primary storage. However, you cannot click the device name to view the events
associated with the deleted device.

e Event Summary By Agent Severity: The list of severity levels of the incoming events from
ArcSight SmartConnectors to your Logger, the number of events received of each severity level, and
the timestamp of the last event received of each severity level. Only events in Logger’s primary
storage (not aged out due to retention or archived data) are considered when summarizing this
information.

e Event Summary By Agent Type: The list of ArcSight SmartConnectors sending events to your
Logger, the number of events received from each SmartConnector (for events that are in Logger’s
primary storage, not aged out due to retention or archived data), and the timestamp of the last event
received from each SmartConnector. If a SmartConnector is deleted, the summary information for it
will continue to display until the events received from it age out from Logger’s primary storage.

The Effect of Search Group Filters on the Summary Page

Search Group filters that enforce privileges on storage groups are applied to the content displayed on

the Summary page. However, Search Group filters that enforce privileges on device groups are not
applied. Therefore, the Summary page includes counts of events in device groups to which a user does

not have privileges. However, if the user tries to drill down to view events, search results in accordance
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with access privileges are returned as the search query is run on the Analyze page, which enforces all
types of Search Group filters. Similarly, if a Search Group filter enforces privileges on both, storage
groups and device groups, only the storage group enforcement is applied on the Summary page.

Help, About, and Logout

When you click the Options drop-down arrow, you can access the following options and the "Logger
Options" on page 36 page as well.

To access the online help: From any user-interface page, click the down-arrow by your user name (llD
and then select Help.

Tip: The latest Logger documentation is available in Adobe Acrobat PDF format, through the
ArcSight Product Documentation Community on Protect 724.

To access version information about your Logger: From any user-interface page, click the down-
arrow by your user name and then select About.

To log out of Logger: From any user interface page, click the down arrow by your user name and then
select Logout. You will be returned to the Login screen.

Tip: Logging out is good security practice, to eliminate the chance of unauthorized use of an
unattended Logger session. Logger automatically logs you out after a user-configurable length of
time (15 minutes by default). To change this length of time, see "Users/Groups" on page 442.

Caution: Simply closing the browser window does not automatically log you out. Click the Logout
link to prevent the possibility of a malicious user restarting the browser and resuming your Logger

session.

Dashboards

Dashboards are an all-in-one view of the Logger information of interest to you. You can select and view
any of several out-of-box dashboards or create and display your own custom dashboard.

Each Logger dashboard contains one or more panels of these types:

o Search Results: Search Results panels display events that match the query associated with the
panel.

¢ Monitor: Monitor panels display the real-time and historical status of various Logger components
such as receivers, forwarders, storage, CPU, and disk.

e Summary: Summary panels display summarized event information about your Logger—the number
of events received of a specific resource or field type, and the timestamp of the last event received for

that resource or field type.
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o Out-0f-BoxX Dashboards ... 42
o Custom Dashboards ..o 56

Out-of-Box Dashboards

Logger comes with several out-of-box dashboards, described below. The Monitor dashboard is
displayed by default unless you configure another dashboard to display as your default.

o The Event Count dashboard, described in "The Event Count Dashboard" on page 55, displays how
many events each receiver or forwarder handled.

¢ TheIntrusion and Configuration Events dashboard, described in "The Infrusion and Configuration
Events Dashboard" on page 52, displays information about configuration changes and intrusions on
your system.

¢ The Login and Connection Activity dashboard, described in "The Login and Connection Activity
Dashboard" on page 53, displays information about login and connection activity on your system.

o The Monitor dashboard displays the Summary panel, which shows the status of CPU Usage, Event
Flow, Receivers, Forwarders, and Storage Groups in a summarized view. The other panels available in
this dashboard are Platform, Network, Logger, Receivers, Forwarders, and Storage. These views are
described in detail in "The Monitor Dashboard" on the next page.

You cannot change or adjust the panels available in the out-of-box dashboards, except the System
Overview dashboard (See "The System Overview Dashboard" on page 50). However, you can add
specific Search Results panels to a custom dashboard, as described in "Creating and Managing Custom
Dashboards" on page 58.

You can add also Monitor and Summary panels to it. These panels provide the same information
available through the default Monitor dashboard and the default Summary dashboard , however in a
modular form that enables you to choose specific views. (See "Summary" on page 38 for more
information about default Summary dashboard.)

For example, if you want to view the EPS for the last 4 hours on all receivers, add the panel Type
“Monitor Graph”, and select “(Logger) All EPS Out-All EPS In - 4 hour” as the Graph, or if you want to
view the EPS on Forwarders in a table form, select the “Monitor (Forwarders)” panel Type. Similarly, if
you want to view only the summary information for receivers on your Logger, add the panel of Type
“Summary (Receivers)”. Besides the four Summary panels (Agent Severities, Agent Types, Receivers,
and Devices), you can also create a user-defined Summary panel in which you can select any indexed,

non-time field by which you want to categorize event summary. For example, if you want to add a
Summary panel to display event summary categorized by “destinationAddress”, you can add a panel of
Type “Summary (User Defined)” for this field if it is indexed on your Logger.

You can also drill down on any of the resources listed in Monitor and Summary panels you add to view
events by a specific resource or field value on the Analyze (Search) page. For example, you can click on a
storage group in a Monitor panel to view its events in the last 24 hours, or you can click on an event
name “Network Usage - Inbound” to view all events of that name in the last one hour. Additionally, you
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can access the Configuration page for any of the resources listed in the Monitor panels to configure
them. For example, if you want to configure a receiver, click the Configure link on top of the Monitor
(Receiver) panel.

Search Group filters that restrict privileges on device groups are not enforced on Summary panels.
Therefore, Summary panels include counts of events in device groups to which a user does not have

privileges. However, if the user tries to drill down to view events, search results in accordance with
access privileges are returned as the search query is run on the Analyze page, which enforces all types
of Search Group filters. Similarly, if a Search Group filter enforces privileges on both, storage groups and
device groups, only the storage group enforcement is applied on Summary panels.

Users can create both shared and private dashboards.

o Shared dashboards are visible to all users with the appropriate privileges.
o Private dashboards are visible only to the creator or users with "admin" privileges.
o Only the creator or users with "admin" privileges can edit or delete dashboards of either type.

A user accessing a shared dashboard must have privileges to view the information displayed in the
dashboard; otherwise, the information to which they do not have the privileges is not displayed, and the
associated panel displays a message that indicates the reason for the undisplayed information.

The Monitor Dashboard

The Monitor Dashboard, displayed by default, contains the real-time and historical status of receivers,
forwarders, and storage, CPU, and disk usage statistics. On Software Logger, the CPU and disk usage
statistics indicate the total use of these resources on the system, not just the use of these resources by
the Logger process.

The Monitor panels, available through a pull-down menu display Summary, Platform, Network, Logger,
Receivers, Forwarders, and Storage information. You cannot change or adjust any of these out-of-box
panels, but you can create your own dashboards to monitor the things in which you are most interested.
For more information, see "Creating and Managing Custom Dashboards" on page 58

All monitor panels, except the Summary panel, include a pull-down menu for duration control. The
summary panel has buttons instead. In both cases, you can choose one of the following fime spans for
historical data: 4 hours, 24 hours, 7 days, 30 days, 90 days, or 365 days. As you hover your pointer over
the data, more details are displayed. In the case of dashboards that displays two fields, details of both
are displayed, and a legend indicates the color that represents each field.

In these dashboards, events per second (e/s) are displayed using standard metric prefixes (k, M, G, T)
for numbers over 1000. Numbers under 1000 are displayed as integers.

The System Overview dashboard provides a different view of these panels. See "The System Overview
Dashboard" on page 50 for more information about that view.
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Monitor Dashboard Summary Panel

The summary panel, displayed by default, shows the status of CPU Usage, Event Flow, Receivers,
Forwarders, and Storage Groups in a summarized view.

Monitor dashboard - Summary panel
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] CPU Usage
100%
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Time
Receivers £} Configure =~ Forwarders £} Configure
Receiver CurrentE.. Current Bytes/S.. Maximum... Total Events Forwarder Current EPS  Current Bytes/S.. Maximum... Total Events
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Storage Groups {3} Configure

On the Summary panel, click on a Receiver, Forwarder, or Storage Group name to jump to the Search
page and include the selected resource in the query.

Additionally, you can click Configure (& cenfizure ) to open the Configuration page for Receivers,
Forwarders, and Storage Groups.

Note: The total space allocated for a storage group includes a certain amount that has been set
aside to ensure that the group can receive new events when it is almost full. As a result, the
percentage of used space for a storage group never reaches 100% (as displayed on the Monitor >
Summary panel). For Software Loggers installed using the Minimal setting, the maximum % Used
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(On the Monitor > Summary panel) for each storage group reaches up to 66.33%. (Two storage
groups of 3 GB each; 1GB is set aside for new events in each group. After 2 GB of space has been
used and the new evenfts are being written to the last 1GB, Logger automatically friggers retention
and reclaims 1GB of the used space. Thus, the % Used field for each storage group only reaches up
t0 66.33%.)

Monitor Dashboard Receivers Panel

The Receivers monitor panel shows the total Events per Second (EPS) received and displays values for
each configured receiver. The list of receivers includes all receivers known to the system, including those
that are disabled. (To create a new receiver, or to enable or disable one, see "Working with Receivers" on
page 298.)

Monitor dashboard - Receivers panel
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Monitor Dashboard Platform Panel

The Platform monitor panel displays information about CPU usage, memory usage, bytes received and

sent on the network, and raw disk reads and writes.
Monitor dashboard - Platform panel
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Monitor Dashboard Network Panel

The Network monitor panel display a graph for each network interface card. (The number of network
interface cards varies by the hardware model.) The graph displays the bytes tfransmitted, overlaid on the
bytes received.

Monitor dashboard - Network panel
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Monitor Dashboard Logger Panel

The Logger monitor panel displays information about events, searches, and memory. JVM Memory
Usage chart displays the memory used by the Logger's back-end server process. For example, this could
be the memory used to perform the search after receiving the search query from the UL.

Monitor dashboard - Logger panel
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Monitor Dashboard Forwarders Panel

The Forwarders monitor panel shows total Events per Second (EPS) sent and displays values for each
configured forwarder. The list of forwarders includes all forwarders known to the system, including
those that are disabled. To create a new forwarder, or to enable or disable one, see "Forwarders" on
page 321.

Monitor dashboard - Forwarders panel
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Monitor Dashboard Storage Panel

The Storage monitor panel displays disk read and disk write information. The list of storage groups
compares allocated and used space in each group. Space is used in 1GB files so a 5 GB storage group
appears 20% used as soon as it is set up. For more information about storage groups, see "Storage
Groups" on page 347.

Monitor dashboard - Storage panel
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The System Overview Dashboard

The System Overview dashboard provides an alternate view of several Monitor dashboard panels. This
dashboard displays the CPU Usage, Platform Memory, Disk Read-sda, Disk Write-sda, Search
Performed, Transmit-ethO, Receive-eth0, JVM Memory, All EPS In, and All EPS Out panels that you use
to monitor your Logger. You can replace any of these panels with other Logger monitor panels to
adjust the display to your needs.

To view the System Overview dashboard, open the Dashboards menu and click System Overview at
the top of the Monitor Dashboard.

e System Cverview

The System Overview dashboard displays.

System Overview Dashboard, Light Background
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The System Overview dashboard can be toggled between a dark or light background.

To change the background color, click the Switch Background icon (=) in the top right.

HPE Logger 6.3 Page 50 of 623



Administrator's Guide
Chapter 2: User Interface and Dashboards

New Monitor Dashboard, Dark Background

sh | 1d | 7d | 50d | 90d | 3esq | M

CPU Usage

One Monitor panel is displayed in a large format at the top of the screen, the others are smaller and
displayed in rows across the bottom.

o Click 4h,1d, 7d, 30d, 90d, or 365d at the top of the large panel to adjust the displayed time range.
o Hover your pointer over a section on the large panel for more detail.

o Click a small panel on the bottom of the screen to move it to the large display at the top.

e You can display other monitor panels in place of the out-of-box panels.

Note: You can only display existing monitor panels; you cannot display search results or
summary panels.

The Forwarder, Receiver and Storage panels available for display varies, based on your Logger
configuration.

To display a custom panel in place of one of the out-of-box panels:

1. Click the edit icon # next to the panel's name.

2. Start typing in the text box to see the list of available panels. For example, to display a receiver,
start typing "re".

3. Click a panelin the list to select it, or click the cancelicon * to close the dialog without selecting
another panel.
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The Intrusion and Configuration Events Dashboard

The Intrusion and Configuration Events dashboard displays information about the following types of
configuration changes and infrusions on your system.

o Top Malicious Code Activity: displays the most active malicious code.

o Top Firewall Drops by Source: displays events in which traffic was dropped by a firewall.

o Configuration Changes by Product: shows products that have had their configurations modified.

o Windows Account Creations: shows user accounts created on Microsoft Windows operating systems.

Intrusion and Configuration Events dashboard
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Each dashboard displays the search results of a Saved Search found in the standard system content
along with the time and date the query was most recently refreshed.

While you cannot update the system content used in the out-of-box dashboard, you can then edit the
search to meet your needs, save your changes, and use your new saved search in your own dashboard
to find exactly what you are interested in. To create a new dashboard, follow the instruction in "Creating
and Managing Custom Dashboards" on page 58.

Note: Dashboards that display charts are aggregated queries. Therefore, the entire search must

complete before the chart is displayed. This can take some time if there are a large number of
events.
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e The dashboards are not automatically refreshed. Click refresh # | to refresh the search results.

e Click View on Search Page to open the Analyze > Search page and run the Saved Search
automatically.

o Click a chart value (a column, bar, or donut section) to drill down to events with specific field values.
(Drill-down is not available for dashboards that display tables.)

Chart Drill-Down

When you click on a chart value (a column, bar, or donut section), the query is rerun on the Analyze
(Search) page with an additional WHERE operator clause that includes the field name and value you
clicked on the chart.

The drill-down information includes a histogram and a table of the search results. You can drill down on
the histogram for further information. For more information on drilling down on a histogram, see
"Histogram Drill Down" on page 115.

Note: The saved search query associated with the Search Results panel in the dashboard is not
modified. If you need to return to the dashboard from the drill-down screen, use the Back function

of your browser.

The Login and Connection Activity Dashboard

The Login and Connection Activity dashboard displays information about the following types of login
and connection activity on your system.

o Top Failed Logins by Product: displays the top failed logins sorted by device product.

o Top Failed Logins by User: displays the top failed logins sorted by user name.

o SSH Authentications: displays the users most frequently logging in or attempting fo log in using
SSH.

o VPN Connections: displays the users most frequently logging in or attempting fo log in using a VPN
connection.

Login and Connection Activity Dashboard
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Login and Connection Activity ~
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Each dashboard displays the search results of a Saved Search found in the standard system content
along with the time and date the query was most recently refreshed.

While you cannot update the system content used in the out-of-box dashboard, you can then edit the
search to meet your needs, save your changes, and use your new saved search in your own dashboard
to find exactly what you are interested in. To create a new dashboard, follow the instruction in "Creating
and Managing Custom Dashboards" on page 58.

Note: Dashboards that display charts are aggregated queries. Therefore, the entire search must
complete before the chart is displayed. This can take some time if there are a large number of
events.

e The dashboards are not automatically refreshed. Click refresh # | to refresh the search results.

o Click View on Search Page to open the Analyze > Search page and run the Saved Search
automatically.

o Click a chart value (a column, bar, or donut section) to drill down to events with specific field values.
(Drill-down is not available for dashboards that display tables.)

Chart Drill-Down

When you click on a chart value (a column, bar, or donut section), the query is rerun on the Analyze
(Search) page with an additional WHERE operator clause that includes the field name and value you
clicked on the chart.
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The drill-down information includes a histogram and a table of the search results. You can drill down on
the histogram for further information. For more information on drilling down on a histogram, see
"Histogram Drill Down" on page 115.

Note: The saved search query associated with the Search Results panel in the dashboard is not
modified. If you need to return to the dashboard from the drill-down screen, use the Back function

of your browser.

The Event Count Dashboard

The Event Count dashboard displays information about the following types of event input and output
activity on your system.

¢ Individual Receivers: displays the events received per receiver.

o Individual Forwarders: displays events forwarded per forwarder.

o All Receivers: displays the total events received by all receivers.

o All Forwarders: displays the tofal events forwarded by all forwarders.
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Each dashboard displays the search results of a Saved Search found in the standard system content
along with the time and date the query was most recently refreshed.
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While you cannot update the system content used in the out-of-box dashboard, you can then edit the
search to meet your needs, save your changes, and use your new saved search in your own dashboard
to find exactly what you are interested in. To create a new dashboard, follow the instruction in "Creating
and Managing Custom Dashboards" on page 58.

Note: Dashboards that display charts are aggregated queries. Therefore, the entire search must
complete before the chart is displayed. This can take some time if there are a large number of

events.

e The dashboards are not automatically refreshed. Click refresh # | to refresh the search results.

e Click View on Search Page to open the Analyze > Search page and run the Saved Search
automatically.

o Click a chart value (a column, bar, or donut section) to drill down to events with specific field values.
(Drill-down is not available for dashboards that display tables.)

Chart Drill-Down

When you click on a chart value (a column, bar, or donut section), the query is rerun on the Analyze
(Search) page with an additional WHERE operator clause that includes the field name and value you
clicked on the chart.

The drill-down information includes a histogram and a table of the search results. You can drill down on
the histogram for further information. For more information on drilling down on a histogram, see
"Histogram Drill Down" on page 115.

Note: The saved search query associated with the Search Results panel in the dashboard is not
modified. If you need to return to the dashboard from the drill-down screen, use the Back function

of your browser.

Custom Dashboards

A dashboard can contain a mix of Search Results, Monitor, and Summary panels. You can assemble
various search queries that match events of interest to you, status of Logger resources such as
receivers, forwarders, storage, CPU, and disk, or a combination of both on a single dashboard.

There is no limit on the number of Monitor and Summary panels you can add to a single dashboard;
however, you can only add up to four Search Results panels.
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Sample Custom Dashboard
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Each Search Results panel is associated with a saved search query. You can only associate saved search
queries that contain an aggregation operator such as chart or top for this type of panel.

Click View on Search Page in the Search Results panels o go to the Analyze > Search page and view
the event details; the panel query is automatically run and the search results are displayed.

Additionally, you can drill down from any chart to quickly filter down to events with specific field values.
To do so, identify the value in the chart on a Search Results Chart panel and click it to drill down to
events that match the value.

When you click on a chart value (a column, bar, or donut section), the query is rerun on the Analyze
(Search) page with an additional WHERE operator clause that includes the field name and value you
clicked on the chart.

Note: Dashboards that display charts are aggregated queries. Therefore, the entire search must
complete before the chart is displayed. This can take some time if there are a large number of
events.

=
e The dashboards are not automatically refreshed. Click refresh '**' to refresh the search results.

¢ Click View on Search Page to open the Analyze > Search page and run the Saved Search
automatically.

o Click a chart value (a column, bar, or donut section) to drill down to events with specific field values.
(Drill-down is not available for dashboards that display tables.)
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Chart Drill-Down

When you click on a chart value (a column, bar, or donut section), the query is rerun on the Analyze
(Search) page with an additional WHERE operator clause that includes the field name and value you
clicked on the chart.

The drill-down information includes a histogram and a table of the search results. You can drill down on
the histogram for further information. For more information on drilling down on a histogram, see
"Histogram Drill Down" on page 115.

Note: The saved search query associated with the Search Results panel in the dashboard is not

modified. If you need to return to the dashboard from the drill-down screen, use the Back function
of your browser.

Creating and Managing Custom Dashboards

The options displayed in the Dashboards > Tools menu vary depending on your permissions.

| ! Create Dashboard

Delete Dashboard

Edit Dashboard
Set as Default

Add Panel
Change Layout

You need these privileges (in the Logger Rights group) to perform dashboard operations:

e Use and view dashboards
o Edit, save, and remove dashboards

With these permissions, you can create a dashboard (see "Adding a Custom Dashboard" on the next
page), and add panels to the dashboard you created. (see "Adding and Managing Panelsin a
Dashboard" on page 60).

Tip: If you are adding a Search Results panel, the saved search must exist. If no saved searches
exist, the Search Results panel option is not displayed.
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Adding a Custom Dashboard

To add a dashboard:

1.

2
3.
4

Open the Dashboards menu.

. Click the Tools pull-down menu and select Create Dashboard.

Enter a meaningful name for the dashboard in the Name field.

. Select whether the dashboard Type is Private or Shared.

The private dashboards are only visible to the user who created them, and the shared dashboards
are visible to all Logger users; however, they will not see the information to which they do not have
privileges.

Click Create.

After creating the dashboard you must add panels to it, as described in "Adding and Managing
Panels in a Dashboard" on the next page.

Editing a Custom Dashboard

The Edit Dashboard page allows you change the name and privacy settings for a custom dashboard. To
add or edit dashboard panels, see "Adding and Managing Panels in a Dashboard" on the next page.

The privacy options are:

Private — Only you can see your dashboard.
Shared — All Logger users can see your dashboard; however, they will not see the information to
which they do not have privileges.

For example, if a user does not have privileges to a storage group and a panel in a Shared dashboard
includes a query that accesses the events in that storage group, the panel will be blank when the user
accesses the shared dashboard.

To edit a dashboard:

1. Open the Dashboards menu.

2. Click the Tools pull-down menu and select Edit Dashboard.

3.

4, If you want to change the privacy setting of the dashboard, select the appropriate setting from the

If you want to change the name of the dashboard, enter a new name in the Name field.

Type pull-down menu, and click Save.
To add or edit dashboard panels, see "Adding and Managing Panels in a Dashboard" on the next
page.
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Deleting a Custom Dashboard

To delete a dashboard:

. Open the Dashboards menu.
. Select the dashboard that you want to delete.

1
2
3.
4

. Click Yes to confirm your action in the confirmation message, or click No to exit without making a

Click the Tools pull-down menu and select Delete Dashboard.

change.

Adding and Managing Panels in a Dashboard

After you create a dashboard, you need to add panels to display the information you want to see. A
dashboard can contain a mix of Search Results, Monitor, and Summary panels. There is no limit on the
number of Monitor and Summary panels you add to a single dashboard; however, you can only add up
to four Search Results panels for optimum performance.

Before you can add panels to a dashboard, you must first create the dashboard. See "Creating and
Managing Custom Dashboards" on page 58 for more information.

You can add the following types of panels:

e Search Results: Chart and Table

o Monitor: All four types available under the default Monitor dashboard

o Summary: All four types available under the default Summary dashboard and user-defined Summary

panels.

Adding a Panel to a Dashboard

To add a panel to a dashboard:

. Open the Dashboards menu.
. Select the dashboard to which you want to add the panel.

1
2
3.
4

Click the Tools pull-down menu and select Add Panel.

. Configure these parameters and click Add.
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Parameter Description
Type Select the type of panel:
o Search Results (Chart): Displays search results in a chart form.
o Search Results (Table): Displays search results in a table form.
o Monitor (Graph): Displays a graph of the selected resource.
o Monitor (Forwarders): Displays forwarder information in a table form.
o Monitor (Receivers): Displays receiver information in a table form.
o Monitor (Storage Groups): Displays storage group information in a table form.

o Summary (Agent Severities): Displays event summary categorized by agent severities configured
on your Logger.

o Summary (Agent Types): Displays event summary categorized by receivers configured on your
Logger.

o Summary (Receivers): Displays event summary categorized by receivers configured on your
Logger.

o Summary (Devices): Displays event summary categorized by devices configured on your Logger.

o Summary (User Defined): Displays event summary categorized by the field you select when adding
the panel.

Note: If no saved search queries exist on your Logger, the “Saved Search” panel types are not
available as selections in the pull-down menu.

Title Enter a meaningful name for the panel.

A default name is present in this field, but you can change it.

Graph Only applicable to Monitor Graph panels.
Select the type of graph you want the panel to display. Some of the available options are CPU Usage
- 4 hour, Platform Memory Usage - Daily, and Disk Read-Write - Weekly.

Saved Only applicable to Search panels.

Search Select the saved search query to use for searching events that will be displayed in the panel.

Chart Type Only applicable to Search Result Chart panels.
Type of chart fo display matching events. You can select from:
Column, Bar, Donut, Area, Line, Stacked Column, Stacked Bar.

Default: Column

Chart Limit  Only applicable to Search Result Chart panels.

Number of unique values to plot. Default: 10

Field Name Only applicable fo Summary (User Defined) panels.

The event field name by which the event summary on a Summary panel will be categorized.
Default: agentSeverity
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Editing a Dashboard Panel

Once you add a panel to a dashboard, whether you can edit it depends on the type of panel. You can
edit the Search Results panels and the user-defined Summary panels; the Monitor panels and some of
the Summary panels are not editable.

The following table lists the panels you can edit and what you can edit in them.

Action Description
All Panels
Delete Removes a panel from a dashboard.

Search Result Panels
Edit Panel Change Title, associated saved search, Chart Type, or Chart Limit
Edit Saved Search Access the Edit Saved search page to edit the associated saved search query

View on Search Page Runs the panel’s query on the Search Results page (Analyze > Search) and displays matching
events on that page

Refresh Refreshes the current contents of the panel.

Note: All other panel types are automatically refreshed; therefore, an explicit refresh is not
required for them.

Summary Panels - User Defined

Edit Panel Change Title or field name by which events are categorized.

To edit a panel:

1. Open the Dashboards menu.

2. Select the dashboard that contains the panel you want to edit.

3. If you are editing a user-defined Summary panel:
a. Click the Edit (&#) icon.
b. Edit the title, field name, or both.

4, If you are editing a Search Result panel:
a. Click the (™) icon.

b. Select Edit Panel if you want to edit the panel title, select a different saved search; or, if
applicable, chart type or chart limit.

c. Select Edit Saved Search if you want to access the Edit Saved Search page (Configuration |
Search > Saved Searches) to edif the saved search query.

5. Click Save.
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Deleting a Dashboard Panel

To delete a panel from a dashboard:

You cannot delete panels from the default Monitor dashboard or the default Summary dashboard.
However, Monitor and Summary panels added to the dashboards you created under the Dashboards
menu option can be deleted.

1. Open the Dashboards menu.
2. Select the dashboard that contains the panel you want to delete.
3. Click the (*)icon.

4. Click Yes to confirm your action in the confirmation message, or click No to exit without making a
change.

Changing the Layout of a Dashboard

To change the layout of a dashboard:

You can only change the layout of the dashboards you create. The Monitor dashboard layout cannot
be changed.

. Open the Dashboards menu.
. Select the dashboard that contains the panel you want to rearrange.

1
2
3. Click the Tools pull-down menu and select Change Layout.
4

. Point your cursor in the blue band that shows the panel title and drag the panel to a different
position.

5. Click Save after you rearrange the panels.

Setting a Default Dashboard

When you set a dashboard as default, it is the default dashboard screen that displays when you
navigate to the Dashboards menu. This setting is user-specific; therefore, your default dashboard can
be different from that of another user.

The Summary page (accessible from the Summary navigation option in the top-level menu bar) is the
default home page for all Logger users. That is, unless another page has been selected as your home
page, the Summary page is displayed when you first log in.

You can configure Logger to display a specific dashboard as your home page, including one your
created.
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To select a specific dashboard as your home page:
1. Select the Dashboard option when configuring the Personal Default start page for
<username>, following the instructions in "Logger Options" on page 36.

Open the Dashboards menu.
Select the dashboard that you want to configure as default.

Click the Tools pull-down menu and select Select as Default.

IS Y N

Click Yes to confirm your action in the confirmation message, or click No to exit without making a
change.
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When you want to analyze events matching specific criteria, include them in a report, or forward them to
another system such as ArcSight ESM, you need to search for them. To search for events, you create
queries. The queries you create can vary in complexity based on your needs. Queries can be simple
search terms or they can be complex enough to match events that include multiple IP addresses or
ports, and that occurred between specific time ranges from a specific storage group.

The following topics describe how to search for specific events in Logger. They discuss the methods
available for search, how to query for events, how to save a defined query and the events that the query
finds for future use. They also describe how to set up alerts to noftify particular users when Logger
receives events that match specified criteria.

e The Process of Searching EVeNTs .. 65
e Understanding Search Field Colors ... 68
e Elements of @ Search QUETY ... . 69
e Using the Advanced Search Builder ... . 90
® SearCh ANAlYZEr ..o 94
o Regex Helper ToOl L 96
o Search Helper . 98
o Searching for EVENTS 102
e The Search Results Display . ... oo L 112
e Saving the Search ResUlts . . 125
e Saving Queries (Creating Saved Searches and Saved Filters) ... . ... 129
e Enriching Logger Data Through Static Correlation ... ... ... 138
® INAEXING Ll 138
o NVIeWING AlErtS 141
O LiVE EVENT VWO 142

The Process of Searching Events

The search process uses an optimized search language that allows you to specify multiple search
commands in a pipeline format. In addition, you can customize the display of search results, view search
results as charts, and so on.

The most straightforward way to run a search is to enter the keywords or information you are searching

for (the query) in the Search text box, select the tfime range, and click Go! You can enter a simple
keyword, such as, hostA. companyxyz.com oracomplex query that includes Boolean expressions,
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keywords, fields, and regular expressions. The system searches for data that matches the criteria you
specified and displays the results in color-coded columns indicating its index status. For more
information, see "Understanding Search Field Colors" on page 68.

Logger Search Page
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The search results are displayed in the table and as a histogram as soon as they are returned, even if the
query has not finished scanning all data. For an example, see "Simple Query Example" on the next page.

You can also add a chart to your search to display the most important information in a more meaningful
fashion. Charts are not displayed until all the data is returned. For an example, see "Chart Query
Example Using a Chart" on the next page.

There are several convenient ways to enter a search query. You can type the query in the Search text
box, use the Search Builder tool to create a query, click a field in the current search results, or use a
previously saved query (referred to as a filter or saved search).

When you type a query, the Search Helper provides suggestions and possible matches to help you build
the query expression. (See "Search Helper" on page 98 for more information.)

In addition to typing the query in the Search text box, you can do the following:

o Create queries by using the Advanced Search tool. For more information, see "Using the Advanced
Search Builder" on page 90.

o Save queries and use them later. For more information, see "Saving Queries (Creating Saved Searches
and Saved Filters)" on page 129.

HPE Logger 6.3 Page 66 of 623



Administrator's Guide
Chapter 3: Searching and Analyzing Events

o Create new queries from the predefined queries that come with your system. For more information,
see "System Filters/Predefined Filters" on page 131.

Although a search query can be as simple as a keyword, you will be better able to utilize the full
potential of the search operation if you are familiar with all the elements of a query, as described in
"Elements of a Search Query" on page 69.

Simple Query Example

This example query finds events containing the word “Logger.” Type Logger in the search box and
then click Go!

ArcSight Logger Summary Analyze Dashboards Reports Configuration System Admin
W B x4 v AlFeds E| Last 24 hours E|
Logger w Go! Advanced
22,493 events (Scanned: 22,493 events, 00:01.953) ¥
1.000
800
500
£00
200
0
12:35:00 20:35:00
aF Time Even T oo Logser | devieVendor | dovisbrodut | _devicversion | dveebvemiasid | name
Sel Fields () 1 2016/08/04 10:17:52 PDT Logger  Local ArcSight Logge: L7800 network200 Numbe *
Ml deviceEventClassld 12
B deviceProduct 1 2 2016/08/04 10:17:52 PDT Logger  Local ArcSight L7800 memory:100 Platforr
W deviceVendor 1 3 2016/08/04 10:17:52 PDT Logger  Local ArcSight L7800 cpu:100 CPUUs
Mijdevicel/ersiont2 4 2016/08/04 10:16:27 PDT Logger Local  ArcSight s L7800 platform:230 Success
M name 18
5 2016/08/04 10:15:10 PDT Logger Local ArcSight Logge 6.3.0.7800.0 storagegroup:100 Storage
-
4 m [
M| Enable Multi-select of field values. Displaying 1 - 25 of 22493 | Events per page | 25 || Page |1 of 900 b M

Chart Query Example Using a Chart

Aggregated search operators such as chart, top, and rare generate charts of search results. This
example query finds events containing the word “Logger” and charts the top ten events by the contents

of the name field. Type the following query in the search box and then click Go!
Logger | top deviceEventClassId

A chart similar to this one displays.
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eps:102 5728
storagegroup:100 2864
eps:103 1432
memory: 100 788
cpul00 788
search:100 716
network-101 714

For more information on the search operators, see "Search Operators" on page 471. For more
information on creating and using charts, see "Chart Drill Down" on page 120 and "Refining and
Charting a Search from Field Summary" on page 124.

Understanding Search Field Colors

Each column in the Search Results table is color-coded to show what type of field it contains, and
whether or not the field has been indexed. Colored column labels can help you refine your searches for

the fastest results.

01:05:00 02:25:00 03:45:00 05:05:00 06:25:00 07:45:00 09:05:00 10:25:00
Time (Event Time) Device Logger  deviceVendor devi di Classid name

1 2016/07/15 13:20:15 PDT Logger  Local ArcSight L7780 platform:230 Successful login

2 2016/07/15 15:18:23 DT Logger  Local ArcSight L7780 network:200 Mumber of Apache Connections

3 2016/07/15 13:18:23 PDT Logger  Local ArcSight L7780 memory-100 Platform Memory Usage

Field type icons will also display on Logger pages where search Fields are used, such as the Field set
editor, the default Fields page, and search auto-complete.

Icon Column Color

[ Darkgreen

I Green

HPE Logger 6.3

Field Type

Super indexed

Indexed

Can Field be Indexed?

Indexed by default

Indexed by default
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Ilcon Column Color Field Type Can Field be Indexed?

Light green Logger Common Event Format Yes (indexable)
(CEP), including custom fields

B Lightgray Metadata No

No color Non-Logger CEF No

Elements of a Search Query

A simple search query consists of a query expression, a time range and a field set. An advanced Logger
search query can also include constraints that limit the search to specific device groups, storage groups,
and peer Loggers.
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Query Expressions

A query expression is a set of conditions used to select events when a search is performed. An
expression can specify a very simple term to match such as “login” or an IP address; or it can be more
complex enough to match events that include multiple IP addresses or ports, and that occurred
between specific time ranges from a specific storage group.

Specify the query in the Search text box by using the following syntax:
<Indexed Search> | <Search Operators>

The query expression is evaluated from left to right in a pipeline fashion. First, events matching the
specified Indexed Search portion of the query are found. The search operator after the first pipe (“|)
character is then applied to the matched events followed by the next search operator, and so on to
further refine the search results.

The search results table and the histogram display the events that match the query as they are found.
As additional events are matched, the search results table and the histogram are refreshed. Certain
search operators such as head and tail, require a query to finish running before search results can be
displayed.

o Theindexed search section of the query is described in "Indexed Search Portion of a Query" on the
next page.
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o The search operator portion of the query is described in "Search Operator Portion of a Query" on
page 76.

« Additional points to take into consideration when writing queries are described in "Things You
Should Know About Logger Searches" on page 106.

Indexed Search Portion of a Query

The Indexed Search section of the query uses fields to search for relevant data quickly and efficiently.
You can use a search expression to specify keywords to search for in the event text or to search using
field-based expressions in a Boolean format.

Keyword Search (Full-text Search)

Keywords are simply the words you want to search for, such as failed, login, and so on. You can specify
multiple keywords in one query expression by using Boolean operators (AND, OR, or NOT) between them.
Boolean expressions can be nested, for example, (John OR Jane) AND Doe*.If you need to search
for the literal occurrence of AND, OR, or NOT (in upper-, lower-, or mixed case), enclose them in double
quotes (““ ) so the search engine does not interpret them as operators. For example, “and”, “Or”,
and so on.

Note: Although the Boolean operators AND, OR, and NOT can be specified in upper-, lower-, or
mixed case when used as an operator, HPE recommends that you use uppercase for ease of reading

the query.

Guidelines for Writing Keyword Search Expressions
Follow these guidelines when specifying keyword search expressions:

o Follow the requirements described in "Syntax Reference for Query Expressions" on page 85.

o Addition points to take into consideration when writing queries are described in "Things You Should
Know About Logger Searches" on page 106.

o Keyword search is not case sensitive.

o Use Boolean operators (AND, OR, or NOT) to connect multiple keywords. If no Boolean operator is
specified between two keywords, the AND operator is applied by default. Also, use the Boolean
operators to connect keywords to fields you specify.

e Use double quotes (“ *’) to enclose a single word for an exact match. Otherwise, the word is treated
as<search string>*. For example, to search for log, type “log”. If you type log (without the
double quotes), the search will match all words that begin with log; for example, log, logger, logging,
and so on.

o When specifying Boolean operators (AND, OR, or NOT) as keywords, enclose them in double quotes
(*“ ). For example, “AND”.
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o Use the backslash (\) as an escape character for )\, “, and *. However, backslash will not escape these
characters if the keyword is enclosed in double quotes.

The following table summarizes how special characters are treated in a keyword search.

Using Special Characters in Keyword Searches

Character Usage
Space Tab You cannot specify keywords that contain the characters in the left column. Therefore, to search
Newline for a phrase such as failed login, enter “failed” AND “login”.
> 5 ()L 1A
Tl o Note: * is a valid character for wildcard character searches.
=:/ \ @ - ? Tospecify akeyword that contains any of the characters in the left column, enclose the keyword
#3$ & _ % > < indouble quotes (“ ). You can also specify an asterisk (*) at the end of the keyword for an
! exact match.
Examples:
e “C:\directory”
e “result=failed”
* asterisk You can use the wildcard character asterisk (*) to search for keywords, however, the wildcard cannot

be the leading character in the keyword. Therefore, the following usages are valid:
log* log\* “log™" log\\*
log*app log*app log*app*app

However, the following usages are not valid:

*log *log*app*

Field-Based Search

The Logger schema contains a predefined set of fields. You can add fields that are relevant to the
events you collect on your Logger to its schema. A field-based search can only conftain fields in Logger’s
schema. "Adding Fields to the Schema" on page 377.

The Logger indexing capability allows schema fields to be indexed. Logger’s search operation and
reports uftilize the indexed fields to yield significant search and reporting performance gains. Although
you can include both indexed and non-indexed fields to a search query, search and reporting
performance will be much faster if all fields in a query are indexed. For more information and a list of
fields you can index, see "Indexing" on page 138. For discussion on field-based query performance, see
"Performance Optimizations for Indexed Fields in Queries" on page 95.

The field operators you can use in a query expression are listed in the table below. In addition to the
field operators, you can use search operators, as discussed in "Search Operator Portion of a Query" on
page 76.
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You can specify multiple field conditions in one query expression by using the listed operators between
them. The conditions can be nested; for example, (name=“John Doe” OR name=“Jane Doe”) AND
message!="“success”.

Note: If a query includes the Boolean operator OR and the metadata identifiers (discussed in
"Constraints" on page 84), the expression to be evaluated with OR must be enclosed in parentheses,

as shown in this example:

(success OR fail) _storageGroup IN [“Default Storage Group”]
If the expression is not enclosed in parentheses, an error message displays.
Any literal operator in the table can be specified in upper-, lower-, or mixed case. To search for these

words as literals in events, enclose them in double quotes (“*). For example, message CONTAINS
“Between”.

o To determine the data type of a field, see "Default Fields" on page 281.
o To determine the size of a custom field, see "Custom Fields" on page 283.

Using Operators in Field-Based Searches

Operator Example Notes

AND name=“Data List” AND Valid for all data types.
message=“Hello”
AND 1.2.3.4

OR (name=“TestEvent” OR Valid for all data types.

message=“Hello”) AND
type=2 AND 1.2.4.3

NOT NOT name=“test 123” Valid for all data types.
1= destinationPort != 100 Valid for all data types.
message!=“failed login”

message!=failed*login
(* means wildcard) “test”

message!=failed\*login
(* is literal in this case)

= bytesIn = 32 Valid for all data types.

message=“failed login” The size of each field in the schema is predetermined. If
the string you are searching for is longer than the field-
length, you should use a STARTSWITH rather than an =
search, and include no more than the number of characters
in the field size. To determine the size of a default field, see
"Default Fields" on page 281. To determine the size of a
custom field, see "Custom Fields" on page 283.

message=“failed*login”
(* means wildcard)
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Using Operators in Field-Based Searches, continued

Operator
> *

<*

BETWEEN*
STARTSWITH

ENDSWITH

Example
bytesIn > 100
startTime <“$Now - 1d”

endTime
>=“01/13/2015 07:07:21”

endTime >=“2015/13/01
00:00:00 PDT”

endTime >=“Sep 10 2015
00:00:00 PDT”

startTime <=“$Now - 1d”
priority IN [2,5,4,3]

destinationAddress IN
[“192.0.2.4”,
€192.0.2.147]

_deviceGroup IN [“DM1”]

_storageGroup NOT IN

[“Internal Event Storage

Group”, “SG1”]

_peerLogger 1IN
[“192.0.2.10”,
“192.0.2.117]

priority BETWEEN 1 AND 5
message STARTSWITH “failed”

message ENDSWITH “login”

HPE Logger 6.3

Notes
Valid for all data types.

* These operators evaluate the condition lexicographically.
For example, deviceHostName BETWEEN AM AND EU
searches for all devices whose names start with AM, AMA,
AMB, AN, AO, AP and so on, up to EU. Therefore, any device
whose name starts with AK, AL, and so on is ignored.
Similarly, devices with names EUA, EUB, FA, GB, and so on
will be ignored.

Valid for string (text) data types only.

Valid for string (text) data types only.
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Using Operators in Field-Based Searches, continued

Operator Example Notes
CONTAINS message CONTAINS “foobar” Valid for string (text) data types only.
IS sessionId IS NULL Valid for all data types.

sessionId IS NOT NULL

INSUBNET sourceAddress insubnet Filters IP addresses based on subnets in address fields such
"192.0.2.*" as sourceAddress,deviceAddress, and
agentAddress insubnet destinationAddress.
"192.0.% . *" You can specify a subnet in one of the following ways:
AND NOT
deviceAddress insubnet « In CIDR notation: “address/prefix-length”, such as

"192.0.2.%*" 192.0.2.23/24,

e Asanaddress range: “addressl-address2”, such as

agentAddress insubnet
192.0.2.0-192.0.2.255.

"192.0.2.1-192.0.2.24"
o Asa wildcard expression where one or more asterisks

replace data on the right-hand side of an address, such as
192.0.2.%

agentAddress insubnet
"192.0.1.0-192.0.2.0"
AND NOT
deviceAddress insubnet
"198.51.100.0/24"

agentAddress insubnet
"192.0.*%.*" AND NOT
deviceAddress insubnet
"192.0.2.*"

agentAddress insubnet
"192.0.2.0/24" AND
deviceAddress insubnet
"198.51.100.0/24"

agentAddress insubnet
"192.0.2.0/16" AND
deviceAddress insubnet
"198.51.100.*"

Field-Based Search Expression Guidelines

Follow these guidelines when specifying field-based search expressions:

o Follow the requirements described in "Syntax Reference for Query Expressions" on page 85.

« Addition points to take into consideration when writing queries are described in "Things You Should
Know About Logger Searches" on page 106.

o For faster searches, follow the recommendations in "Searching for Rare Field Values" on page 109
and "Tuning Search Performance" on page 108.

o By default, field-based search is case sensitive. You can change the sensitivity from the Field Search
Options section of the Configuration | Search > Search Options page. For more information, see
"Search Options" on page 277.
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You can specify any predefined Logger schema field. For example, cat = /Monitor/CPU/Usage. For a
complete list, see "Indexing" on page 138.

You can specify any custom field you have added to the schema. For example, SSN=333-333-3333.
For more information about custom schema fields, see "Adding Fields to the Schema" on page 377.

You cannot specify user-defined fields created through a predefined or user-defined parser in the
Indexed Search portion of a query. (The Indexed Search portion of a query is the expression before
the first pipeline character.)

A query expression (Indexed Search | Search Operators) is evaluated from left to right in a pipeline
fashion. By design, a parser—predefined or user-defined—is applied to an event when the Search
Operators are processed in a search query. Therefore, field creation when a parser is applied to an
event occurs later than the Indexed Search stage. As a result, you cannot specify these fields in a
field-based search query.

For example, the Apache Access Log parser creates the field SourceHost. You cannot specify the
following query expression:

SourceHost=%“192.0.2.0"

However, you can use this field after the first pipeline, as shown in this example.

| where SourceHost=“192.0.2.0”

Or, if you want to search only the Apache Access Logs for SourceHost=“192.0.2.0”, youcan
specify this expression:

| where parser=“Apache Access Log” and clientIP=“192.0.2.0"
Additionally, you can run a full-text (keyword) search on “192.0.2.0”, as follows:
“123.456.789” | where SourceHost=“192.0.2.0”

If an event field contains data of an unexpected type (for example, a string when an integer is
expected), the data is ignored. Therefore, search for that data value will not yield any results. For
example, if the port field contains a value 8080A (alphanumeric) instead of 8080 (numeric), the
alphanumeric value is ignored. The data types of the schema fields are available from the
Configuration | Search > Default Fields page. For more information on how to view this information,
see "Default Fields" on page 281.

For optimal search performance, make sure that event fields on ALL peers are indexed for the time
range specified in a query. If an event field is indexed on one system but not on its peers for a specific
time range, a distributed search will run slower on the peers. However, it will run at optimal speed on
the local system. Therefore, the search performance in such a setup will be slow.

For faster report generation, ALL fields of a report (including the fields being displayed in the report)
need to be indexed. That is, in addition to the fields in the WHERE clause of the query, the fields in
the SELECT clause also need fo be indexed.
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Search Operator Portion of a Query

The Search Operators portion of the query enables you to further refine the data that matched the
indexed search filter. See "Search Operators" on page 471for a complete list of search operators and

examples of how to use them.

The rex search operator is useful for syslog events (raw or unstructured data) or if you want to
extract information from a specific point in an event, such as the 15th character in an event. Other
operators such as head, tail, top, rare, chart, sort, fields, and eval are applied to the fields you
specify or the information you extract using the rex operator.

Prior to Logger 5.2, you needed to use a special search operator—cef—to extract CEF fields from CEF
evenfts (structured data) that matched the indexed search filter (the query portion before the first
pipeline in the query expression) before you could use other search operators to act upon those fields.
However, starting with Logger 5.2, you do not need to explicitly extract the CEF fields and then apply
other search operators to those fields. You can specify the event fields directly in queries. The CEF
operator has been deprecated as of Logger 5.2.

Time Range

An event is timestamped with the receipt time when it is received on the Logger. A search query uses
the receipt time to search for matching events.

Under most circumstances, the Logger receipt time is same as the event time. However, the event time
and the Logger receipt time for an event can be different because there is usually a small lag between
the time an event leaves a device and it is received at the Logger. If the device’s clock is ahead or behind
the Logger clock, the lag or lead can be significant.

A search operation requires you to specify the time range within which events would be searched. You
can select from many predefined time ranges or define a custom time range to suit your needs.

When defining a fime range for your query, be sure to take the information in "Impact of Daylight
Savings Time Change on Logger Operatfions" on page 412 into consideration.

Predefined time range: When you select a predefined time range such as “Last 2 Hours” or “Today”,
the time range is relative to the current time. For example, if you select “Last 2 Hours” at 2:00:00 PM on

July 13th, events from 12:00:00 to 2:00:00 PM on July 13th will be searched. If you refresh your search
results at 5:00:00 PM on the same day, the time window is recalculated. Therefore, events that match
the specified criteria and occurred between 3:00:00 and 5:00:00 PM on July 13th are displayed.

Custom time range: You can specify a tfime range in a 24-hour format to suit your needs. For example,
a custom time range is:

Start: 8/13/2015 13:36:30
End: 8/13/2015 22:36:30
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By default, the end time for a custom time range is the current time on your Logger and the start time is
two hours before the current fime.

You can also use variables to specify custom time ranges. For example, a dynamic date range might start
at SNow - 2h (two hours ago) and end at SNow (the current time). The dynamic search is relative to
when the query is run. Scheduled search operations use this mechanism to search through newer event
data each time they are run.

The “Dynamic” field in the user interface enables you to specify the dynamic time, as shown in the
following figure:

W B X 3% £V | AlFilds |E| Custom time range |Z| Start | SCurrentWeek [¥] Dynamic  End  $Now [¥] Dynamic

Logger | chart count by name Advanced

Following is a typical example of a dynamic search that limits results to the last two hours of activity:

Start: $Now - 2h
End: $Now

The syntax for dynamic search is:

<current_period> [ +/- <units>]

Where <current_period>, such as $Now, either stands alone or is followed by either a plus (‘'+") or
minus (‘-") and a number of units, such as 2h for two hours. The <current_period> always starts with
a‘$’ and consists of a word, case-sensitive, with no spaces, as shown in the table "Current Period" below.
The <units> portion, if given, consists of an integer and a single, case-sensitive letter, as shown in the
table "Units" below.

Current Period

Period Description
$Now The current minute
$Today Midnight (the beginning of the first minute) of the current day

$CurrentWeek  Midnight of the previous Monday (or same as $Today if today is Monday)
$CurrentMonth Midnight on the first day of the current month

$CurrentYear  Midnight on the first day of the current year

Units
Unit Description
m (lowercase) Minutes (Do not confuse with ‘M’, meaning months)

h Hours
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Units, continued

Unit Description
d Days
W Weeks

M (uppercase) Months (Do not confuse with ‘m’, meaning minutes)

Time Stamps in Logger

Events consist of a receipt time, event fime, a source (host name or IP address), and an un-parsed
message porfion.

Event Time is the time the events are received by the Logger Receiver. Logger uses this field to find
matching events when Searching and Reporting.

Receipt Time is the time the events are written to the Storage Group (disk). All events are tfimestamped
with the receipt time when received on the Logger.

Note: Under most circumstances, the Logger receipt time is same as the event time. However, the
event time and the Logger receipt time for an event may be different because there is a small lag
between the time an event is received and when it is stored on the Logger. Other things may also
cause some lag. For example, if event time parsing is enabled in file receiver, the receipt time may lag
behind event time.

o Logger uses the receipt time field to find matching events when forwarding as well as for storage
retention and archives.

o The Logger receipt time of an event is used to determine whether an event will be forwarded to a
destination when a forwarder filter specifies a fime range by which events are evaluated for
forwarding.

o Logger uses the receipt tfime of an event to determine its archival day.
o Search results are sorted by the Logger event time.
o The histogramis based on the Logger event time.

o The default fields are automatically indexed. For the remaining fields, Logger uses the receipt time of
an event and the time when a field was added to the index to determine whether that event will be
indexed. If the receipt time of the event is equal to or later than the time when the field was added to
the index, the event is indexed; otherwise, it is not.

In addition to the event time and the receipt fime, you may see several other time stamps in Logger
events, including the following:

Agent Receipt Time is the time the Connector received the event. Logger does not use this field, but
you can search it.
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End Time is the original time of the event on the device. Logger does not use this field, but you can
search it.

Manager Receipt Time is the time the ESM received the event. Logger does not use this field, but you
can search it.

Fieldsets

A field set determines the fields that are displayed in the search results for each event that matched a
search query. By selecting the field set, you select which fields you see in the search results. For
information, see "Changing the Displayed Search Results Using Field Sets" on page 118. You can use a
predefined field set or create your own.

Predefined Fieldsets

The system provides a number of predefined field sets.

To view the list of available field sets: Click the down-arrow in the Fields dialog box. The System
Fieldsets list is displayed.

All Fields E

Custom
Customize...
System Fieldsets
Base Event Fields
Categories
EndPoint Protection
Firewall
HIDS
Minimal Fields
MetFlow
Metwork, Routers, and Switches
MIDS
Raw Ewvent
Syslog Standard
User Defined Fields
VPN

To display the search results using a specific field set: Click the field set from the drop-down list.
Note: Only fields available for matched events are displayed in a Search Results display (or the
exported file). Therefore, even if you select the All Fields field set, you might not see all fields

displayed in the search results, only the fields included in the events found by the search.

For more information about field sets, see "Managing Fieldsets" on page 281.
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The User Defined Fields Field-Set

When you use a search operator that defines a new field, such as rex, rename, or eval, a new column for
each field is added to the currently selected display. These newly defined fields are displayed by default.
The User Defined Fields field set enables you to view only the newly defined fields.

The Raw Event Field-Set

The Raw Event field set displays the whole raw syslog event in a column called rawEvent, with the
event formatted to fit in the column.

Although the Raw Event field is most applicable for syslog events, you can also display the raw event
associated with CEF events in the rawEvent column. To do so, make sure the connector that is sending
events to the Logger populates the rawEvent field with the raw event.

Note: To see the raw events in the rawEvent column, enable the Search Option, “Populate
rawEvent field for syslog events”. See "Search Options" on page 277 for more information.

Custom Fieldsets

You can create your own field sets by selecting “Customize...” from the “Fields” pull-down menu.

All Fields IL

ystem Fieldsers
All Fields
Base Event Fields

ALEGONIES

The user inferface enables you to select and move event fields you want to include in a field set..
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Customize Fields 8

Field Categories
agent

attacker
category
destination
device
deviceCustom
eventAnnaotation
file

finalDrevice

flex

oldFile

originalagent

»

m

Fields

T ———rr——————

agentTranslatedZoneReferencelD
agentTranslatedZoneResource
agentTranslatedZonelURI

M agentType
agentVersion
agentioneg
agentZoneExternalll
agentZonelD
agentZoneMame
agentZoneReferencelD
agentZoneResource

agentZonelUR]

Use these buttons to create and edit a custom field set.

[#]—Top oflist
[+]-up

_"Add selected field
—'ﬂemmre selected field

"' Down

~Bottom of list

-

I M deviceEventClassid

Selected Fields
H Event Time

H Cevice

H Logger

“user

Raw Message
M deviceVendor
M deviceProduct
W deviceVerzion

M name

™

IDKl |Save| |Clear| |Cance||

A wildcard field (“***) is available in the Fields list when you create a custom field set. This field includes
all fields available in an event that are not individually listed in the custom field set definition. For
example, for the following custom field set definition, the search results will list the fields before the

asterisk (“***) first, followed by any other fields in an event. Lastly, the deviceEventClassld and Name

fields will be listed.
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Customize Fields

Field Categories Fields Selected Fields
& & Exent Ti
eventAnnotation sourceTranslatedZoneResource u e ime
Devi
file sourceTranslatedZonsURI B Device
L
finzlDevice M sourcellserid W Logger
¥ -
flex M zourcellzerMame HEsr

Raw Mezsage

oldFile B sourcellserPrivilzges
deviceVend
originalagent sourceZone . icevendor
deviceProduct
request sourceZoneExternalll u IceFrodu
ract sourceZonelD M deviceVersion

m

M deviceEventClaszsld

source sourceZoneMame =

special sourceZoneReferencelD c @E
target sourcefoneResource

threat ~ W sourceFoneURI -

|'DK| |Save| |Clear| |Cance||

You can save the custom field set or use it only for the current session.

Save Fieldset

Name | MyCustomFieldset
Ohverwrite if exists?
&l Save as Default

| Save | | Cancel

If you click OK, the field set appears in the Custom category. It is labeled as “Custom (not saved)” and is
not visible to other users. It will remain available to you for this session. Once you log out of the current

session, the temporary field set will be deleted. You can only have one temporary custom field set at a
time.

If you click Save, the field set appears under the Shared Fieldsets category and is visible and available to
the other users, as shown in the following figure. After a field set is saved, you can edit and delete it.

When saving a custom field set, you can specify it as the default for this system. If you do so, it is the
default field set for all users on that system. If do not select it as the default, the field set is used only for
your search results and does not affect other users connecting to the same system.

HPE Logger 6.3 Page 82 of 623



Administrator's Guide
Chapter 3: Searching and Analyzing Events

"R R L OV

Logger | where name="CPU |

20
15
10
0.5
0o
14:50:00
7%

Selecred Fields (5)
deviceEventClassld 1

deviceProduct 1

All Fields

Custom (not saved)
Customize...

Shared Fieldsets

My CustomFieldset

23 events (Scanned: 1.572 [System Fieldsets

All Fields

Base Event Fields
Categories
EndPoint Protection
Firewall

HIDS

Minimal Fields
NetFlow

Network, Routers, and Switches

NIDS

Raw Event

Syslog Standard
User Defined Fields
VBN

E Last 30 minutes |Z|

deviceVendor 1

For information about deleting custom field sets, see "Managing Fieldsets" on page 281

Note: Field sefs are not included in the saved filter definition.

14:58:00
Device Logger name deviceVen
PDT Logger Local CPU Usage ArcSight
POT Logger Local CPU Usage ArcSight
DT Logger Local CPU Usage ArcSight

The *user field, shown below, controls the display of fields defined by search operators (rex, rename,
extract, or eval) as well as the fields created when a parser is applied to an event. When *user is
included in the Selected Fields list of a custom field set, the created or defined fields are displayed.

Customize Fields 7]

el e o
eventAnnotation
filz

finalDevice

fle

oldFile
originalAgent
reguest

root

source

special

target

threat

m

4

Fields

additionalData
aggregatedEventCount

M applicationProtocol

W bazeEventCount
bazeEventlds

M bytesin

M bytesCut
concentratorAgents
concentratorDevices
correlatedEventCount
oryptoSignature

oustomer

-

Selected Fields
H Event Time

M Device

Raw Message
W deviceVendor
M deviceProduct
W deviceVersion

M deviceEventClassld

M name

-

|DK| |Save| |Cln.=_'ar| |Cance||
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Constraints

Using constraints in a query can speed up a search operation as they limit the scope of data that needs
to be searched. Constraints enable you to limit a query to events from one or more of the following:

o Particular device groups
o Partficular storage groups
o Specific peers

For example, you might want to search for events in the SG1and SG2 storage groups on the local
system only, or for events on specific peers.

For information about storage groups and peers, see "Storage" on page 347, "Device Groups" on
page 293, and "Peer Nodes" on page 397.

Follow these guidelines when specifying constraints:
o Use the following operators to specify constraints in a search query expression:

Metadata Identifier Example
_deviceGroup _deviceGroup IN [“DM1”, “HostA”]

where DM1 is a device group, while HostA is a device.

Note: You can use this field to specify individual devices, as shown in the example

above.
_storageGroup _storageGroup IN [“Internal Event Storage Group”, “SG1”]
_peerlLogger _peerLogger IN [“192.0.2.10”, “192.0.2.11”]

o |If aqueryincludes the Boolean operator OR and metadata identifiers, the expression to be evaluated
with OR must be enclosed in parentheses, as shown in this example:

(success OR fail) _storageGroup IN [“Default Storage Group”]
If the expression to be evaluated with OR is not enclosed in parentheses, an error message is
displayed on the user interface screen.

o When specifying multiple groups in a constraint, ensure that the group names are enclosed in square
brackets; for example, _storageGroup IN [“SGA”, “SGB”].

e You can apply constraints to a search query by:
a. Typing the constraint in the Search text box

Once you type “_s” (for storage group), “_d” (for device group), or “_p” (for peer) in the Search
text box, Search Helper automatically provides a drop-down list of relevant terms and operators
from which you can select.

Caution: If a search query contains constraints and a regular expression, make sure that the
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constraints are specified before the regular expression. For example, peerLogger IN
[“192.0.2.10”] name contains abc | REGEX=“:\d31”

b. Selecting Storage Groups or peers from the Advanced Search tool. (To access the Advanced

Search tool, click Advanced Search beneath the text box where you type the query.) For more
information about the Advanced Search, see "Using the Advanced Search Builder" on page 90.

Syntax Reference for Query Expressions

To create valid and accurate query expressions, follow these requirements.

Query Syntax Requirements

Behavior

Case sensitivity

Escape character

Escaping wildcard
character

HPE Logger 6.3

Full Text Search

Insensitive

(Cannot be changed.)

\

Use to escape \. You cannot
escape any other character.

Cannot search for *
Example:

log\* is invalid

Field Search

Sensitive

(Can be changed using
Tuning options. See "Search
Options" on page 277.)

\
Use to escape \, “, and *.
Examples:

name=log\\ger
(matches log\ger)

name=logger\*

(matches logger*)

Can search for * by escaping
the character

Example:

name=log\* is valid

Regular Expression

Insensitive

(Can be changed using
Tuning options. See "Search
Options" on page 277.)

\

Use to escape any special
character.

Example:

To search for a term with
the character “[":

|REGEX= “logger\[”

Can search for * by escaping
the character

Example:

name=log\* is valid
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Query Syntax Requirements, continued

Behavior

Exact Match/Search
string includes an
operator or a special
character

Nesting, including
parenthetical clauses,

Full Text Search

Enclose keyword in double
quotes; Otherwise, keyword
treated as keyword*.

Example:

log (maftches log, logging,
logger, and so on)

“log” (matches only log)

Tip: See the list of special
characters that cannot be
searched even when
enclosed in double quotes,
later in this table.

Allowed

Field Search

Enclose value in double
quotes

Example:

message=“failed
login”

Allowed

Regular Expression

No special requirement.

Multiple regular expressions
can be specified in one

o Use Boolean operators to
connect and nest keywords.

o Use any operator listed in

such as (@ OR b AND ¢ the "Field-Based Search"

query using this syntax:

HPE Logger 6.3

o Metadata identifiers
(_storageGroup, _
deviceGroup, and _

peerLogger), but can only
appear at the top level in a

query expression). If the
query contains a regular
expression, the metadata

identifiers need fo precede

the regular expression.

on page 71 section to
connect and nest field
search expressions.

o Metadata identifiers
(_storageGroup, _
deviceGroup, and _
peerLogger), but can
only appear at the top
level in a query
expression

|REGEX= “<REGEX1>”
| REGEX="“<REGEX2>”| ...
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Query Syntax Requirements, continued

Behavior Full Text Search

Operators Upper-, lower-, or mixed case
Boolean operators—AND, OR,
NOT. If an operator is not

specified, AND is used.

To search for literal operator
AND, OR, NOT, in an event,
enclose them in double quotes.

Example: “AND”’, “OR”, “Not”

Note: If a query includes
the Boolean operator OR
and the metadata
identifiers
(_storageGroup,
_deviceGroup, and
_peerLogger), the
expression to be
evaluated with OR must
be enclosed in
parentheses

Example:

(success OR fail) _
storageGroup IN
[“Default Storage
Group™]

HPE Logger 6.3

Field Search

Use any operator listed in
the "Field-Based Search" on
page 71 section.

e Unless a value is
enclosed between double
quotes, a space between
values is inferpreted as
an AND.

For example, name=John
Doe is inferpreted as
John AND Doe.

o If an operafor is not
specified between
multiple field
expressions, AND is used.

e Tosearch for literal
operator, enclose the
operator in double
quotes.

Examples:

message
STARTSWITH=“NOT”

message=“LOGIN DID
NOT SUCCEED”

o If a queryincludes the
Boolean operator OR and
the metadata identifiers
(_storageGroup,
_deviceGroup, and
_peerLoggen), the
expression to be
evaluated with OR must
be enclosed in
parentheses.

Example:

(success OR fail)
_storageGroup IN
[“Default Storage
Group™]

Regular Expression

| and the operators
described in "Time Range"
on page 76.

Use this operator to AND
multiple regular expressions
in one query expression.
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Query Syntax Requirements, continued

Behavior

Primary
Delimiters:

Space
(Yr1:x-
> <

P
| *

Secondary Delimiters:

= ./ \ -2 #

$&_%

Syntax

HPE Logger 6.3

Full Text Search

You can search for keywords
containing primary delimiters
by enclosing the keywords in
double quotes.

Examples:

“John Doe”“Name=John
Doe”“www.hp.com”

You can also search for
keywords containing secondary
delimiters once you have
configured the full-text search
options as described in "Search
Options" on page 277.

Example:

You can search for hpe.comin
a URL
http://www.hpe.com/apps
by specifying hpe . com as the
search string.

keywordl boolean_
operator keyword2
boolean_operator
keyword3

Field Search

You can search for these
characters. Enclose value in
double quotes if value
contains any of these
characters.

Example: name=“John*”

You can search for these
characters. Enclose value in
double quotes if value
contains any of these
characters.

Example: name=“John”

field_name operator
field_value

(List of fields in the "Event
Field Name Mappings" on
page 549 section.)

(List of operators in the
"Field-Based Search" on
page 71section.)

Regular Expression

Cannot contain " in the
beginning and $ at the end
as a mafching character
unless the regular
expression you specify must
look for an event that
contains only the pattern
you are specifying.

Special regular expression
characters such as \ and ?
need to be escaped.

Example:

|REGEX= “~test$” will
search only for events
containing the word test .

e Cannot contain ~ in the
beginning and $ at the
end as a matching
character unless the
regular expression you
specify must look for an
event that contains only
the pattern you are
specifying; for example,
| REGEX= “~test$”
will search for events
containing the word
“test” (without quotes)
only.

e Special regular
expression characters
such as \ and ? need to
be escaped.

| REGEX=“¢<REGEX1>” |
REGEX=“<REGEX2>”]| ...
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Query Syntax Requirements, continued

Behavior

Tab

Newline

{«*

Time format, when
searching for events
that occurred at a
particular fime

HPE Logger 6.3

Full Text Search

Cannot search for these
characters.

Examples:

“John{Doe” is invalid

No specific format. The query
needs o contain the exact

fimestamp string. For example,

“10:34:35”.

Note: The string cannot
contain spaces. For
example, “Oct 19”is
invalid.

Field Search

No restrictions.

Enclose special character in
double quotes. Escape the
wildcard character and
double quotes.

Example:

name=“John\* \“Doe”
(matches John* “Doe")

Use this format to specify a
fimestamp in a query
(including double quotes):

“mm/dd/yyyy hh:mm:ss”
Or

“yyyy/mm/dd hh:mm:ss
timezone”

Or

“MMM dd yyyy hh:mm:ss
timezone”

where

mm = month

dd = day

yyyy =year

hh = hour

mm = minutes

ss = seconds

timezone = EDT, CDT,
MDT, PDT

MMM = First three letters of a
month’s name; for example,
Jan, Mar, Sep, and so on.

Use the <= and >= operators
to narrow down the fime
range. Do not use = or ! =.

Regular Expression
No restrictions.

Special regular expression
characters such as () [ ]
{}"|,and * need to be
escaped.

No restrictions.

Page 89 of 623



Administrator's Guide
Chapter 3: Searching and Analyzing Events

Query Syntax Requirements, continued

Behavior Full Text Search Field Search Regular Expression
Wildcard * Cannot be the leading *Can appear anywhere in * Can appear anywhere.

character; only a suffix or in- the value.

between a keyword.

Examples:
E les:
xamples name=*1og (searches for
¢ *logisinvalid ablog, blog, and so on.)
e log*is valid name=“\*1log”

° |o*g*i5 valid name=\*log

(both search for *1og)

Using the Advanced Search Builder

The Advanced Search tool is a Boolean-logic conditions editor that enables you to build search queries
quickly and accurately. The tool provides a visual representation of the conditions you are including in a
query. You can specify keywords, field-based conditions, and regular expressions using this tool. You
can also specify search constraints such as peers, device groups, and storage groups (see "Constraints"
on page 84). This section describes how to use the tool.

e Accessing the Advanced Search Builder ... 90
o Nested ConditioNS ... L 93

Accessing the Advanced Search Builder

To display the Advanced Search builder:

Click Analyze > Search to open the search page, and then click Advanced Search, to the right of the
Il button, as shown in the following figure.

R KL OV AlFdds [ sst1ominues  [7]

The Advanced Search builder is displayed, as follows:
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Advanced Search
FITER @ B x 24 @

& n = [

= {} Current Filter
& AND

Name « Operator Condition

| »

agentAddress
agentHostName
agentMtDomain
agentSeverity
agentType

Pipeline B2

Device Groups rd

Storage Groups #

To build a new search query in the Advanced Search builder:

1. Click Analyze > Search to open the search page, and then click Advanced Search.

2. Select the Boolean operator that applies to the condition you are adding from the top of Search
Builder. You can select these operators:

Operator Meaning

& AND
]| OR
1= NOT

3. If you wanft to load a system or saved filter, or a saved search, click the ¥ jcon. Select the filter or
the saved search from the displayed list and click Load+Close.
For more information, see "Saving Queries (Creating Saved Searches and Saved Filters)" on
page 129 and "System Filters/Predefined Filters" on page 131.

4, To add a keyword (full-text search) or field condition:

a. Locate the field you want to add under the Name column.
To specify a keyword (full-text search), use the fullText field under the Name column, as shown
in the following figure.
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Advanced Search
FLTER @ B x 1@

& 11 1= o]

= {} Current Filter
=& AND
@ fullText = login
@ fullText = failed

Name « Operator Condition

o=

flexString2 Label

full Text = 'Iogin

full Text = failed

full Text .

message -

Pipeline B

Device Groups rd

Storage Groups rd

b. Click the Operator column associated with the field, select the operator from the displayed list,
and press Enter.

¢. Only operators applicable o a field are displayed in the list.

d. Inthe Condition column associated with the field, enter a value and press Enter.

To edit a condition, right click on the condition for a pull-down menu that enables you to edit,
cut, copy, or delete the condition.

Note: You cannot specify a range of IP addresses. Therefore, to search for multiple IP
addresses in a range, use the CONTAINS operator and wildcard characters in the Condition

column; for example, enter 192.0.2. *.

5. Repeat the steps above until you have added all the conditions.
6. If your search query will include a regular expression, type it in the Regex field.

7. If you want to constrain your search query to specific device groups, storage groups, and Loggers,

click the # icon next to the constraint category. Select the relevant groups and Loggers. (To select
multiple groups, hold the Ctrl-key down.)

You can specify devices or device groups in the Device Groups constraint.
The Logger constraint category is displayed only if Loggers are configured on your Logger.

If multiple values are selected for a constraint, those values are OR’ed together. For example, if you
specify Device Group A, B, C, the query will find events in Device Group A, B, or C.

8. Click Go.
The query is automatically displayed in the Search text box and is ready to be run.
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OR

Click the B icon to save the query (referred as Saved Filter or a Saved Search) for a later use. For
more information about saving queries, see "Saving Queries (Creating Saved Searches and Saved
Filters)" on page 129.

Nested Conditions

You can create search queries with nested conditions in Search Builder. To do so, click the operator
under which you want to nest the next condition and add the condition as described in "Accessing the
Advanced Search Builder" on page 90.

Advanced Search
rer @l B x L@

& 11 1= o]

= {} Current Filter
= IlOR

= & AND
@ deviceVendor = Microsoft
@ deviceProduct = Microsoft Windows

= & AND
@ deviceVendor = SaberNet
@ deviceProduct = NT syslog

Name - Operator Condition
deviceProduct = Microsoft Windows i
deviceProduct = MNT syslog |:

deviceReceiptTime

Pipeline -7

Device Groups &

Storage Groups &

To add a nested condition:

1. Select the new operator from the icons above the query.
2. Select a condition from the menu below the query.

3. Add an operator and a supported condition for the query, for example deviceProduct =
Microsoft.

4. Click Go!
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Alternate Views for Query Building in Search Builder

By default, a tree view representation of the conditions is displayed, as shown in the previous figures in
this section. You can change the view to a color-block scheme and the location where the fields you
select are displayed. They can in the lower part of the screen or to the right of where conditions are
displayed.

To change views:
Click Display in the Search Builder tool and select the view of your choice.

Advanced Search
FLTER @ B x 51 @

- W Display~ | Name « Operator Condition

E Tree View agentAddress
m Tree View agentHostName
rh“"TE’” =port | 3 Color Block View  (2gentNtDomain

Current Filter

fmn| »

’7 LhuIITexf= link agentType
AND agentZone
L |—~1uIITexr= "up” agentZoneMName
IOR agentZoneResource
LhuIITexr = "down" agentZonelURI
applicationProtocol
baseEventCount
bytesin
bytesOut
categoryBehavior -

Pipeline 2]

Device Groups V4

Storage Groups &

Search Analyzer

A query’s performance is dependent on many factors such as load on the system, size of data to be
searched, indexed or non-indexed fields included in the query, the complexity of a query (a large
number of conditions, wildcard characters, nesting), and so on.

The Search Analyzer tool analyzes a query to determine if any of the fields included in the query are
non-indexed for the time range specified and thus affect the query’s performance.

HPE Logger 6.3 Page 94 of 623



Administrator's Guide
Chapter 3: Searching and Analyzing Events

You can run this tool as needed; for example, if a query runs slower than expected. You can use Search

Analyzer on a query after you have run it or while building a query using the Search Builder. Click R fo
access the Search Analyzer tool.

B x| v AlFelds B Last 2 hours B

deviceVendor 1= ight” | where deviceEventClassld is not null

»1,000,000 events (5

0w

8,000

6,000

4,000 Results

2,000 Info The field [deviceVendor] is indexed on all host(s)

4]
12:48:13 13:36:13
More than 1,000,000 s e displayed.
2| [ Logger deviceE
4 L 3

Sel { Fields (5) Larstusahpcom Local [1:648]
B deviceEventClassld 42
e Performance Optimizations for Indexed Fields in Queries ... . ... 95

Performance Optimizations for Indexed Fields in Queries

Even though a search query includes indexed fields, you might not realize the performance gain you
expect in these situations:

e When you include indexed and non-indexed fields in a query. Therefore, HPE recommends that you
identify the fields that you will most commonly use in queries and index all those fields. See
"Understanding Search Field Colors" on page 68 to help you identify indexed and non-indexed fields
within your query.

o When you include fields that are not super-indexed or field operators other than = in a needle-in-a-
haystack search, your search speed may not see the expected performance increase for super-
indexed fields. For fastest results when searching for rare values, be sure to follow the
recommendations in "Searching for Rare Field Values" on page 109.

o When you perform search on data in a tfime range in which a currently indexed field (included in the
query) was non-indexed.

For example, you index the “port” field on August 13th at 2200 PM You run a search on August 14th
at 1:00 PM to find events that include port 80 and occurred between August 11th and August 12th.
The “port” field was not indexed between August 11th and the 12th; therefore, the query runs slower.

e When you include a field in your search query that Logger is in the process of indexing. Therefore,
allow some time between adding a field to the index and using it in a search query.
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e When a query that includes indexed field is performed on archived events, the query runs slower than
when the data was not archived. This occurs because the index data on Logger is not archived with
events. To improve the search speed of archived events, you can index them. For more information,
see "Indexing Archived Events" on page 359

Regex Helper Tool

The Regex Helper tool =l enables you fo create regular expressions that can be used with the rex
pipeline operator to extract fields of interest from an event. (For information about rex, see "Search
Operator Portion of a Query" on page 76 or "Using the Rex Operator" on page 511.) This tool not only
simplifies the task of creating regular expressions for the rex operator but also makes it efficient and
error free.

The tool, which is only available for non-CEF events (unstructured data), parses raw syslog events into
fields and displays them as a list. You select the fields that you wanft to include in the rex expression of
a query. The selected fields are automatically inserted in a search query as a rex expression.

To use the tool, you need to perform the following steps:

Note: These steps are also depicted in the figure that follows the steps.

1. Enter a search query that finds events of interest to you. (For information about running a search,
see "Searching for Events" on page 102.)

2. ldentify a syslog event that you want to analyze further. For example, in the shown figure, event
#7 is the event we will analyze further.

3. Click the ¥ icon (in the left-most column) for the identified event fo expand it and display its raw
event.

4. Click the B! icon (next to the word RAW) to launch the Regex Helper tool.

5. Select the fields that you want to extract.
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6. Click OK.
B K DV Alfds [[] | estzinows [3]
_deviceGroup in ["Logger Infernal Event Device [Apache URL Access Error Laeg]"] Gal

2 events (Scanned: 34,995 events, 00:01.201) El

S Time (Event Time) Device Logger Date

Selected Fields (8) 21 2016/07/18 13:27:04 PDT Logger Internal Event Device Local 18/Jul/20146:13:26:41 -0700
[Apache URL Access Error Logl

RAW E 16.103.210.196 - - [18/ul/2016:13:26:41 -0700] "GET ffaviconico HTTF/1.1" 404 209

Date 1
HTTPVersion 1

ke RawEvent  [16/105:210:396 -- [ ISHUIBOTGHSIEMRMEON0N 1 G aviconics HTTF/LL 404 209
Method 1
RetumCoce + Regex (iPAddress NGRS v 1150 overd 2 « (TR B NGNS GG
SourceHost 1 “(?«Word_3 »\5+) (2<FileName_1+\5+) (?<Word_#>\5+)" (?<Number_l1>\d+) (?<Number_2>\d+)
URL 1
parser 1

[ Field Name Value

IPAddress 1 16.103.210.196

O word 1

[F1 word_2 -

TimeStamp_1 18/Julf2014:13:26:41 -0700

O word_3 GET

] FileName_1 J[favicon.ico

[ word_4 HTTR/11

I’ Number 1 404

O Mumber_2 209

The rex expressions pertaining to the selected fields are automatically entered in the Search query box.
In this example we want to extract the IP addresses from events. Therefore, the IPAddress_1field is
selected in the Regex Helper tool. (The Regex Helper tool assigns incremental labels if a data type
appears more than once in an event. For example, IP addresses are assigned IPAddress_1, IPAddress_2,
IPAddress_3, and so on labels.)

Once the IP address is selected and you click OK, the rex expression that includes the regular
expression for those IP addresses is displayed in the Search text box, as shown in the following
example.

_deviceGroup in ["Logger Internal Event Device [Apache URL Access Error
Log]"] | rex "(?<IPAddress_1>\d+\.\d+\.\d+\.\d+) \S+ \S+ \[(?<TimeStamp_
I>\d+/\S+/\d+:\d+:\d+:\d+ \S+)\.*"

From this point, you can include additional pipeline operators in this query to create charts, identify the
top five IP addresses, and so on. In the following example, the above query is modified to identify the
top IP addresses.

_deviceGroup in ["Logger Internal Event Device [Apache URL Access Error
Log]"] | rex "(?<IPAddress_1>\d+\.\d+\.\d+\.\d+) \S+ \S+ \[(?<TimeStamp_
1>\d+/\S+/\d+:\d+:\d+:\d+ \S+)\.*" | top IPAddress_1
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Search Helper

i B %X 4 v AlFields B Last 10 minutes B
logger | |
| cef Operator  * Examples Help 7
| chart Operator error alert The Indexed search uses Logger's indexing capability to
| dedup Operator message CONTAINS "Between" quickly and efficiently search for relevant data, and enables
| eval Operator (name="John Doe" OR name="Jane Doe") AND you to specify kmrd& indexed, and non-indexed fields in
_ . a boolean expression.
| extract Operator messagel="success
more »
| fields Operator
| head [prm— Suggested Mext Search Operators
| keys Operator cef, rex, exfract, regex
| lookup Operator
| parse Operator
| rare Operator
| regex Operator
| rename Operator |_|
| replace Operator Auto-open is ON
| rex Cperator
| sort Operator

1=l Cinarator

Search Helper is a search-specific utility that automatically displays relevant information based on the
query currently entered in the Search text box.

Search Helper is available by default; if you do not want the Search Helper to display information
automatically, click the “Auto-open is ON” link (in the Search Helper window). The link toggles to

“Auto-open is OFF”. To access Search Helper once it has been turned off, click the down-arrow button
to the right of the Search text box.

Search Helper displays auto-complete search functionality, a search history, a search operator history, a
link to the help system, and suggested next operators.

o Autocomplete SearCh ... 98
e Opening Filters and Saved Searches via Autocomplete ... .. 100
e Search History and Search Operator History ... . e 101
e Examples, Usage, Suggested Next Operators,and Help ... ... 102

Autocomplete Search

The autocomplete functionality provides full-text keywords and field suggestions based on the text
currently entered in the Search box. The suggestions enable you to select keywords, fields, field values,
search operators, or metadata terms from a list instead of typing them in, thus enabling you to build a
query expression more quickly.
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When you start typing, the suggestion list displays many types of entries, as displayed in the following
image.

A X % v AlFelds

4

S
agentAddress Field
agentHostName Field

[ agentSeverity Field

I agentType Field
all 2,258
and Operator |_
apache 2968 1

M applicationProtocol Field
arcsight 44,909
audit 913
ausmreceiver2 a72
ausmreceivers 870 | |
ausmreceivers 863
ausmreceivers 862
auto 4,350

If the entered text is contained in both full-text keywords and schema fields, all of them are displayed in
the suggested list.

If you type “|” (the pipeline character), the list of operators available on Logger are displayed.

The full-text keyword suggestions are obtained from the full-text keywords that are already indexed on
your Logger.

If the Logger schema field is indexed, superindexed, or able to be indexed, an icon matching its index
state displays to the left of the field name. See "Understanding Search Field Colors" on page 68 for more
information.

Note: System-defined fields are not available as fields in the auto-complete . For more information
about system-defined fields and Logger searches, see "Things You Should Know About Logger
Searches" on page 106 and "Additional Fields in the Search Results" on page 116.

The full-text keywords and field values display a count next to each suggestion that indicates the
number of the instances of the keyword or field value stored on Logger.

The count represents the number of values stored for a field. The count is dependent on many factors
and may not be exact. It does not indicate how many events might match the query. Many factors
determine the number of event matches, including the time range, search constraints, and search
operators for the query.
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Note: The autocomplete suggestions and counts are based on data stored on the local system
only. Counts are reset when the Logger restarts. Peer data is not included.

Search Group filters (that restrict privileges on storage and device groups) are not enforced on the
autocomplete list. Therefore, the list includes keywords, fields, field values, and counts of events in
storage and device groups to which a user might not have privileges.

When an archive is loaded back on Logger, the autocomplete list does not include the full-text keywords
or field values that were available before the events were archived. This happens because summary data
is not archived along with the event data. Therefore, when the event data is loaded back from an
archive, the archive datais not included in the summary.

Opening Filters and Saved Searches via Autocomplete

Logger 6.0 adds the autocomplete constants $filter$ and $ss$ to enable you to open Filters and
Saved Searches directly from the search box.

If you type $Filter$ in the search box, the available Filters show up in the autocomplete. (Filters
include only the query.) You can click a suggestion to select it or continue typing the filter name to
narrow down the options. Once you select a filter from the autocomplete, Logger replaces the search
box contents with the Filter definition.

w B X L OV AlFelds B Last 24 hours B

Stilteds
SfilterSConfiguration - Configuration Changes (Unified) Examples Help (7

(CEEZI::;:;O““QUMT[D” - System Configuration Changes error alert Th_e Indexed seard1 Rl e T

message CONTAINS "Between” quickly and efficiently search for relevant dafa, and enables

SfilterSEvents - CEF (name="John Doe" OR name="Jane Doe") AND you to specify keywqrds, indexed, and non-indexed fields
SfilterSEvents - Event Counts by Destination messagel="success" in a boolean expression.
Sfilter3Events - Event Counts by Source more »
SfilterSEvents - High and Very High Severity CEF Events E Suggested Next Search Operators
SfilterSEvents - High and Wery High Severity Events cef, rex, extract, regex

(Unified)
SfilterSFirewall - Deny
SfiltersFirewall - Drop
SfilterSFirewall - Permit

SfilterSintrusion - Malicious Code (CEF format) —

SfilterSintrusion - Malicious Code (Unified)

Sfilter$Logins - All Logins (CEF format) BUICSOPSIEION

SfilferSLogins - All Logins (Mon-CEF format)
SfilferSLogins - All Logins (Unified)

If you type $ss$ in the search box, the available Saved Searches show up in the autocomplete. (Saved
searches include the query, the start date/time, the end date/time, local only, and so on.) You can click a
suggestion to select it or continue typing the saved search name to narrow down the options. Once you
select a saved search from the autocomplete, Logger replaces the search box contents with the Saved
Search definition.
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To use an autocomplete suggestion:

1. From the search autocomplete list, click the suggestion to move it up to the search box.

2. Click Go! to run that search, or continue typing to narrow your search further.

Search History and Search Operator History

The Search History displays recently run queries that match the currently entered search. Click a recent
query to run it again. To see the search history, start typing a search or click the down-arrow next to the

Go! button.

m Ak i Oy Alfieds IZ| Last 2 minutes IZ|

enter search query...

[ »

Search History

{ (deviceVendor = "Microsoft™ AND deviceProduct = "Microsoft Windows" ) OR { deviceVendor = "SaberNet™ AND deviceProduct = "NT syslog” ) OR ( deviceVendor = "In...
categoryBehavior = "/Authentication/Verify" AND categoryOutcome = "/Failure® AND NOT (deviceProduct IS NULL) | top deviceProduct

categoryBehavior ="fAuthentication/Verify" AND categoryOutcome = "/Failure™ AND NOT (destinationUserMame IS NULL} | top destinationUserName

categoryBehavior ="fAuthentication/Verify" AND NOT (destinationUserName IS NULL) AND ssh | chart count as "Count” by destinationUserName sourceAddress source...
categoryDeviceGroup = "/VPN" AND categoryBehavior = "fAuthentication/Verify” AND categoryOutcome = "/Success” AND NOT (destinationUserName IS NULL) | chart c...
deviceVlendor = "Microsoft” AND (deviceEventClassld = "Microsoft-Windows-Security-Auditing:47 20" OR deviceEventClassld ="Security:6247) | chart count as "Count” by ...
categoryBehavior ="/Modify/Configuration® AND categoryOutcome ="/Success" | top deviceProduct | rename _count as "Changes” | rename deviceProduct as "Product”
categoryDeviceGroup = "/Firewall" AND categoryObject STARTSWITH "/Host/Application/Service" AND (categoryBehavior STARTSWITH "/Access™ OR categoryBehavior...
categoryObject STARTSWITH "/Vector” OR categoryObject STARTSWITH */Host/Infection” OR categoryObject STARTSWITH "/Host/Application/Malware” OR categor...
deviceEventClassld = "eps: 103" AND deviceCustomNumber2 > 0| chart sum{deviceCustomNumber2) as "Events" by deviceCustomStringé | rename deviceCustomStri...
deviceEventClassid = "eps: 103" AND deviceCustomNumber2 > 0 | chart sum{deviceCustomNumber2) as “Events” by deviceCustomNumber2Label | rename deviceCus...
deviceEventClassld = "eps:102" AND deviceCustomNumber2 > 0| chart sum({deviceCustomNumber2) as “Events” by deviceCustomNumber2Label | rename deviceCus...
deviceEventClassld = "eps: 102" AND deviceCustomNumber2 = 0| chart sum{deviceCustomNumber2) as "Events" by deviceCustomString® | rename deviceCustomStri...
_peerLogger IN [*127.0.0.1%, "n15-214-132-h191.arst.usa.hp.com"]

deviceVendor CONTAINS "Coat" _peerLogger IN["127.0.0.1","15.214.128.1187]

deviceVendor CONTAINS Coat

_peerLogger IN [*127.0.0.1%, "15.214.128.118"] deviceVendor CONTAINS Coat

_peerLogger IN [*127.0.0.17, "15.214.128.118"] deviceVendor CONTAINS C
... nparlnamar IM [*127 001" ™E 214 128 1181 -

m

The Search Operator History displays the fields used previously with the search operator that is
currently typed in the Search text box. The Search Operator History only displays if you have previously
used the operator you have currently typed to perform searches on this system. Click the operator to
add it to your search.

WA X 4: v AlFields B Last 24 hours B

Logger | where deviceEventClassld is not nuII|

Search History
Logger | where deviceEventClassid is not null | top deviceEventClassid

Search Operator History Help 7
.. | where deviceEventClassid is not null Display events that match the criteria specified in the where expression.
Exampl
[ Usage
.. |'where eventid is NULL .| where <expression=

-. | where eventid=10006093313 OR deviceVersion CONTAINS "4.0.6.4924.1"

. <expression= can be any valid field-based query expression, as described in Indexed and
-. | where eventld >=10005985569 OR categories="/Agent/Started"

Mon-Indexed Fields.
more »

Next Search O

chart, sort

Auto-open is ON
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Examples, Usage, Suggested Next Operators, and Help

The Examples section lists examples relevant to the latest query operator you have typed in the Search
fext box.

The Usage section provides the syntax for the search operator.

The Suggested Next Operators section provides a list of operators that generally follow the currently
typed query. For example, if you type logger |, the operators that often follow are rex, extract, or

regex. You can select one of the listed operators to automatically append to the currently typed query
in the Search text box. This list saves you from guessing the next possible operators and manually
typing themin.

The Help section provides context-sensitive help for the last-listed operator in the query that is
currently typed in the Search text box. Additionally, if you click the £ icon, Logger online Help launches.

Searching for Events

The topics in this section explain how to search for events on Logger.

® RUNNING @ S@aICN L 103
e Things You Should Know About Logger Searches ... .. . 106
e Searching Peers (Distributed Search) ... .. 107
e Tuning Search Performance .. ... . 108
e Searching for Rare Field Values . ... 109

Permissions and Prerequisites
Enable the following User Group permissions for Logger search users:

o Default Logger Search Group > Search > Search for events (local searches only)
o Default Logger Search Group > Search > Search for events on remote peers (for distributed searches)
o Default Logger Rights > Peers > View registered peers (to see peers)

Other permissions may also apply. See "Setting Logger User Permissions" on page 458 for information.
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Running a Search

You can use the options displayed on the search page to help create and run your search query.

W
B X L v Alfeds E Last 10 minufes E o o @

( ( deviceVendor = "Microsoft” AND deviceProduct = "Microsoft Windows" ) OR ( deviceVendor = "SaberNet'

Gal Advanced
'Ini@cfﬁlliance‘ AND deviceProduct = "Snare™ ) ) v e

©

12,374 events (Scanned: 245,899,013 events, 01:26.271) ¥

Search Bar Legend

Option Description Option Description

Load saved search or filter o Set time range

Save query o Open search history

Clear query o Start or cancel search

Open Search Analyzer @ Open Advanced Search Builder

Update search options @ Enter query

Q00000

Select fieldset e Export search results

In addition to the options displayed on the search page, search options enable you to tune search
operations to suit your environment. Those options are discussed in "Search Opfions" on page 277.

Note: You cannot run concurrent searches in the same browser window. If you need to run more
than one search at a time, use two different browsers or a browser with a plug-in that allows you to

open different sessions.

To search for events on Logger:

1. Open the Analyze menu and click Search.
2. Click the down-arrow to view and adjust the search options. Use the default values or change them
suit your needs:
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wm A X i {3V AlFeds B

_,5'-,;: Local Onby
Field Summary
[T Discover Fields

[C] Auto refresh (5 min) |E|
Sort  Mewest event first |Z|

e Local Only: This option is only displayed when peers have been configured for your system.
Local Only is checked by default. If you want to include peers in your search, uncheck the Local
Only checkbox. If you do not see this checkbox, no peers have been configured on your Logger.
See "Searching Peers (Distributed Search)" on page 107 for more information.

o Field Summary: Lists the selected CEF fields in the displayed events. By default, the selected
fields include: deviceEventClassld, deviceProduct, deviceVendor, deviceVersion, and name; you
can edit this list to suit your needs. Selecting this option enables the Discover Fields option. See
"The Field Summary Panel" on page 121 for more information about the Field Summary and
Discover Fields options.

o Discover Fields: Lists the non-CEF fields discovered in raw events. This option is only taken into
consideration when Field Summary has been selected.

o Auto Refresh: By default, the search results are not refreshed. Select this option to have the
Search results auto refresh. You can select from the following refresh intervals: 30 seconds, 60
seconds, 2 minutes, 5 minutes, or 15 minutes.

e Sort : Select Oldest Event First or Newest Event First, depending on how you want the search
results to display.

3. Fieldset: By default, all fields (All Fields) are displayed in the search results. However, you can
select another predefined field set or specify a customized field set. See "Fieldsets" on page 79 for
more information.

B x5 v | AlFeds B

4. Time Range: By default, the query is run on the data received in the last ten minutes. Click the
drop-down list to select another predefined fime range or specify a custom fime range. See "Time
Range" on page 76 for more information.

B X AL v | AlFields [=|| tastiominutes [+]

5. Specify a query expression in the Search text box using one or more of the following methods.
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Note: Refer to "Keyword Search (Full-text Search)" on page 70, "Field-Based Search" on
page 71, and "Searching for Rare Field Values" on page 109 for instructions, exceptions, and
invalid characters before you create a query expression.

a. Type the query expression in the Search text box. For information about building a query
expression, including lists of applicable operators, see "Elements of a Search Query" on page 69.

b. When you type a query, Logger’s Search Helper enables you to quickly build a query expression
by automatically providing suggestions, possible matches, and applicable operators. See "Search
Helper" on page 98 for more information.

¢. Use these guidelines to include various elements in a search query:
o Foracomplete list of fields in Logger schema, see "Field-Based Indexing" on page 139.
o Metadataterms (_storageGroup, _deviceGroup, _peerLogger)

Type “_s” (for storage group), “_d” (for device group), or “_p” (for Logger) in the Search text
box to obtain a drop-down list of constraint terms and operators.

o Regular expression term (| REGEX=)

Note: If your query expression includes multiple device groups and storage groups to
which search should be constrained, make sure that the group names are enclosed in a

square bracket; for example, _storageGroup IN [“SGA”, “SGB”].

¢ Click Advanced to use the Search Builder tool. (See "Using the Advanced Search Builder" on
page 90 for more information.) Also, use this option to specify device groups, storage
groups, and Loggers to which search should be limited.

d. Click the ™ jcon to load a saved filter, a system filter, or a saved search. Select the filter or the
saved search from the displayed list and click Load+Close.
For more information, see "Saving Queries (Creating Saved Searches and Saved Filters)" on
page 129 and "System Filters/Predefined Filters" on page 131.
6. Click Go.

The search results are displayed in the bottom section of same screen in which you ran the search.
For more information about how search results are displayed and various controls available within
the user interface to use those results, see "The Search Results Display" on page 112.

You can also save the search you ran as a saved filter or saved search. Click the B icon to do so.
For more information about a saved filter or a saved search, see "Saving Queries (Creating Saved
Searches and Saved Filters)" on page 129.

HPE Logger 6.3 Page 105 of 623



Administrator's Guide
Chapter 3: Searching and Analyzing Events

Things You Should Know About Logger Searches

Take the following points into consideration when writing search queries.

o Valuesin the system-defined fields, which include Time, Device, Logger, parser, source, and
sourceType, cannot be searched by either keyword or field based searches. These fields are system-
defined and do not exist in the raw event text. Therefore, searching for data in these fields returns no
result.

While the parser field includes only the name of the parser and is not searchable, the parser defines
fields based on its associated source type, and those fields are searchable. See "Additional Fields in
the Search Results" on page 116 for more information.

Note: Fields that are not searchable are not highlighted by mousing over them in the search
results and are not marked as fields in the auto-complete search. See "Refining a Search from the

Search Results Table" on page 117 and "Autocomplete Search" on page 98 for more information.

o Null values are not included in the Search results. For example, when performing a search on event
datasuch asNOT deviceCustomStringl=bar, the search returns results that match
deviceCustomString1 not equal to "bar", but does not return events where the deviceCustomString1
value is NULL. You must explicitly call out NULL values with <field> IS NOT NULL or<field>
IS NULL.

Note: Logger can be configured to make NOT search conditions include NULL values, by setting

the search option Include NULL field value in NOT operator results to yes. For more
information, see "Search Options" on page 277.

o Data contained within a string that has already been fokenized cannot be searched. Searchable
keywords are determined by the set of delimiters used to parse the raw text string into searchable
units called tokens. These delimiters are controlled on the Configuration > Search Options page.

o Logger includes the following primary delimiters for use during full-text (keyword) search: space,
tab, newline, comma, semi-colon, (), [,1,{, }. ", |, and *. If only these primary delimiters are set to yes
on the Configuration > Search Options screen and the raw event contains a string like this:
dmz:10.9.9.9/20, then that entire string would be a single, searchable keyword.

© The Configuration > Search Options screen also enables you to use secondary delimiters when
searching. If the secondary delimiters are also set to yes, the following list of delimiters would

further tokenize the string: =,.,:, /,\, @, -, ?, #, & _, >, and <. As a result, if the raw event contains
the string: dmz:10.9.9.9/20, then the searchable keywords for this event, will be dmz, 10, 9, and
20.

See "Search Options" on page 277 for more information on setting primary and secondary
delimiters.
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Searching Peers (Distributed Search)

When you run a search query, by default, only your local Logger is searched for matching events.
However, when specifying a query, you can select an option to run the search on the peer Loggers.

A user needs to belong to these user groups with the listed permissions set to perform peer searches
and view their search results:

o Logger Search Group with “Search for events on remote peers” user right set (checked).

o Logger Rights Group with the “View registered peers” user rights set (checked).

Follow these guidelines for searching across peers:

o Specify the peer Loggers to search, as described in "Constraints" on page 84.
o Logger supports searching up to 100 peers in the same search.

o For best search performance and functionality, all peers must be on the latest version of Logger.
Searches across peers are limited by the ability of the earliest version peer.

o If an operator does not exist on a peer version, the query will not run on that peer.

o Peers on earlier version will have the performance of that version, so search result for those peers
will be returned more slowly.

o For best performance of non-pipeline searches, do not include the regex, rex, parse, keys,
transaction, extract, or lookup search operatorsin the query.

o If the peer Loggers do not have the same storage or device group names, a search query operation
skips searching for events for those groups on those peers.

o If there are custom schema fields in your Logger schema, those fields must exist on all peers. A search
query containing those fields will not run across peers, and will return an error. See "Adding Fields to
the Schema" on page 377.

e« When a Logger becomes unavailable during a search operation, error messages are displayed. The
displayed message varies depending on the error detected. This is most likely because there is a
problem with the network or the peer is down. In some cases it may be because there is an issue with
the peering relationship. The error messages may still display for the search that was in progress even
after the problem is fixed. However, you can ignore such messages if they go away when you run a
new distributed search. For more information about peers, see "Peer Nodes" on page 397.

¢ Using search heads enables faster peer searches for searches that use search operators, particularly
aggregation operators, such as chart, sort, fop. For best search performance when writing queries to
be executed on a search head, specify all peers to be searched in the query and exclude the local
Logger. See "Setting up Search Heads for Faster Peer Searches" on page 30.

Note: Peer search speed improvements gained by using search heads apply only to searches run
through the user interface. Using search heads does not improve the speed of scheduled
searches or searches run though Logger Web Services.
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Example queries for searching across peers:
Search that sorts five fields:

_peerLogger IN [“peerl”, “peer2”, ..] | sort deviceEventCategory eventId
deviceCustomNumberl deviceCustomNumber2 deviceCustomNumber3

Search with field extraction:
_peerLogger IN [“peerl”, “peer2”, ..] | rex "(?<src_ip>\d{1,3}\.\d{1,3}\.\d
{1,3}\.\d{1,3}H)"

Search evaluating a variable:

_peerLogger IN [“peerl”, “peer2”, ..] | eval (int)urllength=len(requestuUrl)
| sort urllength

Search with results grouped and counted as a top 50 list:

_peerLogger IN [“peerl”, “peer2”, ..] | and priority > @ | top 50 name

Search for events with along URL:

_peerLogger IN [“peerl”, “peer2”, ..] | eval n=len(requestUrl) | where n =
n 1@23"

Tuning Search Performance

Search performance depends on many factors and will vary from query to query. Some of factors that
can affect search performance are listed below. To optimize search performance, ensure that you follow
these recommendations:

o When searching for uncommon field values, use superindexing to narrow the range of data that
needs to be searched, as described in "Searching for Rare Field Values" on the next page.

o Enable field-based indexing for all fields that occur in your events. When events are indexed, Logger
can quickly and efficiently search for relevant data. By default, a recommended set of fields are
indexed on your Logger; you might need to add additional fields, as described in "To add fields to the
field-based index:" on page 275.

o Avoid specifying a time range that results in a query that needs to scan multi-millions of events.
o Limit the search to specific storage groups and peers.

¢ Reduce other load on the system when your query needs to run, such as scheduled jobs, large
number of incoming events, and multiple reports being run.

¢ Before running a query, make sure all Loggers on which it will run support the query features.

For more information on improving search performance, refer to the Logger Configuration and Tuning:
Best Practices guide.
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Searching for Rare Field Values

To enable you to quickly search common IP address, host name, and user name fields for rare field
values; Logger creates superindexes on new data as it comes in. Searches written to take advantage of
super-indexed fields will tell you very quickly if there are no hits and will return results more quickly than
regular searches when there are very few hits. Therefore, they are excellent for fast needle-in-a-
haystack searches. For more information, see " Superindexing" on page 141.

Note: Since superindexes are built on new data as it comes in, they only apply to data collected by
Logger 5.5 or later. Any data brought forward from an upgrade from an earlier version of Logger

will not be superindexed and will not exhibit this search speed improvement.

Using Super-Indexed Fields to Increase Search Speed

To take advantage of superindexing and get the fastest search results, run an equal to (=) search, such
as sourceAddress=192.0.2.0, and write the indexed search portion of your query to find
uncommon values in the super-indexed fields listed in the table below.

Super-indexed Fields

deviceEventClassld deviceProduct deviceVendor destinationHostName
destinationPort destinationAddress destinationUserld destinationUserName
deviceAddress deviceHostName sourceHostName  sourcePort
sourceAddress sourceUserld sourceUserName

Note: Unlike the indexed fields discussed in "Field-Based Indexing" on page 139, you cannot add to
the list of super-indexed fields.

Search on super-indexed fields only using the = operator, and only AND with non-super-indexed fields
for fastest search performance. Superindexes speed up searches that use the equal to (=) operator in
the indexed search portion of the query expression. They have no performance impact on searches that
use greater than (>), less than (<), not equal to (!=), or other operators in the indexed search portion of
the query. While Logger supports full-text search, search on fields that are not super-indexed, and
searches that use operators such as >, less than <, !=, and so on; such searches may not provide the
greatest search speed.

Using AND and OR with the = operator can be very powerful when searching super-indexed fields.
However, to obtain the greatest search speed improvement, you must use them carefully. The table
below provides examples to help you understand how to write queries that take advantage of the
power of superindexing.

Note: To see the faster search results, all fields you use in your query must be indexed.
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Query Examples for Superindexing in Needle-in-a-Haystack Searches

Query
arcsight

(full text)

192.0.2.0

(full text that looks like a super-
indexed field)

sourceAddress = 192.0.2.0

(= on a super-indexed field)

sourceAddress = 192.0.2.0 OR
sourceAddress = 192.0.2.2

(= using OR on super-indexed fields)

sourceAddress = 192.0.2.0 AND
destinationAddress = 192.0.2.2

(= using AND on super-indexed
fields)

sourceAddress !=192.0.2.0

(= on a super-indexed field)
sourceAddress !=192.0.2.0 OR

destinationAddress= 192.0.2.2

(!= using OR on Super-indexed fields)

HPE Logger 6.3

Does It Improve Search Speed?
No difference.

This is a full text query, and so does not take advantage of super-indexed
field-search speed improvements.

No difference.

While this could be an IP address, it is a full text search, not an = search against
one of the super-indexed fields, and so does not take advantage of super-
indexed field-search speed improvements.

The search speed is improved and the results return very quickly when there
are no hits.

If Logger has not encountered 192.0.2.0 as a sourceAddress, it quickly returns
the message "No results were found". If it has encountered that sourceAddress,
the range of events o be searched is narrowed down.

The search speed is improved and the results return very quickly when there
are no hits.

If Logger has not encountered 192.0.2.0 or 192.0.2.2 as a sourceAddress, it
quickly returns the message "No results were found". If it has encountered one
or the other, the range of events to be searched is narrowed down.

The search speed is improved and the results return very quickly when there
are no hits.

If Logger has not encountered 192.0.2.0 as a sourceAddress, it quickly returns
the message "No results were found".

Similarly, if Logger has not encountered 192.0.2.2 as a destinationAddress, it
quickly returns the message "No results were found", even if it has encountered
192.0.2.0 as a sourceAddress.

If Logger has encountered both, the range of events to be searched is
narrowed down.

No difference.

Superindexing does not help with negations, so this query does not take
advantage of super-indexed field-search speed improvements.

No difference.

Since there is a negation on the sourceAddress and this is an OR condition, this
query does not take advantage of super-indexed field-search speed
improvements.
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Query Examples for Superindexing in Needle-in-a-Haystack Searches, continued

Query Does It Improve Search Speed?

sourceAddress !=192.0.2.0 AND The search speed is improved and the results return very quickly when there
destinationAddress = 192.0.2.2 are no hits.

(!=using AND on Super-indexed Since this is an AND condition, both conditions need to be true.

fields)

Even though there is a negation on the sourceAddress, if Logger has not
encountered a destinationAddress address of 192.0.2.2, this AND condition will
never be satisfied. In that case, it quickly returns the message "No results were
found".

If Logger has encountered that destinationAddress, the range of events to be
searched is narrowed down.

sourceAddress = 192.0.2.0 AND The search speed is improved and the results return very quickly when there
arcsight are no hits.

(= on super-indexed field AND full If Logger has not encountered a sourceAddress of 192.0.2.0, this AND condition
text) will never be satisfied. In that case, it quickly returns the message "No results

were found", even though there is a full text search.

If Logger has encountered that sourceAddress, the range of events to be
searched is narrowed down.

sourceAddress = 192.0.2.0 OR arcsight  No difference.

(= on super-indexed field OR full text) Regardless of whether Logger has encountered a sourceAddress of 192.0.2.0,
the OR condition requires a full text search for "arcsight", so this query does not
take advantage of super-indexed field-search speed improvements.
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Query Examples for Superindexing in Needle-in-a-Haystack Searches, continued

Query Does It Improve Search Speed?

name = "CPU Usage" AND The search speed is improved and the results return very quickly when there
sourceAddress = 192.0.2.0 are no hits.

(indexed field AND super-indexed Even though name is not one of the super-indexed fields, because the query
field) uses an AND condition, Logger quickly returns the message "No results were

found" if it has not encountered a sourceAddress of 192.0.2.0.

If Logger has encountered that sourceAddress, the range of events to be
searched is narrowed down.

name = "CPU Usage" OR No difference.

Add =192.0.2.0
souree ress Even though sourceAddress is one of the super-indexed fields, because it is in

(indexed field OR super-indexed an OR condition with name, which is not super-indexed, this query does not
field) take advantage of super-indexed field-search speed improvements.
sourceAddress = 192.0.2.0 AND Results return very quickly when there are no hits.

(sourceHostName = myhost.com OR
sourcePort = 80) AND
(destinationAddress = 192.0.2.2 OR
arcsight)

If Logger has not encountered a sourceAddress of 192.0.2.0, the top level AND
will never be true. It quickly returns the message "No results were found" in that
case.

If Logger has not encountered a sourceHostName of myhost.com AND it has
not encountered a sourcePort of 80, then the OR condition will never be true.
Thus the top level AND condition will never be frue. It quickly returns the
message "No results were found" in that case.

(super-indexed field AND (nested OR
condition) AND (nested OR
condition))

If Logger cannot show that the above conditions are false, then there will be
no difference in search speed.

Even though destinationAddress is one of the super-indexed fields, because it
is in an OR condition with a full-text search for "arcsight", the range of events
to be searched cannot be narrowed down.

The Search Results Display

After you have initiated a search, the search results are displayed in the bottom section of the same
screen in which you ran the search. A search operation can take time when millions of events need to be
searched. When the first screen of events that match the specified conditions is available, Logger
automatically pauses the search and displays the matched events.

Event data is categorized by field name and each field is displayed as a separate color-coded column.
For example, the time when an event was received on the Logger (Event Time) is displayed in a gray-
shaded column (Ml indicating metadata) and labeled Time (Event Time).

e Adjusting the Displayed Search Results ... il 13
e Canceling a Search in Progress ... . M4
o The HistOgram oo L 14
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Adjusting the Displayed Search Results

Search results are sorted by the Logger receipt time. The events are displayed either oldest first or
newest first, depending on what you selected when you ran the search. If you want to change the sort
order, you will need to rerun the search. To change the sort order, open the search options drop-down
and in the Sort field select Oldest event first or Newest event first.

W B X 5 3V AlFilds E|

enter search l:_,E”y'.- Local Cnby
Field Summary
[[] Discover Fields

[[] Auto refresh (5 min) |Z|
Sort  Mewest event first E

By default, 25 events are displayed on one screen. To change the number of events displayed per
screen, open the Events per Page pop-up menu, located at the bottom of the search results, and select
the number of events to display.

10
Disk bytes read 25 127.001
Metwork Usage - Qutbound 50 127001 =
1100 . k
Displaying 1 - 25 of 40632 | Events per page 25| | Page | 1 of 1626 p p|

Some searches may return many pages of results. To move from page to page in the search results, click
the appropriate arrow or type number of the page that you want to move to and then press Enter.
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[4 4 Page 3 of 1626 p p|

Each event is available in its raw form or parsed data. You can show or hide the raw event data from this
page. See "Viewing Raw Events" on page 118 for defails.

In addition to changing how the data is displayed, you can refine your search from the search results
display. See "Refining a Search from the Search Results Table" on page 117 for details.

Canceling a Search in Progress

While the search is in progress, the Go! button changes to Cancel—click Cancel to terminate the search
early. When a query is running, search results are displayed as matching events are found. Therefore,
when you click Cancel, any matching events found so far are displayed as the search results. This might
be helpful in cases when the query needs to scan a large data set, but the search results displayed so far
display the events you were looking for. You can further process the displayed (partial) results; for
example, export the results, use the histogram to drill down in the results, or click on any text in the
Search Results to add it to the query for further drill-down in the search results.

Note: If a query includes chart-able operators such as chart, rare, or top, and the query is
terminated early, a chart of the partial results is not displayed. Additionally, if a query includes the

head, tail, or sort operators, partial results are not generated.

The Histogram

The Search Results page displays a histogram that provides a graphical representation of the events
that match a search query. The histogram is based on the Logger receipt time of the events (similar to
search queries that also use the Logger receipt time to search for events).

The X-axis represents event time and Y-axis represents the number of matching events, as shown in the
following figure. The time distribution on the X-axis is determined automatically, based on the time
range specified in the query.

Note: The time range on the X-axis might not match the time range specified in the search query

because the start and end times on the X-axis are determined by the event times of the first and last
matching events of the search query.
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Histogram showing mouseover details

40,680 events (Scanned: 40,760 events, 00:01.428) ¥

1676 Events
Tr18/16 17-18:00 threugh 7/18/16 18-18:00

Mon 15:18:00 Mon 23:18:00
T/ Time (Event Time) Device Logger deviceVendor
Sel { Fields (5) 1 2014/07/19 15:15:39 PDT Logger Local ArcSight

Bl deviceEventClassld 14

B deviceProduct 1 2 2016/07/19 15:15:39 PDT Logger Local ArcSight

A histogram is progressively built and displayed as events match a search query. If the search query
needs to scan a large amount of data or a large time period, the histogram displayed initially might
refresh multiple tfimes while the query is running. To view the complete (and final) histogram of a search
query, wait until the query has finished running (that is, the screen does not display the circular
“waiting” icon anymore).

The first one million matching events are plotted on the histogram. If a search query matches more than
one million events, an informational message is displayed on the screen. If you need to use the
histogram view for event analysis for a search query that matches more than one million events,
ArcSight suggests that you adjust the time range specified in your search query so that than less than
one million are matched. This will allow you to obtain a complete and meaningful histogram. You can
also use a pipeline operator such as top, head, or chart to further refine search results so that the total
number of hits is under one million events.

Displaying the Histogram

You cannot disable the histogram; however, you can click the Histogram icon i] above the upper-right

corner of the histogram to hide it. To display a hidden histogram, click the i icon again.

Mouse-Over

You can mouse-over any histogram bar to highlight it and view the number of matching events and the
date and fime period that the bar represents. For example, in the last figure, the highlighted bar
represents 1,676 events from 5-6 p.m. on July 18th. The matching events listed below the histogram do
not change, and the histogram continues to display all matching events.

Histogram Drill Down

You can drill down to events in a specific time period by clicking the bar on the histogram that
represents that time period. The bar you drilled down to is highlighted and the events matching that
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time period are listed below the histogram. The histogram continues to display all of matching events, as
shown in the following figure.

40,544 events (Scanned: 40,764 events, 00:01.578) i’

1698 Events
T18/16 16:535:00 through 7/18/16 17-33:00

Maon 15:33:00 Mon 23:33:00

To deselect the time period, click the bar again. You can also select multiple consecutive bars on the
histogram to view matching events in all of the selected time units.

The Search Results Table

The search results table displays the number of events scanned, the number of events found, the index
status of each event type, and how long the search fook.

Below the histogram, events are shown in table form, one row per event. Terms that match your query
are highlighted to make it easy to see why an event matched the query. As you roll the mouse over
other terms in the evenfts table, they highlight in green.

You can drill down info the displayed search results by clicking a green-highlighted term to add it to the
current query. For example, if you search for “login” and roll over the word “fail” in the search results,
“fail” will highlight in green. Click the word “fail” to change the query to “login AND fail.”

Tip: You can also highlight and copy text from any displayed column. This feature is handy when
you need to copy an IP address or a URL. (Click and drag your curser over it to select the text.

Then, right-click to display the Copy option.)

By default, a Field Summary panel is displayed on the left side of the matched events. This section lists
the fields that occur in matching events and the number of unique values for each in those events. For
more information about Field Summary, see "The Field Summary Panel" on page 121.

Additional Fields in the Search Results

In addition to Logger's schema fields, you may see other types of fields in the Search results.
User-Defined Fields

User-defined fields are created when a search query includes operators such as rex, extract, and
rename. See "Search Operators" on page 471for information on these operators. These fields are
displayed as additional columns in the All Fields view (of the System Fieldsets). To view only these

columns, select User Defined Fieldsets from the System Fieldsets list.
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System-Defined Fields

When a search query matches events that were received from a defined source type and were parsed
using a pre-defined or user-defined parser, the search results include a parser field, and may include
fields for the source type, and source, depending on the setting in the Search Options page. For more
information, see "Search Options" on page 277.

System-defined fields contain no event data and are not searchable. See "Things You Should Know
About Logger Searches" on page 106 for more information.

Field

parser

source type

source

Description

Indicates whether or not an event was parsed, and if so, which parser was used.

Note: While the parser field itself is not searchable, the parser defines searchable fields
based on its associated source type. These fields vary based on the source type. For more
information, see "Parsers" on page 315.

If the event was parsed, this field contains the name of the parser. If the event was not parsed
successfully, this field contains “Not parsed”. If no parser is defined for the source type or if
there is no source type, the field is blank.

The type of file from which the event was received, as defined on the Source Type page
(Configuration | Data > Source Types). For more information, see "Source Types" on page 311.

If no source type was applied when the event was received, this field is blank. You can conftrol
whether this field is displayed from the Search Options page.

The name of the log file from which the event was received. For example,
/opt/mnt/testsoft/web_server.out.log.

If no source was applied when the event was received, this field is blank. You can control
whether this field is displayed from the Search Options page.

Refining a Search from the Search Results Table

Use these shortcuts to select terms from the displayed search result columns or the raw events to refine

your search query:

o Click atermin search results to add it to the search query, and rerun the search immediately.

e Flag the Enable Multi-select of field values checkbox (] Enable Multi-select of field values.) and then
click multiple terms to add to the search query. When multiple terms are added, they are joined by

AND operators. Click Go! to run the search.

o Cirl+click to replace the entire search query with <field name> + "CONTAINS" + <selected term>, and
rerun the search immediately.
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Alt or Shift + click the term in search results to add NOT to the term, and rerun the query, thus
eliminating the events that match the term you selected.

Add multiple NOT conditions by holding the Alt key and selecting terms in search results. When
multiple conditions are added, they are joined by AND operators. If Enable Multi-select of field

values is checked, click Go! to run the search. If it is not checked, the search runs when you click the
term.

Combine Ctrl1+Alt, (or Ctr1+Shift) to replace the search query with
NOT + <field name> + "CONTAINS" + <selected term>.

Note: Fields that are not searchable are not highlighted by mousing over them in the search
results and cannot be clicked on to add fo the search. For more information about what is

searchable, see "Things You Should Know About Logger Searches" on page 106, and "Additional
Fields in the Search Results" on page 116.

Viewing Raw Events

Each event is available in its raw form or parsed data. By default, the parsed data is displayed.

To view raw data for a single event, click the [Tlicon to the left of the event.

To view raw data for all displayed events, click Show Raw () af the bottom of the screen.

You can also view the Syslog raw events in a formatted column called rawEvent if you have enabled the
“Populate rawEvent field for syslog events” option on the Search Options page, as discussed in "Search
Options" on page 277. See "Predefined Fieldsets" on page 79 to learn more about displaying raw events.

Changing the Displayed Search Results Using Field Sets

By default, the Search Results are displayed using the All Fields field set, which displays all fields
contained in an event. Once you select another field set, it becomes your default view until you change it
the next fime. For a detailed discussion about field sets, see "Fieldsets" on page 79.

If you view the Search Results using the Raw Event field set, remember these guidelines:

Even though the rawEvent column displays the raw event, this column is not added to the Logger
database and is not indexed. Therefore, you can only run a keyword (full-text) or regular expression
o search on the event.

You can use the Regex Helper tool to identify strings from the raw syslog events in the rawEvent
column that you want to add to a query. (You cannot use the Regex Helper for CEF events displayed
in the rawEvent column.) See "Regex Helper Tool" on page 96 for details about the Regex Helper
tool.
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Multi-line Data Display

An event field might span multiple lines separated by characters such as newline (\n) or carriage return
Q\n). For example,

OXx0000: 0000 0100 00O 0V VVOO 00O VOOV BOO ................
Ox0010: 0000 00VO 00O 0O VPOV 0O VOVO BROO ................
0x0020: 0000 0000 0VVO 00O VOO 0O VPO ..............

The Logger user interface displays these in multi-line format and does not remove the line separators
and collapse the message into one line.

Auto Refresh Search Results

The Auto refresh feature executes the search over specified intervals, updating the search results if new
events match the query. Set this option from the Search Options menu.

{¥v  AllFields

Field Summary

[] Discover Fields

Auto refresh (5 min) IEI £:51
Sort Mewest event first IEI

Depending on your needs, you can auto update the search results every:

e 30 seconds

e 60 seconds

e 2 minutes

o 5minutes (defaulf)
e 15 minutes

You can enable this option for a search operation before or after running it. Once you enable this
option, the setting persists for all search operations until you explicitly disable it.

To auto update search results:

1. Select Analyze > Search from the Navigation bar.

2. From the Search Options menu, check the Auto refresh box and select the refresh interval you
want.
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Chart Drill Down

Aggregated search operators such as chart, top, and rare generate charts of search results. The chart
drill down feature enables you to quickly filter down to events with specific field values. You identify the
value on a search results chart and click it to drill down to events that match the value. For example, in
the following chart, if you want o see events in which the device event class ID is eps 102, click the

column labeled eps:102 to display events shown in the second figure.

D@ Time (Event Time) Device  Logger | deviceVendor | dev

Selected Fields (5) 1 2016/07/19 16:47:53 PDT Logger  Local ArcSight Logy
I B deviceBventClassld 16 [b B deviceEventClassld (16) %

B deviceProduct 1
Display events containing deviceBventClassid

B deviceVendor 1

. . Chart one  Values by time | Top values

B deviceVersion 2
Top 10 Value

B name 16 op =
Field Value Count %

Q eps102 ib 12,924 51.79% -

storagegroup-100 8,622 21208% -
eps103 2,872  T.O064% I
network 101 2,872  T.064F I
network100 2,872  T.064% I
cpuz100 1,580 3.886% I
memory=100 1.580 3.886% I
ep=101 1,436 3.532% I
search:100 1.436 3.532% I
disk102 1.436 3.532% I

W B x5 OV AlFilds [[] | tastzahous 7]

I |
(Logger) andldeviceEvenlClassld ="eps: 102"

v

12,879 events (Scanned: 40.928 events. 00:01.057) #

400

200

0
Mon 16:55:00 Tue 00:55:00

@ Time (Event Time) Device  Logger deviceVersion
sel Fields (5) 1 2016/07/19 16:45-00 POT Logger  Lacal ArcSight Logger 6.3.0.7783.0
W deviceEventClassid 1 2 2016/07/19 16:45:00 PDT Logger  Local ArcSight Logger 6.3.0.7783.0
[ ] o] 2 3 2016/07/19 16:45:00 PDT Logger  Local  ArcSight [ 6.3.0.7783.0
W deviceVendor 1
WeviceVersnts 4 2016/07/19 16:45-00 PDT Logger  Local ArcSight o] 6.3.0.7783.0
B name 1
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When you click on a chart value (a column, bar, or donut section), the existing search query is modified
to include the WHERE operator with the field name and value, and automatically rerun. If you need to
return to the original query from the drill-down screen, use the Back function of your browser.

The Field Summary Panel

When a query is run, the Field Summary panel lists the CEF and non-CEF fields that occur in matching
events and the number of unique values for each in those events. This panel is only displayed for
queries that do not generate charts. If a peer search is performed, the summarized field values include
counts from peer Loggers.

The Field Summary panel contains two sections: Selected Fields and Discovered Fields. The Selected
Fields section lists the CEF fields, while the Discovered Fields section lists the non-CEF fields discovered
in raw events.

461,039 events (Scanned: 615,088 events, 01:08.624) ¥

20.000
15.000
10,000

5,000
0 ||

| |

13:00:00 13:01:00 13:02:00 13:03:00 13:04:00 13:08

2] [« Time (Event Time) Device Logger deviceVendor
Selected Fields (5) 1 2016/07/2% 13:00:04 PDT 15214135201 nl13-214-139-h114 arstusahpcom  Microsoft

B deviceEventClassld 47

B deviceProduct =

B deviceVendor 3

2 2016/07/29 13:00:04 PDT 15.214.135.201 n15-214-129-h114 arstusahpcom Microsoft

B deviceVersion 13

B name &%

Discovered Fields (14)
acct 1 3 2016/07/29 13:00:04 PDT 15.214.135.201 nl15-214-129-h11& arstusahpcom  Microsoft
addr 1
auid 2
exe 1
grantors 3 & 2016/07/29 13:00:04 PDT 15.214.135.201 n15-214-129-h114arstusahp.com  Microsoft

hostname 1

msg 1

pid 10

3 20146/07/29 13:00:04 PDT 15.214.135.201 nl3-214-129-hll&arstusahpcom  Microsoft

res 1

ses 11

subj 1

N 6 2016/07/29 13:00:04 PDT 15.214.135.201 nl15-214-129-h114 arstusahpcom  Microsoft

erminal 1

type &

uid 1

e Displaying the Field Summary Panel .. 122
o Selected Fields List ... oL 122
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e Discovering Fields in Raw Event Data ... .. . 123

e Refining and Charting a Search from Field Summary ... ... 124

Displaying the Field Summary Panel

By default, the Field Summary feature is enabled and the Discover Fields option is disabled. These
options are controlled globally in the "Search Options" on page 277, and locally with checkboxes in the
search results display options. Selecting these options on the Analyze >Search page overrides the
setting for these options on the Search Options page. For more information on the Discover Fields
option, see "Discovering Fields in Raw Event Data" on the next page.

You can display or hide the Field Summary panel by using the Fields Summary checkbox in the search
results display options.

{3~ AllFields

Field Summary
[7] Discover Fields

[ Auto refresh (5 min) IEI
Sort  Mewest event first IEI

Selected Fields List

By default, the Selected Fields list contains these fields: deviceEventClassld, deviceProduct,
deviceVendor, deviceVersion, and name; you can edit this list to suit your needs. For both lists, by
default, the top 10 values for each field are listed.

You can change the fields displayed in the Field Summary panel's Selected Fields list by changing the
field-set. You can use one of the predefined fieldsets or create your own to include only the fields you
need.

To change the Selected Fields list:

1. Define or update an existing custom field set to include fields you want the Selected Fields list to
contain. See "Fieldsets" on page 79 for information on creating custom field sets.

2. Select the custom field set you defined to view search results.

3. After running a search query, if you select a different field set, the Field Summary panel displays
the following message:
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The Field Summary is out of sync with
the Events table.

Update now

This message indicates that the fields listed in the Field Summary panel do not match the ones
specified in the newly selected field set. To display the fields specified in the new field seft, click
Update now.

Field Summary Drill Down

You can drill down on any of the listed fields or a specific value of the listed fields in the Fields Summary
panel.

For example, you might want to view all events containing deviceEventClassld (specific field) or you
might want to view events of deviceEventClassld “storagegroup:100” (specific value of a field).

For fields whose values are of type String, you can view all events, view the top 10, or create charts of
the matching events. For fields whose values are of type Numeric, you can perform mathematical
operations such as average, min, and max.

Every time you run a query or drill down on a specific field or value, a new query using the newly
selected criteria is run and the Field Summary list is updated.

To view drill down in the field summary:

1. Click Analyze | Search to open the search page.

2. Click the search options down arrow (%) to configure the search display options and check Field

Summary.

3. Run asearch.

4. In the Field Summary list, click the field name you want more detail on.

5. The<fieldname><number of values> dialog box displays the top ten field values.

6. Optionally, click Display events containing <fieldname> to run a search that displays only those
events.

7. Optionally, click a field value to run a search that displays only those events.

8. Optionally, create a chart of the results as discussed in "Refining and Charting a Search from Field
Summary" on the next page.

Discovering Fields in Raw Event Data

The Field Summary feature can automatically discover non-CEF fields from a raw event if the Discover
Fields is enabled. By default, the Discover Fields option is disabled.
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If you need to enable the Discover Fields option for all searches on your Logger, change the default
values (“No™) on the Search Options page (Configuration | Search > Search Options) to “Yes” for these
options, as shown in the following figure.

Field Summary Options

Use Field Summary | yac IL

Discover fields | yq IL

However, if you need to use the Discover Fields option occasionally—not for all searches—you can
enable this option for one-time use on the user interface page from where you run the search query

(Analyze > Search). To do so, click the Discover Fields checkbox in the search display options before
running the query.

Note: Selecting these options on the Search page overrides the setting for these options on the
Search Options page.

{3~ AllFields

Field Summary
B Discover Fields

[ Auto refresh (5 min) IZI
Sort Mewest event first IEI

Tip: To auto discover fields, the raw event must contain data in the “key=value” format, and none
of these characters can be the first character of the “value”: comma, space, tab, and semicolon.

For each “key=value” pair found in a raw event, a new field of the name “key” is created. The Field
Summary includes a summary of the values for all the new fields under the Discovered Fields section.
The discovered fields are assigned the type “String” by default. The auto-discovery capability works
only if at least 2,500 of the first 10,000 matching events contain “key=value” pairs. If this threshold is
not met, auto discovery is automatically turned off. However, this threshold does not apply if there are
less than 10,000 matching events; in that case, fields are discovered regardless.

Refining and Charting a Search from Field Summary
When you click a field in the Field Summary, a dialog box labeled <fieldname><number of values>

displays information about the field. From here, you can drill down to see more details and create a chart
of the search results.
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To view field details from field summary:
1. Run a search and drill down to the data you are interested in, as described in "Field Summary Drill
Down" on page 123.

2. To create a chart of the search results, click one of the Chart on values, such as Values by time or
Top values.

3. Theresults display in a Result Chart and a Result Table.
4. In the Result Chart, click Chart Settings to adjust the chart.
5. Enter a useful Chart Title.
e Select the Chart Type best suited to your data.
o Set the Display Limit. The highest valid value is 100.
6. Inthe Result Table, you can use navigation buttons to move forward and backward through list of
results, and refresh the search.

To create a PDF or CSV file containing the search results, click Export Results. For more
information, see "Exporting Search Results" on the next page.

Saving the Search Results

You can save the results of any search by exporting them in PDF or CSV format:

o PDF: Useful in generating a quick report of the search results. The report includes a table of search
results and any charts generated for the results. Both raw (unstructured data) and CEF (structured
data) events, can be included in the exported report.

o Comma-separated values (CSV) file: Useful for further analysis with other software applications. The
report includes a table of search results. Charts cannot be included in this format.

Data for the following time fields is exported in human-readable format: deviceReceiptTime, startTime,
endTime, agentReceiptTime. For example, 2015/03/2120:22:09 PDT.

e Example of a Quick Report in PDF Format (Search Results Export) ... ... ... 126
e Exporting Search ResUltS . 126
e Scheduling an EXport Operation . 129
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Example of a Quick Report in PDF Format (Search
Results Export)

The following is an example of a quick report generated in PDF format. The chart is displayed first,
followed by a table of matched events (not shown in this example). All generated charts (including
stacked charts) can be exported.

Sample Logger Export Search Report

2016/08/08 14:17:50 PDT - 2016/08/09 14:17:50 PDT

[Receiver added = 1|—
Receiver updated = 1 .:

|
|Saved Search updated = 1 r
'
[Dashboard updated = 14
[Configuration backup t... = 94

Individual Receiver EPS = 10,119

Storage Group Space Used =
2,842

[Logger Internal Event = 1,420

[Stability test 1 1ICMP ... = 496
Disk bytes read = 1,417
CPU Usage = 1,417
Network Usage - Inbound =
1,417
1,417 ‘
Number of Searches Per... = ‘
|Overa|| Forwarder EPS = 1‘41?|
|O\-ferall Receiver EPS = 1,417|

|Disk bytes written = 1,41?‘#"
[Individual Forwarder EPS = 1,417
Netwaork Usage - Outhound =
1,417
|Plarform Memory Usage = 1,41?|

M Individual Receiver EPS M Storage Group Space Used M Logger Internal Event B Platform Memory Usage B Overall Receiver EPS

M Overall Forwarder EPS M Number of Searches Per... Bl Network Usage - Outbound B Network Usage - Inbound M Individual Forwarder EPS
B CPU Usage M Disk bytes read M Disk bytes written [l Stability test 1 ICMP .. B Configuration backup t... ™ Dashboard updated

M Dashboard added B Saved Search updated B Saved Search added B Receiver updated B Receiver enabled B Receiver added

Exporting Search Results

To export the results of your search:

1. Run asearch query from the Analyze > Search page or the Analyze > Alerts page.

2. Click the Export Results arrow % above the histogram.
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Export Options © Help
() Save to local disk @ Save to Logger
File format | PDF

Export file name logger_7-16_search_results

Owverwrite?

Title | My Exported Search

Fields [] All fields Clear
Event Time, Device, Logger, deviceVendor, Il
deviceProduct, deviceVersion, [

deviceEventClassld, name, baseEventCount,
destinationAddress, deviceAddress,
deviceCustomMumberl,

Include Event Total [
Include only CEF events [

Rerun query [C]

coor

3. Select from the available options and then click Export. The displayed options change based on
your selections.

Option Description

Save to local disk Select to save the file to a local system from which you are accessing Logger or is it sent
fo the browser for viewing or saving.

Export to remote Select to export the file

locati
ocation On a Logger Appliance, the file is written to an NFS mount, a CIFS mount, or a SAN

system.

On Software Logger, data is always stored in the <install_dir>/data/logger
directory. This directory can reside locally on the system running the Logger software,
or on a remote storage system such as NFS or CIFS.

Note: The Logger Appliance supports mounting through the user interface.
Software Logger uses its filesystem, which can contain remote folders mounted
through the operating system.

Save to Logger Select to write the file to Logger’s local system.

File Format Select €SV to produce a comma-separated values file.

Select PDF to produce a report-style PDF that contains the search results in fables and
charts. Charts are only included if the search query contains an operator that creates
charts, such as chart, top, and so on.
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Option

Export file name

Title

Fields

Chart Type (for PDF
only)

Chart Result Limit (for

PDF only)

Include Event Total

Include Only CEF Events

Include Base Events
(Available for Alerts
only)

Rerun query

HPE Logger 6.3

Description

(Available only when the “Export to remote location” option is selected)
Specify the name of the file to which events will be exported.

If a file of the specified name does not exist, it is created. If a file of the specified name
exists and the Overwrite box is not checked, an error is generated. If the Overwrite box
is checked, the existing file is overwritten.

(Optional, available only when the File Format is “PDF”)

Enter a meaningful name that appears on top of the PDF file. If no ftitle is specified,
“Untitled” is included.

Displays the list of event fields to be included in the exported file. By default, all fields
are included.

Enter fields or edit the displayed fields by deselecting All Fields.

To export fields created as a result of rex, extract, rename, or eval operators, or
field created when a parser is applied to an event, ensure that *user is selected in the
Fields list.

(Available only when a chart is available in search results)
Select the type of chart to include in the PDF file. You can select from: Column, Bar,

Donut, Area, Line, Stacked Column, Stacked Bar.

Note: If the Chart Type is different from the chart displayed on the Search Results
screen, the value selected for this option overrides the one shown in the screen.
Therefore, the exported PDF contains the chart you specify for this option and not
the one shown on the screen.

(Available only when a chart is available in search results)
Specify the number of unique values to plot. Default: 10

If the configured Chart Result Limit is less than the number of unique values for a
query, the top values equal to the Chart Result Limit are plotted. That is, if the Chart
Result Limit is 5 and 7 unique values are found, the top 5 values will be plofted.

Select to include the total number of events in the exported search results.
Select to include CEF events in the exported search results.

Select to include base events in the exported search results.

Tip: The base events option is available ONLY when you Export the search results
from the Analyze > Alerts page.

Select to rerun the query before exporting the search results.
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Scheduling an Export Operation

The time it takes to export search results is proportional to the number of events being exported.
Therefore, for a large number of events, HPE recommends that you schedule the export operation to
be performed at a later time by saving the query and time parameters as a Saved Search, and then
scheduling a Saved Search Job. For more information about Saved Search jobs, including how to create
a scheduled search, see " Scheduled Searches/Alerts" on page 265.

Saving Queries (Creating Saved Searches and Saved
Filters)

If you need to run the same search query regularly, you can save it in as a filter or as a saved search.

o Saving it as a filter saves the query expression, but does not save the time range or the field set
information.

Saving it as a saved search saves the query expression and the time range that you specified.

e System Filters/Predefined Filters ... L 131
e Searching with Saved QUeries ..l 135
e Scheduling Date and Time OptioNs ... 136

To save a query:

1. Define a query as described in "Searching for Events" on page 102 or "Using the Advanced Search
Builder" on page 90.

2. Click the Save icon (B1) and enter a name for the query in the Name field, as shown in the following

figure.
Save Query @ Help
Mame | MySavedQueryl
Save as () Filter @ Saved Search

Schedule it (You can change the schedule settings later)

Type @ Scheduled Search & Scheduled Alert

Save Cancel
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3. Inthe Save as field, select whether you want to save this query as a Filter, as a Saved Search, or as a
Dashboard panel.
If you select to save as a Saved Search, you can either keep the saved query as Saved Search or

change it to a Scheduled Search or Schedule Alert by clicking the Schedule it Check box. (Queries
with aggregation operators cannot be used in Saved Search Alerts.) For further information about

Saved Search Alerts, see "Saved Search Alerts" on page 271.

If the search query includes an aggregation operator such as chart or top, an option to save the
query for a Dashboard panel is also displayed.

If you select the Dashboard panel option, dashboard options are displayed.

Save Query @ Help

PanelTitle | SavedSearchl
Saveas (@ Filter @ Saved Search @ Dashboard panel

Saved Search @ New saved search

Saved search name

[ ]

® | Malicious Code Activity

Dashboard ¢| MyDashboard

[ ]

= New dashboard

Dashboard name

Panel type I Chart j or [] Add both types
Chart type I(Dlurnn j

Chart limit |10

Cancel

Enter the following parameters:

Parameter Description

Title Enter a meaningful name for the panel that will be added to the Dashboard.

Saved search Select an existing saved search from the drop-down box that will be overwritten with
this query.
OR

Select “New saved search” to create a new saved search query. Enter the new name in
the text box.
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Parameter Description

Dashboard Select an existing Dashboard from the drop-down box fo which the Search Results panel
will be added.
OR

Select “New dashboard” to add the Search Results panel to a new Dashboard. Enter the
name of the new Dashboard in the “Dashboard Name” field.

Panel type Select the type of panel:
o Chart: Displays search results in a chart form
e Table: Displays search results in a table form

o Chart and Table: Adds two panels, one for displaying search results in the chart form
and the other for displaying search results in the table form

Chart type Select the type of chart to display matching events. You can select from:
Column, Bar, Donut, Area, Line, Stacked Column, Stacked Bar.

Default: Column

Chart limit Only applicable to Search Result Chart panels.

Specify the number of unique values to plot. Default: 10

4. Click Save.
If you selected Schedule it, you are asked if you'd like to edit the schedule setting now. Click OK. If
you click Cancel, the Saved Search or Alert is not created.

6. Set the schedule options as appropriate. For details about these options, see "Scheduling Date and
Time Options" on page 136.

7. For Scheduled Saved Searches, select the desired options. For details about the parameters, see
"Search Job Options" on page 269.

8. ForScheduled Alerts, select the desired options. For details about the parameters, see "Alert Job
Options" on page 271.

9. Click Save.

System Filters/Predefined Filters

Your Logger ships with a number of predefined filters, also known as system filters. These filters define
queries for commonly searched events. For example, unsuccessful login attempts or the number of
events by source. Filter queries are available as Unified queries and as Regular Expression queries.
Unified queries can be used for searching and reporting while Regular Expression queries are for
defining alerts and forwarders.

Note: To effectively use the Firewall or UNIX Server use case filters (listed in the following table),
define device groups that include the firewall devices or UNIX servers that you are interested in and
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then constrain your search to those device groups. If you do not create device groups specific to
device types, the search results would match all Deny, Drop, or Permit events from all devices
instead of only the firewall devices. Similarly, the “Unix-10 Errors and Warnings” filter would include
IO errors and warnings from all devices and not only the UNIX servers.

The following is a list of all the system filters. For a description of each filter, see "System Filters" on

page 586.

To use a predefined system filter, follow instructions in "Searching with Saved Queries" on page 135.

Note: Even though the filters in the System Alert category (listed in the last section of the following
table) are displayed on the user interface of Software Logger, these filters do not apply to it.

System Filters
Category

Login Status use case

Configuration

Events use case

Intrusion use case

Firewall use case

Network use case

HPE Logger 6.3

Unified Query Filters

All Logins

Unsuccessful Logins

Successful Logins

Failed Logins

Configuration Changes

High and Very High Severity Events

Event Counts by Source

Event Counts by Destination

Malicious Code

Deny (Firewall Deny)
Drop (Firewall Drop)
Permit (Firewall Permit)
DHCP Lease Events

Port Links Up and Down

Regular Expression Query Filters

All Logins (Non-CEF)

All Logins (CEF format)

Unsuccessful Logins (Non-CEF)

Unsuccessful Logins (CEF format)

Successful Logins (Non-CEF)

Successful Logins (CEF format)

System configuration changes
(CEF format)

High and Very High Severity
CEF events

All CEF events

Malicious Code (CEF format)
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System Filters, continued

Category

Connector System
Status use case

UNIX Server use case

Windows Events
use case

HPE Logger 6.3

Unified Query Filters
Protocol Links Up and Down

CPU Utilization by Connector Host

Disk Utilization by Connector Host

Memory Utilization by Connector
Host

CRON related events

10 Errors and Warnings
PAM and Sudo Messages
Password Changes
SAMBA Events

SSH Authentications

User and Group Additions
User and Group Deletions

Account Added to Global Group

Account Added to Global Group (CEF)
Audit Policy Change

Audit Policy Change (CEF)

Change Password Attempt

Change Password Attempt (CEF)
Global Group Created

Global Group Created (CEF)

Logon Bad User Name or Password

Logon Bad User Name or Password
(CEP)

Logon Local User

Logon Local User (CEF)

Logon Remote User

Logon Remote User (CEF)

Regular Expression Query Filters
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System Filters, continued
Category Unified Query Filters Regular Expression Query Filters
Logon Unexpected Failure
Logon Unexpected Failure (CEF)
New Process Creation
New Process Creation (CEF)

Pre-Authentication Failure

Pre-Authentication Failure (CEF)

Special Privileges Assigned to New
Logon

Special Privileges Assigned to New
Logon (CEF)

User Account Changed

User Account Changed (CEF)
User Account Password Set

User Account Password Set (CEF)

Windows Events (CEF)

System Alerts The following filters search for specific internal alert events, which are written in CEF
format to a special Internal Storage Group. These filters are available for both search

methods. In addition to the following filters, you can define your own alerts based on the
system health evenfts listed in "System Health Events" on page 463.

Note: Although these filters are displayed on Software Logger, these do not apply fo

it.
CPU Utilization Above 90 Percent CPU Utilization Above 90 Percent
CPU Utilization Above 95 Percent CPU Utilization Above 95 Percent
Disk Failure Disk Failure
Root Partition Below 10 Percent Root Partition Below 10 Percent
Root Partition Below 5 Percent Root Partition Below 5 Percent
Device Configuration Changes Device Configuration Changes
Filter Configuration Changes Filter Configuration Changes
High CPU Temperature High CPU Temperature

Bad Fan
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System Filters, continued

Category

Unified Query Filters

Power Supply Failure

RAID Controller Issue

RAID Status Battery Failure

RAID Status Disk Failure

Storage Configuration Changes
Storage Group Usage Above 90%
Storage Group Usage Above 95%
Zero Events Incoming

Zero Events Outgoing

Regular Expression Query Filters
Power Supply Failure

RAID Conftroller Issue

RAID Status Battery Failure

RAID Status Disk Failure

Storage Configuration Changes
Storage Group Usage Above 90%
Storage Group Usage Above 95%
Zero Events Incoming

Zero Events Outgoing

Searching with Saved Queries

You can search using the Filters and Saved Searches that you create as well as the pre-defined system
filters, explained in "System Filters/Predefined Filters" on page 131.

To use an existing query:

1. Open the Analyze menu and click Search.
2. Use one of these options to select the desired Filter, System Filter, or Saved Search.
o Type$filter$ or $ss$ in the search text box and select a filter or a saved search from the
dropdown list. See for more information, "Opening Filters and Saved Searches via Autocomplete”
on page 100.

o Click the Load a Saved Filter icon (M) to view a list of all the saved filters and saved searches to
display the Load Filter/Saved Search inferface, as shown in the following figure.
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Load Filter/Saved Search 8
Filter Sawed Search
Name = Type Start Date Start Time EndDate EndTime Local
Tonfiguration Changes Unified Wuery >MNow-1h SMowW o o
by Product
Failed Logins by Product  Unified Query SNow-1h SMow V
Failed Logins by User Unified Query SNow-1h SMow o |
Firewall Drops by Source  Unified Query SNow-1h SMow V
Individual Forwarders Unified Query SNow-1d SMow « E
Individual Receivers Unified Query SNow-1d SMow V
Malicious Code Activity Unified Query SNow-1h SMow v
SSH Authentications Unified Query SMNow-1h SNow v i
Mame: Malicious Code Activity o
Type: Unified Query
Description: categoryObiect STARTSWITH */Vector" OR categoryObiect STARTSWITH "/Host/Infection” OR i

The Load Filter/Saved Search interface enables you to quickly locate the saved filters and the
saved search queries. Click on any of the column names to sort information. To view details of a
filter or a saved search, click its row. Details are displayed in the text box below.

To load a filter, select the filter or saved search you want to use and click Load+Close. The filter
rows display the search query.

To load a saved query, open the Saved Searches page, select a search, and click Load+Close.

Scheduling Date and Time Options

Tip: Make sure you are familiar with the information in "Time/NTP" on page 410 before setting the
schedule.

Choose Every Day, Days of Week, or Days of Month from the upper pull-down menu.

Note: When specifying multiple days, separate them with a comma. When specifying the time, use
24-hour format.

1. If Every Day, select one of the following options from the lower pull-down menu, and enter the
necessary values:

o Hour of day: (0-23) Enter the fime you want the task to run (in 24 hour format) in the Hours
field. Midnight is zero (0).
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o Every: Select Hours or Minutes from the right-most pull-down menu and specify how frequently
you want the task to run.

e Hours: (1-23) Enter how frequently in hours you want the task to run. The result is every n hours
every day.

Minutes: (15-59) Enter how frequently in minutes you want the task to run. The result is every n
minutes every day.

2. |f Days of Week, select from the following options from the lower pull-down menu, and enter the
necessary values:

e Days: (1-7) Enter the days of the week you want the task to run (Sunday=1, Monday=2, and so
on).

o Hour of Day: (0-23) Enter the time you want the task to run in the text field to the right. @ is
midnight.

o Every: Select Hours or Minutes from the right-most pull-down menu and specify how frequently
you want the task to run.

Hours: (1-23) Enter how frequently in hours you wanft the task to run. The result is every n hours
on the selected days.

Minutes: (15-59) Enter how frequently in minutes you want the task to run. The result is every n
minutes on the selected days.

3. If Days of Month, select from the following options from the lower pull-down menu, and enfter the
necessary values:

o Days: (1-31) Enter the day or days of the month you want the task to run.

Note: The number of days in a month vary. Scheduled tasks will only run if the specified day
exists for that month. Tasks scheduled on the 31st day of the month will not run in April,
February, June, November, and September. Tasks scheduled on the 29th day of the month
will only run in February during leap years.

¢ Hour of Day: (0-23) Enter the time of day you want the task to run. (You cannot select Every
for this option.)

Examples:

e To run the scheduled job every 45 minutes of every day, select Every Day in the upper Schedule
pull-down menu. Choose Every from the lower pull-down menu, enter 45 in the text box and select
Minutes.

e To run the scheduled job every four hours on Tuesdays and Thursdays, select Days of Week from
the upper Schedule pull-down menu and enter 3,5 as the Days. Then choose Every from the lower
pull-down menu, enter & in the text box.

e To run the scheduled job on the 14th of each month at 3 AM, select Days of Month from the upper
Schedule pull-down menu and enter 14 as the Days. Then choose Hour of day from the lower pull-

HPE Logger 6.3 Page 137 of 623



Administrator's Guide
Chapter 3: Searching and Analyzing Events

down menu and enter 3 in the text box. (To run the scheduled job at 3 AM and 3 PM, you would
enter 3,15.)

Enriching Logger Data Through Static Correlation

The lookup search operator enables you to augment data in Logger with data from an external file.
This enables geo-tagging, asset tagging, user identification, and so on, through static correlation.

You can use the 1lookup operator to add information to your search results that is not part of the
original data stored on Logger. You do this by creating an external file containing the data, uploading
that Lookup file to Logger, and then using the 1ookup operator to create a join between Logger events
and the uploaded Lookup file.

For example, if you want Logger search results to include which country source IP addresses are located
in, you can create a file listing the IP addresses and countries and then upload that file to Logger as a
Lookup file. After that, you can use the 1ookup operator to perform a join between the sourceAddress
field in the Logger events and the IP address column in the Lookup file, and display the country in the
search results.

o Forinformation about creating Lookup files and uploading them to Logger, see "Lookup Files" on
page 284,

o Forinformation on how fo use the 1lookup operator when searching, see "lookup" on page 487.

Indexing

Once you have initialized Logger, it starts scanning events automatically and indexing them.
Logger’s storage technology enables automatic indexing of events in these ways:
o Full-text indexing: Each event is tokenized and indexed. See "Full-Text Indexing (Keyword Indexing)"

on the next page.

o Field-based indexing: Event fields are indexed based on a predetermined schema. See "Field-Based
Indexing" on the next page.

o Superindexing: Certain event fields are super-indexed so that you can find rare field values quickly.
See " Superindexing" on page 141.

All events received after initialization are indexed for full-text search, a default set of fields is indexed
for field-based search, and a default set of fields is superindexed for fast needle-in-a-haystack searches.

e Full-Text Indexing (Keyword Indexing) . ... . ] 139
o Field-Based INdeXing .. ... L 139
® SUPEIINAEXING o 141
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All events are timestamped with the receipt fime when received on the Logger. The default fields are
automatically indexed. For the remaining fields, Logger uses the receipt time of an event and the time
when a field was added to the index to determine whether that event will be indexed. If the receipt time
of the event is equal to or later than the time when the field was added to the index, the event is
indexed; otherwise, it is not.

Note: Indexing information is not archived when the archive is created. You can choose to add
indexing information to an archive after it has been created. For more information, see "Indexing

Archived Events" on page 359

Full-Text Indexing (Keyword Indexing)

For full-text indexing, each event (CEF or non-CEF) received on Logger is scanned and divided into
keywords and stored on the Logger. The full-text search options control the manner in which an event
is tokenized as described the Full-text Search Options section of the "Search Options" on page 277.

Field-Based Indexing

The field-based indexing capability allows for fields of events to be indexed. The fields are based on a
predetermined schema. The Logger’s reports and the field search method ufilize these indexed fields to
yield significant search and reporting performance gains.

Field-based indexing for a recommended set of fields is automatically enabled at Logger initialization
time. You can add more fields to an index at any time. (See "To add fields to the field-based index:" on
page 275 for instructions.) Once a field has been added, you cannot remove it.

A list of the default index fields, along with their field descriptions is available from the Logger
Configuration menu. For instructions on how to view the default Logger Schema fields, see "Default
Fields" on page 281.

Note: HPE strongly recommends that you index fields that you will be using in search and report
queries.

The fields created when a predefined or user-defined rex parser parses the non-CEF events cannot be
indexed using the field-based indexing capability. See "Parsers" on page 315 for more information about
rex parsers.

In addition to indexing the fields included in the field-based indexing list, Logger indexes event
metadata fields—event tfime, Logger receipt time, and device address—for every event. The event
metadata fields are also known as “internal” fields.

The following fields are available for indexing. The fields that Logger starts indexing automatically after
Logger initialization are indicated in bold fonf.
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In addition to the following fields, the requestUrl field is available for search queries. However, this

field cannot be indexed.

Index Fields
agentAddress
agentHostName
agentNtDomain
agentSeverity
agentType

agentZone
agentZoneName
agentZoneResource
agentZoneURI
applicationProtocol
baseEventCount
bytesin

bytesOut
categoryBehavior
categoryDeviceGroup
categoryObject
categoryOutcome
categorySignificance
categoryTechnique
customerName
destinationAddress
destinationDnsDomain
destinationHostName
destinationMacAddress
destinationNtDomain
destinationPort
destinationProcessName
destinationServiceName

destinationTranslatedAddress

HPE Logger 6.3

deviceCustomDate2

deviceCustomDate2Label

deviceCustomNumber1

deviceCustomNumberiLabel

deviceCustomNumber2

deviceCustomNumber2Label

deviceCustomNumber3

deviceCustomNumber3Label

deviceCustomString1
deviceCustomStringlLabel
deviceCustomString2
deviceCustomString2Label
deviceCustomString3
deviceCustomString3Label
deviceCustomString4
deviceCustomString4Label
deviceCustomString5
deviceCustomString5Label
deviceCustomStringé
deviceCustomString6Label
deviceEventCategory
deviceEventClassid
deviceExternalld
deviceHostName
devicelnboundinterface
deviceOutboundInterface
deviceProduct
deviceReceiptTime

deviceSeverity

flexDate1
flexDatelLabel
filePath
flexNumber1
flexNumberiLabel
flexNumber2
flexNumber2Label
flexString1
flexString1Label
flexString2
flexString2Label
message

name

priority
requestClientApplication
requestContext
requestMethod
requestUrlFileName
requestUrlQuery
sessionld
sourceAddress
sourceHostName
sourceMacAddress
sourceNtDomain
sourcePort

sourceProcessName

sourceServiceName
sourceTranslatedAddress

sourceUserld
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Index Fields
destinationUserPrivileges

destinationUserld

deviceVendor

deviceVersion

sourceUserName

sourceUserPrivileges

destinationUserName deviceZone sourceZone
destinationZone deviceZoneName sourceZoneName
destinationZoneName deviceZoneResource sourcezoneResource
destinationZoneResource deviceZoneURI sourceZoneURI
destinationZoneURI endTime startTime
deviceAction eventid transportProtocol
deviceAddress externalld type
deviceCustomDatel fileName vulnerabilityExternallD

deviceCustomDatellLabel vulnerabilityURI

Superindexing

In addition to full text and field based indexing, Logger and later creates superindexes for common IP
address, host name, and user name fields. Superindexes enable Logger to quickly determine whether a
particular field value has been stored on this Logger, and if it has, to narrow down the search to sections
of data where that field value exists. Therefore, searches that can take advantage of superindexes
return very quickly if there are no hits and return results more quickly than regular searches when there
are very few hits.

o Forinformation on how to use superindexes, see "Searching for Rare Field Values" on page 109.

o A complete list of super-indexed fields is included in "Using Super-Indexed Fields to Increase Search
Speed" on page 109.

Viewing Alerts

You can configure Logger to alert you by e-mail, an SNMP frap, or a Syslog message when a new event
that matches a specific query is received or when a specified number of matches occur within a given
time threshold. For more information, see "Logger Alert Types" on page 332. In addition to receiving an
alert via e-mail, an SNMP frap, or a Syslog message, you can view Alerts and the base events that

friggered them on the Analyze > Alerts page.
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ShGWI All Alerts B Wﬂhinl Last 24 hours B

Base Event Fieldsl All Fields E|¢ m El |:|| Auto refresh (5 min) j

Alerts 50 Stafus Paused
Page Start 2016/08/11 11:18:13 PDT Page End 2016/08/11 11:18:13 PDT

ap
Time (Event Time) name baseEventCount deviceCustomMumberl deviceCustomNumber2
26 2016/08/11 11:18:13 PDT CEF Alerfs 1 3 1
Base Event (1 found)
Time (Event Time) Device Logger deviceVendor deviceProduct devi sion devi {f i name agentAddress  agentHos!
2016/08/11 nl15-214-156- Local Snort Snort 1.8 [1:2003] MS-SQL Worm 192.168.21.138 cnaminenif
11:18:12 PDT h219.arst.usahp.com propagation

[UDP Receiver] attempt

RAW CEF:0ISnortiSnort|1.8I[1:20031IMS-5QL Worm propagation attemptiHighl eventld=10005786480 mrt=1099218722851 proto=UDP categorySignificance=/Hostile categoryf
tionTime=1099452615848 eventAnnotationAuditTrail=1,1099452615848 System,Queued,,,
eventAnnotationVersion=1 eventAnnotationEventld=10005786480 eventAnnotationFlags=0 eventAnnotationEnd Time=1099218482000 eventAnnotationManagerReceipt’

27 2016/08/11 11:18:13 PDT CEF Alerts 1 3 1
Base Event (1 found)
Time (Event Time) Device Logger deviceVendor deviceProduct deviceVersion deviceEventClassld name agentAddress  agentHos
2016/08/11 n15-214-156- Local  Snort Snort 18 [1:2004] M5-5QL Worm  192.168.21.138 cnaminen
11:18:12 PDT h219.arst.usahp.com propagation
[UDFP Receiver] attempt

OUTBOUND

RAW CEF:0|Snort|Snort|1.8|[1:2004]IM5-5QL Worm propagation attempt OUTBOUND]|High| eventld=10005786481 mrt=1099218722851 proto=UDP categorysignificance=/Hos
tionModificationTime=1099452615848 eventAnnotaftionAuditTrail=1,1099452615848,System,Queued,,,,
eventAnnotationVersion=1 eventAnnotationEventld=10005786481 eventAnnotationFlags=0 eventAnnotationEnd Time=1099218482000 eventAnnotafionManagerReceipt”.

To view Alerts, choose a predefined time range, such as “Last 2 hours” or “Today,” or choose “Custom
Time Range” to reveal additional fields for specifying a fime range manually. This aspect works like
Search. Refer to "Time Range" on page 76 for more detail.

When you create Alerts, you name them. Use the Show options to view only events associated with a
particular Alert. The default is All Alerts.

Events that are labeled ‘Action Engine’ are Alert events. The events that triggered the alert are base
events. You can also select whether to view the base events and which fields to view by using the Base
Event Fields: option.

Like on the Search page, the Go button triggers the search, the Export Results button enables you to

create a PDF or CSV file that contains the search results, and the Auto Refresh option determines
whether and how frequently the displayed search results are updated.

Live Event Viewer

The Live Event Viewer provides real-tfime view of the incoming events that match the criteria you
specify. This functionality is useful in environments where the need o view an event quickly is
important; for example, a financial institution might be interested in viewing a specific fransaction type
as soon as it occurs. Because the latency between the events arriving at Logger and the display time is
quite less, events might not have been indexed on Logger before being displayed.
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The Live Event Viewer composes of two tabs—Search Composer and Search Results. The Search
Composer is for defining the search criteria and the Search Results tab displays the matching events in

real time.

The following figure shows the Search Composer. If you specify more than one search term, the
resulting query uses the AND operator to combine them. For example, if the first search term searches

for “failure” and the second one excludes “admin,” the resulting query is “failure AND NOT admin.”
Search Composer

Search Composer Search Results 0 Help

What do you want to find? Build a new filter or load an existing filter

O @B+ - | @
Exclude/Include Terms -~ Search Terms

9 Search For: failure
Exclude From Search: admin

Choose if a logical NOT should be applied to the search ferm and enter the text fo search for

Where do you want to look? Choose from device groups and storage groups.

Device Groups  #

Storage Groups #

o3

Search Composer Legend

Feature Description Feature Description

o Load a saved filter e Specify device groups
Save the current filter Specify storage groups
Add a filter row
Remove a filter row
Remove all filters

e Enter search criteria o Start or Stop Live Event Viewer

The Search Results tab provides the Play, Pause, Stop, Clear, and Export buttons that enable you to
control the display in a manner similar to any electronic device, as shown in the following figure.
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Search Results Tab

Search Composer Search Results 0 Help

ol * Filter storageGroup(Internal Event Storage Group) | o
b x — !Displa\,.I Buffer 1000 :
278 Z016/07/20 16:05:3 783.0lstor roup:100(Stor; roup Space Used|1l -

cat=/Monitor/StorageGroup/Spa d cnl Used cn2=365 cﬂl#eremion (days) cn3=1024
cn3Label=used (MB) cs2=CurrentValue cs2Label=Timeframe dst=127.0.0.1 dwvc=127.0.0.1 end=146905

fileType=storageGroup fname=StorageGroup3 fsize=3 rt=1469055939615

P Searching || 283 events|(283 scanned)

o 2016/07/20 16:05:39 PDT Logger CEF:0lArcSightlLoggerl6.3.0.7783.0Istoragegroup:100IStorage Group Space Used|1l

cat=/Monitor/StorageGroup/Space/Used cn1=33 cnllabel=Percent Used cn2=30 cn2Label=retention period (days) cn3=1024
cn3Label=used (MB) cs2=CurrentValue cs2Label=timeframe dst=127.0.0.1 dvc=127.0.0.1 end=1469055939615
filaType=storageGroup fname=Short retention 1 fsize=3 rt=1469055939615

280: 2016/07/20 16:05:39 PDT Logger CEF:0|ArcSightlLoggerl6.3.0.7783.0lstoragegroup-100|Storage Group Space Used|1|
cat=/Monitor/StorageGroup/Space/Used cn1=33 cnllabel=Percent Used cn2=30 cn2Label=retention period (days) cn3=1024
cn3Label=used (MB) cs2=CurrentValue cs2Label=fimeframe dst=127.0.0.1 dvc=127.0.0.1 end=1469055939616
fileType=storageGroup fname=Short retention 2 fsize=3 rt=1469055939616

A Y o Uy YAy,

L

T SN Do |

Search Results Legend

Feature Description Feature Description

o Play / Pause / Stop / Delete / Export e Events scanned so far

e Filter specified in Search Composer o Events display maximum

e Current state o Search timer

o Events found so far o Matching event number

The following list highlights the features of Search Results display:

o Eventsare displayed in the raw event format and not in the columnar, table form as displayed in the
Search Results page (Analyze > Search) when you run a search query.

o A user can launch a maximum of one Live Event Viewer. There can be a maximum of five Live Event
Viewers running on Logger at any fime.

o The regular expression search method is used to identify matching events. Therefore, you can
specify regular expressions as the search term in the Search Composer.

o Buffer Size defines the maximum number of events displayed in the Viewer. By default, the Buffer
Size is 1000; however, it can be set to any number between the range of 20 and 5000.

o By default, the search is run for 15 minutes and then stopped to preserve system resources. If you
need to run the search for longer than 15 minutes, click the @ icon next to the countdown timer to
reset the timer to 15 minutes.

o When you click Pause, the Search Results display is frozen. However, the search operation continues
in the background and the new matching events are buffered until a maximum of 1000 events have
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been buffered or the search timer, which continues to count down even when the Search Results
display is frozen, reaches 00:00.

o |f the fimer has not reached 00:00, you can click Play to resume the paused search operation. When
you click Play, the buffered events are displayed. The newly found events are appended to the
previously found events on the Search Results display screen.

o When you click Stop, the search for matching events and the countdown of the search timer stop.
When you click Play, the search is started afresh—the currently displayed events are cleared from the
Search Results screen, the search timer is reset to 15 minutes, and the search starts again.

e You must stop the search operation to export the matching events.

To launch a Live Event Viewer:

Note: Live Event Viewer is a resource-intensive application that can impact the overall performance
of your Logger if run for a long period of time. Therefore, use this feature selectively and for short

periods of time.

1. Open the Analyze menu and click Live Event Viewer.
2. In the Search Composer tab, enter the search terms or click the (8 icon to select a saved filter.

You can enter search terms that the event must contain (Search For:) or terms that the events must
not contain (Exclude From Search:). Click the “Search For:” field to display a drop-down list from
which you can select “Exclude From Search:”.

If you specify more than one search term Logger uses the AND operator to combine them in the
resulting search query.

e To add additional search term click the (+)icon.
e Toremove a search term, click the (=) icon.

e Toremove all search terms, click the ('Ii]L]I )icon.

3. Enter constraints to limit your search to specific device groups, devices, or storage groups in the

“Where do you want to look?” section. Click the (#)iconto display a list from which you can
choose the constraints.

4. Click Start.
5. The search results are automatically displayed in the Search Results display screen.

To update the Live Event Viewer query:

1. In the Search Composer tab of the Live Event Viewer, update the search terms.

2. Click Stop first and then click Start fo start search using the new search terms.
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To export Search Results display:
1. Make sure you have stopped the Live Event Viewer. To do so, click the (I icon in the Search
Results display window.
2. Click the (¥)icon to open the Export Options window.

3. To export the displayed search results, select the Export options, as described in "To export the
results of your search:" on page 126 Then click Export.
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Reporting is an essential fool for communicating the state of your network security to internal and

external stakeholders. A report is a captured view or summary of events. Reports can be viewed from
the Logger Reports page or exported for sharing in a variety of file formats.

Note: Reporting is not available before you have applied a license to your Logger. The frial license
does not support Reporting. See "Trial Licenses" on page 393.

The following topics describe how to create, run, and view reports in Logger. For information in about
the out-of-box reports that come with your Logger, see "Logger Content" on page 555.

e The Reports HOmMe Page . oo L 147

e The Explorers

® CalEgONIS L 157

e Dashboards
e Widgets
¢ Running, Viewing, and Publishing Reports
o Scheduled RePOITS . L 192
® DesigniNg RePOI S L 196
® Queries

e Parameters

o Template STYlEs .. 242

e Administration

The Reports Home Page

To access the Reports home page:

1. From the Logger navigation bar, click Reports | Dashboard.

To open the Reports home page from within the Reporting tool:
1. From the Reports left panel, click Dashboard.

Note: If you have configured a dashboard to display as the Reports Home page, Logger opens the
selected dashboard. If a dashboard has not been configured to display, you are redirected to the

Recent Reports page.

HPE Logger 6.3 Page 147 of 623



Administrator's Guide
Chapter 4: Reporting

At the top of the Reports home page, there are links for Dashboard Viewer, Dashboard Preferences,
Widget Designer, Recent Reports, Jobs Execution Status, Classic Viewer, Classic Designer, and Classic
Preferences.

Dashboard Viewer Dashboard Preferences Widget Designer Recent Reports Jobs Execution Status Classic Viewer Classic Designer Classic Preferences

e The Dashboard Viewer enables you fo view your dashboards. You can use the buttons in the upper
right corner of the Dashboard Viewer page to add a widget to the dashboard, save, edit, and
subscribe the dashboard. For more information, see "Dashboards" on page 161.

o The Dashboard Preferences link enables you to specify a default dashboard to display as your
Reports home page, and to display multiple dashboards as tabs in the Reports home page. For more
information, see "Selecting a Default Dashboard View for the Reports Home Page" on page 165.

¢ The Widget Designer page enables you to create a widget displaying either a report or a web link.
You can place the widget in the dashboard from the Dashboard Viewer page. For more information,
see "The Widget Designer" on page 175.

¢ The Recent Reports link lists the status of currently running, recently run, or accessed reports. By
default, all reports except the completed scheduled reports are displayed. You can also use the
Filters fab to restrict the reports displayed. For more information, see "Viewing Recently Run
Reports" on page 180.

e The Jobs Execution Status link displays a graphic summary of the execution status of all completed,
succeeded, failed, and upcoming report run jobs. For more information, see "Jobs Execution Status"

on page 193.

o The Classic Viewer, Classic Designer, and Classic Preferences links enable the view, design and
maintenance of dashboards created in pre-5.2 versions of Logger. See "Using Classic Dashboards" on
page 166 for more information.

Some Reports categories, such as Recent Reports and Jobs Execution Status, include subcategories.

Click the '™/ arrow next to a category to access its subcategories.

Dashboard Viewer Dashboard Preferences Widget Designer Recent Reportsilobs Execution Status [lassic Viewer Classic Designer Classic Preferences
| ~ | Filters Entity Name [(AI]/TAI] | Status [(AID] | Job Type [(AID] I_Jub Name [(Al)] | U;er [ArcSight]
Entity Type | (Al [+]  entity
Job Name | (A [+]  JobRunTime (A [v| status
Date From FE To = Job Type | (ALl El Frequency
Show | Top 500 -]
| » | Jobs Summary
Sr.No. Job Name Entity Name Frequency Owner Scheduled Time
L et P e s P B P et e e i el i e b S e i i bl
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Getting Started

You can get started with Logger reporting with any of the following:

You can schedule any report to run once at a later date or on a specified frequency (such as daily or
weekly). Monthly reports cannot be scheduled currently. To begin, see "Scheduled Reports" on
page 192.

You can design a dashboard to show the things you are most interested in as your Reports Home
page. To begin, see "Designing Dashboards" on page 163.

You can create reports to track information that you are interested in. To begin, see "Designing
Reports" on page 196

You can run, view, and publish the results of any type of report. To begin, see "Running, Viewing, and
Publishing Reports" on page 179.

You can adjust the configuration on your report server. To begin, see "Report Server Administration"
on page 245.

You can create a new query for use in reports, using the visual Query Object Editor. To begin, see
"Queries" on page 219.

HPE Logger 6.3 Page 149 of 623



Administrator's Guide
Chapter 4: Reporting

The Reports Quick Access Menu

All' Logger Report pages include a left menu, for quick access to reporting features. It has the same
options as the Reports menu in the navigation bar.

Dashboard
Scheduled Reports
Navigation
Category Explorer
Report Explorer
Query Explorer
Parameter Explorer

Favorites Explorer

The Dashboard link provides access to the reports Dashboard features.

The Scheduled Reports link enables you to specify when to run your
reports.

The links listed under Navigation enable you to navigate to a category,
report, query, parameter, or favorite item. You can select multiple objects in

any of the Explorers and perform actions such as set access rights, copy,
cut, paste or delete actions.

pesian The links listed under Design enable you to create a new report and create,
New Report . . . .
view and configure any object of the Reporting tool.
Queries
Parameters e The links listed under Administration enable you to perform

Parameter Value Groups administrative reporting tasks.

Template Styles
Administration

Deploy Report Bundle

Report Administration

Report Category Filters

Report Categories

iPackager

The Explorers

You can use the Explorers listed under the Navigation heading in the Reports quick access menu to
navigate to a desired report, query, parameter, dashboard, dashboard widget, or favorite item.

To navigate using the Explorers:

o Click a category to display the objects in that category.
o Click a category or an object in a category to perform an action on it.

o Some Reports categories, such as Recent Reports and Jobs Execution Status, include subcategories.
Click the [™! arrow next to a category to access its subcategories.

The following Explorers are available:

e "Category Explorer" on page 153.
o "Report Explorer" on page 154.
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e "Query Explorer" on page 155.
o "Parameter Explorer" on page 155.

o "Favorites Explorer" on page 156.

The Explorer Actions Menus

The Explorers include context-sensitive Actions menus, which give quick access to tasks that are
available for a selected report object.

To access the Actions menu for an Explorer:

1. Select an Explorer from the Reports quick access menu. A menu displays to the right.

2. Select a subcategory from the Root menu. Another menu displays to the right.
3. Continue to select from the available options until you can select an individual item (such as a
report or query). The Actions menu for that item opens to the right.

The list of items in the Actions menu depends on the Explorer context. The Actions menu for the
Parameter Explorer, for example, displays a different set of actions from the Actions menu for the
Query Explorer.

Example

For example, to access the Actions menu for the Report Explorer:
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Dashboard
Scheduled Reports

Navigation
Category Explorer
Report Explorer 4 [Root) > Errors Detected in Anti-Virus Deployment Actions: o
Query Explorer Default Reports - Failed Anti-Virus Updates Quick Run with default options

Parameter Explorer
P Run in Background

} 4 Device Monitoring = Top Infected Systems
Favorites Explorer
- Run Report
- Anti-Virus » Update Summai
Design o P v
i ) » List Published Outputs
New Report CrossDevice © Virus Activity by Hour
. Create Dashboard Widget
Queries Database
Parameters Customize Report
Firewall
Parameter Value Groups Maore «
|dentity Management
Template Styles

] Properties:
Administration I0S-1PS P

WName: Virus Activity by Hour

Deploy Report Bundle Network

Report Administration Dperating System Type: Adhoc

Report Category Filters VPN Format: HTML

Report Categories Query Object: DM-AV-Virus Activity by Hour
P Foundation

iPackager Modified On: 09/01/2016 08:57

Inmmnr Adminictratinn

° Click Report Explorer from the quick access menu. The list of report categories is displayed.

9 In the report categories list, click Device Monitoring to open the sub-menu,then click Anti-Virus.
The list of Anti-Virus reports is displayed to the right of the category list.

e From the list of Anti-Virus reports, select Virus Activity by Hour.

o The Actions menu is displayed to the right of the reports list. The Actions menu includes items
appropriate for running, viewing, or editing the Virus Activity by Hour report.
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Reports also include a Properties section, with a description of the selected report.

Properties:

Mame: Top Destination Ports

Type: Ad hoc

Format: HTML
Query Object: Top Destination Ports
Modified On: 08/04/2016 11:08
Category: Targets
Public: True

Description: This report displays a table of the to
p destination ports and the number
of events for each port.

Category Explorer

Reports and report objects, such as queries and parameters, can be organized and grouped based on
their function. Such functional groups are called categories. For example, a report pertaining to a
database can be stored under the Database category.

The Category Explorer lists all categorized reports and report objects. It comes with some pre-defined,
commonly used categories. You can also add custom categories based on your requirements.

You can use the Category Explorer to display an overview of all reports, published reports only, Query
Objects, Parameter Objects, Dashboards, Dashboard Widgets, Reports, and Saved Reports (published
reports)

To access objects from the Category Explorer:

1. From the Logger navigation bar, click Reports, then, under Navigation, click Category Explorer.
The Repository pane opens to the right of the navigation pane and displays the available

categories and objects.
2. Click the * arrows to open available sub-menus.

For example, click the * to open the Root menu. Foundation, the * next to Intrusion
Monitoring, and then click Targets > Query Objects.

The Category Explorer displays the Query Objects in the Foundation > Intrusion Monitoring >
Targets category.

3. Click an object and then select an action to take by clicking a link in the Actions menu. If there are
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actions you can take, available options will display in the actions pane. If there are no associated
actions, the action pane will be grayed out.

For example, click Target Counts by Device Severity and then click Edit Query Details. The
Query Object Editor opens, displaying the selected Query Object.

For a complete list and description of reports available on Logger, see "Logger Content" on page 555.

Report Explorer

The Report Explorer is the central location for viewing (publishing), running, or editing existing reports.
For more information, see "Running, Viewing, and Publishing Reports" on page 179.

Note: You cannot create a new report from the Report Explorer. To create a new report, click New
Report under the Design section in the left pane. For more information, see "Designing Reports" on
page 196.

You can view, publish, and edit any type of report. For information on common reporting tasks available
for all reports, see "Task Options on Available Reports" on page 180.)

You can schedule any report to run once at a later date (an ad hoc report) or at a specified frequency
(such as daily or weekly). For more on this, see "Scheduled Reports" on page 192.

To access reports from the Report Explorer:

1. From the Logger navigation bar, click Reports, then, under Navigation, click Reports Explorer.
The Reports pane opens to the right of the navigation pane and displays the available report
categories and reports.

2. Usethe » arrows and click the available links to navigate to the report you want to generate.

For example, click the ® next to Root, the * next to Device Monitoring, and then click Anti-Virus.
The Report Explorer displays the reports in the Device Monitoring > Anti-Virus category.

3. Click areport, and then select an action to take by clicking the appropriate link in the Actions menu.
For example, click Top Infected Systems and then, on the Actions menu, click Run Report.) The
Run Ad Hoc Report dialog box opens, displaying the selected report.

For a complete list and description of reports available on Logger, see "Logger Content" on page 555.
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Query Explorer

Queries comprise query objects (or parameters). You can use the Query Explorer to create new queries
and view or edit existing queries.

To access queries from the Query Explorer:

1.

From the Logger navigation bar, click Reports, then, under Navigation, click Query Explorer. The
Query Objects pane opens to the right of the navigation pane. It displays the existing categories
under which you can find existing query objects and store newly created objects.

Navigate to the desired location using the * arrows.

For example, click the * next to Root > SANS Top 5 > 5 - Suspicious or Unauthorized Network
Traffic Patterns.

The Query Explorer displays the query objects in the SANS Top 5 > 5 - Suspicious or
Unauthorized Network Traffic Patterns category.

Click a query, and then select the action to take by clicking the appropriate link in the Actions
menu.

For example, click Top Ten Types of Traffic and then click More.

Parameter Explorer

Queries comprise parameters (or query objects). You can use the Parameter Explorer to create new
parameters and view or edit existing parameters.

To access parameters from the Parameter Explorer:

1.

From the Logger navigation bar, click Reports, then, under Navigation, click Parameter Explorer.
The Parameter Objects pane opens to the right of the navigation pane. It displays the existing
categories under which you can find existing parameters and store newly created parameters.

Default parameters are shown in the right column.
Navigate to the desired location using the * arrows.

For example, if you click Parameter Explorer > Root, the Parameter Explorer displays the
parameters in the Root category.

Click a parameter in the right column, and then select the action to take by clicking a link in the
Actions menu.

For example, click deviceVendor and then click More.

4. Click Add to Favorites. The selected object is added to the favorites list.

For a complete list of parameters available on Logger, see " Parameters" on page 581.
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Favorites Explorer

For quick access to frequently-used items, you can mark any report, query, parameter, dashboard, or
dashboard widget as a favorite. An item marked as a favorite will be listed in the Favorites Explorer.

Any action that you can perform on an object from its own Explorer can performed from the Favorites
Explorer too. For example, you can run, save, or publish a report published from the Report Explorer. If
you have marked the report as a Favorite, you can run, save, or publish it from the Favorites Explorer
too.

Objects listed in the Favorites Explorer cannot be organized into categories.

To add an object to your favorites list:

1. Navigate to the object in another Explorer. In the Actions menu, click More.

Actions:
Edit Query Details

Create Query Object

ey

2. Click Add to Favorites.

(_l__-) Download Report

View Description

*’ Add to Favorites

fﬁ Delete Report

Less -

To access an object from your favorites list:

1. From the Logger navigation bar, click Reports, then, under Navigation, click Favorites
Explorer.The Favorites pane opens to the right of the navigation pane, displaying any favorites
you have added.

2. Click the desired favorite and then select the action to take by clicking a link in the Actions menu.
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Categories

Reports, queries, and parameters can be organized and stored under categories for ease of access. You

can create your own categories or edit the existing categories’ properties by clicking on the Report
Categories link in the left pane of the Reports Home page.

LookIn [Defau.[Repnr[E |?g.] ié“=J ﬁ X Refresh | Show AlOwners'
Zn
e

Save || Cancel || Delete Cascade
Properties

Public Private [ | Hidden
Category Menu Name Category D |##] System Generated

Objects in each category can be accessed by using the Category Explorer or the appropriate Explorer
for that type of object. For more information, refer to the appropriate Explorer:

¢ "Category Explorer" on page 153

¢ "Report Explorer" on page 154

e "Query Explorer" on page 155

o "Parameter Explorer" on page 155

o "Favorites Explorer" on the previous page

For information on how to run, view, and publish reports, see "Running, Viewing, and Publishing
Reports" on page 179

System-defined Categories

The several categories, based on common areas of usage, come with your system. The Default Reports

> Saved Reports category is for user-created reports. The other categories come with predefined
reports ready for your use. For a complete list of reports in each category, access the category in the

Report Explorer.

Default Reports

User-generated reports are placed in this category.
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Device Monitoring
This category includes the following subcategories.

o Anti-Virus: Use this category to store reports, queries, parameters, dashboards, and dashboard
widgets that provide information on anti-virus activity, such as the anti-virus update status, virus
activity by hour, and top infected systems.

o CrossDevice: These reports provide information on functions that apply fo multiple kinds of devices,
such as failed login attempts, bandwidth usage by hosts, and accounts created by user.

o Database: The report in this category provides information on database errors and warnings.

o Firewall: These reports provide information on firewall activity, such as denied connections by port,
address, and hour.

o Identity Management: This report provides information on the number of connections per user as
reported by the Identity Management devices in your network.

o IDS-IPS: These reports provides information on activity involving Intrusion Detection Systems (IDS)
and Infrusion Prevention Systems (IPS), such as alert count by device, port, severity, top alert
destinations, worm-infected systems, and related metrics.

o Network: These reports provide information on activity involving network infrastructure, including
interface status, device errors, and SNMP authentication failures.

o Operating System: These reports provide information on activity involving operating systems, such
as login errors per user, user and user group creation, and modification events.

o VPN: These reports provide information on activity involving VPN connections, including
authentication errors, connection information such as counts, accepted and denied by address, and
related metrics.

Tip: More reports may be available for download as report packages on the HPE Customer
Support site (SSO). (For information about deploying report packages, see "Deploying a Report
Bundle" on page 243.)

Foundation
This category includes the following subcategories.

o Configuration Monitoring: Logger provides reports that address configuration monitoring.
¢ Intrusion Monitoring Reports: Logger provides reports that address intrusion monitoring.

For example, reports are provided to track password changes, firewall configuration events, firewall
traffic, fop attackers traversing firewalls, and so forth.

¢ Intrusion Monitoring Reports: Logger provides reports that address intrusion monitoring.

For example, reports are provided to track password changes, firewall configuration events, firewall
traffic, fop attackers traversing firewalls, and so forth.

o Netflow Monitoring: Netflow Monitoring reports IP trafficinformation.
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o Network Monitoring Reportfs: Network Monitoring reports describe activities on Virtual Private
Networks.

Logger Administration

This category includes Logger Administration tasks such as Daily Byte Count.

SANS Top 5 Reports

Logger provides reports that address the SANS Top 5 log reports scenarios, all pre-built and available
to run on-demand or schedule for a specified frequency.

The SANS Institute is a cooperative training, certification, and research organization with a focus on
developing solutions for securing information against a variety of potential threats. SANS facilitates
and supports a collaborative effort of a large number of security practitioners in various industries and
sectors around the world to share experience, solutions, and resources related to information security.

Note: SANS stands for “SysAdmin, Audit, Network, Security”. More information is available on their
Web site at www.sans.org

The SANS Top 5 represents the current set of most critical log reports for a wide cross-section of the
security community, and should be reviewed on a regular basis. This quote from the SANS Web site
describes the strategy and focus of the SANS Top 5 Essential Log Reports:

“The goal is to include reports that have the highest likelihood of identifying suspect activity, while
generating the lowest number of false positive report entries. The log reports may not always clearly
indicate the extent of an intrusion, but will at least give sufficient information to the appropriate
administrator that suspect activity has been detected and requires further investigation.”

The SANS Top 5 log reports cover the following five scenarios:

¢ 1- Attempts to gain access through existing accounts

2 - Failed file or resource access attempts

3 - Unauthorized changes to users, groups and services

4 - Systems most vulnerable to attack

e 5-Suspicious or unauthorized network traffic patterns

For a complete description of the SANS Top 5 log reports, see www.sans.org/resources/top5_
logreports.pdf or look for associated topics in SANS resources on their Web site.

The Logger SANS Top 5 Reports offered to address these threat scenarios are:

e SANS Top 5 -1Number of Failed Logins

e SANS Top5-1Top Users with Failed Logins

e SANS Top 5 -2 Failed Resource Access by Users and Drilldown
e SANS Top 5 - 2 Failed Resource Access Events and Drilldown
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e SANS Top5 -3 Password Changes

o SANS Top 5 -3 User Account Creations, Deletions, and Modifications
e SANS Top 5 - 4 Vulnerability Scanner Logs by Host or by Vulnerability
e SANS Top5-5Alerts fromIDS

e SANS Top 5-5IDS Signature Destinations and Source

e SANS Top5-5Top 10 Talkers

e SANS Top5-5Top 10 Types of Traffic

e SANS Top 5-5Top Destination and Target IPs

o SANS Top 5 -1Number of Failed Logins

e SANS Top5-1Top Users with Failed Logins

e SANS Top 5 -2 Failed Resource Access by Users and Drilldown

e SANS Top 5 - 2 Failed Resource Access Events and Drilldown

e SANS Top 5 -3 Password Changes

e SANS Top 5 -3 User Account Creations, Deletions, and Modifications
e SANS Top 5 - 4 Vulnerability Scanner Logs by Host or by Vulnerability
e SANS Top5-5 Alerts from IDS

e SANS Top 5-5IDS Signature Destinations and Source

e SANS Top5-5Top 10 Talkers

e SANS Top5-5Top 10 Types of Traffic

e SANS Top 5-5 Top Destination and Target IPs

Solution Reports

Any solution packages installed on the Logger are listed in separate report groups. Solution packages
address specific compliance requirements or scenarios and are installed separately. Solutions Reports
are available as add-on packages to Logger for specific compliance requirements or scenarios.

Note: You must log into Logger and open the Reports page at least once before installing any
Solutions package.

The available solution packages include:

e |ITGov (ISO 27002 & NIST 800-53 based reports)
e Payment Card Industry, (PCl based reports)
e SOX (Sarbanes-Oxley compliance reports)

For information on deploying Solutions Packages, see "Deploying a Report Bundle" on page 243. Once
deployed, these solution reports are listed in categories under the Solution Reports report group. To
access these reports (once deployed), click Reports | Solutions Reports |<report category name> on
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the left menu, where <report category name> is the solution name, for example: Payment Card
Industry.

For more information on report categories, including how to edit them, see "Report Categories" on
page 248,

Dashboards

Dashboards display reporting data to provide a quick view of the latest information about network

events. You can assemble various reports and external links onto a dashboard. However, you must place

each report or link info its own widget and then place the widget in the dashboard. A dashboard can
contfain multiple widgets.

Placing reports on a dashboard gives you access to the most recently published results for those
reports. Keep in mind, reports must be run and published in order for the results to be accessible on a
dashboard viewer. If you schedule a report to run, publish, and save for a reasonable retention period
(for example, one month), then those results will always be available for dashboard views.

For example, you can add one or more reports to a dashboard, and configure reports to auto-refresh on

a specified interval (for example, every hour). The dashboard will access the latest published reports
results, in this case, every hour.

If you have also scheduled the reports to run and publish every hour, your dashboard will show current
results. This eliminates the need o manually run and view each report once per hour in order to retrieve

the same information updates.

o Viewing Dashboards ... . o 162
e Designing Dashboards .. ... 163
e Creafting a New Dashboard ... L 163
¢ Viewing Dashboards in the Dashboard Viewer ... . . 164
e Removing an Existing Tab from the Dashboard Viewer ... . ... 164
e Deleting a Dashboard ... .. 165
e Editing an Existing Dashboard ... . .. 165
e Selecting a Default Dashboard View for the Reports Home Page ....... ... ... oo i...... 165
e Using Classic Dashboards . ... ... o 166

Note: To view or edit Dashboards created in older versions of Logger, see "Using Classic
Dashboards" on page 166.
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The process for configuring dashboards consists of these tasks:

1. Create a new dashboard. See "Creating a New Dashboard" on the next page for details.

2. Create one widget for every report or web link you want to display on the dashboard. See "Creating
a New Widget" on page 175 for details.

3. Add the widgets to the dashboard. See "Placing Widgets in a Dashboard" on page 178 for details.

4, Optionally, you can configure the dashboard to display as a tab in the Dashboard Viewer. See
"Viewing Dashboards in the Dashboard Viewer" on page 164 for details.

Viewing Dashboards

If a dashboard is configured and selected for display, it is shown on the Dashboard Viewer page, and
serves as the Reports Home page. If you are viewing other pages within the Reports page, click
Dashboard on the left panel to return to the Dashboard Viewer (Reports Home page).

Note: If no dashboard is configured and selected for display, the default Reports home page shows
an empty Dashboard Viewer.

Reports must be run and published first in order for the results to be accessible in a dashboard viewer.
(Reports cannot be run from the Dashboard Viewer but may be viewed there.)

You can set a dashboard to auto-refresh at a certain interval, but auto-refreshing a dashboard simply
updates the dashboard display with the most recently published results, not run the report. Use the
dashboard refresh interval in conjunction with scheduled reports to ensure that report results are
always published and retained long enough fo be available to dashboards. For more information, see
"Designing Dashboards" on the next page and "Scheduled Reports" on page 192.

The Dashboard Viewer page displays the all items placed on the dashboard. If the dashboard includes
reports, reports will show current data from recently run reports.

Dashboards created in pre-5.2 Logger can be viewed and edited from the Classic Viewer, Classic
Designer, and Classic Preferences links. See for information on how to view or edit dashboards
created in pre-5.2 Loggers.

Note: Do not use these links to create new dashboards. Use the Dashboard Viewer link to create
new Dashboards. See "Designing Dashboards" on the next page for details.

Working with Available Dashboards

The set or subset of dashboards shown under Available Dashboard(s) is based on your user group
status. For example, it is likely that a user with Administrative status will be able to see more or all
dashboards than a user with fewer privileges.
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Designing Dashboards

Use the Dashboard Viewer page to create a new dashboard, name it, add items to it, and design the
layout. You can design and save multiple dashboards, but only one at a time can be set as the default
Dashboard Viewer for the Reports home page. Other dashboards can be saved for later use. Each
dashboard can include multiple items (reports, use cases, and Web links).

To access the Dashboard Viewer, click the Dashboard link in the left pane.

What Items Can a Dashboard Include?

The following information is available for placement on a dashboard. However, each report or Web Link
must be placed inside a widget and the widget in turn is placed into the dashboard. A dashboard can
contain one or more widgets containing either of the following:

e Reports: any report can be included. The dashboard will show the latest published version of the
report. Reports must be published in order for the report data to be accessible to users on the
Dashboard View. If no published results are available for a report on a dashboard, the Dashboard
View will display a message indicating this. When the report is published, a refresh of the Dashboard
view will display the report.

o External Links: any external URLs that you want included as a part of a particular Dashboard View.

Creating a New Dashboard

The high-level steps to create a dashboard are described here. A detailed explanation of each of these
steps is provided in the topics that follow. The Reports home page opens with the Dashboard Viewer
open.

To add a new dashboard:

1. In the navigation pane, click Dashboard. This opens a new empty dashboard tab with the name
“Untitled”.

2. Click Dashboard Options 2 and pick Switch to Edit Mode.
3. To place items onto the dashboard, in the right corner, click Add Widget.

Untitled * | + Settings | AddWidget ~ Save ~ |
% |55 [x]

;iﬂn[’\rvirus }J[rnssnwi[! Jna[ahis! }]ﬁr!wa ;’\dm[’\[y }]\nsrws ;’N!twnrk

(e [= (e [= (2 wanagement [= =

/iﬂu!ra['\ngiys[em /]vw

(e [=

4, Select a widget and click-and-drag it onto the dashboard.
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5. For each widget placed, specify Widget Properties, as needed.

Note: By default, a scroll bar is not available in the Dashboard for external links. To include a
scroll bar, set the “Show Scrollbar” property to “Yes” in the Widget Properties section of
“External Links” under Dashboard Items.

6. Click Save to save the dashboard.

Once saved, new dashboards become available in the Dashboard Preferences list of “Available
Dashboard(s)”.

See "Dashboards" on page 161 for information on how to display the new dashboard you just created or
set the default display to a different dashboard.

Viewing Dashboards in the Dashboard Viewer

To open one or more dashboards as tabs in the Dashboard Viewer:

Click the Dashboard Preferences link on top of the Dashboard Viewer page.

In the Available Dashboards box, navigate to the dashboard that you want o display in a tab.
Click +. The dashboard name is displayed in the Selected Dashboard box.

Click Save.

Click the Dashboard link in the left panel to display the Dashboard Viewer. The dashboard you
selected is displayed.

o PR W

Note: The set or subset of dashboards shown under Available Dashboard(s) is based on
your user group status and the selection status of Show All Owners' checkbox. A user with

Administrative rights is able to see more or all dashboards than a user with fewer privileges. If
you limit the view to only your dashboards, the list will not include dashboards designed by
other users.

To access dashboards from all users (designers), select the Show All Owners checkbox.

To view only your dashboards, deselect this checkbox.

Removing an Existing Tab from the Dashboard Viewer

To remove an existing tab from the Dashboard Viewer without deleting the dashboard
from its saved location:

1. Click the dashboard title, and then click Delete.
2. Click OK to confirm deletion.
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Deleting a Dashboard

You can delete an existing dashboard from the Dashboard Viewer.

To delete the dashboard from the Dashboard Viewer:

1. Select the Dashboard, then click Settings.

2. Select Switch to Edit Mode.

3. In Edit Mode, select the down arrow next to the Dashboard title and click Delete.
4

. In the Remove Tab dialog, check the Remove this dashboard from saved location checkbox and
click OK.

Editing an Existing Dashboard

To modify an existing dashboard:
1. Click Settings, and then pick Switch to Edit Mode. Its current configuration is displayed and you
can modify then save settings as needed.

2. The Properties area displays basic dashboard settings. To automatically refresh a dashboard at a
regular interval, check the Auto-refresh every checkbox and specify the automatic refresh fime in
terms of minutes in Min(s). Check the Prompt on First Run checkbox to display the Input

Parameter Form, which shows the values of the Dashboard parameters before reports are run
from the dashboard for the first time after they have been displayed on the dashboard.

3. The Layout area enables you to select panes for the dashboard.
4. The Information area displays Description, Scope and Location where the dashboard is saved.

5. The Dashboard Parameters area shows formatting parameters (Maximum Columns and Column
Width).

Selecting a Default Dashboard View for the Reports Home
Page

If you have multiple dashboards open in tabs in the Dashboard Viewer, you can set one of the
dashboards to display as the default dashboard for the Reports home page.
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To set a default dashboard:

1. Click the Dashboard Preferences link on top of the Dashboard Viewer page.

2. In the Selected Dashboards box, click the radio button corresponding to the dashboard that you

would like to display as the default dashboard on the Reports home page. Click the up arrow to
move that dashboard to the top of the list.

3. Click the Save button.

4, Click the Dashboard link in the left pane and your selected dashboard will show as the default tab
(the first tab).

The Dashboard Preferences page has the following fields:

Field Description

Show All Owners To display all dashboards made by all the users in the Available Dashboard(s)
box, check the Show All Owners' checkbox.

Available Dashboards This box shows a list of all dashboards that are available for display in the
Dashboard Viewer.

Selected Dashboards Move the dashboards you want to display in the Dashboard Viewer from the
Available Dashboards list fo the Selected Dashboards box. Dashboards listed in
this box will be displayed as tabs in the Dashboard Viewer.

Using Classic Dashboards

This section is only applicable to existing dashboards that were created in versions of Logger earlier
than 5.2. To create, edit or view new dashboards, follow the instructions in "Dashboards" on page 161.

Viewing a Classic Dashboard

To view the dashboard, click the Classic Viewer link on top of the Reports page. If no dashboard is

configured and selected for display, the default Reports home page shows the My Reports page that
lists the status of recently run or accessed reports.

To set a dashboard as the default Dashboard View:

1. Open the dashboard in the Classic Designer.

2. Select the Add to My Preferred List checkbox.

The Classic Viewer page displays the contents of various items placed on the dashboard during the
dashboard’s design time. If the dashboard includes reports, reports will show current data from recently
run reports.
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Reports must be run and published first in order for the results to be accessible on a dashboard view.
There are no options available to run reports from the Dashboard view. On a Dashboard view, you can
view saved or published reports but not run them.

Tip: A refresh or auto-refresh on a dashboard simply updates the dashboard display with the most
recently published results, but does not run the report. Use the dashboard refresh interval in
conjunction with scheduled reports to ensure that report results are always published and retained
long enough to be available to dashboards.

Designing Classic Dashboards

Use the Classic Designer page to edit the dashboard, add items to it, and change the layout. Each
dashboard can include multiple items (reports, use cases, and Web links).

What Items Can a Classic Dashboard Include?

The following information is available for placement on a dashboard:

¢ Reports: any report can be included. The dashboard will show the latest published version of the
report. Reports must be published in order for the report data to be accessible to users on the

Dashboard View. If no published results are available for a report on a dashboard, the Dashboard
View will display a message indicating this. When the report is published, a refresh of the Dashboard
view will display the report.

¢ Common Use Cases, including a Report List, Saved Report List, Health Monitor, Recent Run Report
List, Quick Job List, Schedule History, and Audit Log: These are provided as dashboard elements so

that users access a use case without leaving the Dashboard View page.

o External Links: Any URLs that you want included as a part of a particular Dashboard View

Creating a New Classic Dashboard

Do not use the Classic Designer page to create new dashboards. Create new dashboards using the
Dashboard Viewer link. See "Dashboards" on page 161 for more information.

Placing Ifems on an Existing Dashboard

To place an item on a dashboard, click the Classic Preferences link. In the Widgets provided in the
Layout areg, click-and-drag an item from the Dashboard Items list on the left into an empty widget to
the right. Alternatively, click ] next to the dashboard item you want to place the item on an empty
widget.

You can also click-and-drag an item onto a currently occupied widget if you want to replace an itemin a
widget with a different one.
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To add a new widget, click = (Divide Widget Horizontally) or [ (Divide Widget Vertically) on a
widget to split it into two widgets. The original widget remains a new empty widget is placed on the
dashboard layout.

For each item (widget) placed, specify Widget Properties, as needed.

By default, a scroll bar is not available in the Dashboard for external links. To include a scroll bar, set the
“Show Scrollbar” property to “Yes” in the Widget Properties section of “External Links” under
Dashboard Items.

Dashboard Properties
The Dashboard Properties are described in the following table.

Dashboard Properties Description
Property  Description
Name Name of the dashboard

Description Descriptive information about this dashboard

Placing Dashboard Items on the Layout

Click the Classic Designer link on the Reports page. Reports, use cases, and external link objects are
available under Dashboard Items (io the left of the Layout area).

To place a dashboard item, click fo expand the menu for the type of item you want, click-and-drag an
item onto a widget in the Layout area, and specify widget properties as needed. (Widget properties vary
depending on the type of item you place on the dashboard.)

The following sections provide more detail on placing each type of dashboard item and setting
appropriate widget properties.
Placing a Report on a Dashboard

The following sections describe in detail how to place and configure reports on dashboards, including
setting widget properties, report parameters, and dashboard parameters.

A dashboard can only be used to view results of previously saved, published reports. A refresh or auto-
refresh on a dashboard simply updates the dashboard display with the most recently published results,
but does not run the report.

Therefore, reports on dashboards must be run, saved, and published in order for the report data to be
viewable on the Dashboard view. If a report on a dashboard has not been saved or published, its widget
will display an error message on the Dashboard view the report data is not available to the dashboard.
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To place a report on a dashboard:

1. Under Dashboard Items, click Reports bar to expand the list of available reports.

2. If available, select a Reports submenu. (Different reports are displayed depending on the submenu
you select.)
Optionally, select the Saved Reports checkbox to display a list of saved reports.

3. Select a category to view reports deployed in that category.

4. Click and drag the report to the widget in which you want to place the report. Alternatively, click [#]
next to the dashboard item you want to place the item on an empty widget.
The report name is displayed in the widget in the Layout area.

5. Set Widget Properties for the report.
The following table describes Widget Properties settings for Reports dashboard items.

Note: By default, a scroll bar is not available in the Dashboard for external links. To include a scroll

bar, set the “Show Scrollbar” property to “Yes” in the Widget Properties section of “External Links”
under Dashboard Items.

Widget Properties for Reports on a Dashboard

Property Description

Report Name The name of the report that occupies this widget.

Refresh Interval Report refresh will take place at the end of specified number of minutes. For example, if you
(in minutes) want the report results to refresh every 15 minutes, set the Refresh Interval to 15.

Note: Reports must be run and published first in order for the results to be accessible
on a dashboard view. A refresh or auto-refresh on a dashboard simply updates the
dashboard display with the most recently published results, but does not run the
report. Use the dashboard refresh interval in conjunction with scheduled reports fo
ensure that report results are always published and retained long enough to be
available to dashboards. (See also, "Scheduled Reports" on page 192.)

Format Output format in which you want to view the report. Available options are:

e HTML
e Acrobat PDF
e Interactive HTML
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Widget Properties for Reports on a Dashboard, continued
Property Description
Auto Refresh Enables or disables auto-refresh option.

o Select Yes to refresh the reports at the Refresh Interval.

e Select No to view the report generated when dashboard was loaded for the first fime.

Note: Reports must be run and published first in order for the results to be accessible

on a dashboard view. A refresh or auto-refresh on a dashboard simply updates the
dashboard display with the most recently published results, but does not run the

report. Use the dashboard refresh interval in conjunction with scheduled reports fo
ensure that report results are always published and retained long enough to be

available to dashboards. (See also "Scheduled Reports" on page 192.)

Toolbar Specifies Toolbar settings.

o Select Yes to always show toolbar.

o Select No to never show the toolbar.

o Select Multipage to show the toolbar only for multi-page reports.

The Multipage setting is applicable to HTML and Interactive output formats.

Instance Navigation Sets whether to include a report navigation feature on the dashboard.

o Select Yes to provide a pull-down menu that allows Dashboard users to select a saved

report and view it.

o Select No if you do not want to provide this feature on the dashboard.

Link Widgets Click _I to display the Link Widget dialog in which you can specify a link from any of the
charts in the report in this widget to another widget.
See "Linking Widgets" below.

Description Description of the widget.

Linking Widgets

You can link a widget that contains a report (although, not saved reports) to another widget. The

widget that is the link target can contain a use case, a report, or external link.

To link a chart in a report to data in another widget:

1. Select a widget in which you want to provide a link. (The widget that is the link “source” must

contain a report with a chart on it).

2. Under Widget Properties for the selected widget, click o] to display the Link Widgets dialog in
which you can specify a link from any of the charts in the report o another widget. (The widget

that is the target of the link can contain a report, use case or external link.)

3. Inthe Link Widget dialog, select an Item (chart series) from the Item(s) and select (link) it o an item

in one of the other Widgets.
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4. Click I* (add button) next to “Series” to add another row to specify another set of link information
in the same report with a different widget/series combination.

To remove a row, click * (delete button) next to the row you wanft to remove.

5. Click OK to save the settings and close the dialog.

Placing a Use Case on a Dashboard

The following sections describe in detail how to place and configure use cases on dashboards.

To place a use case on a dashboard:

1. Under Dashboard Items, click Use Cases bar to expand the list of available use cases.

2. Click and drag a use case o the widget in which you want fo place it. Alternatively, click #] next to
the dashboard item you want to place the item on an empty widget.

The use case name is displayed in the widget in the Layouft area.

3. Set Widget Properties for the use case.

Widget Properties for Use Cases
The following table describes Widget Properties settings for Use Case dashboard items.

Widget Properties for Use Cases on a Dashboard

Property Description

Name The name of the use case that occupies this widget.

Refresh Interval This is the time in minutes. The external link page is refreshed at the specified interval.
(in minutes)

Auto Refresh Enables or disables auto-refresh option.

o Select Yes to refresh the use case as per Refresh Interval.

o Select No fo execute only once, when the dashboard is loaded.

Show Scroll Bar Select Yes to add a scroll bar if the use case does not fit in widget width.
Description Description of the widget.
Category This opftion is displayed when Report List, Saved Report List or Quick Job List is placed on

widget. Select the category to carry out respective task (get a list of reports in selected
category, display a list of saved reports or quick job lists for the selected report).

Report This option is displayed when Saved Report List or Quick Job List is selected. Select the
report for which saved report list or quick job list is to be viewed.

The use cases displayed in the list will depend on the permissions associated with your user group.
Other properties are displayed based on the use case.
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Placing an External Link on a Dashboard

The following sections describe in detail how to place and configure an external link on a dashboard.

To place a link on a dashboard:

1. Under Dashboard Items, click External Links bar to expand the list.
2. Click and drag an External Link URL object to the widget in which you want to place it.
Alternatively, click *| next to the dashboard item you want to place the item on an empty widget.

The External Link URL object is displayed in the widget in the Layout area.
3. Set Widget Properties for the URL.

The following table describes Widget Properties settings for External Links dashboard items.

Widget Properties for External Links on a Dashboard

Property Description

Name The name of the external link that occupies this widget.

Refresh Interval This is the fime in minutes. The use case page is refreshed at the specified interval.
(in minutes)

Auto Refresh Enables or disables auto-refresh option.

o Select Yes fo refresh the URL as per Refresh Interval.

o Select No to execute only once, when the dashboard is loaded.

Show Scroll Bar Select Yes to display a scroll bar if external link does not fit in widget width.
Description Description of the widget.
URL Specify the URL for this widget.

If you want to add mulfiple Web pages fo the dashboard, use a different widget for each
URL.

Selecting a Dashboard View

Once you have created one or more dashboards, you can select one of them as the default display for

the Dashboard View page, which also serves as the Reports home page. Only one dashboard at a time
can be displayed as the default dashboard view.

Tip: You must have at least one dashboard in order to set a preference for the Dashboard View.

You can also set a dashboard as the “Selected Dashboard” (default dashboard view) in the Dashboard

Designer by enabling the Add to my preferred list, as described in "Viewing a Classic Dashboard" on
page 166.
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To select a default Dashboard View for the Reports home page:

1. Navigate to Dashboard > Preferences.

2. Select a dashboard from the Available Dashboard(s) list and click the right arrow button 2o
move it into the Select Dashboard(s) list for display. Only one dashboard can occupy the “Selected
Dashboard(s)” list at any one time.

3. Click Save to save your preferences and display the selected dashboard.

To remove or change the currently displayed dashboard:

1. Return to the Classic Preferences page.
2. Move the currently selected dashboard out of the Select Dashboard(s) list by selecting it and
clicking the left arrow button i

3. Choose a different one to display if so desired (or none).

4. Click Save to save your preferences.

Creating Widgets
Each dashboard item must be placed in its own widget for display on the dashboard.

Create new widgets using the Widget Designer link.

To add a new widget:

To add a new widget, click =l (Divide Widget Horizontally) or ktl (Divide Widget Vertically) on a widget
to split it into two widgets. The original widget remains a new empty widget is placed on the dashboard
layout.

To remove a widget:

To remove a widget, click Remove Widget, located on the top right corner on the widget you wanft fo
remove.
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Swapping Ifems on Widgets

You can swap items placed in widgets. To do this, click and drag the item to the widget where you want
to place it.

Click and drag an item to a different widget to
swap placement of the two items on the page.

Layout
Widgetl{Use Case) -84 x|

Click and drag "Recent Run Reports
List” to the widget below it to swap
Its place with External Link [tem.

Recent Run Report List

W

Widget2( e Case) +| 4] x| | wi (External Li 3 4] x|/

i S

Health Monitor http: //www.arcsig

Click and drag "Health
Monitor” to the widget above
it to swap it into the top
pasitian.

In the above example, the Recent Run Reports List item is swapped to the position of the External Link
URL, which is then swapped with the Health Monitor item, which will end up at the top of the
dashboard.

Setting Classic Preferences

In the Classic Preferences page, you can specify the dashboard to be made available for viewing. Use
the arrows to move the desired dashboards.
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Widgets

A widget is a mechanism for the display of data. After you have created a new dashboard, you will need
to add one or more widgets to display your reports or web links. A widget is designed in the Widget
Designer. Each dashboard item must be placed in its own widget for display on the dashboard. A widget
can be placed on multiple dashboards.

o The Widget DeSigNer . 175
e Placing Widgetsin a Dashboard ... .. .. 178
e Moving an Existing Widget within a Dashboard ... .. .. ... 178

The Widget Designer

The Widget Designer enables you to create a new widget, save a widget, edit a widget, or delete a
widget. You can place a report or a web link (an external link) into a widget. Each widget can contain
only one object.

Creating a New Widget

To open the Widget Designer page and create a new widget, above the Dashboard Viewer, click Widget
Designer.

On the Widget Designer page, you can choose what to place in the widget, a report, or a web link.

You cannot run reports from a Dashboard view. You can only view results of previously saved,
published reports. A refresh or auto-refresh on a dashboard simply updates the dashboard display with
the most recently published result, but does not run the report. Therefore, reports on dashboards must
be run, saved, and published in order for the report data to be viewable on the Dashboard view. If a
report on a dashboard has not been saved or published, its widget will display an error message on the
Dashboard view the report data is not available to the dashboard.
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Add New Save Save As Open Cancel

Widget Narme:

Contents: (8) Report Web Link

Pre-generated

Widget Contents

Report: | (Select Report) .
By Job: | (Select Job) - [ | Lookin User's All Jobs
InCategory: | (Root) . [ | User's Working Folder

Widget Properties

Report Format: | HTML r
Viewer Toolbar: | On Multipage ¥

Instance Navigation:

Auto Refresh: | Yes ¥

Refresh Interval: ® Min(s) Sec(s)
Width: D

Height:

]

To create a Report widget:

Click the Report radio button on the Widget Designer page to place a report in the widget.
Note: You can only add reports that have already been run and published.

In your widget, you can include the last published instance of the following:

e A report: You need not make any selection in the Report field, By Job or In Category.

o A specific report: Navigate to the report in the Report field. You can leave the By Job and In
Category fields blank.

o A report executed by a specific scheduled report job: Navigate to the job in the By Job field. You can
leave the Report field and the In Category field blank.

e A report deployed in a specific category and executed by a specific job: From the In Category field,
navigate to a category and navigate o a job in the By Job field.

o Any of the reports from the jobs you own: You own the jobs that you created or were created on
your behalf. Check the Look in User's All Jobs checkbox.

e Any of the reports deployed in your default category: Check the User's Working Folder checkbox.
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Specify the following widget properties:

Label Description

Widget Name Enter a name for the new widget fo be created.

Report Format Select the format in which you would like the report displayed.

Toolbar Select whether you want a toolbar displayed and whether you want it displayed on all

pages if this is a multi-page report.
Instance Navigation Sets whether to include a report navigation feature on the dashboard.

e Select Yes to provide a pull-down menu that enables Dashboard users to select a saved
report and view it.

o Select No if you do not want to provide this feature on the dashboard.

Auto Refresh Set to Yes, if you want the report to refresh automatically after a certain interval, and then
set the Refresh Interval parameter.

Refresh Interval This is the time in minutes. Refresh will take place at the end of specified number of
minutes. For example, if you want the report results to refresh every 15 minutes, set the
Refresh Interval to 15.

Width Select the width of the widget in pixels. You can select only whole numbers (no decimals
allowed)
Height Select the height of the widget in whole pixels (no decimals allowed)

To create a Web Link widget:

Click the Web Link radio button on the Widget Designer page to place a web link in the widget.

Widget Name:

Contents: Report  (» Web Link

Widget Contents

URL:

Widget Properiies

Show Scrolibar:

Auto Refresh:
Refresh Intervak: ® Min(s) Sec(s)

Wwidth: D

Height: D
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Specify the following properties:

Label Description

URL Specify the URL for the external link of the page that you want to display in the widget
Show Scrollbar Select whether you want a scroll bar in the widget. By default, the scrollbar is visible.

Auto Refresh By default, the web page will be automatically refreshed. Select No if you want to turn this

feature off.

Refresh Interval This is the fime in minutes. Refresh will take place at the end of specified number of
minutes. For example, if you want the web page to refresh every 15 minutes, set the Refresh
Interval to 15.

Width Select the width of the widget in pixels. You can select only whole numbers (no decimals
allowed).
Height Select the height of the widget in pixels. You can select only whole numbers (no decimals
allowed).
Deleting a Widget

To delete a widget, open the widget in the Widget Designer and click the Delete button on top of the
Widget Designer page. When a dashboard uses a widget that is deleted, an error message explaining

that the widget has been deleted is displayed in the widget on the dashboard.

Editing an Existing Widget

Click the Widget Designer link to open it. Click the Open button on top of the Widget Designer page
and select the widget that you want to edit. After editing it, click the Save button.

Placing Widgets in a Dashboard

Reports and Web Link (external link) objects are available to be placed on a dashboard. However, these
objects must first be placed in a widget and then the widget can be added to the dashboard.

1. With the report in Edit Mode, click the Add Widget button on the upper right corner of the empty
dashboard page.
2. Navigate to the widget you want to place on the dashboard and click-and-drag it to the dashboard.

3. Repeat steps 1and 2 to add more widgets.

Moving an Existing Widget within a Dashboard

To move an existing widget on a dashboard, hover your mouse over the top boundary of the widget.
The widget name bar will drop down. Click the widget name bar and drag it to move the widget to the
desired location on the dashboard.
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Running, Viewing, and Publishing Reports

Reports are available under their respective categories. (See "The Explorers" on page 150.)

You can run, view, and publish reports you create, as well as reports in categories for which the
administrator has given you user access rights. You can run up to 5 ad hoc reports or up 10 scheduled
reports, concurrently.

Tip: There are no options available to run reports from a Dashboard viewer. On a Dashboard
viewer, you can view saved or published reports, but not run them.

® Best PractiCes il 179
o FiNdiNg REPOITS il 179
e Task Options on Available Reports ... . L 180
e Running and Viewing RepOrTS . 181
e Running a Report Manually ... 182
o PUbIiShing REPOITS 187
e Report Delivery OptioNS .o 189
e Viewing the Output of a Published Report ... .. 191

Best Practices

Logger is designed to process events while running a report, but event processing has priority. Running
a complex report while the event processing system is under load will result in report timeout rather
than dropped events.

To effectively manage demands for system resources, HPE recommends using the Scheduled Report
feature so that reports run during periods of light load. If an ad hoc report must be run, run it when the
system is not under load.

For information on working with scheduled reports, see "Scheduled Reports" on page 192.

If you are running a distributed report, also see the best practices discussed in "Selecting Device Groups,
Storage Groups, Devices, or Peers" on page 184.

Finding Reports

You can find reports on the following pages within the Reports page:

o Category Explorer

o Report Explorer
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o Favorites Explorer (if you have marked the report as a Favorite)

o Scheduled Reports page (if the report you are looking for is a scheduled report and it has been run
and published)

e The Recent Reports link on top of any Reports page.
Viewing Recently Run Reports

To view the most recently run reports, click the Recent Reports link on top of the Reports page. Click
on the radio button next to a report to select it.

Dashboard Viewer Dashboard Preferences Widget Designer Recent Reports Jobs Execution Status Classic Viewer Classic Designer Classic Preferences

~ ! Recent Reports
L4

Sr.No. Report Name Category Name Time Stamp
1 @) Top Users with Failed Logins 1 - Attempts to Gain Access through | 08/26/2016 16:02:59
2 @ Dpatabase Errors and Warnings Database 08/26/2016 16:02:17
3 O Traffic Statistics Network Monitoring 08/26/2016 16:00:12
4 User Administration Operating System 08/26/2016 15:58:45

~ ! Report Execution Status

~ | Filters Category Name [(All}] | Report Name [(All] | Execution Type [{Al)] | Status [(AL)] | User [ArcSight/admin]
Select Report(s) [ {Root) | E.] Execution Type = Status =
Select Owner | ArcSight El |admin El
Date From |oBr26r2016 |Em w0 |osrze2016 | =
Refresh
5r.Mo. Report Name Action Execution Type Completion 5tatus Completion Date

After you select a report, the Run '=!/ and the Re-Run ‘¥ buttons are displayed in the top left corner.

You can run the selected report using the same filter options as the original run by clicking the Run
button, or you can run the selected report using different field values by clicking on the Re-Run button.
See "Run Report Parameters" on page 185 for details.

Task Options on Available Reports

Your access to various reports and report options (view, publish, edit, etc.) depends the access rights
associated with your user role and Logger Report Group affiliation. For example, depending on your
access rights, you may have privileges to view some reports but not others, to view but not schedule or
publish a report, or to view and schedule but not edit a report.
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Access rights to report options are configured and managed with the User/Groups option on the

System Admin page. For more information on setting permissions and on Logger Report Group
management, see "Setting Access Rights on Reports" on page 218.

The following sections describe details of running and viewing reports, setting report parameters on a
report run, and the various options for working with report output.

Running and Viewing Reports

To begin run and view reports, choose a report category in the Report Explorer, and then choose a
report within the category. See "Report Explorer" on page 154.

About the Pagination of Reports

The default view option for the report results is Multipage. If Multipage is deselected in the View
Options link, your report will be formatted as a single page. HPE strongly recommends using the
Multipage option for all reports. Specifically, if a report will result in more than 826 records, using the
Multipage option will ensure that the generated report is not blank. By default, PDF reports are set by
default to use the Multipage option. However, if your PDF format report is blank, ensure that the
Multipage option is still checked for that report.

If a report contains more columns than can be displayed horizontally using the default width specified in
the report query, the report is paginated horizonftally, such that additional columns are displayed on the
following pages. For example, if a report contains 45 columns and only 5 can be displayed at once, the
report would be paginated such that Page 1displays columns 1through 5, Page 2 displays columns 6
through 10, and so on. Consequently, if the report contained more rows than can be displayed vertically,
the second group of rows would be displayed starting at Page 10.

Currently, Logger limits the number of pages for horizontal pagination to 10. As a result, if a report
requires more than 10 pages to display all columns, complete report results may not be displayed. To
view all columns of such reports, manually set the width of each column such that all columns fit in 10 or
less pages in the report query (in the Query Object Editor).

About Running a Report

Reports can be run from any of the following Explorers:

o Category Explorer

Click a category in the Repository column, click Reports, select a report in the Reports column and
click Quick Run with default options, Run in Background, or Run Report. Then, set the

parameters and click Run Now, Run in Background, or Run button depending upon what type of
run you chose.

o Report Explorer
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Click a category in the Reports column, select a report in the next column, and click the Quick Run
with default options, Run in Background, or Run Report buttons. Then, set the parameters and
click Run Now, Run in Background, or Run depending upon what type of run you chose.

o Favorites Explorer (if you have marked the Report as a Favorite)

Click on a report in the Favorites column and click Quick Run with default options, Run in
Background, or Run Report buttons. Then, set the parameters and click Run Now, Run in
Background, or Run depending upon what type of run you chose.

Note: Even if you selected Run Report initially, you can run a report in the background after
setting the Run Report parameters.

The report output is displayed in the specified format (such as HTML or PDF).

At this point, the results of this report generation is available as a file for viewing only by you. If you
close the file without saving or publishing it, the results are no longer available.

If you want to make the results of this run available for others, you need to publish it. To do this,

leave the file open, click Publish Report, available in the button bar located on top of the report, and
follow the steps in "Publishing Reports" on page 187.

For information about other delivery options available to you at this point, see "Report Delivery
Options" on page 189.

Running a Report Manually

To run a report manually:

1. Click the Report Explorer in the left pane.

2. Click the category in which the report is stored.

3. Select the report.

4. Click the Run Report, Quick Run with Default Options, or Run in Background button.

Quick Run with Default Options or Run In Background Report
Parameters

When you click either the Quick Run with default options or the Run in Background button, the
report will run with the data filters specified in the deployed report. Options are available to select
additional filters on time frame and constraints, such as Device Groups, Storage Groups, Devices, and
Peers.

You can also run a distributed report: a report that also includes matching events from the specified
peers of a Logger. You select the peers on which the report should run in the Peers list, as shown in the
following figure. If no peers are configured, the Peers list contains only the localhost IP address
(127.0.0.1). However, if peers are configured, their IP addresses are listed.
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Device Type:

Al v

Additional Filters

Start $Now - 2h [# Dynamic

End ENow @ Dynamic

Scan Limit 100000
! Local Only

Use ctrl-click to select or deselect items

Device Groups Storage Groups
There are no Device Groups to display

3

Default Storage Group -
Internal Event Starage Group

Devices Peers (To include peers, uncheck Local Only)
Logger Internal Event Device

Logger Internal Event Device [Apache URL Access Error Lo
Logger Internal Event Device [Audit Log]

I_namar Intarnal Fyrant Novire MWar | nm Maccanac]

]

There are no Peers to display -

The following table describes Quick Run with default options or Run in Background report parameters.

Quick Run with default options / Run in Background Report Parameters
Option Description
Start Specify the starting point for the data gathering from the events database.

By default, the start time is specified with a dynamic data expression ($Now - 2h).

You can modify the dynamic expression to specify a different dynamic start time, or disable
Dynamic and use the calendar options to specify a fixed start fime.

End Specify the ending point for the data gathering that is some time after the starting point.

Keep in mind that large time spans can mean large amounts of data, which can affect
system performance.

By default, the end time is specified with a dynamic data expression ($Now).

You can modify the dynamic expression to specify a different dynamic end time, or disable
Dynamic and use the calendar options to specify a fixed end time.
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Quick Run with default options / Run in Background Report Parameters, continued
Option Description
Scan Limit Specify the number of events to scan.

When you specify a scan limit, the number of events scanned for manually run reports is
restricted to the specified limit. Doing so results in faster report generation and is beneficial
in situations when you only want to process the latest N number of events in the specified
fime range instead of all the events stored in Logger.

The scan limit is 100,000 by default. If you set the scan limit to O (zero), all events are
scanned.

This setting does not apply to the scheduled reports.

Device Groups Select any device groups on which to run the report query, if any. (See "Selecting Device
Groups, Storage Groups, Devices, or Peers" below.)

Storage Groups Select any storage groups on which to run the report query. (See "Selecting Device Groups,
Storage Groups, Devices, or Peers" below.)

Devices Select any devices on which to run the report query. (See "Selecting Device Groups, Storage
Groups, Devices, or Peers" below.)

Peers Select the peer Loggers on which fo run the report query. If no peers are configured on the
Logger, this option only lists the localhost IP address (127.0.0.1). However, if peers are
configured, their IP addresses are listed. (See "Selecting Device Groups, Storage Groups,
Devices, or Peers" below.)

Selecting Device Groups, Storage Groups, Devices, or Peers

You can select or deselect items on Device Groups, Storage Groups, Devices, or Peers as a part of
setting the Quick Run with default options or Run in Background parameters.
o Only highlighted (selected) items will be included in the report query when the report is run.

e To select an item, click on it. To select multiple items in a list, use Ctrl-Click. To deselect a currently
selected item, use Ctrl-Click.

o If none of the storage groups, device groups, or devices are selected, all items are included in the
report query. However, peers must be explicitly selected to run a report query on them. If none of the
peers are selected, the query will only run on the local Logger.

e The selected items in the Device Groups, the Devices lists, and Peers are ORed in the report query,
and these items are ANDed with the other selected items such as Storage Groups.

Follow these guidelines when you run a distributed report (a report on peer Loggers):

e You can run a distributed report in the Quick Run, Run in Background, Run, or Scheduled Reports
mode.

o AllLoggers on which you are running the distributed report must be running Logger 5.2 or later.

o If peer Loggers do not have identical storage or device group names, the report query skips
searching for events for those groups on those peers.
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o If you added custom schema fields to your Logger schema, those fields must exist on all peers.
Otherwise, a query containing those fields will not run (when run across peers) and return an error.
See "Adding Fields to the Schema" on page 377.

o A user needs to belong to these user groups with the listed permissions set to run distributed
reports:

a. Logger Search Group with “Search for events on remote peers” user right set (checked).
b. Logger Rights Group with the “View registered peers” user rights set (checked).

¢. Logger Reports Group with “View, run, and schedule reports” rights set (checked) for specific
reports or the global permission set to run all reports.

For more information on setting permissions, see "Setting Access Rights on Reports" on page 218

o If a peeris unavailable when a distributed report is run, an error message is displayed and the report
is aborted. Similarly, if a peer becomes unavailable while a distributed report is running, the report will
continue to run and displayed. However, the server log will contain exceptions indicating the cause.

Use the following best practices for optimal performance when running a distributed report:

e Avoid running a distributed report on a Wide Area Network (WAN) link.

o If you are running the report on a very large data set and the performance of the report is not
optimal, reduce the size of the data set, and/or defragment the device..

o Ensure that all fields in the report query are indexed on all peer Loggers. The report query will run
slower on the Logger on which the fields are not indexed.

Refer to the HPE Security Security ArcSight Logger Configuration and Tuning: Best Practices guide for
more Logger best practices.

Run Report Parameters

When you choose the Run Report link for a report, options are available to choose a file format, specify
pagination, and to modify the data filter criteria for only this run of the report.

Run Ad hoc Report » Configuration Changes by User

= SIRE

Run Preview Runin Background

[ Select Fiter Criteria [ Rciite Co]

Max. Rows: I:I [ Suppress Duplicates

Open Field Criteria Use Field Value Close Relation

sa[ | o ] e | o
@m[ | o ] e | il
wa[ | o ] e | i
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If you run the report without specifying any override run-time parameters here, the report is generated
with the defaults specified at design time for this report. You can run a report in the background after
specifying the Run Report parameters.

The following table describes Run Report parameters.

Run Report Parameters

Option Description

Report Format Specify a file type or “format” option of the output, and toggle on or off the Multipage option
to generate a report as a multi-page or a single-page document. By default, Multipage is
checked.

Note: HPE strongly recommends using the Multipage option for all reports.
Specifically, if a report will result in more than 826 records, using the Multipage option
will ensure that the generated report is not blank. By default, the reports generated in
the PDF format are set to use the Multipage option. However, if your PDF format report
is blank, ensure that the Multipage option is still checked for that report.

For descriptions of report formats, see "Report File Formats" on the next page.

Select Filter Criteria Provides options to define filters, or modify default filters if any are already built in fo the
report.

The filter expression is applied when the report runs, narrowing the focus of the report to
the specified criteria.

For example, you could set the filter criteria on a report on Top Password Changes to report
only on password changes related to specified user names or involving specified IP
addresses.

For details on how to create these filters (with Field, Criteria, and Value fields), see "Filter" on
page 204 in "Designing New Reports (The Ad hoc Report Designer)" on page 200.

Note: Filter criteria defined at report run time applies only to this run of the report.
Filters set in this way are not saved nor made available to other users. You can also set
built-in, default filter criteria as a part of designing a report.

Template Select the template to apply to this report. The templates pull-down menu shows supplied
templates, and any custom templates you may have added. To include the start time, end
time, scan limit, device group, storage group, and devices information (used to run a report)
in a report, choose the BlankWithHeader template.

See "Template Styles" on page 242 for more information on working with templates.

View Options The default view option for the report results is Multipage. If you deselect the Multipage
option, your report will be formatted as a single page. HPE strongly recommends using the
Multipage option for all reports. You also have the option to download the report results as
a zipped file. To do so, check the Download Zipped option.

When you click Run on this first “Parameters” dialog, the same dialog is displayed as for a Quick Run

with default option (or Run in Background) report where you can specify filters on timeframe and
storage groups on which to run the report. (See "Quick Run with Default Options or Run In Background
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Report Parameters" on page 182 for details on this “Additional Filters” dialog. Clicking Run Now on this
second dialog runs the report.

Report File Formats

Report file formats include:

e HTML (Web page format)

o PDF (Acrobat PDF)

o MS Excel

o Comma-separated (Delimiter-separated file. The delimiter is usually a comma.)
« MS Word

¢ Intferactive HTML ((HTML)

e XML

For most formats, you can select the Multipage option by clicking on the View Options link. HPE
strongly recommends using the Multipage option for all reports.(If this option is checked, the
report results will be formatted for a multi-page report.)

The report formats made available to you depend on access rights associated with your user account.
(See "Setting Access Rights on Reports" on page 218 for more information.)

Some report formats require that the local machine has a separate viewer installed. For example, viewing
reports in PDF format requires Adobe Reader.

Publishing Reports

If you publish a report after you run it ("Running and Viewing Reports" on page 181, the output results
for that run of the report are saved for subsequent use.

You configure scheduled reports to publish after each scheduled run. The publish options for
scheduled reports are the same as for on-demand reports described here. For more about scheduled
reports, see "Scheduled Reports" on page 192 and "Scheduled Reports" on page 192 and "Add Report

Job Settings" on page 189.

To publish a report:

1. In a generated report output file from running a report, click the Publish Report £ button at the
top of the page.
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Pubiish =
Report Format: | '| Options  ~
Saveln: | ..jAnti-Virus e
Report Name: | |
Access: (@) Public Private
Expires an: |MM/dd/yyyy HH:mm:ss |

(Blank date stands for never expires)

Add Comment Publizh Cancel

2. In the Publish dialog, specify the report details. The following table describes the publish report
options.

Publish Report Settings
Option Description

Report Format Format of the report. To publish a zipped version of the file format, in click Options,
then select Publish Zipped File.

Save In Category under which to save the report. If you specify a category in the preferences,
you can navigate to it. If you had not specified a category, the published report will be
saved in the caftegory in which the report resides.

Note: You cannof save a report in the root category.

Report Name Name for this report on the published reports list.
Access Select a value for access:
e Public makes this report available to everyone.

o Private makes this report available to you only.

Expires on Date and time after which the report output is discarded (and, therefore, unavailable for
viewing).

If you do not want the report results to expire (keep always available), then leave this
field blank (that is, do not set a value for this field).

3. Click Publish.
For information on how to view a published report, see "Viewing the Output of a Published Report" on
page 191.
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Add Report Job Settings

The following table describes the Add Report Job settings.

Add Report Job Settings
Option Description
Name Name displayed on the Scheduled Jobs list.

Schedule Set when and how often you want the report to run. For details about these options, see "Scheduling Date
and Time Options" on page 136.

Report Select a report from the list, and click Go to load the report.

Name
Note: You must click Go fo load the selected report at the Report Name field before you save the
scheduled report job.

Delivery Depending on which delivery option you choose, the associated parameters are displayed. Select to
Options enable or disable these options.

Both Email and Publish options for scheduled reports are the same as those provided after you run a
report on demand.

Select a delivery option:
o Email: For details on setting Email delivery options, see "Emailing a Report" on the next page.

o Publish: For details on setting publishing options, see "Publishing Reports" on page 187.

Report Select a report format (Acrobat PDF, HTML, and so forth.)

Format . .
For details on report formats, see "Report File Formats" on page 187.

Report You can either accept the default parameters, or modify them here. These are the same parameters that
Parameters can be specified for an on-demand report run.

For information on specifying report parameters, see "Quick Run with Default Options or Run In
Background Report Parameters" on page 182.

Report Delivery Options

When you run a report from the Report Explorer (as described in "Running and Viewing Reports" on
page 181), many options are available for delivering the generated output.

The most common next step is to publish the resulting report (described in "Publishing Reports" on
page 187), but you can also save the report output to a file, Email it to other users, refresh the results,
change the output format, and so forth. Refreshing a Report

To re-run the report for an updated result sef, click Refresh.
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Emailing a Report

You can send a report using email as either a Web link or an attachment. You can also configure these
Email options on scheduled reports, as described in "Scheduled Reports" on page 192.

Before you can email a report, you must first set up SMTP for reports. Navigate to Reports > Reports
Administration and configure the SMTP settings.

To email a report:

1. In the Report Explorer, after you run a report, click Email Report E4 on top of the page.
2. Specify the following information about the email as shown in the table below.
Email Report Settings
Option Description
Send Report As Choose one of these:
e To provide a link to the report in the body of the email, select Link.

e To send the report as an attachment to the email, click Attachment, and select a
format for the attachment file.

Report Format Select a format for the file to be attached to the email.

Options Select the following options before attaching a report file to an email:

o Pagination: Select whether you would like the report to display in a single page or
multiple pages and whether you want horizontal breaks.

o Download Zipped: If selected, the file is zipped before being attached to email.
¢ Include comments: If selected, any comments added to the report are included.

Save In You have the option to save the report in a location that you can specify here.

Note: You cannoft save a report in the rootf category. Save it in one of the existing
categories or create a new one.

Toand CC Specify email addresses to which to send the report.
Subject Provide email subject header.
Message For the body of the email, you can use the default message provided, modify it, or enter

your own message.

3. Click Email to send the report.
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Exporting and Saving a Report

You can export a report 1o a file format of your choice and save it.

To export and save a report:

1. Click the Export button or click one of the file format buttons on the published report top-level
menu bar.

2. In the Export Options dialog, specify the Export Format and associated settings you want in the
Export Options dialog. Depending on the Export Format you choose, other settings are displayed

as appropriate.

3. Click Generate.
You can save the generated report as a file locally or elsewhere just as you would any other file.

Viewing the Output of a Published Report

To view the output of a published report:

1. In the Report Explorer, navigate to the report for which you want to view output results.

2. Inthe Actions menu, click List Published Outputs. The published outputs are displayed. You can
use the Filters to search for a desired output result.

Saved Report List : Top Infected Systems
~ | Fiters Published Name Includes [1| Report Name [..fAnti-Virusl/[Top Infected Systems]

Published Name Includes | |

Updated Between |h"-. ddiyyyy | B and |:‘\-'-| ddiyyyy | ]
Select Report [...'ﬂ.nu—'u\rus:Tu; Infected Systems |T=-] Orphan
Select Owner | ArcSight v ‘ | admin v ‘ Private Owned By Public Owned By
Search
= Anti-Virus
¥ | 52 =g

Sr.No. File Name Generated Time Expiry Time

Deleting Published Reports

You can delete old instances of the report output that have accumulated over time from this page. To
delete the report, select it and click the Delete button in the toolbar.

Note: Please be certain that you want to remove these old reports, and do so carefully.
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Scheduled Reports

You can schedule a reports to run as a scheduled job, either on a one-time basis, or at regular intervals
(hourly, daily, and weekly). As part of scheduling a report job, you can set delivery options to email,
save, or publish the resulting reports.

HPE recommends using the Scheduled Report feature in lieu of running on-demand (ad hoc) reports
whenever possible, so that reports run during periods of light load. For more on this see "Best Practices"
on page 179.

Time changes due at the beginning or end of Daylight Savings Time may affect your scheduled reports.
For more information, see "Impact of Daylight Savings Time Change on Logger Operations" on
page 412.

Note: If not completed, by default, a scheduled report times out in 4 hours.

¢ Viewing and Editing Scheduled Reports ... . . 192
e Scheduling @ RepOrT 195

Viewing and Editing Scheduled Reports

Reports that are already scheduled are displayed on the Scheduled Reports page.

To view scheduled reports:

On the left pane, click Scheduled Reports.
Note: To view scheduled reports, a user must belong to a Logger Reports Group, a Logger Search

Group, and a Logger Rights Group.

To edit a scheduled report:

1. Click Edit next to the scheduled report job you want to edit.

Add

Task Type Schedule Next Run Time
Daily Report Report Every 6 hours Aug 19, 2074 12:00:00 PM PDT S| x v
Evening Report Report Every 12 hours Aug 19, 20714 12:00:00 PM PDT Sl % v
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2. On the Edit Job Report page, modify the settings as needed, and then click Save.

Edit Report Job

Mame Daily Report

Schedule Everyday

Every

5] Hours v

Report Name *

.[Anti-Virus/Failed Anti-Virus Updates |T:-]

Delivery Operations

[ Emzl [#| Publish Report Format I@
saveln %, [¥) UsersWorking Folder r— Delivery Options
Fie Name | | ) Suffix Timestamp Format Pagination:
* Public'~ Private [+ Deliver Zipped File
Vald Upto
O HfterGenerat’mn
End of this v
Date =

Report Parameters

No Parameters

For details on how to specify these settings, see "Scheduling a Report" on page 195.

Note: The job name is not editable once the scheduled report job is created. Other settings can be
modified with an edit, and work the same way as on the Add a Report Job page described in

"Scheduling a Report" on page 195.

To remove a scheduled report:

Click Delete next to the scheduled report job you want to remove.

Tip: Removing the report from Scheduled Reports list here deletes the scheduled job, not the
report itself nor any instances of its previously published output.

Jobs Execution Status

Click the Jobs Execution Status link at the top of the Reports page to display the Jobs Execution
Status page. The page displays a graphic representation of the status of all executed jobs. The page
has two panels: the Jobs Summary panel, and the Filters panel.
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v Fiters Entity Name [{(AD)]/T¢A] | Status [(AR}]1 Job Type [(A0)]1 Job Name [(AR)] | User [ArcSight/admin]

~ Jobs Summary

Completed Jobs 0 B succeeded Jobs 0 B Failed Jobs 0 Upcoming Jobs
25
2.0 ]
¥ 15
=]
2
=
< L0
g
=
0.5
! g g ! g g ' i '
08/12/2014 08/13/20 08/14/2014 08/15/2014 08/16/2014 08/17/2014 08/18/2014 08/19/2014 08/20/2014 08/21/2014
Date and Time
SrMo. Job Name Entity Name Frequency owner Scheduled Time Execution Time Last Run Status Re-Run
1 Daily Report Failed Anti-Virus Updates ArcSight/admin 08/19/2014 12:00 08/19/2014 12:00 gy ccpss [N
2 Evening Report Accounts Created by User Acco ArcSight/admin  08/19/2014 12:00 08/19/2014 12:00 5ccpss O

The Jobs Summary shows a graph indicating the number of executed jobs by day. Jobs are assigned a
status as follows:

o Completed
e Succeeded
o Failed

e Upcoming

Select a Job Status button (for example, the Failed Jobs button) to display the jobs corresponding to
that status in the graph.

Note: Upcoming jobs will not be displayed when the Upcoming Jobs status button is clicked. Only
a blank list is shown.

Click a date to show jobs for that day in a pop-up.

Beneath the Jobs Summary is a table listing each job and its defails.

Under Filters, you can filter the results of the Jobs Summary to show results matching a variety of
criteria.

To create a filter, enter values for the criteria shown, and then click Refresh. (Next to the Filters label,
the current filter is summarized in text format.) The results in the Jobs Summary include results that
only match the filter criteria.
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Scheduling a Report

You can schedule a report to run daily at a specified time or every so many hours, or on specified days of
week or month, at a specified time.

To schedule a report:

1.

Click Scheduled Reports on the Reports page left menu. The page shows the list of currently
scheduled report jobs, if any.

Click Add fo display the Add Report Job page.

3. Enter the report display name in the Scheduled Jobs list.

Use the pull-down menu next to Report Name fo select a report, and then click the Select Entity
checkmark to load the report.

Add Report Job

Name  myscheduledReport

Schedule Every day |L|
Hour of day |L| 2300 Hours (24 hour format)
Report Name * ~/0perating System/User Administration | T, ]

Use the schedule options to specify how frequently the report should run. For details about these
options, see "Scheduling Date and Time Options" on page 136.

Choose one or both delivery options under Delivery Operations (Email, Publish). By default,

only Publish is selected.
Both Email and Publish options for scheduled reports are the same as those provided after you run

areport on demand.

e To keep the Publish option, select it and enter its associated parameters. For details on setting
publishing options, see "Publishing Reports" on page 187.

e To include the Email option, select it and enfter its associated parameters. For details on setting
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email delivery options, see "Emailing a Report" on page 190.

Delivery Operations
[« Email [ Publish

Send Report As '® Link "' Attachment

Saveln 7=, 1#) User's Working Folder
| |i_l Suffix Timestamp Format

File Name .

To | |

Cc | ‘Bcc | |

Subject | |

Hello, =<BR=<BR>You have received this automated email =
Meszage tolet vou know that report «3MEMU_NAMEY> hasbeen
generated.Please click the following ink to view thereport . .

Report Parameters

7. Enfter settings in the remaining fields based on the report you chose.

o Delivery Operations: Depending on which delivery option you choose, the associated
parameters are displayed. Select to enable or disable these options.

o Report Format: Select a report format (Acrobat PDF, HTML, and so forth.) For details on
report formats, see "Report File Formats" on page 187.

¢ Report Parameters: You can either accept the default parameters, or modify them here. These
are the same parameters that can be specified for an on-demand report run. For information on
specifying report parameters, see "Quick Run with Default Options or Run In Background Report
Parameters" on page 182.

8. Click Save.
The report you added is scheduled, and now shows on the Scheduled Reports list.

Designing Reports

You can use the Ad hoc Report Designer to design simple columnar reports, as well as mixed reports
with embedded charts and matrices. For columnar reports, the Report Designer provides options for
setting up filters, grouping, totals, and sort order to create a full-featured report.

e Opening the Report Designer . . o e 197
o Creating New RepOrTS . o 198
o Editing @ RePOIT 216
e Setting Access Rights 0N RepOITS . e 218
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Opening the Report Designer

To create a new report from scratch:

1. On the left menu bar, under Design, click New Report. The Ad hoc Report Designer will open with
a new, blank report.

Ad hoc Report Designer = Untitled Report

B || & 5 8| k| P2 Expand Al

Run Breview SavEe... Save As... (pen...

&} DataSource

Select Source

Query Object: | (Roat) |Tsv]

Query Editar...

Report Settings
Report Title:
Template: | Blank v
Report Format: | HTML r
View Options
Report Contents: | Detailed v

To open the Report Designer to edit an existing report:

1. Browse to the report in the Report Explorer.

2. In the Actions menu, click Customize Report. The Ad hoc Report Designer will open with the
selected report.
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Actions:
Quick Run with default options
Rumnin Background
Run Report
List Published Outputs

Create Dashboard Widget

Customize Report

Maore -

Creating New Reports

If you are new o the Logger Report Designer, we recommend starting with an existing report as a basis
for a new one, as described in "Quick Start: Base a New Report on an Existing One" below.

If you are starting a new report from scratch, or for more details on each of the settings in the Report
Designer, see "Designing New Reports (The Ad hoc Report Designer)" on page 200.

e Quick Start: Base a New Report on an Existing One ... ... . 198
¢ Designing New Reports (The Ad hoc Report Designer) ... ... o . 200
O I O 204
O GIOUD oL 206
® TOTalS L 207
LYo o E 208
o Highlight 209
& M AT IX .. 209
O AT L 211
LI F- | o PP 213

Quick Start: Base a New Report on an Existing One

Since Logger ships with a variety of useful, pre-built reports for common security scenarios, you can use
these not only to run as-is but also as templates for building new reports. If you are just beginning with
the Report Designer, a good way fo learn fast is to start with an existing report that has some of the
features you want in your new report, save the original report under a new name, and then modify it.

Caution: Modifications to reports and other ArcSight-defined content may be overwritten without

HPE Logger 6.3 Page 198 of 623



Administrator's Guide
Chapter 4: Reporting

warning when the content is upgraded. Do not modify ArcSight-defined content directly.

Make modifications to a copy of any ArcSight-defined content as a general practice, and
subsequent upgrades will not affect the modifications.

To create a new report based on an existing report:

1. Inthe Report Explorer, browse to the report you want to use as a starting point.

2. In the Actions menu, click Customize Report.

Actions:
Quick Run with default options
Run in Background
Run Repaort
List Published Outputs

Create Dashboard Widget

Customize Report

More =

This opens the Report Designer with the report’s properties filled in.

Note: Some reports, such as the ones obtained from ArcSight, or other custom developer
sources, might not be editable. For such reports, the Customize Report link is disabled.

3. Click Save As. This displays the Save Report Layout As dialog for the selected report (and shows
all reports stored in the same category as the one you selected).
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4. In Report Name, enter a name for your report.

=i Q =

Hame

4 77 (Root)
4 [ Device Monitoring
4 [ Dperating System

‘?j Login Errors by User

Report Hame |Eu5tum'|zedLlserﬂdmin'lstrat'lun ‘ Save Cancel

D | | [+#| System Generated

= Public Private
|+ Copy Access Rights

Description | This repart shows user and user group creations, modifications, and deletions.

*=Read Only

5. Click Options, and then enter values for the following:

% Options

e ID: Enter a custom ID for the report, if desired. Alternatively, select System Generated to

automatically generate one (selected by default).

o Public/Private: select one. If public, everyone will have access to this report; if private, only you.

o Description: Enter a description, if needed.

6. Click Save.

7. Click OK to confirm the save. Your new report is now shown under the category in which you saved

if.

8. Select the report you just saved and click the Customize Report button to start modifying the new
report to suit a specific scenario. (See the next section, "Designing New Reports (The Ad hoc

Report Designer)" below.)

Designing New Reports (The Ad hoc Report Designer)

To access the Report Designer to create a new report from scratch, under Design, click New Report link
in the left panel. The Ad hoc Report Designer is displayed with a blank template.

The following sections explain how to use the Report Designer.
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Toolbar Buttons

The toolbar includes these buttons.

o Click Run fo test the current version of the report.

o Click Preview to preview the report before saving it.
e Click Save to save the report.

o Click Save As to save it under a different name.

¢ Click Open to open another report in the Report Designer.

Report Components
Report components can be accessed by the tabs at the top of the designer page:
Tab Description

Data S 3 See "Data Source" on the next page for more information.
ata Source ©

See "Fields" on page 203 for more information.
Fields @ Pagd
See "Filter" on page 204 for more information.
Filter B ped
& See "Group" on page 206 for more information.
Group
See "Totals" on page 207 for more information.
Totals Ej g
Al See "Sort" on page 208 for more information.
Sort £
See "Highlight" on page 209 for more information.
Highlight El g ped
See "Matrix" on page 209 for more information.
Matrix 2 pad
See "Chart" on page 211 for more information.
Chart [{h pad
Q See "Map" on page 213 for more information.
Map
Expand All/ Toggles the detail view.
Coll All T e . .
ofapse Once expanded, you can also toggle visibility of an individual component in the Designer
Expand Al by clicking the component’s title bar. For example, to toggle visibility of the Highlighting

component, click the Highlighting fitle bar (above the Create Matrix title bar).
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Data Source

Every report is built on a base query. To select one for your report, under Select Source, in Query
Object, browse o a query fo use.

For instructions on how to view a list of the default search fields, see "Default Fields" on page 281. For
information about custom schema fields added to the default schema, see "Adding Fields to the
Schema" on page 377.

You can edit the selected query by clicking Query Editor. (For information on building new queries, see

"Queries" on page 219.)

Creating a New Report

To create a new report:

1. Under Design, click the New Report link in the left panel. The Ad hoc Report Designer is displayed
with a blank template.

Report Settings
Report Title:
Template: | Blank r
Report Format: | HTML v
View Opfions
Report Contents: | Detailed ¥

2. Under Report Settings, enter or select values for each of the following settings:

General Report Design Settings

Option Description
Report Title Title of the report.
Template Select the template to apply to this report. The templates pull-down menu shows supplied

templates, and any custom templates you may have added. To include the start time, end
fime, scan limit, device group, storage group, and devices information (used to run a report)
in a report, choose the “BlankWithHeader” femplate.

See "Template Styles" on page 242 for more information on working with templates.
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General Report Design Settings, continued
Option Description

Report Format Select the default format for the report.

For information on available formats, see "Report File Formats" on page 187.

Report Contents Select whether report should detailed or summarized.

Fields

Once you select a query to use in the report, the display fields it contains are shown in the Available
Fields list. You can select which of these display fields you want to use in your report. You can edit the
selected query by clicking on the Query Editor link. (For information on building new queries, see
"Queries" on page 219.)

Ad hoc Report Designer = Untitled Report

a8 & || & = 8 8 @ m | 92 Expand Al

Run Preview Save... Save As... Open...

& Select Display Fields

mvallable Fields [Username 4 |@ ® Selected Fields wa: [ ]
[[] rResult Event Name Render As:
User Name , | Count
Significance i
[T sig 5 End Time N
< W

<<

[7] Add New Fields At Runtime

Note: In addition to the fields in the WHERE clause of the query, the fields in the SELECT clause
also need to be indexed to yield faster report generation. For more information about indexing

fields, see "Indexing" on page 138.

Enter a title for the report in the Report Title field, and then select whether the report contents should
be Detailed or Summarized in the Report Contents field. The report title is displayed at the top of a
report.

Select the query you want to use for the report from the drop-down list located on top of the Select
Display fields section. The Available Fields list is populated with the fields defined in the selected query.

Select the fields to use in the report by moving fields from Available Fields into the Selected Fields
list.

Note: You must move at least some available fields to the Selected Fields list, or the report will not
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run correctly

o Select afield in Available Fields and click 3_] to move it into the Selected Fields list, or click #*| to
add all fields.

e To deselect fields that you do not want in the report, select a field in the Selected Fields list and click

f_i to move it back to the Available Fields list, or click « to deselect all fields.

e Use the move up | and move down *larrows to order the Selected Fields.

Tip: For information on how to create query objects for use in reports, see "Queries" on page 219.
All available queries, including new queries you create, show up in the pull-down menu in the
Select Display Fields section of the Ad hoc Report Designer.

Filter

Filter criteria are defined as part of a report design. When other users run the report, they receive the
built-in filters by default. You can also sef filter criteria and row limits on an ad hoc basis when you run a
report. However, values set at run time are not built in to the report like those set at design time. Run-
time parameters are only applicable to a particular report run and do not persist.

G selectFiterCriteria [

Max. Rows: I:l || Suppress Duplicates

Open Field Criteria Use Field Value Close Relation
gm[ | ol ] 8 | i
s | ol ] 8 | i
9= | o ] 8 | i

If a report does include default filter criteria, users have the option to run the report with the defaults,
or modify or remove the built-in filters at run time. For more information, see "Run Report Parameters"
on page 185.

You can set filters on the results of the base query with logical expressions to narrow the focus of the
report results. For example, you could set the filter criteria on a report on Top Password Changes to
report only on password changes related to specified user names or involving specified IP addresses.

You can limit the number of rows in a report by defining a Max. Rows value, or require filtering on one
or more fields of your choice using the Mandatory option.
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Select Filter Criteria Options

Option

Maximum Rows
(Max. Rows)

Field

Criteria

Value

HPE Logger 6.3

Description

Specify the maximum number of rows in the report output. Results that push the number of rows
beyond the Max. Rows limit you define will not be included in the report.

e Selecting set Max. Rows and also specifying a grouping under Set Grouping (as described in
"Group" on the next page), may produce a different result than if you just specified Max. Rows
without grouping.

o Setting this field to O returns an unlimited number of rows.

¢ Increasing the maximum rows for report may not always increase the number of rows returned
by the report. If the query invoked by the report limits the number of rows returned, increasing
the Max. Rows setting in the report has no affect. For example, if you edit the NIST IR Top 10
High Risk Events report and change the value in the Max. Rows column from 10 to 20, when the
report is run report only 10 rows are returned. This is because the query invoked by the report is
returning 10 rows. However, you can limit the number of rows returned by the report to a number
less than the default value. For example, if the value of the Max. Rows field is changed from 10
to 5 for the NIST IR Top 10 High Risk Events report, this report returns 5 rows during run time.

¢ You canincrease the number of rows returned by editing the query and changing the number of
rows returned by the query and change the number specified in the Max. Rows field of the
report.

The Fields will be populated with event data fields specified in the base query. (Fields will
generally equate to columns in reports.)

1. Select a field on which to filter.
2. To add another field on which to filter, click [ (Add Filten).

3. Toremove a filter, click (Remove Filter).

For instructions on how fo view a list of the default search fields, see "Default Fields" on page 281.
For information about custom schema fields added to the default schema, see "Adding Fields to
the Schema" on page 377.

Multiple filters with conditions set on different fields will be AND’ed together. Multiple filters
with conditions set on the same field will be OR’ed together.

For example, if you want to filter on events to return data based on a value/count (of rows or

other) between 90 and 100, use the Between criteria to do this (for example, <Field> Between 90
and 100)

Setting two filters on the same field with criteria “Above 90” and the other as “Below 90” would
not give you the data you are looking for. Only one of these filters would be friggered.

If the query you choose for this report has mandatory filtering, the “Select Filter Criteria” panel
title and one or more fields are marked with a red asterisk. See details.

Select a logical operator. (For example, Is, Is Nof, Starts With, Ends With, Contains, and so forth.)
Tip: To make the query case-sensitive, select the Match Case option for your operator.

Select a value to complete the conditional filter expression.
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Group

Grouping brings together related report data into logical groups based on particular fields. The data can
be arranged in ascending or descending order, and can display the selected field value, or a summary
value. You can create different groups to display information in different ways.

To configure report groups, select Reports | New Report, then click New Report from the Design
menu. The Ad hoc Report Designer page displays. Click the Group tab ( # ) to open the Select

Grouping menu.

&% Select Grouping n

Field Order Ranking Field Ranking Function Show When

Group ey | 2 gL ]
ThenBy | v||:|| '”:l
ThenBy | '||:|| '”:I

Note: A report that has a group defined can only display up to 100,000 lines.

Example 1: Let's say you create a group that displays "Total Sales" in descending order (Zto A). The
total sales of "East Region" is 1000 units, and total sales of "West Region" is 1900 units. In the report, the

"West Region" group detail will appear before "East Region" group details.

Example 2: If the report uses a query that includes a Date field, you can group results by date. You
could add additional statements to group by “User Name”, “Source Address”, “Destination Address”,

and so forth, depending on what other fields are available in the report query.

Note: Selecting set Max. Rows under Select Filter Criteria (as described in "Filter" on page 204)
and also specifying grouping may produce a different result than if you just specified Max. Rows

without grouping.

See the table "Add Report Job Settings" on page 189 for more information about report settings.

To define a group:

1. From the Group By menu, select available options from the following menus to specify what event
information should be groups, in what order, and under what conditions.

The Group By field is the primary field in the data group, organized by the ranking field, in
ascending or descending order.
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Select Group By Fields
Option Description
Field Select an option from the menu fo make it the primary field in the report group. The

Field menu is populated with event data fields specified in the base query.

e To add another grouping field, click H (Add Field).
e Toremove a group-by field, click (Delete Field).

Order Select in what order you want the information to display.

e Ascending (0,1, 2.. or A-Z)
o Descending (2,1, 0. or Z-A)

Ranking Field Select a field to order by (Ranking Field) and the type of information you want the report

Ranking Function to show (Ranking Function). Logger can group the data by date, number, and character.

For example, if you select the query object "Login Errors by User," you can group the data
by "User Name", in "Ascending" order, with "Error" as the ranking field, and "Count" as
the ranking function.

This allows you fo see users with the highest number of errors listed at the top of the
data group section of the report.

Show When Use this menu if you want information to display when more detailed criteria are met.

2. If you wanft fo include secondary groups, populate the Then By fields. For example, if your report
uses a query that reports on password changes and includes a “User Name” field, you might want

to sub-group the results for each date by “User Name”.

Use the [# (Add Field) and x| (Remove Field) buttons to add or remove Then By fields for sub-
groups.

The report will generate records organized and grouped in the order you selected.

Tip: Alternatively, you can specify only a sort order (instead of groups). See also, "Sort" on the next

page.
Totals
F1 selectTotais [
Field Function Level
| 7] ’ ,
| 7] ; ;
| 7] ’ ,
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You can specify the summary (total) fields. You can apply a summary on any of the following levels:

e Report
o Page
e Group

To specify summary details:

1. From Field, select the field that will be processed to calculate summary information.
2. On the same row, from Function, select the summary function.

3. On the same row, from Level, select the level at which you want the summary.

Note: If a Total is applied o a field that is not already in the Selected Fields list, that field is
automatically added to the Selected Fields list.

Sort

Run Preview Save.. Save As.. Open...

21 sortOrder n

Field Criteria

s | S
res | ]
rey | I

If you do not want grouped report results (as described in a "Group" on page 206) but you do expect
sorted results, then specify a sort (instead of a grouping).

Note: A report that has a sort order defined can only display up to 100,000 lines.

You can have up to three levels of sorting.

To specify a sort order:

1. In Field, select the field on which you want to sort the report.

2. In Criteria (in the same row), select the sort criteria.
3. If desired, provide values in the “Then By” rows to specify more sorting criteria.
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Highlight

A report can include multiple levels of highlighting for specified fields. Highlighted items can serve as

visual alerts on generated reports when specified set conditions are satisfied.

A& | 4|84 8@ @ P2 | oo
Run Preview Save.. SaveAs... Open...

Highlight Using 5tyle
HE| *] | ]

When Open Field Level Function Criteria Use Field

Relation

| -\| v 2l x| O

'|| '|

To set up a highlight:

1. In Highlight, select the field that should be highlighted. Select Entire Row to highlight an entire

record.
In Using Style, select the style to be applied to highlight it.
Select Alert checkbox fo receive a visual alert on report viewer.

In Field, select the fields to evaluate for highlight (alert).

o R W

o DETAIL evaluates each row (record)
o REPORT evaluates at the end of report
o Respective groups evaluate at the end of each group

o PAGE evaluates at the end of the page

6. When REPORT or PAGE is selected in Level, select a Function to be applied.

7. Select Criteria and specify its Value.

In Level, select the level at which the selected field should be evaluated:

Click & (Remove Condition) on the left of the criteria entry to delete an entry. Click & (Add

Condition) to add another entry.

Matrix

You might choose to include a matrix in your report, since it presents a summary of data. Make sure that

the appropriate query object is selected (under Select Display Fields).
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B Create Matrix

Link Chart: I:I Clear Matrix

Available Fields Column Fields -3 -

| SRIONO] Field Group By Totals  Show When

Row Fields o h 4 Summary Fields o h 4

Field Group By Totals  Show When Field Function Highlight

To create a matrix:
1. To place a field in Row or Column, click the field and drag it to the Row Fields or Column Fields
boxes.
2. To place a field as a cell (summary), click the field and drag into the Summary Fields box.
3. Select a Function from the pull-down menu provided for a field placed in Summary Fields.

4. Optionally, for numeric or date fields in columns or rows, specify a Group By function in the pull-
down menu provided.

5. Optionally, for fields in columns or rows, check the Totals checkbox to view a row or column.

Select a field and click padding-right: Opx; to add that field fo the matrix as one of the Column
Fields. Select a field in Column Fields and dlick -] to remove it from the matrix.

Select a field and click _ﬂ to add that field to the matrix as one of the Row Fields. Select a field in

Row Fields and click ﬂ to remove it from the matrix.

Select a field and click El to add that field to the matrix as one of the Summary Fields. Select a
field in Summary Fields and click Elto remove it from the matrix.

To move a field up or down, select the field and click 2 (Move up) or ~| (Move down), to move
the field in the respective direction.

To remove all settings and contents of the current matrix, click Clear Matrix.
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Chart

il CreateChart

Chartl x| +

Available Fields

Value Fields (Y-Axes) Y+

Field Function

@ Normal Stacked 100% Stacked

Group Fields (X-Axis)

Field Group By

Series Type

Display Field

Trend

Pivat

X-Axis

LabelAngle:

Sort Order

Show (N):

Clear Chart

Setfings

[ Show Title
¢ Show Legends
[ Show Point Labels

Align: | Top v

Field:

Order:

J]I] O

For pictorial representation of summary data, you can add a chart to your report. Make sure that the

appropriate query object is selected (under Select Display Fields).

To create a chart, specify values for the following:

Setting
Title

Chart Type
Link

Available Fields

Settings

Sort Order

HPE Logger 6.3

Description

Title of the chart.

Select a chart type from the drop-down list.

Choose fo link the chart to either report fields or a maftrix.

Available Fields are drawn from the report query. Using the > button, assign these fields to
Value Fields (Y-axes on the chart) or Group Fields. See "Assigning Fields" on the next page.

o Show Title: if selected, the chart title displays.

o Show Legends: if selected, the chart will show legends for each field.

o Show Point Labels: if selected, a label is shown with the number of matches for a value of a

field in a chart.

o Align: Select an alignment for chart placement.

o Level: Select a level from which to draw data for the chart:

© Report: Data will be plotted with data from entire report

o Page: Data will be plotted with data from the page where the chart is located)

Select a sort order for the chart.
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Assigning Fields

You can set value and sort fields for a chart.

To Set Value Fields (Y-Axis):

1.

Click and drag the Field in Value Fields (Y-Axis) box, or use the > button (Add field) to add the
selected field.

Select summary function for the field.

To select a different chart type, click the button on the right to open a box with chart types. Select
the type you need. Follow steps 1through 3 above for each attribute to be placed as series. To re-

position fields, select a field and click A (Move up) or ~| (Move down) as needed.

To Set Group Fields (X-Axis):

1.

Click and drag the field in Group Fields (Y-Axis) box, or use the > button (Add field) to add the
selected field.

Select the method to group (for Numeric or date type).

You can specify groups in numeric fields. For example, to have groups of 10, specify 10 in Groups
box.

You can specify groups in date fields. From the drop-down box select from Day, Week (Sunday to
Saturday), Month, Quarter (Jan-Mar, Apr - Jun, Jul - Sep, Oct - Dec), Year.

Tip: To remove fields from Value fields (Y-Axis) or Group Fields (X-Axis), drag them out of the
respective box or use the < button (Remove field) on selected fields.

To remove all settings and contents of the current chart, click Clear Chart.
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Map

Your report can include a GIS (Geographic Information System) map based on your data.

? Create Map

Map:

Area Field;

Area Attributes:

Heatmap Properties

Value Field;

Functiom:

Start Color:

HAFCAFF

End Color:

#e17CB4

The GIS map can include a heat map, which highlights by color the areas of most activity that you

specify.

Note: In the context of a GIS heat map, heat refers to activity level.

A map includes the following parameters:

Map Parameters

Parameter

Map

Area Field

Area Attfributes

HPE Logger 6.3

Description and Values

Select the map name for inifial loading of dafa.

For example, if you want to depict a map of US states, then select “USA - Regions”.

This is the value used o group map data. Select an area based on the initial
selection of value for Map.

Click an area of the map to see an informational balloon. Set values for the following
attributes in the balloon display.

Prefix: the prefix caption value for the field
Field: the value of the field

Function: the aggregation summary for the field
Suffix: the suffix caption for the field

As Title: if selected, this line appears as a title bar in the balloon.
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Map Parameters, continued

Parameter Description and Values

Heatmap Properties - Value Select the value field by which the heatmap is calculated.

Field

Function Select the aggregation summary for the field by which the heatmap is calculated.
Start Color Select a color representing the lowest value of the value field.

End Color Select a color representing the highest value of the value field. All in-between colors

will be assigned values automatically by an even distribution.

Adding a Map to a Report

You can create a GIS map reflecting the values of a field in a query. This map can be included in a report.
When adding a map to a report you must select a GIS-enabled field a map type, as described in the steps
below. The map displays in interactive HTML GHTML) format.

To add a map to a report:

1. In the navigation pane, under Design, click Queries to open the Query Object Editor.

2. Click Open to browse to and open an existing query, or, alternatively, create a new query to usein
the report. (If creating a new query, specify the query as discussed in "Designing a New Query" on

page 222.)
In the Transformation workspace, click the Format step.
4. On the Properties tab, select the field to add to the map.

In the field details, select GIS Enabled. The field that you select must contain GIS classification data
such as country names, state, or city names.

HPE Logger 6.3 Page 214 of 623



Administrator's Guide
Chapter 4: Reporting

Transformation

Data Source —F e

G5 3

4

Properties Result
Fields Field: Zone
Ag Vendor - Source: Data Source
. Aa Product
b A Caption: |Enne | HyperLink:
Ap Address A*
a Group Label: [{Selecttoadd grouplabel b i
Ag Host Name P |ll‘ group iabel) [ | Hidden
Ae Errer GIS Enabled
i2a Count
Format

Align: Input Format:

RenderAs|:|

Width: P Height: P Source Type: v

6. Inthe toolbar, click Save to save the modified query object.
7. In the navigation pane, under Design, click New Report. The Ad hoc Report Designer opens.

8. In Data Source, browse to and select the query object in which you previously GIS enabled the
field.

9. Under Report Settings, in Format, select iHTML from the drop-down list.

10. Click the Map tab. 9

1. In Map, select a map type from the drop-down list.
12. In Area Field, select the field you enabled for GIS earlier.
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9 Create Map

Map: [World - Countries L
Area Field] | Zone v
Area Attributes:
Heatmap Properties
Value Field: -
Function: v

Start Color: |#AFCAFF

End Color: (#617CB4 .

13. Click Area Attributes. In the Attributes dialog, select a field to display in the information balloon,
as described in the table "Map Parameters" on page 213.

14. Under Heatmap Properties, in Value Field, select the field from which the map is to derive its
values from, to populate the map.

15. For Start and End Color, select two colors from the palette to display the range of values on the
map. For example, a lighter color on the map would indicate a lower value, while a darker color

would represent a higher value.

16. Make any additional edits to the report as needed, and then run the report.

Editing a Report
You can use the Report Designer to edit existing user-designed reports. (The supplied reports are not

editable.)

To edit an existing report:

1. Browse to the report in the Report Explorer.

2. In the Actions menu, click Customize Report. This displays the Report Designer for the selected
report.
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Run Preview Save... Save As... Open...

& Select Display Fields

Available Fields -Ziﬁ- ® Selected Fields Width: I:I
[C] zone Address Render As: v
[T vendor 5 | HostName
[T product 5> | Result N

< Name v

<< Count

|| Add New Fields At Runtime

3. Modify the report as needed (using the settings described in "Creating New Reports" on page 198).

4. (Optional) Before saving the report, you can run it to ensure that the changes you expected in the

report output suit your needs. To do so, click Run. (For more information see, "Running a Report
While Designing It" below.

5. Click Save.

See also "Quick Start: Base a New Report on an Existing One" on page 198.

Private Reports

If you have access rights to view, run, and schedule all reports, you can create private reports. If you do

not have permissions to edit a public report that you want to modify but you do have permissions to
create private reports, then you can save the public report as a private one and edit the private report.

For more about publishing a report as public or private, see "Publish Report Settings" on page 188. For
more about access rights for reports, see "Setting Access Rights on Reports" on the next page.

Running a Report While Designing It

While editing or designing a report in the Ad hoc Report Designer, you can run it before saving it to
ensure that the output meets expectations.

To run a report while designing it:

1. With the report open in the Ad hoc Report Designer, click Run.

2. Edit the report parameters as needed.

3. Click Run Now. The report is displayed using the parameter values you sef.

The Ad hoc Report Designer is useful in adding formatting and display elements to a report definition
and viewing the output with those elements before saving the report definition. For example, you can
specify a sort pattern or add a chart to a report.
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Setting Access Rights on Reports

Administrators can set access rights on various report categories, reports, and report options (such as
view, publish, and edit) based on user roles and Logger Report Group affiliation. For example, you can
grant users privileges to view some reports but not others, to view but not schedule or publish a report,
or to view and schedule but not edit a report.

Access rights are given at the folder level. If you want o give access only to specific reports, you can put
them in their own folder and give access to it. Access rights on report options are configured and
managed with the User/Groups option on the Logger System Admin page. For more information on
System Admin User/Group management, see "Setting Logger User Permissions" on page 458.

Determining What Access Rights to Give

When setting access rights for a user or group, be sure to give the user all the necessary permissions. In
order to access a particular child node, users need access rights to all higher nodes in that branch of the
free.

To determine the necessary rights for a report, open the report tree to that report.

Note: In order to access a particular child node, users need access rights to all higher nodes in that
branch of the tree.

Example: Giving a User Group Access Rights for a Report

Suppose you wanft to give a Group the rights to view, run, and schedule, but not to change the
Attackers reports. To determine the necessary rights, scan the report tree and note the nodes. You will
then need to navigate to the System Admin menu to set the rights.

To view Attackers Report tree and determine the necessary rights to access it:

1. Click Reports in the menu bar.
2. Click Report Explorer in the Navigation section on the left panel.

3. In the Reports list, navigate to the group of reports you want to give access to. For the example,
click Foundation > Intrusion Monitoring > Attackers.

4. In the Reports list, navigate to the group of reports you want to give access to. For the example,
click Foundation > Intrusion Monitoring > Attackers.

5. Make a note of each node you open.

Now that you know the nodes you need to give access rights to, you can set them from the System
Admin menu.
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To create a new User Group and give it Logger Reports Rights:

1. Click System Admin in the menu bar.

Click Use Management in the Users/Groups section on the left panel.
Open the Groups tab, and click Add.

Type in a Name for the group and add a description.

Select Logger Reports from the Group Type drop down menu.

Click the arrow fo display the list of Logger Reports Rights.

Click Clear All fo remove all permissions.

© N O v F W

Click the box next to each permission you want o give the user group.

For the example, you noted Foundation, Intrusion Monitoring, and Attackers, and you wanted to
give the rights to view, run, and schedule these reports. Therefore, put a mark in the box next to
each of the following access rights:

Report folder [Attackers]: view, run, and schedule reports

Report folder [Foundation]: view, run, and schedule reports

Report folder [Intrusion Monitoring]: view, run, and schedule reports
9. Click Save and Edit Membership.
10. Click Add in the Edit Group Membership dialog.
1. Put amarkin the box for the user you want to add to the group, and click OK.

12. Login as a member of the group you created and test whether you can perform the desired
functions. For the example, the user should be able to view, run, and schedule the Attackers
reports only.

Queries

Query objects (which comprise queries bundled with additional metadata) are used as the basis for
designing reports.

Note: Some queries may require parameters. We recommend first designing all needed parameter
objects before creating the query object that will use those parameter objects.

For information on developing parameter objects, see "Parameters" on page 233.

To view a query object, in the navigation pane, click Query Explorer. You can then browse queries by
category. Click » to toggle visibility of each category and drill down. See "Query Explorer" on page 155.

Logger Reporting provides a set of pre-built queries, which are used as the basis for the System-defined
Reports and Solutions Reports to address common security use cases (as described in "The Explorers"
on page 150).
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To search for an existing query by name or other criterion:

1. In the navigation pane, under Design, click Queries.
2. On the toolbar, click Open.

3. Click Search, %
4, In the criteria dialog, select the criteria for your search.

5. Click Search. All queries matching your criteria are returned.

For instructions on how to view a list of the default search fields, see "Default Fields" on page 281. For
information about custom schema fields added to the default schema, see "Adding Fields to the
Schema" on page 377.

You can use a provided query object as is, as the basis for your own reports, or design new query
objects on the Query Object List page. You can use existing query objects as a starting point for new
ones.

Note: Reports that directly invoke SQL queries can use the standard insubnet SQL function as
follows: insubnet( "subnet string", address_column )

Caution: Modifications to reports and other ArcSight-defined content may be overwritten without
warning when the content is upgraded. It is not good practice to modify ArcSight-defined content
directly.

Make modifications to a copy of any ArcSight-defined content as a general practice, and
subsequent upgrades will not affect the modifications.

This topic explains how to design new query objects (either from scratch or based on existing ones).

e How Search and Report Queries Differ ... 220
e Overview of Query Design Elements ... 221
e Creating a Copy of an EXisting QUETY ... 221
e Designing a New QUeTY oo . 222

How Search and Report Queries Differ

Even though a search and a report query both perform the same function (finding events that match
specific conditions) the two queries are distinct in these ways:
e You use Logger’s Query Object Editor to create a report query.

¢ You use the Logger’s Search Ul to create a search query. The query can be specified using plain
English keywords, field names, or regular expressions. See "Searching for Events" on page 102 for
more information.
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However, report queries and field name queries can utilize indexed fields to expedite the underlying
search.

Overview of Query Design Elements

To create a new query object, you need to specify a query name, define a data transformation, and save
it. The data source for Logger Report queries is always the Logger databases, so there is no need to
specify this as part of the query object.

Optionally, you can specify formulas, set field properties, define transformations, define formatting,
define field groups, provide hyperlinking, define lookup values, and build mandatory filtering into the
query.

Creating a Copy of an Existing Query

To use an existing query object as the basis for a new one:

1. In the Query Explorer, click on a category and select the name of the query that you want to copy
from the query list.
2. On the Actions menu, click More to expand the menu.

3. Click Copy Query Object.

4 (Root) Anti-Virus Errors Actions:

Default Reports O Failed Anti-Virus Updates Edit Query Detals

_ - Create Query Object
4 Device Monitoring Infected Systems

Anti-Virus QueryObject - Sample r. Copy Query Object

4, In the list of categories, right-click the category name under which you want to place the copied

query, and select Paste.
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Name|Denied Connections by Address
4 (Root) Cop:

Default R 0f

@ Add New Category
4 Device M
Create Query Object

Anti-V

Paste

Crossh

c Refresh

Databi

Firews Properties

ldentit <l 4ddto Favorites

DsP! [ Delete

A temporary version of the new query object is created with the same contents as the original and
the same name pre-fixed with “Copy of.”

Designing a New Query

A query object represents a data transformation, which comprises a set of steps (elements) to produce
the final output. A step can be a data source, a sort, a filter, an output, or other element. You design a
query interactively using the Query Object Editor.

The Query Object Editor is shown here. Highlighted are the Steps list and the Transformation
workspace.
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Dashboard
Scheduled Reports
Navigation
Category Explorer
Report Explorer
Query Explorer
Parameter Explorer
Favorites Explorer
Design
New Report
Parameters
Parameter Value Groups
Template Styles
Administration
Deploy Report Bundle
Report Administration
Report Category Filters
Report Categories

iPackager

Query Object Editor

'.'IT-.[lel—.'.—. Save | SaveAs || Cancel | Advanced

Name | Querydbject

61-2135 \ (ransformation \ -
4 Data Source i
Data Sowrce Format E
N Join =
' union {Ejjy =
Y riter
B sort
S Formula Fields
Dynamic Fields
£| External Task \I m ] /,, -
7 Farmat Droperties Result
\ J ficlds @ Mew Source ) Existing QO fe.| =
Connection: | (Parent) Iz‘
soL
Design
[7] Sorted
Field Properties
Data Type: Data Format:
Length: Locale:
Sort Priority: Sort Criteria: -

To create a transformation, you drag query elements (steps) from the Steps list to the Transformation
workspace, linking them in the sequence in which they will be evaluated. Then, you specify properties

for each Step.

Working with Steps

e To add a Step to a query, drag it from the list fo the Transformation workspace.

a. To specify properties for a Step, select the Step, then enter values for it in the Properties fab.
Values for Steps are listed in "Steps" on page 226

b. To see the results of a Step after you’ve added it, click the Results tab.

C. Tolink one Step to another, in the Transformation workspace, select the Step. Holding your
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mouse button down, drag and draw an arrow (link) to the linked Step.

Data Sourcel

Format2

g‘;i; \ Filter
v >

o To add a Step between two linked steps, drag and drop the step on the link.
e To rename a Step, right-click it and choose Rename Step. Then enter a new name.

e To delete alink or a Step, right-click on the item, then choose Delete Link or Delete Step.

The Query Design Process
You design a query visually in the Transformation workspace.

To design a query:

1. In the navigation menu, under Design, click Queries. The Query Object Editor opens.

2. In Name field, specify a unique name for this query object.

MWarme | Query0bject

3. Inthe Transformation workspace, drag and drop the required steps for the query from the Steps
menu into the desired sequence. (By default, the Transformation window already includes a Data
Source and Format step.)

For example, to add a sort to the tfransformation, drag a Sort element from the Step list to the
Transformation field and drop it on a link.
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Query Qbject Editor

AddMNew || Open || Delete | Save || SavedAs || Cancel | Advanced

Mame | Myanti-Virus Errors v

Steps < | | Transformation

4 Datasource

Data Source Format
N Join —
' union ‘-\i m
YV ritter =

oo

. Drop on a link to add between the steps
X Formula Fields

Dynamic Fields

] External Task 4 | m

Then, in the Properties tab, select a field to sort by.
Query Object Editar

Add New || Open Delete | Save SaveAs || Cancel || Advanced

Name | MyAanti-Virus Errors v

Steps < | Transformation

& DataSource
Data Source Format
N Join

' unien Sort _ m
Y Fitter \

‘ﬁ'Eﬂ Sort
JX Farmula Fields

Dynamic Fields

# External Task < m
E‘ Format Properties Result
Field Criteria Case Insensitive
Sort By - | El
. Then By |vendor | El
Frod
ThenBY | zana | El
Address
Host Name
Error
Count

4. Optionally, in the toolbar click Advanced, then set any advanced properties for the query object.
5. Click Save.
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Note: A blank (empty) query object is displayed when this page is opened, and the Add New
button on the toolbar is disabled until the blank query object is saved. After saving, you can

add a new query object by clicking Add New.

Steps

A step is an element of a transformation, used in the construction of query objects. To use a step, drag
it from the Steps menu to the Transformation window. The behavior of a step depends on the
properties you assign to it on the Properties tab. You can check the results of a step on the data on the
step’s Result tab.

Steps <

£ DataSource

P4 Join

U union

YV riter

& Sort

A Eormuta Fields

Dynamic Fields

El External Task

E’ Format

The following steps are available for use in the Query Object Editor:

Steps

Step Description

Data Source Brings data into the query object. You must have at least 1 data source. For more information, see
"Data Source Step" on the next page.

Join Joins two inputs. For more information, see "Join Step" on page 229.

Union Appends one input to another. For more information, see "Union Step" on page 230.

Filter Applies pre-defined filters and sets lookup values. For more information, see "Filter Step" on
page 230.

Sort Sets sorting criteria. For more information, see "Sort Step" on page 230.

Formula Fields Enables addition of calculated fields populated at runtime. For more information, see "Formula

Fields Step" on page 231.
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Steps, continued
Step

Dynamic Fields

Description

Step" on page 231.

External Task

on page 232.

Format

Lists all fields provided by the query object. Generally, the format step is the last one in the

transformation workflow. For more information, see "Format Step" on page 232.

Data Source Step

Add or remove fields to the query object at runtime. For more information, see "Dynamic Fields

Call standard and custom 3rd party procedures. For more information, see "External Task Step"

A Data Source Step brings data into the query object from the Logger database or an existing query
object. A query can have multiple Data Source Steps.

Transformation

Data Sewrce Format
) 2
< [0
Praperties Result
lelds @ New Source () Existing QO _Ev
An - -
Reporting Device Connection: | (Parent) [=]
Aa Type
soL
s User Name ¢
A#t 5ource Zone Design
Aw 5ource Address SELECT IF( events.arc_categoryDeviceGroup ="fApplication’, IF( events.arc_categoryObject LIKE 'fHost/Application/Database’, -
Aet source Host Name "/Database’, IF( events.arc_categoryObject ="/IDS/Host/Antivirus', "fAnti-Virus', IFNULL{ events.arc_categoryDeviceGroup, ") )}, IFNULL{ D
A o events.arc_categoryDeviceGroup, ) ) "Reporting Device™,
Drestination Zone events.arc_name "Type",
A#t Destination Address events.arc_destinationUserName “User Name™,
A# Destination Host Name events.arc_sourceZoneURI "Source Zone", -
An pecylt events.arc_sourceAddress "Source Address”,
@ End Time [ Sorted
Field Properties
DataType: |CHAR  [v] DataFormat:
Length: Scale: Locale: |Default w
Sort Priority: l:l Sort Criteria: ﬂ
Qualified Name: | |
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A data source step has the following properties:

Data Source Step Properties

Property Description

New Source/ Choose whether o use the Logger database or existing Query Object.
Existing QO

Connection Select either parent or the name of a connection.

e Parent: data is fetched from the connection specified at the Query Object level, or falls
back to the default connection configured for the user.

e Connection name: data is fetched only from the specified connection.

SQL A complete SQL statement designed with the SQL Designer. Only visible if the Logger
database is the data source.

The SQL Designer enables you to design SQL statements by dragging and dropping tables
(on the Design tab) or by typing the complete SQL (Edit tab).

When using the Query Editor, be sure to use the appropriate SQL syntax for your data type.
For example, to call a string data type, you must enclose the string with single quotes, as in
the query below.

select arc_deviceVendor from events where lower(arc_deviceVendor)

= 'arcsight’

Sorted If selected, the data is sorted.

Field Properties The Field Properties sub-menu (when enabled) allows you to configure the properties of
the selected field. See the "Field Properties Sub-menu" below for a description of these
properties.

Field Properties Sub-menu

Property Values Comments
Data Type CHAR, NUMBER, DATE, BINARY Select the data type of the incoming data.
Data Format Format String Specify the format of the incoming data. This is useful

only if the Date or IP Address type data are incoming in
CHAR fields, but need fo be converted to Date and
Number types for further use.

Database Time Zone Select Time zone from the list Specify the tfime zone in which the incoming date data
is stored. This is useful only if date fime data needs fo
be converted fo other time zone data based on
reporting requirement.

For example when incoming GMT data should be
converted to another time zone in the report, specify
that the incoming data is GMT. The output format is
generally specified in the Format Step or in user
preferences.
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Property Values Comments

Length/Precision Enter Enter the length of field for Char data types, and the
precision or length of field for the Number data type.

Scale Enter Enter the Scale or number of digits after the decimal
point.

Locale Select from menu Select the language/ country in which the incoming date

data is stored.

Sort Priority Number O-N If the data is sorted on multiple fields, then specify the
sort priority number of this field. Primary sort field
should be the lowest number.

Sort Criteria Ascending/ Descending Specify sort as either ascending or descending order.

Qualified Name Enter This name helps by providing a field name for SQL
clauses such as WHERE and ORDER BY.

It can also be used fo resolve field name ambiguity
when the same field comes from different tables or
expressions.

Join Step
A Join Step joins two inputs. A Join Step has the following properties:

Join Step Properties
Property Description

Select All Fields If enabled, all fields from both sources will be available in the output of this step. If
deselected, you can select which fields will be available in the output.

Join Type Select from one of the following join types:

e Inner Join

o Left Outer
e Right Outer
o Full Outer

Join Conditions Forms the Join Key.
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Union Step
A Union Step appends one input to another. A Union Step has the following properties:

Union Step Properties

Property Description

Union Type Select either Sorted or Unsorted.

Remove Duplicate Rows If selected, each row in the result will be distinct.
Column Enter the name of a column.

Click to rename the column.
Click to add a column

Click to delete the column.

Filter Step

A Filter step will apply pre-defined filters and set lookup values. A Filter step has the following
properties:
Filter Step Properties

Property Description

Ad hoc filters To apply one or more ad hoc filters, under Select Filter Criteria, enter the Field Name,
Criteria, and Value. Click + to add more filters or click X to delete one.

Lookup Values If enabled, a list of lookup values is provided to the end user to easily choose values o
apply a filter.
Mandatory If enabled, then any reports using this Query Object must apply the filter on the selected
field.
Hide If enabled, the field will be hidden from the end user in the list of fields that can be
filtered on.
Sort Step

A Sort step sets sorting criteria. A Sort step has the following properties:

Sort Step Properties

Property Description

Field Select a field from the list on which to sort. You can add multiple fields for the sort using

Sort by and Then by lines.

Criteria Sorting criteria, either ascending or descending order.
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Sort Step Properties, continued

Property Description
Case Insensitive If enabled, then case is ignored for sorting. (ABC would be the same level as abo).
Hide If enabled, the field not be seen by the end user in the list of fields that can be filtered on.

Formula Fields Step

A Formula Fields step enables you to add calculated fields populated at run fime. These calculated fields
are generally based on existing fields.

To add a formula field, click +. Then specify values for the field as follows:

Formula Fields Properties

Property Description

Name Name and capftion of the field.

Return Type Data type of the formula field (Number, Char, or Date).

Length/ o Length of field for Char data type

Precision e Precision or length of field for Number data type.

Scale Scale or number of digits after decimal point.

Formula Formula, using JavaScript syntax. To create a formula, you can use field names and define
variables.

o A formula caninclude an if construct as well as nested if and logical operators.
e Toinclude more than one statement in a formula, use a semicolon () fo separate them.
Example: For a formula field named TotalAmount,
var total ;
if (unitprice < 10 )
{total = unitprice*quantity;}
else
{total = unitprice;}
TotalAmount = total;

Dynamic Fields Step

A Dynamic Fields step can add fields to, or remove fields from, a query object at runtime. Dynamic fields
can be added by pivoting data from a single data source, or dynamically fetching metadata for field
properties.

« Dynamic Mapping ftakes each field from the metadata result set and maps it to Query Object Field
Properties. The primary mappings are Field ID, Field Name, Caption, and Data Type.

o Pivoting converts normalized, name-value paired data into flattened tabular data. The Pivot tab
includes these fields.
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o Pivot Columns: specifies which column has field ID and which column has value.

o Select Grouping: specifies grouping fields, which when grouped on, the normalized data
converfs to a flat table.

External Task Step

An external task step enabled you to call standard and custom third-party processes. Logger includes
the following pre-configured external tasks:

o Java Row Processor: for processing of Java rows

e R Job: for R Analytics Server scripts (See the table "R Job Parameters" belowfor the properties)

¢ Hive Job: for Hive scripts

¢ Pig Job: for Pig scripts

¢ Custom Map Reduce Job: for custom map reduce scripts

R Job Parameters

Property
Server IP

Plot Type
Format Type
Model File
No. of Images
Script

Validate

Format Step

Description

IP address of R server

If Format Type is an image format, select a plot type from the drop-down list
Select a format type

Location of the R model file

If Format Type is an image format, enter the number of images in the output
R script file name

Click to validate the R job

A Format Step is the last step in the workflow, and lists all fields provided by the Query Object. A Format
Step includes these parameters:

Format Step Parameters

Property
Field
Source
Caption

Hyperlink

HPE Logger 6.3

Description

Original name of field.

Step in which this field originated.

The end user will see the field by this name.

Drilldown detail or hyperlink URL.
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Format Step Parameters, continued
Property Description

Group Label To assign this field to an existing group, select the group name from the drop-down list. To
create a new group, type the new group name.

Hidden If selected, the field will be invisible to users for the reporting process.

GIS Enabled The selected field must contain GIS classification data such as country names, state, or city
names. A GIS Enabled field will appear in the selection list for the grouping option in the
GIS Mapping dialog and the Area field and the Heat Map Properties > Value fields on the
Create Map dialog. For more information, see "Map" on page 213.

Format properties
Width The default width of this field when dragged onto a report. Valid values 1-100.

Output Format Enter a format string. The field value will be formatted using the format string. Useful for
date and number formatting. (If you need to decide the format string at runtime, select
Apply Locale Default.)

Align Field alignment (left, center, right) when assigned to a report.

Input Format Enter a format string. The string determines the prompting format for the value of this field
in Ad hoc filters. Useful in prompting date or IP values in the desired format.

User Time Zone Time zone for the display of report dafa. The Report Server calculates the difference
between Database Time Zone and User Time Zone, and does fime conversion. To decide
time zone atf runtime, select SYS_USER_TZ

To define a Format Step:

1. From the Fields list, select the field for which you want to define an input format. (The selected
field is bold.)

2. Select the appropriate format and provide necessary values for that format.

To designate a mandatory filtering field:
From the Fields list, select a field you want as a mandatory filtering field.
Click the Mandatory checkbox to the right of the Fields list.

Other fields can be selected or deselected using the Mandatory checkbox.

Parameters

Reports retrieve data by running pre-built query objects. If a query needs a value at report run time, it
uses built-in, run-time parameters. At report run time, the user is prompted to provide values for run-
time parameters as a prerequisite for running the report. The report is then generated based on the
user-provided values for those parameters.
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Parameters are stored on the server, and therefore can be used in one or more report and query
objects.

Note: We recommend first designing all needed parameter objects before creating the query object
that will use those parameter objects. (For information on creating queries, see "Queries" on
page 219.)

e Parameter Object Editor

e Configuring Parameter Value GroUpsS ... . . .. 240

Parameter Object Editor

To view and work with Logger Report parameters, under Design, click Parameters in the Reports left
pane or click Parameter Explorer and click on a category, select a parameter, and click the Edit
Parameter Details button to open the Parameter Object Editor.

Parameter Object Editor

dd New Open || Delete || Save || SaveAs || Cancel
|Parameter0b]ect | Combo Source
Wame
Values ‘= PreDefined soL
D Pre Defined List
Prompt | | Display Name Value
DataType | CHAR v | size[30 |
Format - N
Prompt Format
|
Description
|| Mandatory [##] Visible + Restrict to List
|| Pass Values Using Tables [##] Enable[ | Forced
r~Input Type Display Parameter Name
(® TexiBox () Combo (_) Option
Muiti Select Search Tree View Linked Parameter [ validations
— Valid Character(s) Invalid Character(s)
Alowed Characters Invalid Characters
Range(s) Range(s)
’7 From To ’7 From To
e Creating NeW Parameters o 235
o Modifying a Parameter 239
o Deleting a Parameter oo 239
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Creating New Parameters

To create a new parameter:

1. In the Parameter Object Editor, click the Add New button located at the top left.

2. Specify values for the new parameter. (Details are given in the topics below.)

Caution: The parameter name must be unique amongst all parameters in the system.

3. After providing all required values, click Save.

4. The parameter is added to the Parameters list.

Note: A blank (empty) parameter object is displayed when this page is opened, and the Add
New button on the toolbar is disabled until the blank parameter object is saved. After saving,
you can add a new parameter object by clicking Add New.

Setting Parameter Name, Data Type, and Default Values

Specify the parameter unique ID, display name, data type, size, format, and default value as described in
the table below.
Parameter Name, Data Type, and Default Values

Option Description

Name Provide a name fo uniquely identify this parameter. This name should be unique amongst all
parameters in the system.

Prompt Parameter name displayed to the user at report run time.

Data Type Specify type of value the user must provide at reportf run fime:

e CHAR - Value may include alphabetical characters, numbers and special characters.
e NUMBER - Value may include digits and decimal points
e DATE - A date or part of a date, like day, month, or year

e BOOLEAN (For more information, see "Setfting up Boolean Parameters" on page 237.)
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Parameter Name, Data Type, and Default Values, continued
Option Description

Size Specify number of characters or digits this parameter should accept.

Note: This is only applicable to CHAR and NUMBER data types, not for BOOLEAN or DATE

parameters.

Format Select the appropriate format in which user should provide value for this parameter. Click _| to
open a Data Format dialog box. Based on the format you have selected, a format string is
displayed in the entry box.

Default Specify a default value that is appropriate in most cases to provide for this parameter at report

Value run time.

The default value will be automatically selected at report run fime. The user can change the
default value, if needed. If the user does not change it, the report will run using the default value
you specify here for this parameter.

Default Value for Date Type Parameter

For a date type parameter, the Default Value field provides a pull-down menu and a calendar. Click the
calendar icon B 1o provide an explicit date, or select one of these dynamic variable values from the
pull-down menu:

o CURRENT_DATE
o MONTH_START_DATE
o YEAR_START_DATE

You can also set a default date that is relative to any of the above three dynamic variable dates.

For example, to set a default date as 3 days after CURRENT_DATE, specify
CURRENT_DATE + 3.

To set a default date as 5 days before MONTH_START_DATE, specify
MONTH_START_DATE - 5.

To provide a value that is relative to a dynamic variable, select one of the dynamic variables, then type a
suffix fo it in the Default Value field by adding + or - and the number.

At report run fime, a parameter with a Date format will display with the default date set here.
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Defining Input Type

The parameter input type describes the style of interface provided to users at report run time in which
to enter a value for this parameter. Choose from Text Box, Combo, or Option as described below.

Note: In the Reports Designer, changing the parameter type TextBox to another type causes an
error. If you need to change the parameter type to TextBox, do not edit an existing parameter,

delete that parameter and add a new one.

Input Type
Option Description
Text Box Select Text Box input type if you want the user to type the value for the parameter.
Combo Select Combo if you want the user to select one value or multiple values from a pull-down menu.
Select the Multi Select checkbox so that user can select multiple values from the box.
See "Setting Multiple Default Values" on page 239 to configure other settings for this option.
Option Select Option if you want the user to select values represented as options.

Select the Multi Select checkbox to have value options in the form of checkboxes.

Keep the Multi Select checkbox deselected o have options in the form of radio buttons.

Setting up Boolean Parameters

Parameters that have a Boolean data type are represented to the user as checkboxes (the input type)
and have only two states:
o Checked (chosen at run time)

e Unchecked (deselected at run time)

To set up a BOOLEAN parameter:

1. Select Data Type as BOOLEAN.
2. In the Values ares, select an option:
a. Checked: Specify the value to be passed when the user selects this option at run time.

b. Unchecked: Specify the value to be passed when the user does not select this option at run
fime.

Setting Various Run Time Behaviors

You can specify a variety of options on how the parameter will look and act at report run time. These
options are generally related to the input type, and further define acceptable user input values, whether
the parameter will be displayed or hidden, which values can be searched, and so forth.
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Parameter Options

Option Description

Mandatory Select this checkbox if you want to require the user to specify a value for this parameter at

report run fime.

Visible Select this checkbox if you want the parameter to be displayed on the input form at report run

time.

Keep this deselected if the value for this parameter is populated from another report or if you
want the parameter fo use the default value in all cases.

Restrict to List This setting is applicable for parameters with Input Type of Combo. select the Restrict to List

checkbox here to force user input of a parameter value from the available run-time options
only.

If Restrict to List is not selected in the parameter definition you create here, the user can
specify a value or can select values from available options.

Pass Values Using This setting is applicable for Multi Select. Select this checkbox when you want to pass
Tables parameter values through a table. This is done especially when the number of values that can

be passed (total number of bytes of selected values) as part of the SQL is more than allowed.

Enable

Forced Select this checkbox if you want to restrict parameter values to a pre-specified list of values.

Setting the Data Source List

Specify values for Check box, Combo, and Option input type. Values can be predefined only.

To Set Predefined Values:

1.
2.

In the Display Name field, specify the value to be displayed to the user at run fime.
In the Value field, specify the value to pass as a filter.

Click [ (Add) to add the display name to the list.

(To delete an option from the list, select the value and click )
Repeat these steps for each option.

Select the Display Parameter Name checkbox if you want to provide the user with the option of
adding the parameter as a control on a report.

Once selected, the Display Parameter Name field is auto-filled with the parameter display name
that can be selected for use on a report. The name displayed on the report is the one specified in

the Prompt field.

Tip: The Display Parameter Name settings have no effect when the Parameter Object is
used in an ad hoc report.
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Setting Multiple Default Values

If you selected Combo Input Type (as described in "Defining Input Type" on page 237), you need to
define the following settings in the Parameter editor:

Maximum Selectable Values: Specify the maximum number of values that can be selected or provided

for a parameter.

Enclosed By: Specify the character to use to enclose the set of values. This will depend on the
database.

Separator: Specify the character to use to separate the two values. This will depend on the database.

Select Default Values: Specify the number of default values to display at report run time. You can
choose from the following:

a. Selected: Only values for the selected parameters are displayed.
b. All: Values for all parameters are displayed.

c. None: No default values are defined.

Modifying a Parameter

To modify a parameter:

1. On the Reports right panel menu, click Parameter Explorer to display the Parameter Object list.
2. Browse to the parameter you want to modify.

3.
4

. Edit the parameter as needed (using the settings described in "Creating New Parameters" on

In the Actions menu, click Edit Parameter Details.

page 235) and click Save.

Note: Only custom parameters can be modified, not supplied parameters, since supplied
parameters are required for use in system Reports and Solution pack add-ons.

Deleting a Parameter

To delete a parameter:

1.

On the Reports left panel, click Parameter Explorer to display the Parameters Object list.

2. Browse to the parameter you want to modify.

3.

In the Actions menu, click Delete.

4. Click Yes to confirm deletion.

Note: Only custom parameters can be removed, not supplied parameters, since supplied
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parameters are required for use in foundation Reports and Solution pack add-ons.

Configuring Parameter Value Groups

Some reports may require users to provide multiple run-time values that would be easier to select if they
were grouped. For example, a report that requires a user to select more than one country name might
be a good candidate for parameter value groups. Users might find it difficult to select a few country
names from a single, long list of countries.

As an alternative, the query designer could create parameter value groups for the Americas, Europe,
Asia, Africa, and so forth. Each parameter value group would conftain lists of countries belonging to
those continents or areas. At report run time, when the user selects a group, values belonging to the
group are pre-selected. Users do not have to manually select countries in parameter groups for every
report run. Selections are saved from one report run to the next.

Using parameter value groups as a part of your query design strategy can save users time and reduce
error at report run fime.

To view and work with Logger Report parameter value groups, under Design, click Parameter Value
Groups on the Reports left panel.

Parameter Value Groups

=

Name

4 £ (Roob)
7 Default Reports
7 Device Monitoring
7 Foundation
7] Payment Card Industry
7] SANS Top§s
gﬁ category0bjectParameter
gﬁ commonlyBlockedPorts
ps destinationAddress
p% destinationPort
gﬁ deviceGroupParameter
p¥ deviceProduct
gﬁ deviceSeverityParameter
pt deviceVendor
tps dmBandwidthParameter
gﬁ dmConfigurationParameter
p¥ dmLoginParameter

g@ eventNameParameter

HPE Logger 6.3

-

Save Cancel
Selected parameter: categoryObjectParameter
Avaiable Values
Host -
Host/Operating System
Host/Applcation
Host/Applcation/Database
Host/Application/Database/Data
Host/Applcation/Service
Host/Application/Service/Email

Host/Application/ServicefInstant
Messenger

Host/Applcation/Service/MMS
Host/Application/Service/Peer to Peer
Host/Applcation/Service/Phone Call
Host/Application/Service/SMS

& |~ ¥ v

Host/Applcation/Service/Remote Control
Host/Applcation/Malware
Host/Applcation/Malware/Adware
Host/Appication/Malware/Backdoor
Host/Applcation/Malware/Do5 Cient
Host/Appiication/Malware/Spyware
Host/Applcation/Malware/\Virus
Host/Appiication/Malware/Worm

-

Value Groups

AllHost Dbjects

Host

Host/Operating System

Host/Application
Host/Application/Database
Host/Application/Database/Data
Host/Application/Service
Host/Application/Service/Email
Host/Application/Service/Instant Messeny
Host/Application/Service/MMS
Host/Application/Service/Peer to Peer
Host/Application/Service/Phone Cal
Host/Application/Service/SM5
Host/Application/Service/Remote Contro
Host/Application/Malware
Host/Application/Matware/Adware
Host/Application/Malware/Backdoor
Host/Application/Malware/Do5 Client
Host/Application/Malware/Spyware
Host/Application/Malware/Virus

[#]

= ﬂ ] Show AllOwners'

Private ® Public

User : admin
Organization  : ArcSight
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The following table describes the options on the Parameter Value Groups page.

Parameter Value Groups

Option Description

Name Lists all the parameter objects.

Available Values Lists available values for the selected parameter.

Value Groups Lists groups created and the values selected within a group. An icon is displayed on the left

of a Private group.

Show All Owners If selected, displays groups created by all users.
Option buttons: Select Private to list the groups you have set for you only.
Private

Public

Select Public if you wish fo list the groups you have set for everyone.

To create a group:

1.

Click & (Add Group) next to the Value Groups box. A group is created and listed under Value
Groups with a default name (based on the currently selected parameter in Parameters list).

In the Value Groups list, edit the new group name as needed. (Double-click the name to edit it, if it is
not already in edit mode.) Double-click the name again to set it, or click outside the box.

Add the values you wanft in the group by selecting a value in Available Values list and clicking 2|
(Add value to selected group) button. The selected value is added to the selected group in the
Value Groups list.

Repeat the previous step for each value you want to add to the group.

If a value that you want to add to a group is not listed in Available Values list, specify the value in

Additional Value field (under Available Values) press Return key. The custom value is added to
the currently selected group.

Select an Available Value and click 22| to add all the values to the selected group in Value Groups,
click ¢! to remove the selected value from Value Groups, and click 4 to remove all the values from
Value Groups box.

Select a group and click up #land down | arrows to move the selected group up or down. Select
avalue and click up ~land down *!arrows to move the selected value up or down (within the
group).

Click Save.

Note: If the name of a group is changed by a user, the values under that group will be removed
from the Selected Values group of that user's preferences.
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To create a tree view parameter:

1. Click the leaf node and click the right arrow >l button.

e To select all values in a branch (only for a multi-select parameter), click the branch and click the

3_] button.

o To make changes in name of a group, double-click the group name to make it editable. Specify a
new name and click outside the box.

e To delete a group, click X in the title of group you want to delete, and then click the Save
button to save the changes.

Template Styles

Logger reports use a style file (. sty) to generate report output in a specified format. The style file
defines the look and feel, arrangement, and orientation of the report output.

You can modify any of the style files from the Logger Reports Template Styles page or you can define a
new style o suit your needs.

Note: A report layout file (. irl) defines factors like paper size, static controls, and headers and
footers to include in a report. You can define your own layout files. See "Defining a New Template"
on the next page for more information.

To view and work with Logger Report template styles, under Design, click Template Styles on the

Reports left menu bar.

Templates [+][&]
A staswin 2]

Layourt File

Style File

»

P Style Name
Beach
Blank Report Header
BlankMuttiChart1
BlankMuttiChart2

BlankWithHeader

Report Footer
Page Header

Classic Page Footer

Delicate Group Header
Natural Group Footer
Nature
NatureMulfiChart1
NatureMultiChart2
NightSkyChartWidget

Ocean

Detail Section
Grid

Chart

Matrix
Ocean_Liners DataBar
Official

P b b b b b b b b b ob b b S i 4

4

Orientation
HTML
Wetwork Graph
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ftems————

- Autumn.irl

- Autumn.sty

Item Properties

Edit Layout Preview

Save Cancel

Stvle
Horizontal Alignment

Vertical Algnment

Preview

|funt-fam'\|y: Arial Unicode MS; font-weight: bold; for| | ...

Sample

Item Description

Fontand alignment refated infarmation for the text on report header section of the report. This section appears once on the top of the repart.
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Defining a New Template

Before creating a new template, you may want to check whether there is an existing one that meets
your needs.

To search for an existing template, do one of the following:
o Enter the first few letters with which the template name begins (if the Starts With search criteria is
selected) in the text box above the list of existing templates.

e Enter a word or part of a word that the femplate name contains (if the Contains search criteria is
selected) in the text box above the list of existing templates.

To define a new template:

Under Design, click Template Styles on the Reports left menu bar.
. Click the ¥ icon in the right panel.

1.
2
3. Define the Items and Item Properties for the template.
4

. If you want to define or change the report layout file, click Edit Layout.

Tip: You will need to edit the layout of the report to include a header or footer in a report.
After clicking Edit Layout, click “Report Header” (to include a header) or “Page Footer” (to

include a footer) to select that section. Click Insert > Layout Control > select an option from
the sub-menu.

v

Click Save.

Administration

This section discusses Logger report administration. It discusses how to deploy report bundles,
configure report server settings, administer report categories and category filters, and manage report
packages.

Deploying a Report Bundle

You might obtain additional sets of reports from ArcSight to address new security scenarios, add
packaged solutions, or enhance your current coverage with updated reports. You can use the Deploy
Report Bundle page fo load and deploy packages of new reports onto your Logger system.

On the Reports page left panel menu, click the Deploy Repository Bundle link to start.

HPE Logger 6.3 Page 243 of 623



Administrator's Guide
Chapter 4: Reporting

Deploy Repository Bundle

Step T:(Upload & View Cab Information)

Browse

|Jpload

Step Z2:(Deploy Objects On Report Server)

¥| Create Log File

A report package (or CAB file) can contain several types of reporting resources, including:

Categories and reports

Organization information

Portal properties and server properties
Parameter objects

Query objects

Ad hoc report templates

Printer seftings

Database connections

To upload and deploy report package:

1.

In the entry box provided under Step 1, specify the reports package file name and with its full path.
Click Browse to locate the file.
Click Upload.

The content is uploaded and information is displayed about the included categories and reports. (A
legend is provided below these steps).

3. If you want to create log of the deployment process, select the Create Log File option.

Click Deploy to continue with the deployment process, or click Cancel to discontinue with
deployment process.)

Status information is displayed about the objects in the package being deployed.
A legend is displayed just below the Deploy button. Information about each of the components in
the package is displayed in respective tabs.

Note: Overwrite behaviors are determined when the package was created.

For example, protocol on whether or not an object in the deployed package will overwrite an
existing object on the system, and under what circumstances, is determined at package
creation time. Therefore, these settings on package deployment are not available to you at
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deploy time.

A log file will be created if the Create Log File checkbox was selected.
The content of the deployed reports package is available on the respective Logger Reports pages.

Solution Reports will be listed under Solution Reports on the left panel menu. For more information
about these types of reports, see "Solution Reports" on page 160.

Report Server Administration

Logger Reporting provides a default configuration for the report server. If you do not modify the
report server, reports will run with the default settings.

Timeouts when Running Reports

There are two timeouts that can affect long running reports.

e The client timeoutis 1hour. If an ad hoc report takes more than an hour to run, it will fime out. Use a
scheduled report instead.

o The default database connection timeout for scheduled reports is 4 hours. If a scheduled report
takes more than 4 hours to run, you can increase the database connection timeout from the Report

Configuration pane.
Report Configuration

To view or modify the report server configuration:

1. Click Reports in the navigation bar.

2. Click Report Administration under Administration. The Report Configuration dialog is
displayed.
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Report Configuration

Save || Cancel

Database Connection TimeOut (seconds) |2r.]'| 18 |ﬂ
Data Source Fetch Size (rows per fetch) | 50 |
Log Level H

SMTP Server |‘IS.2'I4.'I 28.13 |
EMail From Address | F |
Jab Errar Mail To | F |
Host URL |ttps://<logger_hostname>/lo|

Sign Document Formats |

Sign Document Manaage Certificates
|PDF
AL

Sign Document Operations

Sign Document On Page ﬂ
Sign Document Location Corner Left Bottom H

Save || Cancel

3. When you have finished entering the report configuration settings, click Save.
The following table describes the report configuration settings.

Report Configuration

Option Description
Database Connection Time in seconds after which the database connection will be closed, if not used for that
Timeout (seconds) many seconds.

Valid values include any integer greater than zero.

Default: 14400

Example: If DATABASE_CONNECTION_TIMEOUT is set to 50, the report server will close the
connection to a database if there is no communication between the report server and
database server for 50 seconds.

Data Source Fetch Size Specifies the number of records to be fetched from the data source at one time (in one
(rows per fetch) “read”).

A valid value is any positive integer.

Default: 50

Example: DATA_SOURCE_FETCH_SIZE=50
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Report Configuration, continued

Option

Log Level

SMTP Server

Email from Address

Job Error Mail To

Host URL

Sign Document

Sign Document Formats

Sign Document
Operations

Sign Document on Page

Sign Document Location
Corner

HPE Logger 6.3

Description

Sets the level of criticality fo be considered for logging.
Valid values are DEBUG, INFO, WARN, ERROR, FATAL.
Default: ERROR

Example: LOG_LEVEL=ERROR

Sets the server IP address or domain name (as IP or URL) used to email scheduled reports.
All email communications, such as nofifications and report delivery, are sent by Logger
Reporting using this email server.

Example: SMTP_SERVER=127.0.0.1

For information on Logger's SMTP settings, see "SMTP" on page 413.

Sets the sender's address in emails originating from the Logger Reporting system.
Example: loggeradmin@companyxyz.com

Email address to receive job error messages, when generated. To include multiple addresses,
separate them by commas.

Host URL (URL to the Logger application) sent as part of Logger Reporting Emails.
Syntax: HOST_URL=[Host URL](String)

Default: https://<logger_hostname>/logger/report

Example: HOST_URL=https://loggerA.xyz.com/logger/report

Enable or disable the digital signing of reports. Options are Enable and Disable.

Default is Disable.

An administrator with correct permissions can browse and upload signature files. This can
be done at global, organization or user level. When the Sign Document property is enabled,
then these signatfures are applied to the documents. See "Certificates" on page 342.

Currently, PDF is the only supported format for signatures.

Enter what types of report operations should have a signature applied. Options are View,
Email, Publish, Upload, Print, or All.

Default is ALL
Choose on which page the signature should appear. Options are First and Last.
Default is Last.

Choose on which page corner the signature should appear. Options are Right Top, Right
Bottom, Left Top, Left Bottom.

Default is Left Bottom.
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Report Categories

The Category Explorer comes with some System-defined commonly used categories. You can edit them
as needed.

To navigate to an existing report category:

1. Click Reports on the top-level menu bar.

2. Click Report Categories in the Administration section in the left pane. The Deploy Reports and
Categories displays available categories.

Deploy Reports And Categories

LookIn [ (Raot) [z = [0 B X Reirasn | Show AlOwners

iz Default Reports

(7] Device Monitoring

[z Foundation

[z Payment Card Industry
57 SANS Top5

Save || Cancel | Delete Cascade

Properties

Public Private || Hidden

Category Menu Name Default Reports CategoryD Default_Reporis

3. Click the navigation tree button (=) next to the Look In field, and navigate through the tree to
the desired location.

For this example, navigate to Root > Foundation and double click Intrusion Monitoring.

The Deploy Reports and Categories dialog displays the subcategories and reports in that
category.

4. Click the report you want to access.
For this example, click Device Interface Down Notifications.

The Deploy Reports and Categories dialog displays the properties and Default output format of
the report you selected.

Adding a New Category

In addition to using the existing report categories, you can create additional categories to meet your
business needs.
To add a custom category:

1. Click Report Categories in the Administration section in the left pane.

The Deploy Reports and Categories displays the available categories. A toolbar across the top of
the page displays buttons for the available actions.
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2. Click Add New Category ﬂ

3. Define the properties for the new category and click the Save button.

Property
Public
Private

Hidden

Used for...
Setting this as Public makes the category available to everyone
Setting this as Private make the category available to you only

Select the Hidden checkbox to hide the display of this category in the Report Explorer. It
will still be displayed in other Explorers.

Category Menu Name of the Category

Name

Category ID

System
Generated

Category ID should be unique across all the categories. By default, the Category ID is auto-
generated by the system. To specify the Category ID manually, deselect the System
Generated checkbox and specify the category ID.

To specify the Category ID manually, deselect the System Generated checkbox and
specify the category ID.

Delete Cascade You can delete a category only if it is empty. To delete a category including its contents,

check the Delete Cascade checkbox.

Note: Once set, Category ID and scope (Public / Private options) cannot be changed.

4. You can optionally add a report to the category. To do so, double-click any category to open it and

click the Add New Report T button. Define the following properties in the Properties box:

Property
Public
Private

Hidden

Report File

Report
Name

Report ID

Design
Mode

HPE Logger 6.3

Used for...
Setting this as Public makes the report available to everyone
Setting this as Private make the report available to you only

Check the Hidden checkbox, if you do not want fo display this report in any of the dialogs and
pages (except in the Report Explorer). Mark a report as hidden to stop users from directly accessing
it.

An existing data file from which a report is generated. See "Report File Formats" on page 187.

The Report Name has to be unique within a category

A unique ID for the report that is auto-generated by the system by default when you run and
publish the report. To manually enter an ID of your choice, deselect the System Generated
checkbox and enter an ID in the Report ID field.

Text in Design Mode indicates if the report was designed using Studio (Web Studio or Desktop
Studio) or ad hoc Report Wizard.
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Property Used for...

Deployment A report deployed as Read Only cannot be modified and uploaded with same name. A report

Type deployed as Custom can be modified and uploaded with the same name.

Output Output Formats in which this report can be generated. Formats not selected here will not be
Format available for this report.

System To specify a Report ID manually, deselect the System Generated checkbox and specify the Report

Generated ID.

Deleting an Existing Category

You can delete a category only if it is empty.

To delete an empty category:

1. Click Reports on the top-level menu bar.

2. Click Report Categories in the Administration section in the left pane.

The Deploy Reports and Categories displays the available categories. A toolbar across the top of
the page displays icons for the available actions.

3. Click the tree button (:E';) next to the Look In field, and navigate through the tree to the desired
category.

4. Select the category click the Delete (7<) button to delete the selected category.

To delete a category and its contents:

Click the Report Categories link in the left pane, select the category, check the Delete Cascade
checkbox and click the Delete Selected Category < button.

Note: If you attempt to delete a category that is not empty, and the Delete Cascade checkbox is
deselected, a message Failed to delete the category isdisplayed on top left of the page.

Report Category Filters

A Search Group filter can be optionally assigned to each report category. Assigning a Search Group
filter to a report category means that all the reports in the category will only process events returned by
this filter.

To assign a search group filter to a report category:

1. Create the filter that you would like to apply to every report in a given category. See "Filters" on
page 260 for the details of creating a filter of type Search Group.

2. Open the Reports page.
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3. In the menu, under Administration, click Report Category Filters.
4. The new search group filter are displayed in the pull-down menu associated with each category.
Select the desired filter for each category.

5. Click Save.

To remove a search group filter from a report category:

1. Open the Reports page. In the menu, under Administration, click Report Category Filters.
2. Inthe pull-down menu associated with the report category from which you want to remove the
filter, select None.

3. Click Save.

Placing a System-defined Query or Parameter into a Category

You can place a pre-defined query or parameter into a category. Use the cut/paste feature to do so
because cutting and pasting will preserve its ID.

To cut and paste a query/parameter:

1. Click the Query Explorer or Parameter Explorer link (depending on what you want to place in
the category) in the left pane.

2. Click on the pre-defined query/parameter you want to move.

3. Click the Cut Query Object/Cut Parameter Object = button on the side button bar.

4, Click the category name under which you would like to place this query/parameter.

Note: You cannot save a report in the root category. Save it in one of the existing
subcategories, or create a new category.

B=
Click the Paste - button on the side button bar.

5. Do not copy and paste a query or parameter to place it in a category. Doing so will give the query
or parameter a new ID and render it unusable to reports or other existing objects that are using it.

Use cut and paste, instead.
You can schedule any report to run once at a later date or on a specified frequency (such as daily or

weekly). Monthly reports cannot be scheduled currently. For more on this, see "Scheduled Reports" on
page 192.

You can run, publish, and save the results of any type of report. For information on these common
reporting tasks available on all reports, see "Running, Viewing, and Publishing Reports" on page 179 and
"Task Options on Available Reports" on page 180.)
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Backup and Restore of Report Content

You can back up and restore report content. For more information about this feature, see
"Configuration Backup and Restore" on page 383.

iPackager Utility

The iPackager utility enables you to package reports and report objects residing in Logger. This
package can be later imported to a different Logger installation. If you own multiple Loggers, you can
use the packages to configure reporting features on them. This method eliminates the need to
configure reporting features for each Logger.

Note: The iPackager utility requires administrator privileges.

To access the iPackager utility:

Open the iPackager page in one of the following ways:

o Click Reports from the top navigation bar, and click iPackager from the Administration section.

o Click iPackager from the Administration section of the Reports quick access menu.

How iPackager Works

The iPackager enables you to first create a configuration (. conf) file, in which you can collect (import)
the references for all the entity objects that you want o include in the package. You can save the
configuration file and edit it at any time. Once you are satisfied with the contents of the . conf file, you
can build the package into a CAB file. Data can be imported from multiple report servers and packaged in
a single CAB.

Note: You can open only one . conf file in iPackager at a time.

When iPackager opens a . conf file, it checks for the availability of the objects already imported in the
.conf file. If any of the objects already imported are not found on the report server, it is indicated on the
tree view. The CAB file cannot be built until the missing object is replaced, or the object is removed from
the . conf file.
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The iPackager Page

The iPackager page consists of three panes that are located to the right of the quick access menu on
the Reports page—Entity Type, Select Entities, and Selection Summary.

Repository= iPackager > Untitled.conf

Open

Entity Type

4 [ Repository
Reports
Query Objects
4 Parameter Objects
[T] nclude value Groups
Dashboards
Dashboard Widgets
4 [7] configuration
Web Client Properties

Templates

Select All Data From Report Server

Save Save As Build Cab

Select Reports

4 [ Repository
4 [¥; ) Device Monitoring

[T Anti-virus
¥ crossDevice
[ patabase
[Tl Firewall
[[I%+7 1dentity Management
[ 1 1Ds-1PS

4 ¥ ) Network

{= Report Layouts{2/6)

[[I%: ) operating System
[t ven

[T 1 Foundation

¥z Logger Administration

[CIf:] SANS Top 5

Cancel

m

Upload Download

Selection Summary

2 Client Config Property(s) Selected
6 Category(s) Selected

3 Parameter(s) Selected

1 Query Object(s) Selected

19 Reportis) Selected

¢ The Entity Type pane displays the repository objects available in the report server. These contents
are displayed in a tree view, and checking or unchecking the object will add or remove the object

entities in the . conf file.

e The Select Entities pane displays a list of selected object entities available and selected. The pane
title will vary with the enfities you select. Checking or unchecking the enftity will add or remove it from

the . conf file.

e The Selection Summary is the area where you can view the summarized details of your selected

objects and entities.

Messages and information display above the menu buttons.

HPE Logger 6.3
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Actions Available from the iPackager

The following actions can be performed from within the iPackager:

Action Description

Add New Creates a new configuration (. con-) file.

Open Opens an existing . conf file in iPackager.

Delete Deletes the selected . conf file.

Save Saves the currently open . conf file.

Save As Saves the . conf file that is currently open under a new name.
Build CAB Initiates the process of building a CAB file.

Cancel Cancels the operation.

Upload Uploads the . conf file fo a web server.

Download Downloads the .

Selecting Entities

conf file from a web server to the browser’s default download folder.

Repository= iPackager = Untitled.conf

Open Save Save As Build Cab

Entity Type

Repository o-
4 [ configuration
Web Client Properties 0

Templates

Select Web Client Properties

4 ¥ configuration
o
0 s
Egn
WS
D

Adhoc Viewer Configuration
Portal Use Cases Configuratior
HTML Toolbar Configuration
Web Client Configuration

Web Portal Menu Configuratiol

T | »

Select All Data From Report Server e

v

You can select entity objects with different levels of granularity:

Cancel

e R e s R e e i o S ey

Upload Download

Selection Summary
2 Client Config Property(s) Selected

(2]

Al entities inside repository are selected. ()

0 To select all the entities within a repository, click the check box for the entity type. The Selection
Summary pane displays "All entities inside <repository name> are selected."

0 To select a subset of a repository, open ( ) the entity type and select an entity sub-type from the
open list. The Select Entities pane displays available entity objects. After you've made your selection, the
Selection Summary page displays the number and type of entities you select.

HPE Logger 6.3
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6 To select all the entities from the report server, click "Select All Data From Report Server" at the
bottom of the Entity Type pane. The Selection Summary pane displays "All data from report server is
selected." Click "Deselect Complete Data" to revert the selection.

Adding Entity Objects to a Configuration File

You can import entity object references from a report server into a . conf file.

Note: Only references to the entities will be imported. The actual components will be imported
during the creation of the CAB file.

To add entity object references to a .conf file:

1. Select the entity objects you want to import. See "Actions Available from the iPackager" on the
previous page.

2. Click Save or Save As to open the Save Configuration File dialog box.

3. Enter a name for the configuration file.

4. Click Save. If successful, a confirmation message displays at the top of the page.

Repository= iPackager > MyReportsCfig.conf

@5 MyReportsCfg.conf Saved Successfully

Add New Open Delete

Note: The Add New button is now available, which clears the entity selection panes for a new
configuration file.
Modifying Entity Object Properties

You can modify the properties for entity objects in an open . conf file.

To modify an entity object property:

1. Click Open to open an existing . conf file.
2. Select the entity types to open the object you would like to modify.

3. From the Select Entity pane, right-click the object and click Properties from the popup menu.
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D‘@ Accounts Created by User Acc
D‘@ Accounts Deleted by Host
‘@ Accounts Del=ted b llaoe fo-
D‘@ Anti-Virus Ug Prnp@s

D‘@ Anti-Virus Updates-all-Summa

m

The Properties dialog box displays for the object. Each object displays its own default properties.

Report Properties x

Category Name: | Configuration Monitoring
Report: | Accounts Deleted by User

Version: = 0.00

Deployment Type: Editable H

Deployment Options

if Exists: [¥] Overwrite
[ Delete
if Not Exists: Add

Update || Cancel

Object names are pre-populated with the object name from the report server. You can change the
name of the object. If you change the name here, the object is packaged with the new name, but its
original name on the report server will not change.

In addition, all objects have some variation of the following Deployment Options:

o If Exists:

o Qverwrite — While importing, if the component is found in the package, replace the one in
package with the one on the report server.

o Delete — While importing, if the component is found in the package, delete it.

o Cascade Delete (Category folders only) — Delete the category folder, even if it contains
reports.

o If Not Exists:

o Add — While importing, if the component is not found in the package, add it to the package.
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Opening an iPackager Configuration File

To open an existing .conf file in iPackager:

1. Click Open in the iPackager toolbar. The Open Configuration File dialog opens.

2. Select an available configuration file.

3. Click Open.

Deleting Entity Objects from a Configuration File

To delete an entity object within a .conf file:

1. Open the . conf file in iPackager.

2. Open the repository that contains the entity object.
3. Deselect the check box for the object.
4,

Click Save.

Deleting an iPackager Configuration File

To delete a .conf file:

1. Open the . conf file in iPackager.
2. Click Delete.

3. On the warning dialog, click Yes to confirm the deletion.

Building the CAB File

When you issue command to build the CAB file, the actual objects specified in the references in your
open .conf file are actually picked up from the respective locations and a CAB file is built. This CAB file
will contain all the objects.

If any of the information saved in the . conf file is not available at the right source while building the
CAB, then you will see an error message and the CAB building process stops. You will need to fix any
errors before rebuilding the CAB file.

To build the CAB file:

1. Click Build CAB.
2. On the Build Properties dialog, enter a name for the file.

3. Optionally, enter information in the Author, Company, Version, and Comment fields.
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4. Click Build and Download. The Build Status window displays the status. To halt the process, click
Cancel Build.

5. When the CAB file is complete, follow the prompts to view the objects included in the file.
Deploying a Repository (CAB) File

Caution: When deploying a CAB file from a source Logger to a target Logger, if the categories
being imported do not have identical names and IDs on both Loggers, the deployment will fail.

Should you encounter this issue, rename the conflicting category in the target Logger or the source
Logger (you will need to recreate the CAB file if you do this on the source Logger) such that the
category has a unique name or ID. Then, redeploy the CAB file.

To deploy a CAB file:
1. In the Reports navigation pane, click Deploy Report Bundle.

Deploy Repository Bundle
Step 1:{Upload & View Cab Information)

Browee
|Upload
Step Z:(Deploy Objects On Report Server)

¥| Create Log File

2. Click Browse to select the CAB file, and click Upload.
3. Click Deploy. The CAB file is deployed.
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The following topics describe how to create and manage receivers, forwarders, devices, device groups,
SmartConnectors, and filters. Receivers, devices, and other resources created by one user are visible to
all other users, although subject to user group privileges. Resources are shared by all sessions.

O S AN L 260
L - - N 291
LY (e =T = 347
o Scheduled Tasks ... 359
o Advanced Configuration . 363

You can access these configuration options in the Logger Ul from the Configuration dropdown menu
or by starting to type the feature name in the Take Me To... text box and clicking it in the dropdown list.

Configuration “*

Search
Filters

Search Group Filters

Saved Searches
Scheduled Searches/alerts

Saved Search Files

Search Indexes
Search Options
Fieldsets
Default Fields
Cusfom Fields

Running Searches

Lookup Files

HPE Logger 6.3

System Admin

Data
Devices

Device Groups

Receivers
Source Types

Parsers

Forwarders
Realtime Alerts
SNMP Destinations
Syslog Destinations
ESM Destinations

Certificates

Data Validation

Storage
Storage Groups
Storage Rules

Storage Volume

Event Archives
Daily Archive Settings

Archive Storage Settings

Scheduled Tasks
Scheduled Tasks
Currently Running Tasks

Finished Tasks

Advanced

Retrieve Logs

Maintenance Operatfions

Maintenance Results

Configuration Backup

Import Content

Export Content

License Information

Data Volume

Peer Modes

Peer Authorization
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Search

The options in the Configuration | Search category enable you to manage how search works on your
Logger.

O R OIS . 260
o Search GroUp Filters oo 263
0 SaVed SEArCNES . 264
e Scheduled Searches/AlBrts . L 265
o Saved Search Files . . 274
® SearCh INAEXES .. 275
e Guidelines for Field-Based IndexXing . ... ... L 276
® Search OPTiONS L 277
o Managing Fieldsets . L 281
o Default Fields ..o 281
o CUSTOM FIElAS . 283
® RUNNING SEArCNeS . 283
O LoOKUP FilES 284

Filters

You can create search filters to save specific queries so that you can easily use them again. Filters are
similar to saved searches. However, filters save the query only, while saved searches save the time range
information in addition to the query.

Your system comes with a set of predefined search filters. For more information about these filters, see
"System Filters/Predefined Filters" on page 131. You can add new filters and edit the existing ones from
the Filters page.
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Filters

Type of Filter I All :

Name ¥ Category
Configuration - Configuration

Changes (Unified) System

Configuration - System
Configuration Changes (CEF System
format)

CustomRegexFilterQueryl Shared
CustomSearchGroupFilterl paah

Group
CustomUnifiedFilterl Shared

The following categories of filters are displayed on the Filters page.

Type

Unified Query

Regular Expression

Regular Expression

Regular Expression

Unified Query

Query
categoryBehavior = "/Modify/Configuration® AND

categoryQOuicome = "/Success"

cef-0.*categoryBehavior=/Modify/Configuration
:AND: categoryOutcome=/Success
cef:0 *categoryBehavior=/Authentication/Verify

cef:0 *categoryBehavior=/Authentication/Verify
:AMND: categoryOutcome=/Success

categoryBehavior = "/Modify/Configuration® AND
categoryOutcome = */Success"

Creator

SystemFilters-6.3

SystemFilters-6.3

admin

admin

admin

Last Editor

SystemFilters-6.3 [EE]

SystemFilters-6.3 B

admin PR
admin PaEE
admin s B %

o Shared: Shared search filters are user-created and are visible o all users. Once created, any user can
use a shared search filter to search for events.

o Search Group: Search group filters provide an access control mechanism to limit the events that users
in a particular user group can see. Search group filters can also be used to limit the events processed
by a category of reports (see "Report Category Filters" on page 250). The query for these filters can
only contain regular expressions. For more information, see "Search Group Filters" on page 263.

You must have admin-level privileges to create or edit search group filters. See "Users/Groups" on
page 442 for more information on Logger user rights and how to administer them.

o System: A set of pre-defined filters, known as system filters, come with your system. For more
information about system filters, see "System Filters/Predefined Filters" on page 131.

Search filters can have one of two different types of query:

o Unified Query: Unified Query (Unified) search queries specify keywords and fields.

o Regular Expression: Regular Expression (Regex Query) search queries specify a regular expression.
Regular expression based search filters are useful for creating real time alerts, which accept only

regex queries.

To create a filter:

1. From the navigation bar Configuration menu, select Filters to open the Filter page.

N

Click Add. The Add Filter page displays.
Enter a name for the new filter in the Name field. Filter names are case-sensitive.

Select one of the following options:

o If you are creating a shared filter, select Unified or Regex Query.

e If you are creating a Search Group filter, select Search Group.

HPE Logger 6.3
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Note: Only administrator users can create Search Group filters. See "Users/Groups" on
page 442 for more information on Logger user rights and how to administer them.

5. Click Next.

6. If you selected Unified or Regex Query method in the previous step, enter the query for the new
filter.

o For Unified queries:

When you type a query, Logger’s Search Helper enables you to quickly build a query expression
by automatically providing suggestions, possible matches, and applicable operators. See "Search
Helper" on page 98 for more information.

OR

Click Advanced Search to use the Search Builder Tool to create the query. For details about
using the Search Builder Tool, see "Using the Advanced Search Builder" on page 90.

o For Regex queries: Enter the regular expression in the Query text box.
7. Click Save.

Note: If you created a Search Group filter, make sure that you associate it fo a user group, as
described in "Search Group Filters" on the next page.

To create a filter by copying an existing one:

1. From the navigation bar Configuration menu, select Filters to open the Filter page.

2. Locate the filter that you want to copy from the list of filters. Click the Copy icon [CE))
A new filter with the name “Copy of <filtername>" is created.

3. Change the name of the filter and edit the query for the new filter if necessary.

4. Click Save.

To edit a filter:

1. From the navigation bar Configuration menu, select Filters to open the Filter page.
2. Find the filter that you want to edit and click the Edit icon (#") on that row.

3. Change the information in the form and click Save.

To delete a filter:

1. From the navigation bar Configuration menu, select Filters to open the Filter page.
2. Find the filter that you want to delete and click the Delete icon ( %) on that row.

3. Confirm the delete.
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Search Group Filters

The Search Group Filters manage the association of User Groups with Search Group Filters. Search
Group Filters can be used to restrict events in the following two ways:

o Restrict the events processed by a Report Category: A Search Group Filter can be associated
directly with a Report Category. This association provides a way to restrict the events processed by

all the reports in a Report Category.

When a Search Group filter is used to restrict the events processed by a Report Category, you do not
need configure the Search Group in the Search Group Filters page as described below. After adding a
filter of type “Search Group”, you can go directly to the Reports Category Filters page under the
Reports menu and select the filter for the Report Category. For more information, see "Report
Category Filters" on page 250.

o Restrict the events visible by members of a user group: A Search Group Filter can be associated
with a user group (of type Logger Search). This association means that all members of the user
group only see events that match the Search Group Filter. User groups (described in more detail later
in this chapter) provide a way of assigning privileges to a specified set of users.

Search Group Filters Page

Search Group Filters

You may assign a search filter fo a search group that will be appended to all searches performed by users in that search group.

To create a new search group filter, you must first go to the Filters page and add a new filter of type Search Group.

MName Filter Description

Default Logger Search Group MOME  The default search group allows both local and distributed searches. rd

Tip: The User Group of type Default Logger Search Group is listed in the Name column and the
associated filter is listed in the middle column.

Users who belong to a User Group that does not have a Search Group Filter will see all events.

To add, edit, or delete Search Group Filters, see "Filters" on page 260. To add, edit, or delete User
Groups, see "Users/Groups" on page 442 for more information on Logger user rights and how to
administer the. Only users that are members of a System Admin group can assign Search Group Filters.

To associate a Search Group Filter with a User Group:
1. If the User Group that you want to associate with the Search Group Filter does not exist, create a
new User Group of type Search Group. For instructions, see "Users/Groups" on page 442.

2. If the Search Group Filter you want to associate with the User Group does not exist, create a filter
of type Search Group. For instructions, see "To create a filter:" on page 261. When creating the filter,

from the Type pull-down menu select the Search Group option.
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From the navigation bar Configuration menu, select Search Group Filters.
Find the User Group in the Search Group Filters table. Click the Edit icon ).
Select a filter from the pulldown list. (Only Search Group type filters are listed.)
Click Save.

S A

Saved Searches

A saved search, like a search filter, recalls a specific query. However, in addition to the query, a saved
search saves the time range and the field set to display in the search results. Saving the time range
supports scheduled searches and reports. You can schedule a Saved Search to run at a specific interval.
A scheduled Saved Search can be also configured to generate an alert. For more information, see "
Scheduled Searches/Alerts" on the next page.

The Saved Searches page displays all Saved Searches and supports adding, editing, and deleting Saved
Searches. You can add a saved search here or directly from the Search page.

Saved Search Page

Saved Searches

Add
Name Start End Type Query Creator ¥
StorageGroupSavedSearch  SCurrentWeek SMow  Unified Query (success OR fail) _storageGroup IM ["Default Storage Group'] admin PalE
SavedSearchLogger SCurrentWeek SMNow Unified Query deviceProduct=Logger admin PARERE
MySavedQueryl SCurrentWeek SMow Unified Query Logger and deviceEventClassld = memory:100 admin PR

deviceVendor = "Microsoft* AND (deviceEventClassid = "Microsoft-
Windows Account Creations  SMow-1h SMow Unified Query Windows-Security-Auditing:4720" OR deviceEventClassid System-6.3 [EE)
="Security:624" | ch..

For information on how to save a search from the Search page, see "Saving Queries (Creating Saved
Searches and Saved Filters)" on page 129.

For information on how fo use the saved searches created on this page, see "Searching with Saved
Queries" on page 135.

To add a Saved Search:

1. Open the Configuration | Search menu and click Saved Searches.

2. Click Add and enter the following parameters:
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Parameter Description

Name A name for this Saved Search. This name will be used for exported output files, with the
Saved Search date and time appended.

Start Time Absolute date and time of earliest possible event. Alternatively, check Dynamic to
specify the start tfime relative to the time when the Saved Search job is run.

End Time Absolute or Dynamic date and time of latest possible event, as described above.
Query Terms Enter the query in the text field or select one or more Filters from the list below the text
field.

When you type a query, Logger’s Search Helper enables you to quickly build a query
expression by automatically providing suggestions, possible matches, and applicable
operators. See "Search Helper" on page 98 for more information.

Local Search Check this box fo limit the Saved Search to the local Logger box. If the Local Search box
is left unchecked, the Saved Search will include all Peer Loggers as well as the local
Logger.

3. Click Save to add the new Saved Search, or Cancel to quit.

To edit a Saved Search:

1. Open the Configuration | Search menu and click Saved Searches.
2. Find the Saved Search that you want to edit and click the Edit icon (#") on that row.

3. Change the information in the form and click Save.

To delete a Saved Search:

1. Open the Configuration | Search menu and click Saved Searches.
2. Find the Saved Search that you want to delete and click the Delete icon ( *) on that row.

3. Confirm the delete.

Scheduled Searches/Alerts

You can schedule a Saved Search to run at a specific interval. A scheduled Saved Search can be
configured to generate an alert. The results of a scheduled search are written to a file, as described in
"Saved Search Files" on page 274. The results of a scheduled Alert are sent to a specified destination.

The Scheduled Searches/Alerts page displays a list of currently scheduled Saved Searches and Alerts.
From here you can add a new Scheduled Search or Alert and manage existing ones. For more
information about scheduled Saved Search Alerts, see "Saved Search Alerts" on page 271.

Note: Before you schedule a Saved Search Alert, you must have created at least one Saved Search.
Saved searches used in Alerts cannot contain aggregation operators such as chart or top.
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To add an new Scheduled Search or Alert:

You can add a new Scheduled Search or Alert from the Configuration menu or directly from the search
results page.

e To set up a Scheduled Search Alert from the search results page (Analyze > Search), see "Creating
Saved Search Alerts (Scheduled Alerts)" on page 272.

e To set up a Scheduled Search from the search results page (Analyze > Search), follow the
instruction in "Saving Queries (Creating Saved Searches and Saved Filters)" on page 129, set the Type

to Scheduled Search and select the Schedule it option.

e To set up a Scheduled Search or Alert from the configuration menu (Configuration | Search >
Scheduled Searches/Alerts, see "Adding a Scheduled Search or Scheduled Alert" on the next page.

To see list of the existing Scheduled Searches and Alerts:

Open the Configuration | Search menu and click Scheduled Searches/Alerts.

A list of the current Scheduled Searches and Alerts is displayed.

To edit a existing Scheduled Search or Alert:
1. Open the Configuration | Search menu and click Scheduled Searches/Alerts.
2. Locate the Scheduled Search/Alert that you want to edit and click the Edit icon (#") on that row.

3. Click the Edit icon (#) and update the parameters as needed. For details about the settings, see
"To set up a Scheduled Search or Alert from the Scheduled Searches/Alerts page:" on the next

page.
4. Click Save to update the Scheduled Search/Alert or Cancel to abandon your changes.

To remove a Scheduled Search or Alert:

1. Open the Configuration | Search menu and click Scheduled Searches/Alerts.

2. ldentify the Scheduled Search/Alert that you want to remove, and click the Remove icon ( *) on
that row.

3. Click OK to confirm the removal, or click Cancel to keep the Scheduled Search/Alert.

To enable or disable a Scheduled Search or Alert

1. Open the Configuration | Search menu and click Scheduled Searches/Alerts.
2. ldentify the Scheduled Search/Alert that you want to enable.

3. Click the associated icon (% or @) to enable or disable the alert.

To view triggered Alerts:

See "Viewing Alerts" on page 141.
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Adding a Scheduled Search or Scheduled Alert

You can schedule a Saved Search or an Alert to run at any time. Before you schedule a Saved Search or
Alert to run, you must have created or saved at least one Saved Search. See "Saving Queries (Creating
Saved Searches and Saved Filters)" on page 129.

You can add a new Scheduled Search or Alert from the Configuration menu or directly from the search
results page.

e To set up a Scheduled Search Alert from the search results page (Analyze > Search), see "Creating
Saved Search Alerts (Scheduled Alerts)" on page 272.

o To set up a Scheduled Search from the search results page (Analyze > Search), follow the instruction
in "Saving Queries (Creating Saved Searches and Saved Filters)" on page 129, set the Type to

Scheduled Search and select the Schedule it option.

To set up a Scheduled Search or Alert from the Scheduled Searches/Alerts page:

1. Open the Configuration | Search menu and click Scheduled Searches/Alerts.
2. Click Add. A screen like the following is displayed.
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Add Scheduled SearchfAlert

Name  myScheduledSearchl

Schedule | Eyery day IZI
Hour of day Izl 23 Hours (24 hour format)
Job type I Search EI

Saved Searches n

All Forwarders T
Configuration Changes by Product
Failed Logins by Product

Failed Logins by User

Firewall Drops by Source
Individual Forwarders

Individual Receivers P
Malicious Code Activity

S5H Authentications -

m

Use ctrl-click to select or deselect items

Search Resulr Export Options

Export Options ™) Export to remote location @ Sawve to Logger
File format Csv
Export directory name | Chmydirectory\saved_search_results
Fields All fields
Include Event Total
Include only CEF events
Delete files after |45 days

3. Enter the following parameters:

Parameter Description
Name A name for this Scheduled Search.

Schedule Set when and how often you want the report to run. For details about these options, see "Scheduling
Date and Time Options" on page 136.

HPE Logger 6.3 Page 268 of 623



Administrator's Guide
Chapter 5: Configuration

Parameter

Job Type

Saved
Searches

Description

Select Search to schedule a Saved Search.
Select Alert to schedule a Saved Search Alert.
Select from the list of saved searches. If none of the saved searches suits your needs, click the Saved

Searches page fo define a new search. Then come back to this page to schedule it. For more
information about defining a Saved Search query, see "Saved Searches" on page 264.

You can use Ctrl+click to select and remove items from the list.

Note: When multiple saved searches are specified in one scheduled search job, the resulting
file contains the number of hits for each saved search and not the actual events.

Note: You can only select one Saved Search for each Alert you configure.

Note: Aggregation operators such as chart and fop cannot be included in the search query for
Scheduled Alerts. Saved searches that contain aggregation operators are not displayed in the
selection list after you specify searches you have created are not displayed in the selection list
for Saved Search Alerts.

4, If you selected the job type Search, specify the Search Result Export Options

Search Job Options

Parameter

Export
Options

File Format

Remote
Location

HPE Logger 6.3

Description

For the Logger Appliance:
Select from one of these options:
e Export to remote location: The file is written to an NFS mount, a CIFS mount, or a SAN system

location that you specify.

e Save to Logger: The file is saved to the Logger’s onboard disk. If the file is saved locally, you can
use the Saved Search Files ("Saved Search Files" on page 274) feature to access those files.

For Software Logger, the only available option is “Save to Logger,” which is preselected for you.

Tip: The Logger Appliance supports mounting through the user interface. Software Logger
uses ifs filesystem, which can contain remote locations mounted through the operating system.

Select a format for the exported search results.

e CSV, for comma-separated values file.

o PDF, for a report-style file that contains search results as charts and in tables. You must specify a
title for the report in the Title field. If the search query contains an operator that creates charts such
as chart, top, and so on, charts are included in the PDF file. In that case, you can also set the Chart
Type and Chart Result Limit fields. These fields are described later in this table.

This field is only available on the Logger Appliance. Use the dropdown to select an existing Remote
File System location. If there are none, a link to the Remote File System location page is displayed.
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Search Job Options, continued
Parameter Description

Export For the Logger Appliance, select the directory where the search results will be exported from the
Directory pull-down menu.

Name For Software Logger, enter the directory path in this field, which can be a path to a local directory or
to a mount point on the machine on which Software Logger is installed.
By default, all saved searches are stored in /opt/arcsight/logger
/userdata/logger/user/logger/data/savedsearch.
Tip: To group your searches in folders, indicate a subdirectory in which to store them.
If a directory of the specified name does not exist, it is created. If a directory of the specified name
exists and the Overwrite box is not checked, an error is generated. If the Overwrite box is checked,
the existing directory contents are overwritten.
Title (Optional) Enter a title o appear at top of the PDF file. If no fitle is specified, the default “Unftitled” is
used.
Tip: This field becomes available when you select the PDF output format.
Fields A list of event fields that will be included in the exported file. By default, all listed fields are

included.

Deselect All Fields to the view and edit the list of fields. Click Clear to remove the listed fields.

Chart Type Type of chart fo include in the PDF file. You can select from:

(for PDF Column, Bar, Donut, Area, Line, Stacked Column, Stacked Bar.
only)
Note: This option overrides the Chart Type displayed on the Search Results screen.
(If the search query includes an operator that creates a chart, this field is meaningful; otherwise, it is
ignored.)
Chart The maximum number of unique values to include on the chart. The default is 10.
Result (If the search query includes an operator that creates a chart, this field is meaningful; otherwise, it is
Limit (for ignored.)
PDF only)

If the configured Chart Result Limit is less than the number of unique values for a query, the top
values equal to the Chart Result Limit are plotted. That is, if the Chart Result Limit is 5 and 7 unique
values are found, the top 5 values will be plotted.
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Search Job Options, continued

Parameter Description

Include Check this box to include an event count with the Saved Search, or a total when more than one
Event Saved Search is specified.

Total

Include Check this box to include only Common Event Format (CEF) events. Uncheck the box to include all
only CEF events in the output.

Events

For more information about CEF, refer to the document "ArcSight CEF." For a downloadable a copy of
this guide, search for “ArcSight Common Event Format (CEF) Guide” in the ArcSight Product
Documentation Community on Protect 724.

Delete Specify how many days to keep the saved search results.
Files After

5. If you selected the job type Alert, specify the Alert Options

Alert Job Options
Parameter Description
Match count Number of events that should be matched in Threshold number of seconds for an alert
to be triggered.
Threshold (sec) Number of seconds within which the “Match count” events should be matched for an

alert to be friggered.
Notification destinations are optional. If none is specified, a notification is not sent.
Email address(es) (Optional) A comma-separated list of email addresses to which the alert will be sent

SNMP destination (Optional) An SNMP destination to which the alert will be sent. For more information, see
"SNMP Destinations" on page 337.

Syslog destination (Optional) A syslog server address to which the alert will be sent.

For more information, see "Syslog Desfinations" on page 337.

ESM Destination (Optional) An ArcSight Manager address to which the alert will be sent. For more
information, see "Sending Notifications to ESM Destinations" on page 338.

6. Click Save to add the new Scheduled Search/Alert, or Cancel fo quit.

7. Once a Scheduled Search is created, enable it as described in "To enable or disable a Scheduled
Search or Alert" on page 266.

Saved Search Alerts

This section describes Saved Search Alerts. Saved Search Alerts are based on the search queries that
you have saved on Logger. For detailed information about Saved Search queries, see "Saved Searches"
on page 264.
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Note: Forinformation on Real Time Alerts, see "Real Time Alerts" on page 328. For information on
alerts in general, see "Logger Alert Types" on page 332.

For each Saved Search Alert, you configure a match count, threshold, destination, and a schedule at
which the alert will be triggered (if specified number of matches occurs within the specified threshold). If
the new Alert will send notifications to an email, SNMP, or Syslog Destination, set up the destination
before creating the Alert.

See "Static Routes" on page 409, "Receiving Alert Nofifications" on page 334, and "Setting Up Alert
Nofifications" on page 336 for more information. Audit events for alerts are only written to the Internal
Storage Group and not forwarded to ESM Destinations by default. If you need to forward these audit
events to ESM, please contact customer support for assistance.

Note: This change only applies to audit events generated for alerts; other audit events are can be
sent to ESM Destinations.

Note: To ensure system performance, a maximum of 200 alerts are allowed per saved search alert
job. Therefore, if a saved search alert job triggers more than 200 alerts, only the first 200 alerts are

sent out for that job iteration; the rest are not sent. Additionally, the job is aborted so it does not
trigger more alerts for that iteration and the status for that job is marked “Failed” in the Finished

Tasks page (Configuration| Scheduled Tasks > Finished Tasks). The job runs as scheduled at
the next scheduled interval and alerts are sent out until the maximum limit is reached.

This limit does not exist on the real-time alerts.

Creating Saved Search Alerts (Scheduled Alerts)

This section describes how to schedule Saved Searches to run as Scheduled Alerts. For information on
creating Real Time Alerts, see "Creating Real Time Alerts" on page 330. For a description of the types of
alerts, see "Logger Alert Types" on page 332.

You can schedule a Saved Search to run at any time. Before you schedule a Saved Search Alert, you

must have created at least one Saved Search.

Note: Saved searches used in Alerts cannot contain aggregation operators such as chart or top.
See "Saving Queries (Creating Saved Searches and Saved Filters)" on page 129 for more

information.

You can add a new Scheduled Search or Alert from the Configuration menu or directly from the search
results page.

e To set up a Scheduled Search Alert from the search results page (Analyze > Search), see "Creating
Saved Search Alerts (Scheduled Alerts)" above.
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e To set up a Scheduled Search from the search results page (Analyze > Search), follow the
instruction in "Saving Queries (Creating Saved Searches and Saved Filters)" on page 129, set the Type

to Scheduled Search and select the Schedule it option.

e To set up a Scheduled Search or Alert from the configuration menu (Configuration | Search >
Scheduled Searches/Alerts, see "Adding a Scheduled Search or Scheduled Alert" on page 267.

To set up a Saved Search Alert from the search results page:
1. Run asearch, as described in "Searching for Events" on page 102.

2. Click the Save icon (E1) and enter the following settings.

Parameter Description

Name A name for the query you are saving.

Save as To enable the Scheduling option, select Saved Search.
Schedule it  Click to schedule now or leave blank to schedule later.

Type Select whether you want to schedule a Search or an Alert.
Scheduled searches run on a predetermined schedule and export results to a pre-specified location.

Scheduled alerts run a search on a predetermined schedule but only generate an alert if the
specified number of events within the specified threshold is found.

Select Scheduled Alert to create an Alert.

3. Click Save.
If you checked the “Schedule it” setting in the previous step, you are prompted to choose if you

want to edit the schedule. If you click OK, the Edit Scheduled Search page is displayed, as shown in
the next step. If you click Cancel, the search is saved but it is not scheduled to run.

4, The Edit Scheduled Search/Alert page enables you to define a schedule for the saved search job

and alert options. Select the desired options, and click Save. For details about the parameters, see
"Alert Job Options" on page 271.
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Edit Scheduled Search/Alert

Name  savedSearchLogger job

Schedule | every day -~
Every -| & I Hours j
Job type | Alert E|
Saved Searches |V T i
Alert Options

Match count |4
Threshold (sec) | 4o

Email address(es)

SNMP destination | NONE

Syslog destination I MONE

& =1 E]

ESM destination | NONE

5. After creating the Scheduled Alert, enable it as described in "To enable or disable a Scheduled
Search or Alert" on page 266.

Saved Search Files

Access Saved Search results that were saved to Logger with the Saved Search Files command. Saved
Search Files can be retfrieved (streamed to the browser) or deleted. Click Refresh to update the list of
files.

Saved Search Files page

Saved Search Files

Name Last Modified Size State Error Message
Export_save_guery.pdf Jun 153, 2006 10:27:22 AM PDT 122 MB Exported ﬁ x
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Access the saved search results:

1. Open the Configuration | Search menu and click Saved Search Files. The files containing the
search results are displayed.

2. To download and open afile, click a link in the Name column or click the Retrieve icon in the row.

Search Indexes

You can add fields to the field-based index at any time. However, once a field has been added to the
index, you cannot remove it.

Prerequisites
Users must be assigned to the following User Groups to access this feature:

o Default Logger Rights Group
o Default System Admin Group

See "Setting Logger User Permissions" on page 458 for more information.

Caution Before adding any fields to the index, make sure you are familiar with the information in
"Guidelines for Field-Based Indexing" on the next page.

To add fields to the field-based index:

1. Open the Configuration | Search menu and click Search Indexes.
2. Select the fields from the Indexable Fields list.
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Edit Search Index

Important

Once a field is indexed, it cannot be changed. Significantly exceeding ArcSight's default recommended indexed fields
could result in performance degradation in certain situations. If you need to exceed the default number of fields, only
index those additional fields which are necessary for your environment.

To add indexed fields, select one or more fields below

Indexable fields | Jgentaddress

agentHostName
agentMtDomain
agentZoneURI
customerMName

m

destinationDnsDomain
destinationMacAddress
destinationTranslatedAddress
destinationUserPrivileges
deviceCustomDatel
deviceCustomDatellabel
deviceCustomDate2
deviceCustomDateZLabel
deviceCustomMNumberlLabel
deviceCustomMNumber2Label
deviceCustomMumber3Label

T SR Y S R S |

Use cirl-click to select or deselect items

Indexed fields | jevicevendor

deviceProduct
deviceVersion

deviceEventiClassid

name

agentSeverity

agentType

applicationProtocol

baseEventCount

bytesin -

All recommended fields have already been indexed

Full text indexing is enabled

Apply Changes

3. To select multiple fields at the same time, hold the Ctrl key down and click on the fields.

4. Click Apply Changes.

Guidelines for Field-Based Indexing

Make sure you are familiar with these guidelines before you index any fields:

o Events are indexed by the fields in the “Indexed fields” list (on the Search Indexes page) and the
default event metadata fields—event time, Logger event, and device address.
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¢ You can index up to 123 fields on Logger. This number includes the custom schema fields you may
have added to your Logger.

e Once afield has been added to the index, it cannot be undone.
e Only users belonging to a System Admin Group can add fields to index.

o After you add a field to the index, Logger might not immediately start indexing on that field.
Therefore, allow some time between adding a field and using it in the search query. If Logger is in the
process of indexing on a field and you use that field to run a search query, the search performance
for that operation will be slower than expected.

o If an event field contains data of unexpected type (for example, a string when an integer is expected),
the datais ignored. Therefore, search for that data value will not yield any results. For example, if the
port field contains a value 8080A (alphanumeric) instead of 8080 (numeric), the alphanumeric value
is ignored.

o Forfaster report generation, ALL fields of a report (including the fields being displayed in the report)
need o be indexed. That is, in addition to the fields in the WHERE clause of the query, the fields in
the SELECT clause also need to be indexed.

o For optimal search performance, make sure that event fields on ALL peers are indexed for the time
range specified in a query. If an event field is indexed on a Logger but not on its peers for a specific
time range, a distributed search will run slower on the Loggers. However, it will run at optimal speed
on the local Logger. Therefore, the search performance in such a setup will be slow.

o Although the requestUrl field is available for search and report queries, it cannot be indexed.
Including this field in such queries will result in the query running slower than a search performed on
indexed data.

Search Options

Prerequisites
Users must be assigned to the following User Groups to access this feature:

o Default Logger Rights Group
o Default System Admin Group

See "Setting Logger User Permissions" on page 458 for more information.

The search options on this page support internationalization (i18n) choices. To adjust these options,
open the Configuration | Search menu and click Search Options.
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Edit Search Options

Most users shouldn't need to adjust these settings

Field Search Options

Case sensitive I Yes

Include NULL field value in NOT operator results I No

Full-text Search Opftions

Use primary delimiters I Yes

Use secondary delimiters I No

Regular Expression Search Options

Case sensitive I No

Unicode case sensifive I Mo

Check for canonical equality I No

Search Display Options

Populate rawEvent field for syslog events I No

Show source and sourceType fields I Mo

Field Summary Options

Use Field Summary I Yes

B [ & B B XN N ] [

Discover fields I No

Modifying Logger search options:

The following table lists the advanced search options you can view and configure.

Note: Several of the options on this screen will require you to reboot your Logger Appliance or
restart your Software Logger.
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Option
Field Search Option

Case sensitive

Include NULL field
value in

NOT operator
results

Description

Default: Yes

Controls whether to differentiate between upper- and lower-case characters during a search.
When this option is set to No, searching for "login" will find "login," "Login," and "LOGIN".

You must reboot the Logger Appliance/restart the Software Logger for this change to take effect.
Notes:

1. Setting this option o No may affect query performance.

2. Changing the case-sensitivity only applies to the local Logger. Peer Loggers will continue to
use their own settings.

3. Full-text search (keyword search) is case insensitive. You cannot change its case sensitivity.
Default: No

Setting this option to Yes causes queries using the NOT operator to return events where the field
value matches the filter criteria or is NULL.

The default, No, causes queries using the NOT operator to only return events where the field
value matches the filter criteria.

You must reboot the Logger Appliance/restart the Software Logger for this change to take effect.

Full-text Search Options

Use primary
delimiters

Use secondary
delimiters

Default: Yes
Controls whether primary delimiters are applied to an event to tokenize it for indexing.

A primary delimiter tokenizes an event for indexing. For example, an event "john doe the first" is
tokenized into "john" "doe" "the" "first" using the “space” primary delimiter.

The primary delimiters are:
space, tab, newline, comma, semi-colon, ( ) [ ] { } “ | *

Default: No

Controls whether secondary delimiters are applied to an event to further tokenize a token
created by a primary delimiter thus enabling searches that can match a part of a primary token.

For example, you can search for "hpe.com" in http://www.hpe.com.

The secondary delimiters are:
period,= : / \ @ - ? # & _ > <

Regular Expression Search Options

Case sensitive

HPE Logger 6.3

Default: No
See "Case sensitive" above.

You must reboot the Logger Appliance/restart the Software Logger for this change to take effect.
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Option Description
Unicode case Default: No
sensitive

Controls whether events in languages other than English should be compared in a case-sensitive
way.

Caution: HPE strongly recommends that you do not change this option.

You must reboot the Logger Appliance/restart the Software Logger for this change to take effect.

Check for canonical Default: No

equalit . ) .
q ¥ Controls whether events in languages other than English should be compared using locale-

specific algorithms.

Caution: HPE strongly recommends that you do not change this opftion.
You must reboot the Logger Appliance/restart the Software Logger for this change to take effect.

Search Display Options

Populate rawEvent  Default: No
field for syslog

; Controls whether raw events are displayed in a formatted column called rawEvent using the Raw
events

Event field set. This option applies to syslog events only. If you want to view the raw events
associated with CEF events, you do not need to configure this setting. Instead, configure the
connector that is sending events to Logger to populate the rawEvent field with the raw event.

Note: Even though the rawEvent column displays the raw event, this column is not added
to the Logger database and is not indexed. Therefore, you can only run a keyword (full-
fext) or regular expression search on the event.

Show Source and Default: No

S T field
ourceType Tields Controls whether the Source and SourceType fields are included in the Field Summary and query
results.

You must reboot the Logger Appliance/restart the Software Logger for this change fo take effect.
Note: Setting this option to Yes can impact query performance.

Field Summary Options

Use Field Summary Default: Yes

Controls the whether the Field Summary panel is included in the search results by default.
Regardless of the default, you can change the setfting on-the-fly by using the Fields Summary
checkbox on the Search screen.

Discover Fields Default: No

Controls whether the Field Summary feature automatically detects non-CEF fields in raw events.
Regardless of the default, you can change the setting on-the-fly by using the Discover Fields
checkbox on the Search screen.

This field is hidden if Use Field Summary is set to No.
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Managing Fieldsets

You can view the predefined fieldsets and the ones you have created on the Fieldsets page
(Configuration | Search > Fieldsets).

Fieldsets
Name Type Fields -
Event Time, deviceVendor, deviceProduct, name, deviceEventClassld, sourceAddress, sourceHostName, sourcePort, destinationAddress, destinationHostName,
Network, destinationPort, fransportProtocol, deviceAction, deviceSeverity, deviceAddress, deviceHostMName, deviceCustomMNumber2Label, deviceCustomNumber2,
Routers.and System deviceCustomString2Label, deviceCustomString2, deviceCustomString3Label. deviceCustomString3, deviceCustomStringSLabel, deviceCustomString5.
Switches deviceCustomStringéLabel, deviceCustomString6, categoryDeviceGroup. categoryBehavior, categoryObject, categoryOutcome, categorySignificance, *user. Raw
Message
Event Time, deviceVendor, deviceProduct, name, deviceEventClassld, sourceAddress, sourceHostName, sourcePort, destinationAddress, destinationHostName,
NIDS S destinationPort, fileMame, deviceCustomString2Label, deviceCustomString2, deviceCustomString3Label, deviceCustomString3. deviceCustomString4Label,

deviceCustomSiring4. deviceCustomStringSLabel. deviceCustomSiring5. deviceCustomMumberlLabel. deviceCustomMumberl, deviceAddress. deviceHostName.
deviceSeverity, categoryDeviceGroup, categoryBehavior, categoryObject, categoryQuicome, categorySignificance, *user, Raw Message

Event Time, deviceVendor, deviceProduct, name, deviceEventClassld, message, deviceAction, sourceAddress, source TranslatedAddress, sourceHostName,
destinationAddress, destinationHostMame, transportProtocol. deviceAddress, deviceHostName, deviceSeverity. sourcelUserMame. destinationUserName.
deviceCustomMumberllLabel. deviceCustomMNumberl. deviceCustomNumber2Label. deviceCustomNumber2. deviceCustomNumber3Label,

VPN System deviceCustomMNumber3, deviceCustomStringlLabel, deviceCustomStringl, deviceCustomString2Label, deviceCustomString2, deviceCustomString3Label,
deviceCustomString3, deviceCustomString4Label, deviceCustomString4, deviceCustomString5Label, deviceCustomString5, deviceCustomString6Label,
deviceCustomStringd, bytesin, bytesOut, devicelnboundlnterface, deviceOutboundinterface, categoryDeviceGroup. categoryBehavior, categoryObject.
categoryOutcome, categorySignificance. “user. Raw Message

In this list of fieldsets, *user indicates user-created fields. An asterisk (*) at the end of the list of fields
indicates that more fields are included than are listed.

If you have “Edit, save, and remove fieldsets” privileges, you can delete your custom fieldsets from this
screen.

Note: You can only delete the field sets you create, and not the predefined ones available on
Logger.

To delete a custom field set:

1. Open the Configuration | Search menu and click Fieldsets.
2. ldentify the field set you want to delete and click the Delete icon ( *).

3. Confirm the deletion.

Default Fields

The Logger schema comes with a set of predefined fields. Some of these fields are already indexed for
improved search speed and efficiency. You can add custom fields to Logger's schema and index them
for field-based search. A field-based search can only use fields in the schema.

Note: The size of each field in the schema is predetermined. If the string you are searching for is
longer than the field-length, you should use a STARTSWITH rather than an = search, and include no
more than the number of characters in the field size. For more information, see “Field-based
Search” on page 1.
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The Default Fields page (Configuration | Search > Default Fields) displays the predefined fields
included in the schema. It includes the Display Name, Type, Length, and Field Name for each default
field. To view information on existing custom fields, see "Custom Fields" on the next page.

Prerequisites

Users must be assigned to the following User Groups to access this feature:

o Default Logger Rights Group
o Default System Admin Group

See "Setting Logger User Permissions" on page 458 for more information.

To view the default schema fields:

1. From the Configuration menu under Search, click Default Fields.

Default Fields

Display Name * Type
agentAddress TEXT
agentHostMame TEXT
agentNtDomain TEXT

B agentSeverity TEXT

B agentType TEXT
agentZone TEXT
agentZoneName TEXT
agentZoneResource TEXT
agentZoneURI TEXT

B applicationProtocal TEXT

B baseEventCount LONG

Length Field Name
14 agt
40 ahost
40 agentNtDomain
- agentSeverity
16 at
200 agentZone
50 agentZoneMame
100 agentZoneResource
2048 agentZoneURI
40 app

- cnt

indexed

Indexad

Indexed

Indexed

Indexad

2. The Default Fields page displays the default schema fields. You can sort the fields by clicking the

column headers.

Logger displays the Index status of each field in two ways:

e The Indexed column shows indexed and superindexed fields.

e The Display Name field includes a light green icon () for indexed fields, and a dark green icon

) for superindexed fields. Non-indexed fields have no icon.

HPE Logger 6.3
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Custom Fields

You can view the custom fields that have been added to the Logger schema under Configuration |
Search > Custom Fields.

Custom Fields

Display Name Type Length Field Name Actual Field Name Creator Created
DoubleField1 DOUBLE - DoubleField1 ad.DoubleField1.r admin Jul 12, 2016 9:36:11 AM PDT
Peer_Field TEXT 25 MytextField ad MytextField admin Jul 12, 2016 9:35:40 AM PDT

This page lists all custom schema fields that have been saved. You can view the alphabetical list of fields,

but cannot edit or delete them. For detailed information about custom fields, see "Adding Fields to the
Schema" on page 377.

Running Searches

When a search initiated as a result of any of the following operations is in-progress, the Running
Searches page (Configuration | Search > Running Searches) displays the currently running process.
e A manual search on local or peer Logger (Analyze > Search)

o A scheduled search (Configuration | Search > Saved Search

e A saved search alert (Configuration | Search > Scheduled Searches/Alerts)

o A search export, with the “Rerun query” option checked (Analyze > Search > Export Results)

The table shows the session ID, user who started the tasks, the date and ftime that the task started, the
number of hits, the number of scanned events, the elapsed time, and the query.

Running Searches

Session ID User Start Hits Scanned

Elapsed Query
0 admin Jul 21, 2016 3:52:25 PM PDT 0 22,508,626 06:13.667 receiver = "UDP Receiver" ®
4] admin Jul 21, 2016 3:58:26 PM PDT 77 129,784 00:12.378 Logger .

Once a task finishes, the task’s entry on the Running Searches page is removed. (The fask entry is
removed upon page refresh, either when you refresh the browser page or when you navigate away
from this page and come back to it.)

You might need to end a currently running search task when it is taking too long to run, or appears o
be stuck and slowing the overall Logger performance.
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Note: You must have admin user privileges to end a running search process. See "Setfting Logger
User Permissions" on page 458 for more information on Logger user rights and how to administer

them.

To view the currently running searches:

Open the Configuration | Search menu and click Running Searches.
Any searches that are currently running are displayed.

To end a currently running search:

1. Open the Configuration | Search menu and click Running Searches.

2. To end a search process, click the * icon for the task.

Lookup Files

Lookup files are used by the 1ookup search operator to enrich Logger data during a search. After you
upload a valid Lookup file to Logger, you can use that Lookup file in a lookup search command.

The Lookup Files page displays the uploaded Lookup files.

Lookup Files
Add
Mame Schema Row count Schedule
deviceVendor_dept_org_status_protocel Write down 12 MNaone o X 7
SL_Lookup ip, host, status, protocol 7 MNaone oo X F

o Forinformation on when to use the 1lookup operator, see "Enriching Logger Data Through Static
Correlation" on page 138.

e Forinformation on how to use the lookup operator when searching, see "lookup" on page 487.
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Creating Lookup Files

Lookup files must be in CSV format with the Lookup field names as the first row. (A Lookup field is an
individual column in the Lookup file.) Each row in the table is loaded sequentially and the first row is
treated as the definition of the columns in the table. Any subsequent row that does not contain the
same number of comma-separated values as the first row will be skipped during the search by the
lookup operator. If a search using the 1ookup operator needs to skip one or more rows, a warning
message displays on the search page. HP recommends that you check the table with a fool such as
MicroSoft Excel to make sure that each row has the same number columns as the header row before
uploading it as a lookup file.

Tip: For more information on the CSV format your lookup files need to follow, refer to RFC 4180.

Naming Lookup Files

The Lookup filenames can contain only alphanumeric characters and underscore, and must NOT begin
with a number. Do not include +, -, or * in the filename. These characters are reserved for the 1lookup
command.

Creating a short and meaningful Lookup filenames make it easy to identify Lookup fields in the output.
To help differentiate them from Logger fields, fields from the Lookup file are appended with the first six
characters of the Lookup file name when displayed in the search results.

As an example, look at the following search:
lookup _table 20160608 ip as src output hostname

In this example, “_table_” will be appended to the Lookup field "hostname”. The date (20160608) will
not be included. The name displayed in the search results will be "hostname_table_" because only the
first six characters of the Lookup file name are appended.

Naming Fields in the Lookup File

Lookup fieldnames can contain only alphanumeric characters and underscore, and must NOT begin
with a number. Do not include +, -, or * in the fieldname. These characters are reserved for the 1lookup
command.

Duplicate Values in the Lookup File

When there are multiple rows with identical values in a Lookup column, the lookup operation only uses
the first row that matches and ignores any subsequent matches.

When using Logger exported search results as Lookup file, you can use "dedup" operator to remove the
duplicate values in the fields that will be used as Lookup fields. For more information on duplication in
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Lookup fields, see the 1ookup operator "lookup” on page 487. For more information on the dedup
operator, see "dedup" on page 476.

Lookup Capacity

e The maximum size Lookup file that can be uploaded is 50 MB (uncompressed or compressed)

¢ The maximum disk space allocated for storing Lookup files is 1GB. This is the cap on overall disk
space allowed for storing all Lookup files.

e Maximum number of Lookup enfries is 5,000,000 (A Lookup entry is an individual comma-
separated value in the Lookup file.)

For example, if a Lookup file has four columns and ten rows, the total number of lookup enftries is
4x10=40. When such a Lookup file is used in the search, all of its entries will be loaded into memory. It
is worth noting that the maximum number of rows loaded for lookup varies depending on the
number of columns in the Lookup file.

For example, if a Lookup file contains 500 columns, the maximum number of rows allowed for lookup
will be 5,000,000/500 = 10,000 rows, and any subsequent rows will not be used. On the other hand,
if the table has only four columns, the maximum number rows allowed for lookup will be
5,000,000/4 = 1,250,000 rows.

When exporting Logger search results to use them as Lookup files, uncheck All Fields and export
only the fields you need.

Export Options © Help

@ Save fo localdisk ) Save fo Logger

File format I PDF :

Title | ExportSearchtolocalPDF

Fields [] All fields Clear
Event Time, Device, Logger, deviceVendor, =
deviceProduct, deviceVersion, L4

deviceEventClassld, name, agentAddress,
agentHostName, agentType, agentZoneURI,
baseEventCount, categoryBehavior,

Include Event Tofal
Include only CEF events [[]

Rerun query [C]

Since there is an overall limit of 5 million lookup enftries, exporting only the necessary fields will reduce
the number of rows loaded for lookup.
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Uploading Lookup Files

Click Add on the Lookup Files page to upload a Lookup filein .csv, . zip, or .gz format. You can
upload an individual Lookup file from your local desktop or schedule a lookup file to be uploaded

regularly from a location accessible to Logger.

Uncompressed files (files uploaded in .csv format) will be compressed into .zip format and stored with
the name you specified (<name>. zip.) Compressed files will be uploaded and stored in their original
compression format with the name you specified (<name>. zip or <name>.gz.) Upload compressed
Lookup files (. zip or . gz) when possible. This saves upload time and loads more information for the
same upload file size. You can only include one Lookup file in .csv format in each . zip or . gz file.

For information on how to use the 1ookup operator when searching, see "lookup" on page 487.

To add a Lookup file:

1. Open the Configuration | Search menu and click Lookup Files.

2. Click Add. The Add Lookup File page opens.

Add Lookup File

Name deviceVendor_dept_org_status_protocol

File Location I Local E|

ez 705 713 ImportedLookupFile.csv

3. Enter a meaningful name for the Lookup file. This name can contain only alphanumeric characters
and underscore, and must NOT begin with a number. Do not include +, -, or *in the name. These
characters are reserved for the Llookup command.

4. Select where to access the Lookup file.

e Select Local to browse to a location on your local machine and upload the file one time only.

o Select On Logger to enter a path on the Logger's server. If you select this option, you can
choose to set up a regular update schedule.

The available options change based on your selection.

5. Specify the Lookup file's location:
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o If you selected Local, click Browse, navigate to the desired .csv, .zip or .gz file, and then click
Open.

e If you selected On Logger, specify the absolute path and file name on the Logger system. For
example, if the file is in the /opt folder on your Logger you could specify /opt/lookup.csv.
The lookup file must already exist in this location. The user Logger was installed with must have
read permissions on the lookup file itself and on the directory you specify here.

Note: The Logger Appliance supports mounting through the user interface. Software
Logger uses its file system, which can contain remote folders mounted through the

operating system.

6. If you selected On Logger, specify how often to upload the Lookup file.

e To upload the Lookup file only once, check One time only.

o To schedule the Lookup file to be uploaded now and at regularly scheduled interval, remove the

checkmark by One time only and then use the schedule options to specify how frequently to
update the lookup file. For details about these options, see "Scheduling Date and Time Options"

on page 136.

7. Click Save. After the Lookup file is uploaded, it will be displayed in the list of Lookup files. If you
specified a schedule, the Lookup process will look in the specified location at the indicated time and
upload the new version (if there is one).

Managing Uploaded Lookup Files

After you upload a Lookup file, you can view it, edit it or delete it by using the icons at the end of the
row for that file.

Lookup Files
Add
Name Schema Row count Schedule
deviceVendor_dept_org_status_protocol Write down 12 None oo % 4
SL_Lookup ip, host, status, protocol 7 None w %

To view an uploaded Lookup file:

1. Open the Configuration | Search menu and click Lookup Files.
2. Find the Lookup file you want to view, click the view icon (%) or the Lookup file’s name.

This view only shows a few rows. The entire file may not be displayed.
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Note: The Schedule field is only displayed if the Lookup file has been scheduled for update.

View Lookup Files

Name SL_Lookup

Schedule pgne

Schema p host, status, protocol

Row Count

Preview host

ip status protocol
15.214.133.124 hacker.com reported TCP
15.252.64.240 flash.com reported TCP
15.252.64.240 flash.com reported UDP
15.252.64.250 flash.com watched UDP
15.199.224,251. p2p.org alert TCP
15.252.64.242 fakeips.com ok TCP
15.252.64.248 staffit.com unknown UDP
Done

3. Click Done to return to the list of Lookup files. You cannot edit the file from here. If you need to
change something, follow the steps under "To edit a Lookup file: " below.

To delete a Lookup file:

1. Open the Configuration | Search menu and click Lookup Files.

2. Find the Lookup file you want to remove, click the Remove icon ( *) on that row and then click OK.

Note: Attempting to remove a Lookup file that is still being used in a current search session
will result in an error message. The file will not be deleted. To quickly clear such files from the

search cache so that they can be removed, run a search that does NOT use the 1lookup
operator. This closes the lookup search session and ensures that the Lookup file is no longer in
use. Once the session is closed, you can remove the Lookup file.

To edit a Lookup file:

1. Open the Configuration | Search menu and click Lookup Files.
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2. Find the Lookup file you want to edit, click the Edit icon (#") on that row and then click OK. The
Edit Lookup File page opens.

Edit Lookup File

Name  deviceVendor_dept_org_status_protocol

File Location | gn Logger IZ|

Path and File fcpif{:.l.-"SL_Iookup.csv{

Schedule One time only

Save Cancel

You can upload a new version of the Lookup file, schedule a lookup update, or change the existing
update schedule.

3. Select where to access the Lookup file.

o Select Local to browse fo a location on your local machine and upload the file one time only.

e Select On Logger to enter a path on the Logger's server. If you select this option, you can
choose to set up a regular update schedule.

The available options change based on your selection.
4, Specify the Lookup file's location.
o If you selected Local, click Browse, navigate fo the desired . csv, .zip or . gz file, and then click

Open.

o If you selected On Logger, specify the absolute path and file name on the Logger system. For
example, if the file is in the /opt folder on your Logger you could specify

/opt/lookup.csv.The lookup file must already exist in this location.

Note: The Logger Appliance supports mounting through the user interface. Software
Logger uses its file system, which can contain remote folders mounted through the

operating system.

5. If you selected On Logger, specify how often to upload the Lookup file.

e To upload the Lookup file only once, check One time only.

o To schedule the Lookup file to be uploaded now and at regularly scheduled interval, remove the

checkmark by One time only and then select a schedule. For scheduling information, see
"Scheduling Date and Time Options" on page 136.
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6. Click Save. After the Lookup file is uploaded, it will be displayed in the list of Lookup files. If you
specified a schedule, the Lookup process will look in the specified location at the indicated time and
upload the new version (if there is one).

Data

The options in the Configuration | Data category enable you to control the data going in and out of

your Logger.

O D VICES .. 291
O DEVICE GrOUPS ... 293
O RECBIVEIS L 294
® SOUICE T PO o M
O P IS OIS 315
O P OTWaAINderS |l 321
o Real Time AlBITS 328
o SNMP DestinatioNS . 337
o Syslog DestinatioNs ..l 337
e Sending Notifications to ESM Destinations .. ... ... 338
® ESM DestinatioNs .. 339
o CertifiCaleS |l 342
e Forwarding Log File Events 10 ESM 343
o Data Validation .o L 344
Devices

A device is a named event source, comprising of an IP address (or hostname) and a receiver name. Two
receivers can receive events from the same IP address, so IP address alone is insufficient to identify a
device. Event source is the device that directly sends the event to Logger. When an event is sent
through a SmartConnector, the event source is the system on which the SmartConnector is running and
not the device that sent the event to the SmartConnector.

Devices can be added to device groups, and device groups can be referenced in filters and queries.

Receivers perform autodiscovery by automatically creating a device for each source IP address. Devices
created by autodiscovery are named for their hostname, or if the hostname cannot be determined, their
IP address.

The Devices page displays all defined devices and includes controls to add, edit, or delete them.
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Devices page

Devices

Name IP Address Receiver Creator Last Editor

Logger Internal Event Device 12700.1 Mot Applicable System  System

Logger Internal Event Device [Apache URL Access Error Log] 127001 Apache URL Access Error Log System P
Logger Internal Event Device [Var Log Messages] 127001 Var Log Messages System 7%
n15-214-194-hé5.arstusa.hp.com [AusmReceiverl] 15.214.194.65  AusmReceiverl System 7 %
n13-214-194-hé5.arstusa.hp.com [AusmReceiver101] 15.214.194.65  AusmReceiverl0l System 7%

Maximum number of devices that can be defined on Logger: No limit.

Autodiscovery creates devices automatically, but you can also define them manually.

To define a device:
1. Open the Configuration | Data menu and click Devices.
A display similar the "Devices page" above appears.

2. Click Add.

3. Enter aname, an IP address, and select a receiver for the new device.

4. Click Save to add the new device, or Cancel to abandon it.

One reason for editing a device is to replace the default name created by autodiscovery (the IP address
or hostname) with a more meaningful one.

To edit a device:
1. Open the Configuration | Data menu and click Devices.
A display similar the "Devices page" above appears.
2. Locate the device that you want to edit and click the Edit icon (#") on that row.
3. Change the Name or IP address for the device.

4. Click Save to update the device group, or Cancel to abandon your changes.

To delete a device:
1. Open the Configuration | Data menu and click Devices.
A display similar the "Devices page" above appears.

2. Locate the device that you want to delete and click the Remove icon ( *) on that row.

Deleting a device does not block the source IP address from sending events. If new events are
received, autodiscovery recreates the device.

3. Confirm the deletion by clicking OK, or click Cancel to retain the device.
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Device Groups

Device groups allow you to categorize named source |P addresses called devices. The Device Groups
page lists all device groups with edit and delete icons and includes the ability to create new device
groups.

Tip: Device groups can be associated with storage rules that define in which storage groups where
from specific devices are stored. Doing so enables you to retain event data from different sources

for different lengths of fimes (because you can define different retention policies on different
storage groups). For more information about storage rules, see "Storage Rules" on page 349.

Tip: There is no maximum number of device groups that can be created on Logger.

To create a device group:

1. Open the Configuration | Data menu and click Device Groups.
2. Click Add. A display similar to that shown below appears.

Device Groups

Add

Device groups are used to group devices for search queries and storage group rules. You may assign one or more devices fo a device group.

If you wish to add a device which is not yet created, you must first go to the Devices page and create it

Name Devices Creator Last Editor
ausmDG4 n15-214-194-h65.arstusa hp.com [AusmReceiveri] Admin PR
ausmRegexDGS n15-214-194-h65 arstusa hp.com [AusmReceiver3] Admin S %
devicegroup101 n15-214-194-h65.arstusa hp.com [AusmReceiver101] Admin PR
n15-214-194-h65 arstusa hp.com [AusmReceiver102], n15-214-194-h6é5. arstusa hp.com
DevicelGroupFarStorageGroupStorageGroup2  [AusmReceiver2], n15-214-194-hé 5. arst.usa hp.com [AusmReceiver6], n15-214-194- admin P

hé5.arst.usa.hp.com [Au.

3. Enter a name for the new device group. Click to select devices from the list. Press and hold the Ctrl
key when clicking to add additional devices to the selection. To select a range of devices, click to

select the first device, then press and hold the Shift key while clicking the last device.

4. Click Save to create the new device group, or Cancel to abandon it.

To edit a device group:

1. Open the Configuration | Data menu and click Device Groups.
2. Locate the device group that you want to edit and click the Edit icon (¥ on that row.

3. Change the Name, add, or remove devices from the selection. Ctrl-Click devices that are not
selected to select them, or Ctrl-Click selected devices to remove them from the selection.

4. Click Save to update the device group, or Cancel to abandon your changes.
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To delete a device group:

1. Open the Configuration | Data menu and click Device Groups.

2. Locate the device group that you want to delete and click the Remove icon ( %) on that row.
Deleting a device group does not affect the set of devices.

3. Confirm the deletion by clicking OK, or click Cancel fo retain the device group.

Receivers

Logger can receive text events, either sent through the network or read from a file. From the Receivers
page, you can set up and configure the receivers that will capture event data, and populate each event
with information about its origin. Some receivers capture streaming events transmitted over the
network by devices, applications, services, and so on. Other types of receivers monitor individual files for
events or monitor files selected from a directory free, based on a pattern you specify. Since receivers can
only receive events of a single source type, you should set up separate receivers for each type of log file.

To start receiving events, direct your event sources to the default receivers. For more information about
the default receivers, refer to the Logger Installation guide.

Receiver types include UDP, TCP, SmartMessage, and three types of file based receivers, File Transfer,
File Receiver, and Folder Follower Receiver.

Before the receiver can receive data, the port it is listening on must be opened through the firewall. For
more information, see "Firewall Rules" on page 469.

You can configure the following types of receivers:

o UDP Receiver: UDP receivers listen for User Datagram Protocol messages on the port you specify.
Logger comes pre-configured with a UDP Receiver on port 514 or 8514, enabled by default. For
Software Loggers, this port may vary based on the port numbers available at installation time.

o CEF UDP Receiver: UDP receivers that receive events in Common Event Format.

e TCP Receiver: TCP receivers listen for Transmission Control Protocol messages on the port you
specify. Logger comes pre-configured with a TCP receiver on port 515 or 8515, enabled by default.
For Software Loggers, this port may vary based on the port numbers available at installation time.

o CEF TCP Receiver: TCP receivers that receive events in Common Event Format.

o Event Broker Receiver: Event Broker receivers are consumers for the Event Broker's publish-
subscribe messaging system. They subscribe to event topics and receive events in Common Event

Format (CEF) from Event Broker.

o Folder Follower Receiver: Folder follower receivers actively read the log files in a specified directory
as they are updated. If the source directory contains different types of log files, you can create a
receiver for each type of file that you want to monitor. Logger comes pre-configured with folder
follower receivers for Logger’s Apache Access Error Log, the system Messages Log, and Audit Log
(when auditing is enabled). You must enable these receivers in order to use them.
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o File Transfer: File Transfer receivers read remote log files using SCP, SFTP, or FTP protocol. These
receivers can read single- or multi-line log files. You can schedule the receiver to read a file or batch of
files periodically.

Note: Be aware of the following when setting up file transfer receivers.

o The SCP, SFTP, and FTP file transfer receivers depend on the FTP (File Transfer Protocol)
SCP (Secure Copy Protocol) and SFTP (SSH file transfer protocol) clients installed on your
system. Ensure that the appropriate client is installed on the system before you create the
receiver.

o The SCP and SFTP protocols on Logger Appliances are not FIPS compliant.

 SmartMessage Receiver: SmartMessage receivers listen for encrypted messages from ArcSight
SmartConnectors. Logger comes pre-configured with a SmartMessage receiver with the name
“SmartMessage Receiver.” To use this receiver to receive events from a SmartConnector, set the
Receiver Name to be “SmartMessage Receiver” when configuring the SmartConnector’s destination.
For more information on SmartConnectors, see "Using SmartConnectors to Collect Events" on
page 506.

Event Broker Receivers

Event Broker receivers connect to ArcSight Data Platform Logger and ArcSight Event Brokers and
consume all events for the topics that they subscribe to. Loggers receiving events from the Event
Broker can be part of a pool of Loggers for balanced distribution and redundancy. The events will be
distributed among Loggers in the poolin a round-robin fashion. If one Logger in the pool is down, the
events will be sent to one of the others.

You can configure multiple Loggers with Event Broker receivers that subscribe to the same Event Topic
List and belong to the same Consumer Group. Each Logger Event Broker receiver in the group will
receive events from a different subset of partitions in the topic. The Event Broker will balance the
partitions between all Event Broker receivers configured in the same Consumer Group.

The events are published to the Event Broker by ArcSight Data Platform Logger and ArcSight
SmartConnector. When configuring your SmartConnector to send data to an Event Broker receiver, use
the "Event Broker (CEF Kafka)" destination.

For more information about ArcSight Data Platform Logger and ArcSight Event Broker, refer to the
ArcSight Data Platform Logger and ArcSight Event Broker User's Guide, available for download from
the ArcSight Product Documentation Community on Protect 724.

For more information about SmartConnectors, refer to the SmartConnector User's Guide, available for
download from the ArcSight Product Documentation Community on Protect 724.

For more information about Kafka, refer to the Kafka documentation.
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File Based Receivers

File based receiver types include File Receivers, File Transfer Receivers, and Folder Follower Receivers.
You can set them up as multiline receivers, and configure them to use source types with associated
parsers to extract data from captured events.

Note: When a receiver cannot read the file it logs from, such as when the file or folder is deleted or
renamed, Logger records a message in current/arcsight/logger/logs/logger_
receiver.log

Multi-line Receivers

TCP and UDP receivers interpret line break characters, such as \r or \n, as the end of the event. If the
input event contains embedded \r or \n characters, the event will be treated as more than one event. If
your events span more than one line, you may want to use a multi-line receiver. Multi-line receivers
include the File Transfer, File Receiver, and Folder Follower Receivers.

A multi-line receiver can read events that span more than one line, such as a server log. You could set up
the receiver to handle stack fraces reported in the log by reading the entire stack trace as a single event
instead of reading each line separately.

When creating a multi-line receiver, you must specify a regular expression that the receiver should use
to detect the start of a new event in the log file. Each new event starts where the characters in the log
file match the regular expression.

For example, in the following log file, each event starts with a fimestamp embedded within square
brackets ([yy-MM-dd HH:mm:ss.SSS]); therefore, you can use this regular expression to identify
each event:

M [\d+-\d+-\d+ \d+:\d+:\d+,\d+\].*

[2016-06-06 13:11:26,824] [INFC] [I18N]Locale has not been chosen by the user.
[2016-06-06 13:11:26,824] [ERROR] [DirectConnectionféReadChannel]
java.io.I0Exception: end of communication channel
at com.arcsight.logger.distributed.DirectConnection.a (DireccConnection,.java:39)
at com.arcsight.logger.distributed.DirectConnection.access5200 (DirectConnection.java:19)
at com.arcsight.logger.distributed.DirectConnection$ReadChannel . run (DirectConnection.java:85)
at java.util.concurrent.ThreadPoolExecutoriWorker.runTask (ThreadPoolExecutor. java:886)
at java.util.concurrent.ThreadPoolErecutoriWorker.run (ThreadPoolExecutor.java:908)
at java.lang.Thread.run (Thread.java:6189)

o For multi-line file receivers and file transfer receivers, the regular expression that idenfifies the
beginning of a new event must be specified in the receiver’s Multiline Event Starts With field.
o For multi-line folder follower receivers, the regular expression that identifies the beginning of a new

event must be specified in the Multiline Event Starts With field of the source type associated with
that receiver, rather than in the receiver itself.
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For information on creating and using receivers, see "Working with Receivers" on the next page. For
information on creating and using source types, see "Source Types" on page 311.

Folder Follower Receivers

When you want to monitor active files as they are updated, use a folder follower receiver. After you set
up a folder follower receiver and enable it, it will monitor the specified files in that directory and
continuously upload new events to the system. Folder follower receivers recognize file rotation.

Overview of the steps to monitor a directory:

1. Determine the types of logs you need to monitor.

2. Determine whether the out-of-box source types or source type/parser pairs will satisfy your needs.
For more information, see "Source Types" on page 311, and "Parsers" on page 315.

If so, proceed to the next step.
If not, create the parsers and source types that you need.

a. Select an appropriate parser or set of parser for the log files in the directory you want fo follow.
If the out-of-box parsers do not provide what you need, create appropriate parsers.

b. Assign a source type for each parser. If the out-of-box source types do not provide what you
need, create appropriate source types.

3. Create the folder follower receivers required to monitor the logs in the directory, selecting the
source type you chose or created, above. For more information, see "Working with Receivers" on
the next page.

4. Enable the receivers.

5. Optionally, to forward log file events, set up and configure one or more forwarders. For more
information, see "Forwarders" on page 321.

Using Source Types with File Follower Receivers

Logger uses the parser associated with the source type you select for a receiver to extract fields and
their respective values from the received events. These fields are parsed at search time. For more
information on using source types and parsers, see "Source Types" on page 311, and "Parsers" on
page 315.

When creating a file follower receiver, you must select a source type appropriate to monitor a specific
type of log file. After you select the source type for the file follower receiver, ensure that the parser
associated with it works with your source files.

Events from different versions of the same source type can be in different formats. Similarly, events
from different source types of the same vendor might be formatted differently. Therefore, if the source
type of your source file does not exactly match the specifications of your source type, the associated
parser will not parse events correctly, and the search results will not display any parsed fields.
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To confirm whether the source type has a valid parser for your source type, after you have set up the
receiver, check whether the incoming events are parsed. To determine this, run a search and review the
“parser” field in the search results. The parser used in the search will be displayed in the parser column
of the search results. If the event was parsed, this field contains the name of the parser. If the event was
not parsed successfully, this field contains “Not parsed.” If no parser is defined for the source type or if
there is no source type, the field is blank.

Working with Receivers

Several receivers come set up on your system. You can add other receivers as needed. The maximum
number of receivers that you can create is limited by system resources—memory, CPU, disk
input/output and possibly network bandwidth. The receiver ports available on your system may vary
from the image shown.

Before the receiver can receive data, the port it is listening on must be opened through the firewall. For
more information, see "Firewall Rules" on page 469.

Receivers page
Receivers
Add

Once you enable the Apache URL Access Error Log receiver, Logger will start storing entries from the <install_dir>/userdata/logs/apache
Jhitp_error_log file.

Logger can also store entries from the messages and audit.log files in the fvar/log/* folders. Before enabling the receivers for these files, consulr the
Logger Administrators guide for details.

Name ¥ Type IP Address Port

Apache URL Access Error Log Folder Follower Receiver PR v
Audit Log Folder Follower Receiver P e
AusmReceiverl TCP Receiver All 30001 PR v
AusmBReceiver101 CEF TCP Receiver All 30101 PR v

Before creating a receiver of type File Receiver:

o Forthe Logger Appliance, set up a Network File System mount. See "Storage" on page 347.

o For Software Logger, the file system from which the log files will be read needs to be mounted on the
system on which you have installed Logger.

Note: Before creating a receiver of type File Transfer, ensure that the appropriate SCP, SFTP, and
FTP client is installed on your system.

The Logger Appliance supports mounting through the user interface. Software Logger uses its file
system, which can contain remote folders mounted through the operating system.
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To create a receiver:

1. Open the Configuration | Data menu and click Receivers.

The "Receivers page" on the previous page displays the current receivers and their status. You can
sort the fields by clicking the column headers.

2. Click Add.

3. Enter a name for the new receiver. SmartMessage receiver names are used when configuring the
associated ArcSight SmartConnectors.

4. Choose the receiver type. Select UDP Receiver, TCP Receiver, CEF UDP Receiver, CEF TCP
Receiver, File Receiver, Folder Follower Receiver, File Transfer, or SmartMessage Receiver.

Note: The receiver type cannot be changed after the receiver is created.

5. Click Next to edit receiver parameters.

The fields displayed in the Edit Receiver dialog box vary according to the type of Logger and the
type of receiver.

6. Fillin the appropriate fields. Refer to the following tables for field descriptions.
e "UDP, TCP, CEF UDP, and CEF TCP Receiver Parameters" on page 301

o "Event Broker Receiver Parameters" on page 302

o "File Receiver Parameters" on page 303
e "Folder Follower Receiver Parameters" on page 305
o "File Transfer Receiver Parameters" on page 307

e "SmartMessage Receiver Parameters" on page 309

7. The Enable checkbox is flagged by default, so that the receiver will be enabled immediately after
you create. If you do not want to enable the receiver now, click the checkbox to remove the flag.
You can enable it later.

8. Click Save.
To enable or disable a receiver:

Note: Before enabling the following preconfigured folder follower receivers for Software Logger,
ensure that the files are readable by the non-root user that you installed with or specified during
installation.

e /var/log/messages

e /var/log/audit/audit.log
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Open the Configuration | Data menu and click Receivers.

The "Receivers page" on page 298 displays the current receivers and their status. You can sort the
fields by clicking the column headers.

Locate the receiver that you want to enable or disable.

o |f the receiver is currently disabled, click the Disabled icon (@) 10 enableit.

o If the receiver is currently enabled, click the Enabled icon (+") to disable it.

Tip: Wait a few minutes after enabling a receiver before disabling it. Likewise, wait before
enabling a receiver that has just been disabled. Background tasks initiated by enabling or
disabling a receiver can produce unexpected results if they are interrupted.

To edit a receiver:

1.

Open the Configuration | Data menu and click Receivers.

The "Receivers page" on page 298 displays the current receivers and their status. You can sort the
fields by clicking the column headers.

Locate the receiver that you want to update and click the Edit icon (#") on that row.

The fields displayed in the Edit Receiver dialog box vary according to the type of Logger and the
type of Receiver.

Edit the appropriate fields. Refer to the following tables for field descriptions.
e "UDP, TCP, CEF UDP, and CEF TCP Receiver Parameters" on the next page

o "Event Broker Receiver Parameters" on page 302

o "File Receiver Parameters" on page 303
o "Folder Follower Receiver Parameters" on page 305
o "File Transfer Receiver Parameters" on page 307

e "SmartMessage Receiver Parameters" on page 309

Flag the Enable checkbox to have the receiver immediately enabled, or remove the flag from the
checkbox to enable the receiver later.

Click Save.

To delete a receiver:

1.

Open the Configuration | Data menu and click Receivers.

The "Receivers page" on page 298 displays the current receivers and their status. You can sort the
fields by clicking the column headers.

Locate the receiver that you want to delete and click the Remove icon ( *) on that row.

Click OK to confirm the delete.
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UDP, TCP, CEF UDP, and CEF TCP Receiver Parameters

Fill in the following fields when creating or editing UDP Receivers, TCP Receivers, CEF UDP Receivers,
and CEF TCP Receivers.

Parameter Description

Name Enter the name of the Receiver, used for reporfing and status monitoring.

IP/Host Select one of the available network connections for the receiver to listen to, or select All to listen on both
network connections.

Note: If localhost (127.0.0.1) appears in the list, it means that the Logger hostname has not been
configured. To configure the hostname, see "Network" on page 406.

Port For the Logger Appliance:

e The default UDP Receiver is pre-configured on port 514.
o For SmartMessage receivers, configure the SmartConnector for port 443.

For Software Logger:

o If youinstalled Software Logger as a roof user, you can use any available port. The default UDP Receiver
is pre-configured on port 514. If that port is not available, then the next higher available port is chosen.

o If youinstalled Software Logger as a non-root user, you can only use a port numbers greater than 1024.
The default UDP Receiver is pre-configured on port 8514. If that port is not available, then the next
higher available port is chosen.

Encoding  Select a character encoding, such as US-ASCII, Big5, or EUC-KR, from the pulldown list. CEF UDP, CEF TCP,
and SmartMessage receivers must use US-ASCII or UTF-8 encoding.

Source Select from the pull-down list of log file types, including:
Type e Apache HTTP Server Access
e Apache HTTP Server Error

e Juniper Steel-Belted Radius
e Microsoft DHCP Log

o |BM DB2 Audit

e More options..

Additionally, you can define your own source types, based on the needs of your company. See "Source
Types" on page 311

A receiver can only receive events of a single source type. Set up separate receivers for each type of log
file.

Note: CEF TCP and CEF UDP receivers are set to the CEF source type, and cannot be changed.
Currently, there is no parser associated with the CEF source type.

Associating Source types with TCP and UDP receivers was introduced in Logger 5.3 SP1. When upgrading,
TCP and UDP receivers from earlier releases are set to the “Other” source type.
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Event Broker Receiver Parameters

Fill in the following fields when creating or editing Event Broker receivers.

Parameter

Name

Event broker host(s)
and port

Event Topic List

Retrieve Event from
Earliest Offset

Consumer Group

HPE Logger 6.3

Description
Enter the name of the Event Broker receiver.
This is a required field.

Enter a list of host/port pairs to use for establishing the initial connection to the Event
Broker Kafka cluster.

This is a required field.
Valid Values: Should be in the following format:
host1portl, hotst2:port2,...

Note: The hostname needs to be resolvable. Be sure to configure a DNS and add the
appropriate hosts. See "Network" on page 406 for more information.

Enter the event topics the receiver should subscribe fo.

This is a required field.

Valid Values: Comma separated list of event topics. Event topic names are case sensitive.

Set to true fo refrieve the earliest offset of this partition. (Retrieves all existing events as well
as new incoming events.)

Set to false to retrieve the latest offset. (Only retrieves new incoming events.)

This option is only used in initial configuration.

The default is true.

Enter a name that uniquely identifies the Consumer Group this receiver belongs fo.

When multiple Loggers have Event Broker receivers that subscribed to the same topic and
belong to the same Consumer Group, each Logger in the group will receive events from a
different subset of partitions in the topic. The Event Broker will balance the partitions
between all Logger configured in the same Consumer Group.

This is a required field.
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Parameter

Use SSL/TLS

Description

Select true to enable SSL/TLS encryption. HPE Security ArcSight recommends that you set
this option to true. If you select false, information sent via this receiver will in plain text.

Default: false

When set to true, you must provide the Event Broker CA or Self-Signed Certificate File
Location.

Event Broker CA or Self- Required if use SST/TLS is true.

Signed Certificate File

Location

Enable

If the certificate is the Certificate Authority (CA) signed, specify the location of the Java
KeyStore (JKS) truststore that contains the CA certificate (CA root that signed the Event
Broker certificate.)

If the Event Broker certificate is self-signed, the location of the JKS truststore of the self-
signed cerfificate.

Check this box to enable the receiver.

File Receiver Parameters

Fillin the following fields when creating or editing File Receivers.

Parameter
Name

RFS Names

Folder

Source
Type

Description
Enter the name of the receiver, used for reporting and status monitoring.

Select from the pulldown list of NFS or CIFS mount names. The list also includes attached SANs on Logger
models that support SAN.

To mount NFS volumes, see "Storage" on page 421. To mount CIFS shares, see "Storage" on page 421. For
more information about SAN, see "SAN" on page 424.

Choose “Local” and then specify the directory on your Logger where the remote file system is mounted in
the “Folder” field.

To mount a remote file system on the system on which you have installed Logger, see its operating
system’s documentation.

Select from the pulldown list of log file types, including:

Apache HTTP Server Access
o Apache HTTP Server Error
e Juniper Steel-Belted Radius
e Microsoft DHCP Log
« |BM DB2 Audit
e More options..
Additionally, you can define your own source type, based on the needs of your enterprise. See "Source

Types" on page 311.

A receiver can only receive events of a single source type. Set up separate receivers for each type of log
file.
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Parameter Description

Wildcard A regular expression (regex) describing the log files to read.

regex .. . P .
(regex) This is a regular expression, not a typical file wildcard like “* . *”.

The default is .*, meaning all files.

Examples:

Toinclude all files ending with . process, you could use:
.*\.process

To monitor only *properties files, you could use:
.*\.properties

Toinclude only .log files with eight digit filenames, you could use:
\d{8}.1log

Note: Uploading any type of data other than text, including binary files such as .zip or .bin, may
prevent Logger from functioning correctly. Use caution when pulling everything from a directory by
specifying . * in the Regex field, as you could inadvertently include binary files.

Mode Select one of the following:

o Delete - delete the log file once it has been processed

« Rename - rename the log file once it has been processed. The file is named by appending the Rename
Extension.

o Persist - Logger remembers which files have been processed and only processes them once.

Rename The suffix o append to log files that have been processed.
extension

Character  Select a character encoding, such as US-ASCII, Big5, or EUC-KR, from the pulldown list. CEF UDP, CEF TCP,
encoding and SmartMessage receivers must use US-ASCIl or UTF-8 encoding.

Delay after Number of seconds to wait after a source file is first seen untfil it is processed. This allows the entire file to
seen be copied to Logger or (in the case of File Receiver) copied to the remote file system, before processing
begins.

The default is 10 seconds.

Note: For File Transfer Receivers, this parameter should be set to a larger value if large files are
expected. The default, 10 seconds, does not allow enough time for a large file, such as 1 GB.

Event Select a locale from the pulldown list, such as English (United States), Chinese (Hong Kong), Chinese
Time (Taiwan), and so on.
Locale

Date/time  Required if the timestamp in the log file does not specify a fime zone.

zone ) . . . - e ) .
For File Transfer and File Receivers, this parameter is ignored if either Date/time format or Date/fime

location regex are blank.

On appliance Loggers you can see the time zone configured on the LoggerSystem Admin | System |
Network > Time/NTP tab. Software Loggers use the system time.
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Parameter Description

Event A regular expression describing which characters represent the timestamp in the log file. For example:
Time
. SAVECLED AN P
Location
This regular expression specifies that the timestamp is found inside the first set of square brackets on
each line. The first capturing group (the part of the regex in parentheses) is that part that is then parsed
using the Date/time format.
The default is no timestamp.
Event Required if the log file contains fimestamps in the same format for each event. If not specified (or if the
Time Date/time location regex is blank), each event in the file will be stamped with the date that the file itself
Format was first seen by Logger (not its file system timestamp).

See "Date and Time Specification" on page 310 for a list of formats.
The default is no timestamp.

Multiline A regular expression that specifies the start of a new event in a log file. Specify this expression o enable
Event the receiver to read multi-line log files. Each new event starts at the point where the regular expression is
Starts With  matched to the characters in the log file. For example,

A\ [\d+-\d+-\d+ \d+:\d+,\d+].*

This regular expression matches timestamps such as:

[2010-12-06 13:09:46,818]

When this field is left blank, each line in the log file is freated as a single event.

The default is each line in the log file is a single event.

Folder Follower Receiver Parameters

Fillin the following fields when creating or editing Folder Follower Receivers.

Parameter Description

Name Enter the name of the receiver, used for reporting and status monitoring.
Local Specify the local folder to process. On the Logger Appliance, this field is only available if you select
Folder “Local” for the Mount Name.
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Parameter Description

Source Select from the pulldown list of log file types, including:
Type Apache HTTP Server Access
e Apache HTTP Server Error

e Juniper Steel-Belted Radius
e Microsoft DHCP Log

o |BM DB2 Audit

e More options..

Additionally, you can define your own source type, based on the needs of your company. See "Source
Types" on page 311

A receiver can only receive events of a single source type. Set up separate receivers for each type of log
file.

Wildcard A regular expression (regex) describing the log files to read.

regex . . . o .
(regex) This is a regular expression, not a typical file wildcard like “**".

The default is . *, meaning all files.

Examples:
Toinclude all files ending with .process, you could use:
.*\.process

To monitor only *properties files, you could use:
.*\.properties

To include only .log files with eight digit filenames, you could use:
\d{8}.1log

Note: Uploading any type of data other than text, including binary files such as .zip or .bin, may
prevent Logger from functioning correctly. Use caution when pulling everything from a directory by

specifying .* in the Regex field, as you could inadvertently include binary files.
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Parameter Description

Blacklist A regular expression (regex) describing the name of the log files to ignore. Files are not monitored if they
(regex) match this expression.

This is a regular expression, not a typical file wildcard like *. *.
Example:

To exclude files that end in .txt, you could use:
SR\ txt

To monitor all files except *txt, you could use:
Wildcard: . *
Blacklist: .*\.txt

Character  Select a character encoding, such as US-ASCII, Big5, or EUC-KR, from the pulldown list. CEF UDP, CEF TCP,
encoding and SmartMessage receivers must use US-ASCII or UTF-8 encoding.

Date/time  Required if the timestamp in the log file does not specify a fime zone.

zone ) . . . . o ) .
For File Transfer and File Receivers, this parameter is ignored if either Date/time format or Date/fime

location regex are blank.

You can see the time zone configured on the LoggerSystem Admin | System | Network > Time/NTP
tab.

Software Loggers use the system fime.

File Transfer Receiver Parameters

Fillin the following fields when creating or editing File Transfer Receivers.

Parameter Description

Name Enter the name of the receiver, used for reporting and status monitoring.
Protocol Select SCP, SFTP or FTP protocol.

Port The port number for the receiver. The default port is 22.

IP/Host Select one of the Logger’s network connections for the receiver to listen to, or select All to listen on both
network connections.

Note: If localhost (127.0.0.1) appears in the list, it means that the Logger hostname has not been
configured. To configure hostname, see "Network" on page 406.

User Enter a user on the host with privileges to view and read the source log files. If the protocol is FTP, you
can specify the special user, “anonymous.”

Password Enter the password of the specified User. The password must not be empty, even in the case of
anonymous FTP (although in this case, the password will be ignored.)
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Parameter Description

File path Enter the path and the name of the log file(s) to be read. You can use wild cards like ? and * (for
example, ¥.1log or Log-??.txt)in the path name and the file name. Separate directories with forward
slashes (/).

Separate multiple file specifications with commas.

Example: /tmp/SyslogData/syslog.log.gz, /security/logs/*/, /security/
log?/admin/special/

Note: Uploading any type of data other than text, including binary files such as .zip or .bin, may
prevent Logger from functioning correctly. Be sure that any directories you specify do not include
binary files. Use caution when pulling everything from a directory by specifying *, as you could
inadvertently include binary files.

Schedule Specify when and how often you want the File Transfer to run. If no schedule is specified, the File
Transfer will occur just once. For scheduling information, see "Scheduling Date and Time Options" on
page 136.

Zip Format Choose gzip, zip, or none.

Source Select from the pulldown list of log file types, including:
Type e Apache HTTP Server Access

e Apache HTTP Server Error

o Juniper Steel-Belted Radius

e Microsoft DHCP Log

« |BM DB2 Audit

e More opftions..

Additionally, you can define your own source type, based on the needs of your enterprise. See "Source

Types" on page 311

A receiver can only receive events of a single source type. Set up separate receivers for each type of log
file.

Character  Select a character encoding, such as US-ASCII, Big5, or EUC-KR, from the pulldown list. CEF UDP, CEF TCP,
encoding and SmartMessage receivers must use US-ASCII or UTF-8 encoding.

Delay after Enter the number of seconds to wait after a source file is first seen until it is processed. This allows the
seen entire file to be copied to Logger or (in the case of File Receiver) copied to the remote file system, before
processing begins.

The default is 10 seconds.

For File Transfer Receivers, this parameter should be set to a larger value if large files are expected. The
default, 10 seconds, does not allow enough time for a large file, such as 1 GB.

Event Select a locale from the pulldown list, such as English (United States), Chinese (Hong Kong), Chinese
Time (Taiwan), and so on.
Locale

HPE Logger 6.3 Page 308 of 623



Administrator's Guide
Chapter 5: Configuration

Parameter Description

Date/time  Enfter the date/time zone. For more information, see "Date and Time Specification" on the next page.
zone
Required if the timestamp in the log file does not specify a tfime zone.

For File Transfer and File Receivers, this parameter is ignored if either Date/time format or Date/time
location regex are blank.

You can see the time zone configured on the Logger System Admin | System | Network > Time/NTP tab.

Software Loggers use the system fime.

Event A regular expression describing which characters represent the timestamp in the log file. For example:
Time [ F2IN]L
Location
This regular expression specifies that the timestamp is found inside the first set of square brackets on
each line. The first capturing group (the part of the regex in parentheses) is that part that is then parsed
using the Date/time format.
The default is no timestamp.
Event Required if the log file contains timestamps in the same format for each event. If not specified (or if the
Time Date/time location regex is blank), each event in the file will be stamped with the date that the file itself
Format was first seen by Logger (not its file system timestamp).

See "Dafe and Time Specification" on the next page for a list of format specifiers.
The default is no timestamp.

Multiline A regular expression that specifies the start of a new event in a log file. Specify this expression o enable
Event the receiver to read multi-line log files. Each new event starts at the point where the regular expression is
Starts With  matched to the characters in the log file. For example,

M\ [\d+-\d+-\d+ \d+:\d+,\d+].*

This regular expression matches fimestamps such as:

[2010-12-06 13:09:46,818]

When this field is left blank, each line in the log file is freated as a single event.

The default is each line in the log file is a single event.

SmartMessage Receiver Parameters

Fillin the following fields when creating or editing SmartMessage Receivers.
Parameter Description

Name Enter the name of the receiver, used when configuring an associated ArcSightSmartConnector.

Encoding  Select a character encoding, such as US-ASCII, Big5, or EUC-KR, from the pulldown list. CEF UDP, CEF TCP,
and SmartMessage receivers must use US-ASCII or UTF-8 encoding.
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Date and Time Specification

To specify the date and fime format so that it can be parsed from a file receiver, (File Receiver, Folder
Follower Receiver, or File Transfer), refer to the table "Date/Time Format Specification" below.
Internally, Logger uses a common Java method called SimpleDateFormat. Sophisticated uses of
SimpleDateFormat, as described in Java sources, will work with Logger. Pattern letters are usually
repeated, as their number determines the exact presentation.

The following examples show how date and time patterns are interpreted in the U.S. locale. The given
date and time are July 4th 2013, at 12:08:56 local time, in the “U.S. Pacific Time” time zone.

Date/Time Examples
Source
2013.07.04 AD at 12:08:56 PDT
Wed, Jul 4,"13
12:08 PM
12 o'clock PM, Pacific Daylight Time
0:08 PM, PDT
2013.July.04 AD 12:08 PM
Wed, 4 Jul 2013 12:0856 -0700
130704120856-0700

2013-07-04T12:08:56.235-0700

Date and Time Pattern
yyyy.MM.dd G 'at' HH:mm:ss z

EEE, MMM d, "yy

h:mm a

hh 'o'clock’ a, zzzz

Kimm a, z

yyyyy.MMMMM.dd GGG hh:mm aaa
EEE, d MMM yyyy HH:mm:ss Z
yyMMddHHmmssZ

yyyy-MM-dd'T'"HH:mm:ss.SSSZ

Date/Time Format Specification

Symbol Meaning

G Era designator

y Year

M Month in year (1-12)
w Week in year (1-52)
w Week in month (1-5)
D Day in year (1-366)

d Day in month (1-31

E Day in week

F Day in week of month
a Am/pm marker

HPE Logger 6.3

Presentation Examples
(Text) AD

(Number) 2013 or 13

(Month) July or Jul or 07
(Number) 39

(Number) 2

(Number) 129

(Number) 10

(Text) Tuesday or Tue
(Text) AM or PM
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Date/Time Format Specification, continued

Symbol Meaning Presentation Examples

H Hour in day (0-23) (Number) 0

k Hour in day (1-24) (Number) 24

K Hour in am/pm (0-11 (Number) 0

h Hour in am/pm (1-12) (Number) 12

m Minute in hour (0-59) (Number) 30

s Second in minute (0-59) (Number) 55

S Millisecond (0-999) (Number) 978

z Time zone (Text) Pacific Standard Time, or PST, or GMT-08:00
Z Time zone (RFC 822) -0800 (indicating PST)

Source Types

Source types identify the kind of event that comes from a specific data source. For example, an event
could come from an Apache access log, a simple syslog, or the log of an application you created. You can
use parsers to parse event data from a specified source type.

Once events are associated with a source type, if the source type is associated with a parser, the events
are parsed by that parser when you run a search that matches those events. The search result displays
the matching parsed event fields in columns, similar to the CEF events. (Use the “User Defined Fields”
field set to view these events.) For more information, see "Parsers" on page 315.

The source of the event, the source type, and the parser will be displayed in the column list of the search
results if any row is fetched from a search that contains a non-CEF source type.

Prerequisites
Users must be assigned to the following User Groups to access this feature:

o Default Logger Rights Group
o Default System Admin Group

See "Setfting Logger User Permissions" on page 458 for more information.

The following columns are displayed in the search results when a source type is used:

e Source: The name of the log file from which the event was received.

For example, /opt/mnt/testsoft/web_server.out.log.If no source was applied when the
event was received, this field is blank. You can control whether this field is displayed from the Search
Options page. See "Search Options" on page 277 for how to set this option.
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o Source Type: The type of file from which the event was received, as defined on the Source Type
page (Configuration | Data > Source Types). If no source type was applied when the event was
received, this field is blank. You can control whether this field is displayed from the Search Options

page. See "Search Options" on page 277 for how to set this option.

o Parser: If the event was parsed, this field contains the name of the parser. If the event was not
parsed successfully, this field contains “Not parsed.” If no parser is defined for the source type or if

there is no source type, the field is blank.

Working with Source Types

Logger provides a number of source types with pre-configured parsers. Additionally, you can define
new source types and assign parsers to them. This lets you choose the set of fields you want to extract
for a given kind of event. Only one parser can be associated with a source type, however, multiple
source types can be associated with a parser. Out-of-box source types cannot be edited or deleted, but
you can copy them to make similar source types to meet your needs. You can edit or delete custom
source types, as desired. The source types available on your Logger may vary from the image below.

Source Types page

Source Types

Add

WMWare_ESX

TippingPoint_SMS

syslog

Other

4 Description

VMWare ESX Syslog

Tipping Point SM5 2.5
Syslog

Simple Syslog

Parser Event Time Location  Event Time Format

FOwENs\d+H\s\d\d:\d

WMWare_ESX \dAdvd)*

MMM dd HH:mm:ss

TippingPoint_SMS

Q{3 \dd \d\d:\d

\d:d\d).* MMM dd HH:mm:ss

syslog

legacy Other

The following source types have associated parsers:

Source type
Apache_access
Apache_error
audit_log
Bluecoat_proxy
Cisco_PIX
IBM_DB2

Juniper_NSM

HPE Logger 6.3

Description

Apache Access Log
Apache Error Log

Syslog for Audit Log files
Bluecoat Proxy SG

Cisco PIX

IBM DB2 9.x Audit Log

Juniper NSM 2009 Syslog

Multiline Event Starts With Locale

English

(United [iEs
States)
English
(United lEE]
States)
English
(United lEE]
States)
English
(United lEE]
States)
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Source type
logger_syslog
Microsoft_DHCP
syslog
TippingPoint_SMS

VMware_ESX

Description

Syslog for syslog files on Logger Appliance
Microsoft DHCP for 2008 vé6 log files
Simple Syslog

Tipping Point SMS 2.5 Syslog

VMware ESX Syslog

Logger can forward an event to ESM by using a Connector forwarder, which then forwards it to a

Streaming Connector. This connector normalizes the event and forwards it to ESM.

If you need forward events to ESM by using a Connector forwarder, you must choose one of the
following source types:

Source Type

Apache HTTP Server Access  Juniper Steel-Belted Radius

Apache HTTP Server Error Microsoft DHCP Log

IBM DB2 Audit

Other

To add a source type:

1. Open the Configuration | Data menu and click Source Types.

The "Source Types page" on the previous page displays the current source types. You can sort the
fields by clicking the column headers.

2. Click Add.

HPE Logger 6.3
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3. Fillin the fields to define the source type:

Source Type Fields
Field Description
Name The name of the source type.

Description A description of the source type.

Parser The parser you want to associate with this source type. If the parser you need does not appear in the
drop-down list, you can add one. For information on how fo add a parser, see "Parsers" on the next
page.

Event A regular expression describing the timestamp in the log file. For example:

Time S[(L %)\ *

Location

This expression specifies that the timestamp is found inside the first set of square brackets on each
line. The first capturing group (the part of the regex in parentheses) is the part that is then parsed
using the Date/time format.

You can specify that there is no timestamp in the log file with “°.

Event A regular expression describing the date and time format in the log file. For example,
Time dd/MMM/yyyy:HH:mm:ss Z
Format

You can specify that there is no timestamp in the log file with “°.

For more information about event fime, see "Time Range" on page 76 and "Date and Time
Specification" on page 310.

Multiline A regular expression describing how fo recognize when adjacent lines are of the same event or

Event when a new event starts. For example if each event starts with the date in the format, yy-MM-dd

Starts With  HH:mm:ss.SSS you could use (\d+-\d+-\d+ \d+:\d+:\d+.\d+) toindicate the start of a new
event.

Locale Select a locale from the pulldown list, such as English (United States), Chinese (Hong Kong), Chinese

(Taiwan), and so on. This is locale of the data Logger should find in the file.

4. Click Save.

To edit a source type:

1. Open the Configuration | Data menu and click Source Types.

The "Source Types page" on page 312 displays the current source types. You can sort the fields by
clicking the column headers.

2. Locate the source type that you want to update and click the Edit icon (#" on that row.

Note: The Edit icon (#) is not available for out-of-box source types. You can copy the source
type and make a similar one instead.

3. Edit the fields as appropriate.
See the table "Source Type Fields" above for field details.
4. Click Save.
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5. Disable and then re-enable any receivers that use this source type.

Note: Changes in source type are not reflected in the associated receivers until you have re-
enabled them.

To copy a source type:

1. Open the Configuration | Data menu and click Source Types.

The "Source Types page" on page 312 displays the current source types. You can sort the fields by
clicking the column headers.

2. Locate the source type that you want to copy and click the Copy icon (2) on that row.
3. Enter a name for the new source type and edit the fields as appropriate.

See the table "Source Type Fields" on the previous page for field details.

4. Click Save.

To delete a source type:

1. Open the Configuration | Data menu and click Source Types.
The "Source Types page" on page 312 displays the current source types. You can sort the fields by
clicking the column headers.

2. Locate the source type that you want to delete and click the Remove icon ( *¥) on that row.

Note: The Remove icon ( *) is not available for out-of-box source types. You can only remove
source types that you added.

3. Click OK to confirm the removal.

Parsers

Parsers enable you to extract and manipulate raw events (non-CEF data) from different sources in your
network environment. Once you have parsed event fields, you can easily search for data, chart it, and
perform other operations on it. One user with in-depth knowledge of the events can create the parser,
and then all users who look at those events will get the benefit of that work.

Parsers provide you with a simple way fo read events. Instead of looking at raw event data and trying to
figure out what it means, you can use a parser to extract portions of non-CEF events into fields.
However, the fields created by the parser are available only for search operations, and are not added to
the Logger schema.

You can use a parser either of the following ways:

e Use the parser with a source type: You can associate the parser with a source type to extract any
set of fields in any kind of event. For more information, see "Source Types" on page 311.
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e Use the parse command in a search: During a search, you can use the parse command to extract
fields from events and use other search operators (such as where, chart, fop, and so on) to further
refine the search or manipulate the data in the fields. This is particularly useful for IT operations and
other customers who need to extract and manipulate raw event data.

Prerequisites
Users must be assigned to the following User Groups to access this feature:

o Default Logger Rights Group
o Default System Admin Group

See "Sefting Logger User Permissions" on page 458 for more information.

Using Parsers with Source Types

Logger provides a number of pre-configured parsers with associated source types. You can also define
new parsers and associate them with source types. Only one parser can be associated with a source
type, however, multiple source types can use the same parser. Out-of-box parsers cannot be edited or
deleted, but you can copy them to make a similar parser to meet your needs. You can edit or delete
custom parsers as desired.

Parsers page
Parsers

Add

Name 4 Parser Type Description Definition

VMWare ESX (7<Module>\S+?mware-hostd|Hostd|Fdm|DCUIvmkwarningljumpstart|dhclient-
VMWare_ESX Rex Parser Syslog Parser uw-\d+lesxupdatelVpxalvodblauthdlcimslplsfcblnssquerylvmkernellwatchdog-\S+|dhdlientlVMware\[init [EE]
vsiog lsyslogd\sDd\J+)AL?<PID=\d+ \D2+:(?<message>.")

(F<timestamp>\w{3} \d+ \d\d:\d\d\d\d)? 2(?<host=[wid\.1+)? H?<actionType=\d\t(?<appSeverity>
A< policyUUID = \w+-Yw+-\w+-\w+- w0\ (2 < signatureUUID = \w+-\w+-\w+-\w+-\w+)\1(?<message> B
[\1+ 042 <appld > \d + (2 < protocal=\w+\{?<srclp_..

; Tipping Point SM3
TippingPoint_SM5 Rex Parser 2.5 Syslog Parser
Simple Syslog
syslog Rex Parser Parser for syslog
files on Linux

(<C2<priority>\d+)=)?(?<timestamp>\w{3Ns"wi0.3Ns*\d+ \d{0. &NsNSIBD(s"(? < DeviceHostName=[* e
T)?2(?<message=.")

Using the Parse Command

The parse command can be used to invoke a parser on any non-CEF events that are returned by a
search. It applies the definition of the parser, such as the regular expression of a rex parser, to each
event. Then it adds the fields that are extracted by that regular expression to the fields that are being
passed through. For a REX parser, this is functionally the same as having a rex command with the same
regular expression as the definition of the parser, so you can think of a REX parse command as invoking
a saved rex expression.

For more information about the parse command, see "parse" on page 492. For information about
searching in general, see "Searching and Analyzing Events" on page 65.
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Working with Parsers

You can define two types of parsers—a REX parser or an Extract parser. Before adding the parser, you
need to define the query you wanft o use for parsing events.

For a Rex parser, one way to do this is to use the rex search operator to test and adjust a regular
expression until it returns the desired fields from the events that you want it to handle. Then copy the

rex expression and paste it into the parser’s Definition field. For an Extract parser, use the extract
operator. For more information about the search operators, see "parse" on page 492, "rex" on page 497,

and "extract" on page 483.

The parser used in a search will be displayed in the Parser column of the search results. If the event was
parsed, this field contains the name of the parser. If the event was not parsed successfully, this field
contains “Not parsed.” If no parser is defined for the source type or if there is no source type, the field is
blank.

Prerequisites
Users must be assigned to the following User Groups to access this feature:

o Default Logger Rights Group
o Default System Admin Group

See "Setting Logger User Permissions" on page 458 for more information.

To add a parser:

1. Open the Configuration | Data menu and click Parsers.

The Parsers page, shown in "Parsers page" on the previous page, displays the current parsers. You
can sort the fields by clicking the column headers.

Click Add.

Enter a name for the parser.

Choose the Parser Type from the drop-down list.

Click Save.

The fields display in the Edit Parser dialog box according to the type of parser.

SN AN
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6. Fillin the fields for the parser.

Parser Fields
Field
Name

Description

Rex parsers only
Definition

Extract parsers only

Pair Delimiter

Key/Value Delimiter

Fields

7. Click Save.

To edit a parser:

Description
The name of the parser. Enter a new name if you want fo change the existing name.

A meaningful description of the purpose of the parser.

The rex expression that you want fo use to parse events.

The characters separate key/value pairs within an event. Enter only the separator
characters, for example:

\ s

The characters that separate the key from the value. Enter only the delimiter character, for
example:

The list of field names o use when parsing events.

Enter the field names, separated by comma (). For example, to parse events like:
foo=abc, bar=xyz, baz=def

Enter: foo,bar,baz

1. Open the Configuration | Data menu and click Parsers.

The Parsers page, shown in "Parsers page" on page 316, displays the current parsers. You can sort
the fields by clicking the column headers.

2. Locate the parser that you want to update and click the Edit icon (#") on that row.

Note: The Edit icon (#) is not available for out-of-box parsers. You can copy the parser and
make a similar one instead.

3. Edit the parser fields as appropriate.

The fields displayed in the Edit Parser dialog box according to the type of parser. Parser fields are
documented in the table "Parser Fields" above.

4. Click Save.
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To copy a parser:

1.

4,

Open the Configuration | Data menu and click Parsers.

The Parsers page, shown in "Parsers page" on page 316, displays the current parsers. You can sort
the fields by clicking the column headers.

Locate the parser that you want to copy and click the Copy icon (tB) on that row.
The fields displayed in the Edit Parser dialog box according to the type of parser.
Enter a name for the new parser and edit the fields as appropriate.

Parser fields are documented in the table "Parser Fields" on the previous page, above.

Click Save.

To delete a parser:

1.

Open the Configuration | Data menu and click Parsers.

The Parsers page, shown in "Parsers page" on page 316, displays the current parsers. You can sort
the fields by clicking the column headers.

Locate the parser that you want to delete and click the Remove icon ( * ) on that row.

Note: The Remove icon ( *) not available for out-of-box parsers. You can only remove
parsers that you added.

Click OK to confirm the removal.

Tip: Be cautious when deleting a parser. Logger doesn't warn you when you modify or delete a
parser that is associated with a Source Type.

Example: Creating an Extract Parser

Suppose you wanft fo create a parser to find the contents of the INT, MAC, DST, and SRC fields of a log
like the one below.

Jul 12 14:30:31 nl15-214-128-h92 kernel: IN=eth2
MAC=00:24:e8:60:cb:82:00:50:56:92:2a:d5:08:00 SRC=192.0.2.9 | DST=192.0.2.2
LEN=52 TOS=0x00 PREC=0x00 TTL=128 ID=21408 DF PROTO=TCP SPT=56978 DPT=443
WINDOW=8192 RES=0x00 SYN URGP=0

Jul 12 14:30:31 nl15-214-128-h92 kernel: IN=eth2 |
MAC=00:24:€8:60:cb:82:00:50:56:92:2a:d5:08:00 | SRC=192.0.2.9 | DST=192.0.2.2
LEN=52 TOS=0x00 PREC=0x00 TTL=128 ID=21408 DF PROTO=TCP SPT=56978 DPT=443
WINDOW=8192 RES=0x00 SYN URGP=0

Jul 12 14:30:31 nl15-214-128-h92 kernel: IN=eth2 |
MAC=00:24:€8:60:cb:82:00:50:56:92:2a:d5:08:00 | SRC=192.0.2.9 | DST=192.0.2.2
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LEN=52 TOS=0x00 PREC=0x00 TTL=128 ID=21408 DF PROTO=TCP SPT=56978 DPT=443
WINDOW=8192 RES=0x00 SYN URGP=0

In this sample log, the field values are indicated with an equal sign (=), and fields are delimited by pipe (|)
and colon (). You could use the following query to search for the contents of the IN, MAC, DST, and
SRC fields.

extract pairdelim= “|:” kvdelim= “=” fields= “IN,MAC,DST,SRC”

The following steps describe how to make an extract parser using that query.

To create an example extract parser:

1. Open the Configuration | Data menu and click Parsers.
2. Click Add. The Add Parser dialog box opens.

Add Parser

Name  ssmple_Extract_Parser

Parser Type I Extract Parser IZI

Save Cancel

3. Entfer a Name and select the Parser Type. For the example, enter:

Name: Sample_Extract_Parser
Parser Type: Extract Parser

4. Click Save. The Edit parser dialog box opens.

Edit Parser

Mame sample_Extract_Parser

Description  sample Extract Parser

Pair Delimiter |y,

Key/Value Delimiter |-

Fields |y, MAC, DST, SRC|

5. Enter the Pair Delimiter, Key value, and Fields for the parser. For the example, enter:
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Pair Delimiter: \ |\ :
Key/Value Delimiter: =
Fields: INT, MAC, DST, SRC

Note: You need to escape the pipe () and the colon (:) with a backslash (V.

6. Click Save. The Parsers page displays the new parser.

Parsers
Add
Name Parser Type Description Definition
Extract Sample

Sample_Extract_Parser Parser Extract pair delimiter [V\] key/value delimiter [=] fields [IN. MAC, DST, SRC] Pl ERE
Parser
Apache (?«SourceHost>\5+)[\s-1+(?<ldentity >\S+)2[\s-1+\[(?<Date> +TN\]\s+\"

Apache_access Rex Parser Access Log  (7<Method >\S+)\s+(?<URL>*?N\s+(HTTP/(? <HT TPVersion>*2)?\"\s+(? ()
Parser «ReturnCode>\d+Ms+-7(?«Length=\d+)?
ApsLApache Access Log Parser . <\ 73 13+ \dTATNs A\ <severity>[s-21)

Apache_error Rex Parser Error Log \s+(\[client\s+(? <clientlp>[\d\ 1"\ ]\s+File\s+does\s+not\s+exist: [§ES)
Parser \s+(?<«filename=15+))?+(? <message>.")

Forwarders send all events, or events that match a particular filter, on to a particular host or destination
such as ArcSight Manager.

The ability to define a different filter for each forwarder allows Logger to divide trafficamong several
destinations. For example, because Logger can handle much higher event rates than ArcSight Manager,
Logger might be used to forward events to a number of ArcSight Managers. Forwarder filters make it
possible to split the flow between the Managers, using one forwarder for each Manager. Additionally,
forwarding enables you to send a subset of events to other destinations for further processing while
maintaining all events on Logger for long-term storage.
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Forwarders page

Forwarders
Type of Filterl All j
Add

Mame Type Type of Filter IP/Host Port Query

Auto_Test TCP_Forwarder—InstallLogger jlch Regular 1521419465 5001 NONE # % +/ N
Forwarder Expression

Auto_Test_UDP_Forwarder—InstallLogaer Az fealla 1521419465 5000 NONE # % +/ 1l
Forwarder Expression

tcpAndUdpForwarderDisabled-TCPForwarder jlch Regular 1521419465 6015 NONE / % @
Forwarder Expression

_ UDP Regular

tepAndUdpForwarderDisabled-UDPForwarder ; 1521419465 6014 NONE # X @

Forwarder Expression

The forwarding filter is a query that searches for matching events, optionally within a time range. You
can create two types of forwarder filters—continuous and time-range bound.

¢ A continuous filter constantly evaluates the incoming events and forwards the matching ones to the
specified destination.

o A time-range bound filter uses a time range in addition to the specified condition to determine
whether an event should be forwarded to the destination. If the event falls within the specified time
range and matches the specified condition, it is forwarded; otherwise, it is not. The Logger receipt
fime of an event is used fo determine whether an event will be forwarded fo a destination when a
forwarder filter specifies a time range by which events are evaluated for forwarding. Once a
forwarder has forwarded all events within a time range, it does not forward any more events.

A forwarder only forwards events from the Logger that it is configured on; it cannot forward events
from peers.

A forwarder’s operation can be paused and resumed at any point in fime. When a forwarder resumes
operation, forwarding resumes from the last checkpoint that was established before the forwarding
operation was paused.

You can also disable and re-enable a forwarder. When you re-enable a forwarder, all previously
established checkpoints are removed and forwarding starts over again as per the forwarder
configuration-forwarders with continuous filters start from the current time, while forwarders with time-
range bound filters start from beginning of the configured time range.

Forwarder types include UDP Forwarder, TCP Forwarder, Connector Forwarder, and ArcSight ESM
Forwarder:

o UDP Forwarder UDP forwarders forward events by using the User Datagram Protocol.

e TCP Forwarder: TCP forwarders forward events by using the Transmission Control Protocol.

o Connector Forwarder: Connector forwarders send events to the Logger Streaming Connector.

o ArcSight ESM CEF Forwarders: ArcSight ESM CDF forwarders send Common Event Format (CEF)
events to an ESM Destination. The built-in connector on Logger is used to forward these events to
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ESM.

Note: In order to create an ArcSight Data Platform Logger and ArcSight ESM forwarder, you
must first create an ESM Destination. See "ESM Destinations" on page 339 for more information.

As a best practice, do not add more than ten regular expression forwarders. Even though each
additional forwarder improves the forwarding rate, the relation is not proportional. In high EPS (events
per second) situations or situations where other resource-intensive features are running in parallel
(alerts, reports, and several search operations) and the forwarding filter is complex, adding foo many
forwarders may reduce performance because forwarders have to compete for the same Logger
resources besides competing for the same built-in connector for forwarding.

You can specify a regular expression or an indexed search query (Unified Query) for the filter. Doing so
enables you to take advantage of the indexing technology to quickly and efficiently search for events to
forward.

Note: Unified query-based forwarders forward events once they have been indexed. Therefore,
these forwarders can exhibit “bursty” behavior because indexing occurs in batches on Logger. You

might notice the bursty behavior in the EPS out bar gauge (on top of the Logger interface
screen)—the bar gauge will display high EPS level as a burst of data is forwarded and then drop
back to normal level.

To create a forwarder:

1. Open the Configuration | Data menu and click Forwarders.

2. Click Add to display the following form.

Add Forwarder

Name < CEF Forwarder

Type I ArcSight ESM (CEF) Forwarder |z|
Type of Filter I Unified Query EI
Next Cancel

3. Enter a name for the new forwarder and choose the forwarder type appropriate for your need:
UDP Forwarder, TCP Forwarder, Connector Forwarder, or ArcSight ESM (CEF) Forwarder type.

4. Select the type of forwarding filter you want this forwarder to use—Unified or Regular

Expression. Select “Unified” if you want to specify an indexed search query or “Regular
Expression” to specify a regular expression query.
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5. Click Next.
6. Enter additional type-specific information as described in the following table.

Forwarder Parameters

Forwarder
Parameter Types Description
Name All The name that you entered in the previous screen is displayed automatically. If you
want to change the name, make the change on this screen.
Query All Enter the query that will be used to filter events that the forwarder will forward, or

select a filter from the Filters list.

Forwarder queries can be constrained by device groups and storage groups, but not by
Peers.

If you selected Unified Query in the previous screen, enter an indexed search query
that includes full-text and field-based indexed fields. You can click the Advanced
Search link to access the Search Builder tool to build an indexed query. (See
"Accessing the Advanced Search Builder" on page 90 for more information.)

Tip: The unified query you specify must follow the following guidelines, or you
will not be able to save the query or the forwarder.

Queries in the following format are valid; no other formats are allowed.
(full-text terms | field search)* | regex

That is, the query must only contain full-text (keyword) and field-